VATION

T 0O

THE PROFESSIONAL DESKTOP
PUBLISHER

Reference Guide

© David Pilling, P.O. Box 22, Thornton Cleveleys, Blackpool. FY5 1LR.
Web: http://www.pilling.demon.couk  Email: david@pilling.demon.co.uk



1l ConTenTs Qwamion Pro

Copyright © David Pilling 1999, 2000

All rights reserved.

No part of this product may be reproduced in whole or part by any means without written permission of
the publisher. Unauthorised hiring, renting, lending, public performance or broadcasting of this product
or its parts is prohibited.

‘While every care is taken, the publisher cannot be held responsible for any errors in this product, or for
the loss of data or consequential effects from the use of this package.

The Program:
Ovation Pro was written by David Pilling.
The new Ovation Pro templates were created by John Ferguson.

The Manual:

First edition 1996, written by John Wallace.
New and revised second edition 2000, by David Pilling and Jan van Vredenburch.

Published by David Pilling.

P.O. Box 22, Thornton Cleveleys, Blackpool. FY5 1LR.
Fax: +41 (0)870 0520941

Email: david@pilling.demon.co.uk

Web: http://'www.pilling.demon.co.uk

All trademarks acknowledged.



OvaTion Pro

Contents

1.1
1.2
1.3
1.4
1.5

21
2.
23
24
25
2.6
2.7
2.8
2.9
210

31
3.2
3.3
3.4
3.5
3.6
3.7
3.8
39
3.10
3.1
3.12

Introduction

OBV 1 i 3 050058 7
Ovation Pro Documentation . .. .....oviviinininnnnennnn.
Typographical Conventions . ..........c.cereiriiinenennnn
If you 'have Problems: .oz e snnivsvenies se s e s vave s
Latestinformalion:  coousas i s s s s s

Getting started

Loading Ovatlon Pro. . ... vsvesisseirsaiias s iamimim s
The!lean Bar MenU:.; v s dmdi i i e i rosas
Loading Existing Documents ............coiiiiiiiiiiinnns
OpeningaNewDocument .........coouiiinnninicianianas
The Document Window. . ......coviiiniinnnrnnnannrenes
The ToolboX .. ...t it r e ie e e eaeneeaeaenans
The nfa Palete . v rsemivnsrivimeive sy iy s v
The Bulton Bar o s diis sy d didi i syamss sian
Document ZOOME . ovw s samem stiasine 8 e e O e S
InteracVE HBID . < o s svimmmmiance mm e s nies sanam v v v

Working with Text

Typing & Editing Text .. ovvivisavmvisiniisvesimeiavssdd
Inserting Special Characters. . ..........coviiiiiiiiannnn
IPONG TORL o v smvws mima o svms wins o asm v s we. o 6w i s
DR BERBAD v ovmosamesmsmms sgrrom e s s ee
Revert o Saved . .c..vvewvrmscasnroesrserrssesssnssssss
Selacting Text s vismarmyiuaaap i iinnesiniass
Delete, Cut, Copy &Paste ........c.ovvviieviivinnanennns
Drag:& Drob o o vsise s smmomiss: e #ima s i s s 5 i s
Find& Replace . ....coovuiiiiiriiiiisnaneennenenaennns
SavING DOCUMBINS. ... o oo nmmimns 505 558 EE & B r S i A AT
Basic:PHANNG =55 s s s s s s e ewn
Closing Documents & Quitting . .........cooiiiiiiiine,

ConTENTS i



v

4
41
4.2
4.3
4.4
4.5
4.6

5.1
5.2
5.3
54
5.5
5.6
5.7
5.8

6.1
6.2
6.3
6.4
6.5
6.6
6.7
6.8

7.4
7.2
7.3
7.4
75

ConTeENTS

Adding Style

Applying StyleEffects. .. .......ooiiiiii i

Changing Font .

Changing Type SIZe wu . uivs v sis s s evvasaycandai s

Formatting Text
Applying Format
Alignment ... ..

ElOBt s s s s T A T

The Format Dialogue BoX. .. ......covvviiiiiiniinninnn

The Tab Ruler. .

Automatic Hyphenation. . ... v.iiiiiiviiaiaseivaiininsads
Enhanced Justification .. ........ ... o i il
Automatic Paragraph Numbering . .........covviiiininn.

Defined Styles

The Edit Style Dialogue Box. ..........coviiiiiiinninnnn

Creating Styles .
Editing Styles . .

Renaming & DeletingStyles. ......... ...,

Applying Styles .
Removing Styles
Merging Styles .

Document View
The View Menu.

39
40
41
42
44
46
47

51
52
53
54
56
61
64
66
69

73
74
75
76

79
80
81
82

84
84
85
89
20

Ovarion Pro



Owarion Pro

8
8.1
8.2
8.3
8.4
8.5
8.6
8.7
8.8
8.9
8.10
a1

9.1
9.2
9.3
9.4
9.5
9.6
9.7
9.8
9.9
2.10
an
9.12
913

10

10.1
10.2
10.3
10.4
10.5
10.6
10.7
10.8
10.9

10.10
10.11
10.12
10.13

Drawing and Editing Objects

DiraWIng FrAMBS .« o oo sraiatie s & s el s s
Dirawing HInes. s evass e ais ey o osmveism s i
Text Overflow and Linked Frames ........................
Drawing Aids. . .. .v e e
SoleCHNG OBOCIE . . o vvvv v v s vim s b wee v o b fEF e s A
Moving Obleets:: v vm e ie i i s s e v i i e
Rosizing OBeetS. v s aa e
Rotalng OBJeets .« s vwan vinis s se s wvass s s c s siens s
Editing Objects usingthe EditMenu. . .....................
Embedding Objects ..........ccuriiiiiiiiiiiennennnnnnn
Patht Edit Mode .o cuni sinnisaalaidid s danyisas e vy

Working with Objects

TORE TN A A L S BN TS
3135117 | - | R SRR ol G e o
SNBPE e s e  R A
FrONEBACK o oo i wia i s sl bali s i e e
Group/Ungroup Objects .. ....covviiiiiiiniinanannrenns
Make Local/Make Master . ..........coiiiiiiinnenninnnn
SAEEIEONE, oo vnsirimmaronsnon s S b s A b e A AT S 5 S

Working with Pictures

General Picture Handling

ImpOrting PICHITes . . sone s mwwen mmsimss s mmms s s s
Selecting Pictures. . . ...coviniiiiiiiiiie i
Moving PIGlures .o dnmi s S i i ioeis
ROSIZING PICIINOE o s s oot St s AT R s
Rolating PIGUres ....cuamvsme s e i s itse vt
CroppING PICIIEE «ov.ic0mimowamnsim eremimsmions oo v sisisssosmin aran
Modify Picture. ... ...oovni i
OptionsontheEditMenu. ........cciiiviiinnnnnnnnanns
Object Linking &Embedding ...........covviiiiiinnn..

Large Picture Support

IMPOrtiNg PICtUrES . . oo v et eena s
Setting Picture choices . ... .......oiiiiiniiiiniiniinnnns
Referenced PicturesandMailMerge . . ..........coivunennn
Snags; Hinteand Tips. s« voais i aiavme i nsmimins
For Image processing, see Chapter 13B

111
112
113
116
17
119
120
122
125
126
127
127
128
128

129

CoNTENTS

v



Vi

11

1141
11.2
1.3
1.4
11.6
1.6
1.7
1.8
1.9

12

121
12.2
12.3
12.4
12.5
12.6
12.7

13

13.1
13.2
13.3
13.4
13.5
13.6
13.7
13.8

13.9

13.10
13.11
13.12

CoNTENTS

Pages, Chapters and Master Pages

OV BIVIEW .« o ittt ettt et e
Creating New Documents. .. ......coviiviiiininennennnnn.
Edit Master Pages . vcivvunsiisoin ciadviie ses vis iy
AddingaNewChapter...........cooiiiiiiiiiiiiiinnnns
MOdHVING A CRAPIEI.: -« . o wvvimie wwid e s mmss s s sis s w9ae
ImportingaChapter . ......ouriiiiii i
Deleling A ChAPIOR .« oo vun s vensevmanasssremes s somse s
Page Insertion & Deletion............coooiiiiiiiiii.,
EXAMPIES o iiimio s iy S i G e e U R S

Printing & Mail Merge

Printers & PrinterDrivers . ........cooiiviiiiiniiinnnnn..
Basic PRRENG s v v e s w5 b b S 0 s, Bt
Advanced Print Setup Options . .. .......civiiiiieennann.
Background PrntING ..o .ovnimiisvumanais v e saviies s
Mail Merge, the basic principles . . . .........ccoiiiiiiinnn..
Mail Merge, advancedfeatures. . .................c00vunn.
Mail Merge, Some examples. .. «cveossasinsissinsssesses

Commercial Printing

Commercial Colour Printing

Installation of the Colour Supplementapplet . ...............
Litho PHRHNG o misasivs snasamrai s s e aasve s
SPO-COlOUrPARNING s o s s s e R s
Full-Colour PAnting: « o vvwee snmvsswem swmmmammes sooas s
Colour Correction . ......vvieniniiniene i inaann
Preparing Your Document. . . .....ovviiinininninnnnnnn
Creatinga PostScriptFile. .. .........iiiiiiiiiiiininias
Submittingthe FiletoaBureau ...............cociviuiunn

Image Processing

The Process Dialogue BoxX . . ......ooiiiiiiiiinininnnns
Brightness, Contrast & Gamma . ...........covvievnern...
Custonm:Cololr MaP e s s e s s iaes
LN EBCHRONMEIES eyt 00 35 B AR B B S AR

For General Picture handling, see Chapter 10

Ovamion Pro

149
150
152
155
157
157
158
158
159
161

163
164
167
173
176
177
180
180

185



Qvation Pro Contents VI

14 The Spelling Checker 207
T OPOlCTECKIN o ave b s s em o a0 w0 8 208
T2 DICHONBIIOB. < x«s e v s asm am s s s 56w, ST e e 208
143 CheckStory/fFromCaret............c.cciiiiiiiniinannnns 210
T4 CRECWNOI i i e n s £ 055 v 08 o8 et e e S mrdpm m s o 212
145 CheckDooUMent ;. . iuu sydusids e e 213
146  CHOCES YO TYPB: v e s s i s e S SR 213
14.7  Creating & Editing Dictionaries. ...............ccovvuvunn. 214
14.8 Hyphenation Exceptions. ... ......ccoviiiiiiiiiiiinnnnnn. 217
149 Relocating Spelicheck Dictionaries. ................ccuu... 218
15 Customisation 219
184 Silesheels:. .o vvevmemmmiesnm im e O R 220
15.2  Changing the Default Document. .. .......... ... ... ..., 221
15.3 Application Choices .........coviiiiiniiiiainnnennnann 222
154 PrintChoICES . ...oivir i iieet e einnasnsnnennans 223
165 General ChoiCes. .. viiveesiveriisssnsonsssssssanasass 224
156  VIBWEHOICES vonw et i w via st s e i s 225
15:7 T CROICEE .o i e e s o s mle o o e e 226
15.8  Picture ChoiCes. . . .ottt e e et e i it nnaanes 227
159  Line@ ChOICES. . .ottt it i e e e ei e iae s 228
15.10 Colour Correction ChoiCeS . . . ..o v e ei i inennans 228
15611 Document Preferences . .. ween s vimmiiv et su i o 229
1512 ‘Conoral Profaranens: . «ue e oo wea s s s s ems o s vise e 230
1548  VIGW POTOTOINTOE o .c.ominimrais s snosim s e Srars v 6o o oo 231
15.14 TextPreferences. . .........coiuriiiiiiiniininiiiunenans 232
16 Defined Colours 233
16 OVBIVIBW. oo s s A B e A T BT 234
162 Eding COlOURS i« ovssmmansmavnn sy e ssmn semse s 235
16.3 ColourModels. .. ...ttt i it 237
1848 ColourChars i sanitniainsesss 240

For Image processing, see Chapter 13B

17 MBETEE v i v e e S I A AT A T A MU I N 241
17.1  The Macros Dialogue BoxX. . .. ......vviiiiniinninunnnann. 242
17.2 CreatingButtonMacros ............coviiiiiiinnennennas 243
17.3 CreatingKey Macros ..........c.ciiiiiiiiiiiennennnnnn 244
17.4 Creating Usar Macros. . ... «avim s i evasiveases s 245
1785 DaliniNg Matros .o cv.emmms s o5 qmmn o s osmenmas, @ms s o 246
17.6 OtherMacroOperations .. .......covviiirniinnneunnnann. 247
17.7  Summary of Pre-definedButtons . ... ..........ccovivninnn 248
18 APPIBES. o oo cdus o ilas T R S e e e e R s 251
18.1  Adding featureswith Applets .. .........ciiiiiiiiiinnnn, 252
18:2  InSaling APPIBES. . o v v v v s oo pe swmime v wmes s weo 252

18.3  INSIB APPIBTS . ... .o et eeeeeeeeeees 253



VIl Contents

19 Script Language

T8 OVBIVIEW: coonn i imim a5

Appendices
Memory Management.........

KeyNames.................
Date and Time Format ........
Keyboard and Mouse Short-cuts
DefiningBorders.............
Defining Colour Charts .. ......
Adding Sprites to the Button Box
Document Description Language
Expression Evaluation and Units

LT IOTMMOoOO®@>

Glossary

Index

Character Set and Escape Sequences. ....................

256

257
257
259
263
265
267
271
273
275
277
279

281

291

Ovamion Pro



Introduction

14 OVOIVIBW: < s s s ey e R e e e
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This chapter introduces the concept of desktop publishing and lists some
of the special features of Ovation Pro. It summarises all the
documentation provided with the software and describes the order in
which it should be read.



2 INTRODUCTION

1.1 Overview

A desktop publisher allows you to take text and
pictures and arrange them on the page in virtually
any way you wish. Text may be typed in directly
or imported from another source, such as a file or
another word processor. You can then alter the
style of the text and control how it flows around
the page. Pictures can be imported from file or
from another application such as Draw or Paint,
and then scaled, cropped, rotated etc. as required.

Once the page has been completed, it may be
printed out on a wide range of printers, such as
dot-matrix, ink jet, laser and even professional
typesetting machines.

Ovation Pro

Ovation Pro brings together word processing with
state-of-the-art page layout features to deliver a
extremely powerful desktop publishing system.
You may use Ovation Pro to create just about any
type of document, from a single-page letter to an
entire book, or from a simple leaflet to a complex
advert.

Even with such a vast range of features available,
Ovation Pro is still easy-to-use, thanks to a superb
user interface that makes the software easy to learn
and instinctive to use. It is also extremely fast and
responsive, and of course in true What You See Is
What You Get (WYSIWYG) manner, faithfully
represents the document on the screen exactly as it
is printed.

Special features of Ovafion Pro, include:

+ Toolbox attached to the active document.

= Context sensitive info palette gives information
and options about the current operation.

« Definable button bar allows you to choose
which options you would like to appear on a
bar across the top of the document.

+ Irregular frames drawn using lines and curves.
Text can flow inside or around irregular
frames, and pictures are cropped inside them.

+ Rotated text frames with fully editable text.

» Multi-step Undo/Redo. The number of steps
that may be undone is determined by the size of
a user definable buffer.

CHapTER 1

Drag and Drop for text and objects within the
same page as well as to another page or
document.

User-definable named colour system allows
you to use colours consistently throughout your
documents. You can even create your own
colour charts.

.

Automatic drop-caps. These are large capitals
that are often seen at the start of paragraphs.

Pasteboard around document for temporary
storage of objects and to allow objects to bleed
off the page.

Advanced justification with fully controllable
letter spacing. This allows you to fit text into
narrow columns easily.

Advanced automatic hyphenation control.

Multi-column frames, frames with rounded
corners, skewed frames and vertical alignment
of text in frames.

Automatic text flow around irregular pictures.

Picture cropping can easily be achieved using a
special tool. —

Frame borders and auto drop shadows on
rectangular frames.

Straight and curved line drawing.

Grid and ruler guidelines for easy page design.
Plus facility to snap to other objects.

Full page and chapter handling with separate
master pages for each chapter. Easy-to-use
headers and footers.

Character selector and single-shift font change
allow you to easily insert special characters
from other fonts.

Extensive printing capabilities including
pamphlet and galley printing, tiling and other
formats.

Integrated script language based on a subset of
the C programming language.



Section 1.2

1.2 Qvation Pro Documentation

The separate CD Guide gives details of the
minimum systems requirements to run
Ovation Pro, and how to install it on your system.

If you are a beginner to desktop publishing you
should read the separate tutorial which describes
how to create a simple document step-by-step.

This reference guide describes all the features of
Ovation Pro, but does not attempt to teach you
desktop publishing or good document design. For
this you are recommended to refer to the many
specialised works on typography, book, magazine
and layout design.

It is assumed that you are familiar with the

RISC OS desktop environment and filing system.
If you are not, please read the relevant sections of
your computer user guide.

The chapters in this reference guide may be
divided into a number of groups:

- The Basics

Chapter 2 describes the Ovation Pro user interface
and how to create, print and save a simple
document. Chapter 7 details options that change
the way the document may be viewed on screen.

- Adding Style

Chapters 3, 4, 5 and 6 describe how to type in text
and add style to that text. You can add local text or
paragraph effects, or define named styles that may
be applied at the press of a key.

- Objects

Chapters 8 and 9 describe how to draw and
manipulate frames, which are the basic building
blocks of desktop publishing. Chapter 10 deals
with manipulating pictures in frames.

- Page Handling
All aspects of handling pages, chapters, master
pages and stylesheets are described in Chapter 11.

- Miscellaneous

Chapters 12 to 18 describe all the remaining
features, such as printing, spell checking and
customisation. The integrated script language an
introduction to which is given in chapter 19, is
intended for advanced users who have a
knowledge of the C programming language.

Ovanon Pro DocuMENTATION 3

- Appendices

The appendices at the end of this guide list
character sets, summarise key short-cuts and
provide other advanced information not normally
required in everyday use.

- Glossary

This explains many of the terms used in desktop
publishing.

- The disc based version of the manual

If possible use a 256 colour or greater mode when
reading this manual on screen. The pictures of

windows will look clearer if a zoom of 111% is
used to view the manual.

The pictures in this manual may differ slightly
from what you see on screen. In general Homerton
is used as desktop font instead of the System font.
And in many cases Textured Window Background
has been deselected to enhance readability.

The latest version of this manual for registered
owners can be found on the Ovation Pro web site.

How to use the electronic manual

The original manual (1996) was printed. Because
of continuous development of the program that
manual could never have information on the latest
developments of the program. But you can now
also use an electronic version. This version may
also not always contain the very latest information
but it is far better and it is easier to update.

If you use the disc version, do use a copy for your
investigations. The disc version has been set up so
that you can "play" with it. That means you can
see or discover how text, styles, effects, frames,
pictures and lines have been added to a document.

Start your explorations on the electronic Tutorial.

Menus

If your menus show more or less entries than
shown in this manual it is because of additional
software in the form of Ovation Pro applets. This
is nothing to worry about.
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1.3 Typographical Conventions

The following typographical conventions are used
throughout this user guide.

- Key Presses
Key presses are shown capitalised in normal type:

Press the Page Up and Page Down keys to
scroll the window up or down by one screen.

- Mouse Clicks

Mouse clicks are shown capitalised in normal type:

Click Select to zoom up by 50%.

- Dialogue Boxes
Names of dialogue boxes, and options on them are
shown in bold type:

Click on OK on the New dialogue box.

- Menus
Menu options are shown in bold type:

The Misce>Macros dialogue box allows
macros to be created and edited.

The example above means choose the Macros
option on the Misc menu from the main menu of
an Ovation Pro document. Where necessary it
will be mentioned as:
Menu......... - ST,

‘When a menu option on the icon bar Ovation Pro
icon menu is referred to it will be shown as

IconbarMenu=...... Dieense Key

In both examples the possible key short-cut has
been added as "Key". ("Key" is only used as
example, it does not exist as such in the program.)
To ease finding certain options while reading this
manual the menu option is given on a row of its
own under Headings, Sub-headings or where
appropriate within the text.

Key

Some options are only available when the Master
Page has been opened. In that case references to
menus are mentioned as follows

MasterpageMenu.........uueune

CHapTeR 1

- Key Short-cuts

Following a menu reference, as mentioned above
at -Menus, a possible key short-cut is added right
aligned.

E.g. pressing ATH
will open the Change Shape menu

while pressing ATZ
opens the Zoom window

and pressing AF2

closes the document.

- References

References to illustrations or other parts of the user
guide are shown in italics:

-These are explained in detail, later in this user
guide (see 11.2).
This means: see Section 11.2.
-This is the final result (fig. 8.24).
This means : see Figure 8.24, i.e. figure 24 in
chapter 8
-Please refer to Appendix A which gives full
details.
This means that you should consult Appendix A.
- Technical Terms
The first time a technical term is used, it is shown
in italics:

Inside the document window is the default
master frame into which text may be typed or
imported.
- Filenames
Filenames and pathnames are shown in Corpus
type:
To run the software, double click on the
application ! OvnPro.
- Messages
Warning and error messages are displayed in
Corpus type:
The error message Not enough free
memory will be displayed.
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1.4 If you have Problems

If you discover a problem with Ovation Pro please
report it in writing by either letter, fax or email to:

Ovation Pro Support
David Pilling
P.O. Box 22
Cleveleys
Blackpool
FY5 1LR.
Fax: +44 (0)870 0520941

Email: david@pilling.demon.co.uk

Please describe briefly the steps that must be
followed to reproduce the problem, and if
necessary send a copy of any problem documents.
Also include the following information about the
system you are using:

+ The version of Ovation Pro you are running
(found on the Info dialogue box).

» The version of RISC OS you are using.
+ The amount of RAM you have installed.
+ Any additional software that is running.
« Any additional hardware that is fitted.

+ If you are having problems when printing, give
details of the printer and printer driver you are
using.

Please do not return any discs or packaging until

requested to do so.

IF You HAVE PRoBLEMS

5
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1.5 Latest Information

The Ovation Pro CD Guide document provides
supplementary information on using Ovation Pro
and on software and resources supplied with it.

CHAPTER 1
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This chapter explains how to run Ovation Pro, and how to load existing

documents and create new documents. It also describes the document
environment in detail, and introduces the toolbox, info palette and
button bar. It is assumed you have installed Ovation Pro according to
the separate installation instructions.



8 GetTiNg STARTED

2.1 Loading Ovation Pro

Locate and double-click on the application
tovnPro. Ovation Pro should then be loaded and
its icon installed on the icon bar.

If there is insufficient memory to load

Ovation Pro, an error message will be displayed.
If this happens, remove any other applications that
are running and then try loading it again. If you
still encounter problems, please refer to
Appendix A which gives details of how to make
best use of the memory available.

Fig. 2.1 - Ovation Pro icon bar menu.

CHAPTER 2

2.2 The lcon Bar Menu
IconbarMenu<.......

Click Menu over the Ovation Pro icon on the icon
bar to display the icon bar menu (fig. 2.1). This
menu provides the following options which are
described in detail later in this user guide.

- Info

Info displays information about the version of
Ovation Pro you are using (fig. 2.2). The version
number given should be quoted in any
correspondence with David Pilling concerning this
product.

The goto to Web-site button works by running the
HomePage file inside Ovation Pro. If the button is
greyed out the run type (Alias$@RunType_B28)
has not been properly set up for this file typically
by your browser. You can check this by going to
the command line (press F12) and typing Show
Alias$* followed by Return.

= New
New opens the New document dialogue box

(fig. 2.4), which allows the paper size, margins etc.

to be specified (see 11.2).

- Clipboard

Clipboard displays the contents of the clipboard
(see 3.7 and 15.5).

- Choices

Choices opens a dialogue box that allows
Ovation Pro to be configured (see 15.3).

- Quit
Quit exits Ovation Pro (see 3.11).

Several Applets, when active, will add other
options to the icon bar menu. Further information
can be found in the Applets' documentation.

‘Purpose: | Desktop Publisher
Author [ © David Piling, 1999
Version | 2.56 (05-Dec-99)  Web site |

Fig. 2.2 - The Info dialogue box.
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2.3 Loading Existing Documents

To load an Ovation Pro document, double-click on
the document’s icon. This operation also loads
Ovation Pro if it has not been already loaded
(provided the application has been ‘seen’ by the
filer).

Alternatively, drag the existing document to the
Ovation Pro icon on the icon bar.

Font Mapping

If you load an Ovation Pro document that uses
fonts that are not present on your system, a
warning box will be displayed (fig. 2.3).

Click on Stop loading document to stop the
document from being loaded.

Click on Permanent replacement to permanently
replace the missing fonts with Trinity. If the
document is subsequently re-saved, then Trinity
will be saved and the original fonts will be lost.

Click on Temporary substitution to temporarily
replace the missing fonts with Trinity until the
document is closed or until the missing fonts are
made available.

Loaping Existing DocumenTs 9

Loading Ovation Documents

You may also load old Ovation documents by
dragging them to the Ovation Pro icon bar icon.
However, please note the following points:

* The Ovationl Applet must be installed.

= Ovation documents will be bigger in size when
loaded into Ovation Pro and when re-saved in
Ovation Pro format.

= You will be warned if you load an Ovation
document into Ovation Pro then attempt to re-
save it, overwriting the original document.

« Ovation Pro does not support nested objects,
so any nested objects in Ovation documents
will not be nested in Ovation Pro. This will not
matter if you just wish to view or print the
document, but if you wish to edit it, objects
may need to be grouped to keep them together.

*  Ovation line and border styles are emulated
fairly closely in Ovation Pro, but they may not
be an exact match. Extended border styles in
Ovation are not supported in Ovation Pro.

+ The operation of master pages in Ovation Pro
is significantly different from Ovation. This
will not matter if you just wish to view or print
the document, but editing the master pages in
Ovation Pro may result in objects appearing
twice in the document.

« Aslightly different missing font window which
does not have the temporary substitution
facility will appear if any fonts are missing.

fg}g This documentuses 4fonts

(BRITANNIA.BOLD...) which are not

present. Do you wish to reflow the
document with new fonts?

e

| _Temporary substuton |

Fig. 2.3 - Warning box if fonts are missing when loading a document.
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2.4 Opening a New Document
IconbarMenu=>New...

Click Select on the Ovation Pro icon on the icon
bar to open a new document based on the default
document. If required you can edit the default
document (see 15.2).

The default page is A4 with 10mm margins all
around, but if you want a different paper size or
margins, choose New from the icon bar menu
(fig. 2.4). Now change the page size or margins as
required and click OK when complete. At this
stage you should not change any other options on
this dialogue box. The New dialogue box is
explained in detail later in this user guide

(see 11.2).

Fig. 2.4 - The New document dialogue box.

CHAPTER 2
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2.5 The Document Window

The document window is a standard RISC OS
window, but with a toolbox, info palette and button
bar attached (fig. 2.5). You can have more than
one document open at the same time, but only one
can be active. Clicking inside a document window
makes it active; indicated by a yellow title bar.
Typing and other operations always apply to the
active window. Only the active window has the
toolbox and info palette attached.

The document window title bar shows the name of
the document. If it is followed by the * character,
it indicates that the document has been changed
but not yet saved.

Close icon

Tue Document Winoow 11

Scrolling the Document

The amount of the document that is in view in the

window depends upon the size of the window and

the current zoom (see 2.9). You can move the

document around in the window in the following

ways:

= Use the horizontal and vertical scroll bars in
the usual way.

= Press the Page Up or Page Down key to scroll
the window up or down by one screen.

= Holding down the Shift key whilst pressing the
Page Up or Page Down key scrolls the
document to the top of the preceding or of the
following page.

E Toolbox
j )
| '\/ Info palette
E ﬁ e e e iy Lk A o o N Nl
Text frame X[ 10mm
11 Y 10mm

Fig. 2.5 - The active document window.

Default master frame

Scroll bars
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Default Master Frame

Inside the document window is the default master
frame into which text may be typed or imported.
The size of this frame is determined by the
margins set in the default document.

This frame is a master frame, meaning that it is
generated by the master pages and will appear on
all pages of the chapter. The size and position of a
master frame can only be changed on the master
pages or by making the frame local (see 11.3).
Text that overflows at the bottom of the default
master frame, automatically flows onto the next
page.

The default master frame has a red outline to
indicate that it is active. Click Select outside it (in
the margins) to make it non-active with a grey
outline. Click back inside it to make it active
again.

View
Text
Style
Object
Page
Misc
Applets
Fig. 2.6 - The main menu.

b
b
P
P
b
P
b
P
P
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The Caret

The red I-shaped vertical bar is called the caret and
indicates where text will appear when typed or
imported into the document. When a new
document is opened, the caret is automatically
positioned in the top left corner of the default
master frame ready for text entry.

The caret is always displayed in the active text
frame (unless there is a text selection). If there is
no active text frame, the caret will disappear and
text cannot be entered.

The Main Menu

Almost all Ovation Pro operations are available
from the main menu (fig. 2.6), which is displayed
by clicking Menu over the document window.

To clear the main menu, click Select over the
document window.
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2.6 The Toolbox

The foolbox is attached to the left-edge of the
active document (fig. 2.7).

The top eight tools are the main tools for DTP
work, including editing text and manipulating
objects. One of these tools will always be selected;
by default it is the Select tool which is used for
selecting objects and editing text.

The bottom four tools provide the four shapes that
may be used when drawing frames and lines. One
of these will always be selected; by default it is the
Rectangle tool.

To select a tool, click Select on it. Apart from the
Frame and Line tools, tools remain selected until
another tool is chosen. The Frame and Line tools
normally revert back to the Select tool once the
object has been drawn.

Select tool
Frame tool
Line tool
Path Edit tool

Rotate tool
Link tool

Crop tool

Zoom tool
Rectangle
Ellipse

Straight line segment

Curved line segment

Fig. 2.7 - The toolbox.

THe TooLsox 13

Moving the Toolbox

By default the toolbox is attached to the left edge
of the document window. However, if required
you may move it to a new position by dragging on
its background or by pressing Shift and dragging
on a tool. If the document window is moved, the
toolbox moves relative to it.

‘You may use an option on Choices to detach the
toolbox from the window (see 15.5).

Changing the Toolbox Shape

You can change the toolbox shape by clicking
Adjust on the toolbox background and dragging up
and down until the required shape is achieved

(fig. 2.8).

The position and shape of the toolbox may be
different for each open document. They are not
saved with documents, but may be saved as default
(see 15.2).

Re-ordering the Tools

You can swap the order of tools by holding down
Ctrl and dragging one tool onto another tool. The
positions of the two tools are swapped. The order
of tools may be saved with the application choices
(see 15.3).

Fig. 2.8 - Other toolbox shapes.
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2.7 The Info Palette Current Page & Chapter
The info palette is attached to the bottom of the ’Ihe.curn.':nt chapter and page number are shown in
active document. It is context sensitive i.e. it the icon in the bottom left comner of the info

provides information and options according to the ~ Ppalette. The number is in the form c.p, where ¢ is
currently selected tool or object (figs. 2.9 t0 2.14).  the chapter number and p is the page number. =

So, if you are working on text, it gives options If there is more than one page visible in the
concerned with changing the font, size and style of  document window, the current chapter/page is the
the text. one in the centre of the window.

The icon in the top left corner of the info palette
shows the name of the current tool, or if the Select
tool is active, it shows the type of object selected.

114 ¥[12mm | H|285mm

'Mﬂ_rﬁg,’ﬁanm wi 181mm h ~ Trinity

Fig. 2.9 - The info palette displayed when a Text frame is active.

Picture frame.  X|8.86mm | W[137.49m] Scale| %0 [= X[ovm |=a[ o |5
114 ¥[158.61mq H| 13.76mm| Aspect| 100 |- ¥[o.4mm |- it | o |

Fig. 2.10 - The info palette displayed when a Picture frame is active.

Line X[20.45mm] W[ 31.46mm| Line wiotn| Thin | *E|
114 ¥[ 125.02m{ H[0.51mm '

Fig. 2.11 - The info palette displayed when a Line is active.

Fig. 2.14 - The info palette displayed when the Zoom tool is active.
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Moving the Info Palette

By default the info palette is attached to the bottom
of the document window. However, if required
you can move it to a new position by dragging on
its background or by pressing Shift and dragging
on one of the two icons at the left-hand side. If the
document window is moved, the info palette
moves relative to it.

You may use an option on Choices to detach the
info palette from the window (see 15.5)

The info palette position may be different for each
open document, but it is not saved with documents.
However, its position may be saved as default

(see 15.2).

15
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2.8 The Button Bar

The button bar provides access to common general
purpose functions in Ovation Pro. It is located at
the top of every document window (fig. 2.15).

A default set of buttons are provided on one row,
and these are listed in the next column. You can
scroll the button bar by moving the pointer over
either end of the button bar.

To change the number of rows position the pointer
on the button bar (but not on a button), hold the
Ctrl key and drag with Adjust.

You can change the position of a button on the
button bar by pressing Cirl and dragging it to the
required position. The button will be placed before
the button over which it is dropped.

To insert or delete a gap before a button, hold the
Citrl and Shift keys and click with Adjust on the
button.

The new positions may be saved if required using
the Save option in the Macros dialogue box.

Menu=>Misc>Macros...

The Macros dialogue box also allows you to add,
remove or define further buttons, and save them as
the default (see 17.6).A larger set of buttons is also
available from which you may choose those that
suit your requirements (see 17.7).

CHaPTER 2
Default Buttons
File info dialogue box (see 3.1).
;%J Save as dialogue box (see 3.10).
&J| Print dialogue box (see 3.11).
| Select all (see 3.6).
ﬁl Cut selection (see 3.7).

£|_| Copy selection (see 3.7).
& Paste selection (see 3.7).

(¥ Delete selection (see 3.7).

Show/hide Clipboard (see 2.2).

Undo (see 3.4).

Redo (see 3.4).

Show/hide Rulers (see 7.3).

Show/hide Guidelines (see 7.3).
Enable/disable Grid and grid lock (see 7.4).

Zoom dialogue box (see 7.5).

Modify text/picture box (see 4.6 & 10.7).
Text Colour dialogue box (see 4.5).

Text Format dialogue box (see 5.4).
Display tab ruler (see 5.5).

Modify object dialogue box (see 9.1).
Frame border dialogue box (see 9.6).
Spellcheck Word (see 14.4).

=
3
iy
£
o
@
%)
]
&l
]
O
“

Spellcheck Story (see 14.3).

fHE FEEE

Fig. 2.15 - The default button bar.
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2.9 Document Zoom

You can view and edit the document in range of
preset zooms or any variable zoom. The default
zoom is 100% which shows your document on
screen at approximately 100% of the true printed
size.

To change the zoom choose the Zoom tool

(fig. 2.16). Now move the pointer over the point in
the document you wish to zoom in on, and click
Select to zoom up by 100% or click Adjust to
zoom down by 50%. The current zoom is shown in
the info palette.

You may enlarge a particular area of the document
by dragging a box around that area with the Zoom
tool.

When the Zoom tool is selected, the info palette
provides the following options (fig. 2.17).

The Zoom tool can be accessed by holding down
Control and Alt when the Select tool is current.
This will often be a handy short cut.

For example with the Select tool current a single
click with Select whilst holding down Control and
Alt will double the scale.

+—— Zoom tool

Fig. 2.16 - The Zoom tool.

Document Zoom 17

- Zoom allows you to enter any zoom value
between 10% and 1000%. Press return to update
the document. You may also step up and down by
1% using the up and down arrows. Or by 10% if
the Shift key is held down as well.

- Previous restores the zoom that was current
before the zoom tool was chosen.

-50%,75%,100%, 150%, 200% and 400% are
the standard preset zooms.

- Fit window sets the document zoom so that an
entire page (or pair of pages) fits in the document
window.

- Fit screen sets the document zoom so that an
entire page (or pair of pages) fits on the screen.

- Fit width sets the document zoom so that a page
fits the total width of the screen.

- Fit height sets the document zoom so that an
entire page (or pair of pages) fit the total height of
the screen.

(Further information on zoom: see 7.5).

Document zoom Zoam] 100
AT | ¢ Hm‘iﬂ

Fig. 2.17 - The info palette displayed when the Zoom lool is active.
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2.10 Interactive Help

Ovation Pro supports the standard Acom
interactive help system.

Since interactive help uses a fair amount of
memory, it is normally disabled. To use it, it must
be enabled using an option on Choices (see 15.4),
and then Ovation Pro must be re-run.

IconbarMenu<=> Choices=>General

To display interactive help, double-click on

! Help which is supplied with your computer.
When this has loaded, the Help icon appears on
the icon bar and a window entitled Interactive
help is displayed (fig. 2.18).

The window contains information about whatever
the mouse pointer is over. As you move the mouse,
the information changes.

You can remove the interactive help window by
clicking on its close icon. To re-display the
window, click Select on the Help icon on the icon
bar. To close down interactive help altogether,
choose quit from the Help icon bar menu,

o BT

is is the Title bar.

Click SELECT to bring the window to the top.

Drag SELECT to move the window around the desktop.

Drag ADJUST to move the window without affecting the order of windows.

Fig. 2.18 - The interactive help window.
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This chapter describes all aspects of typing, editing and importing text.
Once you have created a simple document, it explains how to save and
print the document, and finally how to quit Ovation Pro.
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3.1 Typing & Editing Text

You can type and edit text whenever there is an
active frame containing the caret. A later chapter
will describe how to draw your own frames, but
this chapter assumes you have opened a new
document as described in the previous chapter
(see 2.4). You should have a document window
open, with the caret in the default master frame
ready for text entry. The Select tool should be
chosen (fig. 3.1).

Try typing a few words at the keyboard. The caret
moves to the right of each character as you type.
The style and format of the text you type is
determined by the style called Bodytext. By
default Bodytext uses the font Trinity
(equivalent to Times) at a size of 12pt, and is
suitable for general-purpose word processing.

Type more words until you have filled a complete
line. If necessary the window automatically scrolls
sideways so that the portion of the page you are
editing always remains in view.

The entire text in a frame or in a number of linked
frames is referred to as a story.

«—— Select tool

Fig. 3.1 - The Select tool.

CHAPTER 3

Word Wrap

Ovation Pro automatically re-formats text to fit
into the active frame, so there is no need to press
Return at the end of each line. If a word is too long
to fit on a line, it is automatically transferred to the
start of the next line. Similarly, if a word at the
beginning of a line is reduced sufficiently in length
for it to fit on the end of the previous line, then it
will be automatically moved up.

New Paragraph & New Line

Press Return to start a new paragraph, putting the
caret at the start of the next line. You can
optionally add white space at the end of a
paragraph to separate it from the next paragraph.
This is called Space after (see 5.4).

Choose Misc>Insert=>New line or press Shift
Return to start a new line, without starting a new
paragraph (see 5.1).

New paragraph and new line characters may be
deleted, causing paragraphs and lines to be joined
back together.
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Caret Movement

If the Select tool is chosen, and the pointer moved

over an active text frame, the pointer shape

changes to the text insertion tool (fig. 3.2). You

may position the caret by clicking with this tool:

« If you click within some text, the caret appears
at that position.

» If you click beyond the end of a line, the caret
appears at the end of that line.

+ If you click in an empty frame, the caret
appears in the top left corner of the frame.

The caret may also be moved using the cursor keys
on the keyboard:

— = Caret left/right one character
Tl Caret up/down one line

e f— Caret left/right one word

fiT il  Caret up/down one paragraph
e "—  Caret to start/end of line

AT ~l  Caretto start/end of text story

~MT ~fil  Scroll up/down through story
Where * and Tl refer to the Ctrl and Shift keys.

Tab Key

Pressing Tab inserts a tab character into the text,
causing subsequent text to be aligned to the next
tab stop. The default tab stops are at 10mm
intervals, but these may be changed if required
using the tab ruler (see 5.5).

Transposing Characters

A common typing mistake is to transpose character
pairs e.g. feild and otfen. This can easily be
corrected by positioning the caret between the two
characters and pressing Ctrl Shift Q.

I

Fig. 3.2 - The Text Insertion tool.
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Deleting Text

Press Delete or Backspace to delete the character
to the left of the caret, or Copy/End to delete the
character to the right of the caret.

Press Shift Delete to delete the word before the
caret, or Shift Copy/End to delete the word
containing the caret.

Press Ctrl Delete to delete from the caret to the
start of the line, or Ctrl Copy/End to delete from
the caret to the end of the line.

Press Ctrl Shift Delete to delete the line at the
caret. This also deletes a Return or New Line at the
end of the line.

You may also delete selected blocks (see 3.7).

Automatic Page Creation/Deletion

If text fills the default master frame, a new page is
added with its own master frame. The text then
flows automatically into that frame. This process is
called automatic page insertion and the frames are
said to be linked.

If you delete sufficient text from a document to
leave the default master frame on the last page
completely empty, the last page is deleted. This is
called automatic page deletion. This only happens
if the last page does not contain any additional
objects.

It is possible to alter this behaviour (see 15.12).
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Force Page Break
Menu=>Misc=>Insert=>New Page AP
or Enter

You can force a page break in the default master
frame at any time by pressing Ctrl P (or by
pressing Enter on the keypad or choosing
Misc>Insert=>New page). This inserts a new
page and forces the text after the caret to the top of
it

Doing this in a multi-column frame will force the
caret and following text to the next column. With
linked frames the caret is forced to the next linked
frame.

The page break character may also be deleted,
causing text that follows to flow back onto the
previous page, the previous column or the previous
frame.

Moving Around Pages

Once you have a document with a number of
pages, you may use the following keys to move
around the pages.

TPage Up Start of previous page

flPage Down  Start of next page

“Page Up Start of first page in chapter
APage Down Start of last page in chapter
Home Start of first page in document
THome Start of last page in document
Afup move page down one line
AflDown move page up one line

You can also move directly to any page using
Menu=>Page=>Goto page (see 11.1). F5

Remember that the number of the page shown on
the info palette (see 2.7) is the one present in the
centre of the document window.

Fig. 3.3 - The document Info dialogue box.

CHAPTER 3

Document Info
Menur>File=Info F1

Choose Filec>Info to display a dialogue box that
gives information about the document (fig. 3.3).

Document is the name of the document.

Date is the time and date stamp of the file. If the
document has not been saved, it is the time and
date the document was created.

Size is the size, in bytes, of the entire document (in
bytes).

Story size is the size of the text story containing
the caret (in bytes).

‘Words is the total number of words in the
document i.e. all stories.

Words in story is the number of words in the text
story containing the caret. If a selection has been
made Selection words gives the number of words
selected including partially selected words.

Page is the current page number i.e. the one in the
centre of the document window.

Total pages is the number of pages in the
document.

Chapter is the current chapter number.

Total chapters is the number of chapters in the
document.
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3.2 Inserting Special Characters
Menu=>MiscoInsert........

There are a number ways of inserting special

characters and control sequences into a document.

Insert Menu

The Misc=>Insert menu allows a number of

special control characters to be inserted at the caret

(fig. 34).

Chapter number inserts the current chapter
number.

Page number inserts the current page number. AN

Date inserts the current date. The date format may
be set in Choices (see 15.5). AD

Active date inserts the current date which is
updated automatically each time the document is
loaded. The date format may be set in Choices
(see 15.5).

Time inserts the current time. The time format
may be set in Choices (see 15.5).

New page inserts a page break (see 3.1). AP
You can also use Enter as a key short-cut.

New line starts a new line, but not a new
paragraph (see 5.1). MReturn

Chapter number
Page number *N
Date D
Active date

Time

New page sp
New line TReturn
Hard space

Hard hyphen
Soft hyphen  ~-
Merge tag... ™™

Fig. 3.4 - The Insert menu.
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Hard space inserts a non-breaking space. Words
separated by a hard space are never split between
lines and the space between them is not expanded
during justification. Alt-Space
Hard hyphen inserts a non-breaking hyphen.
Words separated by a hard hyphen are never split
between lines (see 5.7). Alt -
Soft hyphen inserts a soft hyphen that doesn’t
appear until it is needed to split the word at the end
of a line (see 5.7). Ctrl -

Merge tag inserts a field for the mail merge
facility (see 12.5).

The Choices menu is selected via the icon bar.
IconbarMenu=>Choices...=........
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Characters
Menuc>Misc>Characters

Most fonts contain a wide range of special
characters that are not accessible directly from the
keyboard. You can easily obtain these using
Misc=>Characters. This opens a dialogue box
displaying all the characters in the character set,
for the current font (fig. 3.5). Just click on a
character to insert it at the caret. The selected
character will be inserted in your document and the
Characters window will close. If you want to
select more than one character, select the
characters using Adjust and use Select on the last
character you want.

You can change the font displayed, using the font
menu at the top of the dialogue box. This font is
used for the inserted characters only and any
typing afterwards will be in the original font i.e.
the one that was current before opening
Characters.

The fields Bold and Italic are automatically ticked
depending on the font chosen from the font menu.

F11

CHapTER 3

Inserting Characters using Alt

Notice that when choosing characters, the pointer
shows the ASCII code for each character. This is
useful if you wish to insert special characters
directly from the keyboard using the Alt key.

You can type characters not normally accessible
from the keyboard by holding down Alt and typing
the ASCII code on the numeric keypad. When Alt
is released, the character is inserted at the caret. So
to type the bullet character =, hold down Alt, type
143 on the keypad, and then release Alt.

A full list of ASCII codes is given in Appendix B.

$N )

2(3als

R|S|T|U

ris|tju X

.

o

= k,l-‘-a - e

Fig. 3.5 - The Characters dialogue box.
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Single Shift Font (SSF) F10

This facility allows you to switch to another font to
insert a single character and then return to the
previous font. The default single shift font is
Selwyn which contains a range of symbols, but
you can choose another font (see 15.7).

Single shift font is accessed using the key F10.
Telephone ® (01727) 840303

To produce the line above, type Telephone
followed by a space, then press F10 and type &.
Then type another space followed by (01727)
840303. This works because in Selwyn font, &
appears as the “telephone’ character.

You may also use the Alt key to insert characters

not normally accessible from the keyboard.
Jack of Diamecnds ¢

To produce the line above, type Jack of

Diamonds followed by a space, then press F10,

hold down Alt, type 169 on the keypad, and then

release Alt. This works because the diamond
character has ASCII code 169 in Selwyn font.

See Appendix B for a full list of characters in

Selwyn font.

Combining SSF and Characters

If you press F10 before opening Characters, the

font used in Characters will be set to the single

shift font.

Changing Single Shift Font (SSF)
IconbarMenu=>Choices=> Text

The Choices menu allows you to set the SSF.

25
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3.3 Importing Text

Instead of typing in text, you may drag ASCII text
files directly from disc or from other applications.
The imported text is inserted at the pointer position
and takes the style of the preceding text.

If you import text into a frame that is too small and
that frame isn’t linked, the text will overflow

(see 8.3).

You can also drag a text file to the Ovation Pro
icon on the icon bar causing a new default
document to be opened and the text file inserted
into it.

Stripping Return Pairs

If you hold down the Cirl key when dragging in a
text file, single Return characters in it will be
converted to spaces and pairs of Return characters
will be converted to single Return characters. This
is useful when importing text from text editors
such as Edit which terminate each line with a
Return, since in Ovation Pro the line breaks will
not necessarily fall in the same places. If Ctrl is not
held down while importing text, Return characters
will be unaffected.

Smart Quotes

‘When text is imported, plain single quotation
marks (') or double quotation marks (") enclosing
text are converted to fancy open and closing single
(*") or double () quotation marks respectively.
This gives a more professional appearance to
quotations and expressions such as “fish ‘n’ chips”
and “rock ‘n’ roll”.

This facility is called ‘smart quotes’ and can be
disabled if required (see 15.7).

' Insert iu"ﬁ’j‘s'of'ww_fmﬂ‘m&

Fig. 3.6 - The text import warning box.
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Importing Ovation Pro documents

It is possible to import an Ovation Pro document
into another as separate chapters (see 11.6) Of
course you can also import the contents or a
selection thereof from one Ovation Pro document
into another either by dragging or by Copy and
Paste. In these cases if certain styles of a
document from which the text is taken do not exist
in the document to which the text is imported,
these styles will be added (see 6.8).

Importing Other Types of files

Please refer to the Ovation Pro release notes for
details of other formats that may be imported.

If you attempt to import a file that is not supported,
you will be asked to confirm whether you wish to
proceed (fig. 3.6). If you do proceed, only the
ASCII content of the file will be imported.
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3.4 Undo & Redo
Menu<yEdit<>Undo .......... F8

Undo

Edit=>Undo (fig. 3.7) cancels the last operation
performed, restoring your work to its previous
state. You can undo anything that changes a
document, such as deleting or editing text,
changing styles or manipulating objects. You
cannot undo things that just change the way a
document looks e.g. View menu options.

A special feature of Ovation Pro is that you can
undo more than one operation. The number of
undo operations that can be performed depends
upon the size of the undo buffer which can be
increased or decreased as required (see 15.5).

Undo is shaded if there is no further operation that
can be undone.

By default, the undo buffer is automatically
flushed before saving a document. This means
that after the document has been saved, you
cannot undo operations that were carried before
saving.

There are three reasons for automatically flushing

the undo buffer before saving a document:

* As you edit a document, deleted objects are
retained so that they can be put back. Flushing
the undo buffer when the document is saved,
recovers the memory used by these objects.

+ It ensures that the saved document uses as little
disc space as possible.

= Anyone receiving the document cannot use
undo to see the contents of previous versions.

Undo Insert text F8
Redo F9
Cut Text frame X
Copy Text frame bl
Paste Global clipboard*V
Delete Text frame K
Embed object

Select all ATA
Clear ~z
Find F4

Fig. 3.7 - Undo and Redo

Unpo & Rebo 27

Redo F9

Redo cancels the last undo operation performed.
The Redo option will be shaded if there is no
further operation that can be re-done i.e. the
document is up-to-date.

Note that if you edit a document after using undo,
the Redo function will not be available.

Min. Memory
Menu=>Misc>Min memory

Whilst the undo buffer is automatically flushed
when you save a document, you may need to flush
it manually if you run out of memory when editing
a document. You can do this using the option
Misc=>Min. memory. This minimises the memory
used by a document by flushing the undo buffer
and recovering any memory used by deleted
objects.

Saving the Undo Buffer

You can use an option on Choices which causes
the undo buffer to be saved with documents
(see 15.5).

Making Undo Use Less Memory

‘When you delete an object such as a frame or
picture, that object is retained in memory and a
reference to it placed on the undo buffer so that the
deletion can be undone. As a result even with a
very small undo buffer, it is possible that
significant amounts of memory may be used
storing deleted objects. Eventually, as other
operations are carried out, references to deleted
objects are pushed off the undo buffer and the
objects are removed from memory.

So, if you have little free RAM available for your
document, you may wish to disable the undo
buffer completely so that deleted objects are not
retained. You can do this by setting the undo
buffer size on the Choices window to 0 (see 15.5).

Alternatively, you could save the document at
regular intervals, since this has the effect of
flushing the undo buffer and deleting any
referenced objects.

The exact text following the words Undo
and Redo on the Edit menu is context sensitive
and is not mentioned here.
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3.5 Revert to Saved

Menuc>FilecoRevert to saved
Revert to saved restores the document to the most
recently saved version. A warning prompt is
displayed before proceeding (fig. 3.8). Click on
Discard to delete the current document and reload
the previously saved one, or on Cancel to cancel
the operation.

Revert to saved is shaded and unavailable if the
document has not changed since it was last saved
or if it has never been saved.

Fig. 3.8 - The Revert to saved warning box.
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3.6 Selecting Text

Many operations are applied to a text selection.
The selection may be any amount of text from a
single character to an entire story.

There are a number of way to select text:

1. Click and hold down Select at the start of the
text to be selected, drag to the end of the text
and then release Select.

2. Click Select to position the caret at the start of
the text to be selected. Click Adjust at the end
of the text. Further clicks on Adjust can be used
to adjust the range of the selection at either
end.

3. Use one of the following short-cuts:

« Double-click with Select on a word to select
that word including following spaces (if Shift is
held down, the word only will be selected);

« Triple-click with Select on a line to select that
line;

« 4 clicks with Select anywhere in a paragraph to
select that paragraph;

= 5 clicks with Select anywhere in text to select
the entire story

4. Choose Edit=>Select all to select all the textin a
story. ATA

After any of these operations the selected text is

highlighted, i.e. inverted (normally white text on a

black background).

Note, it is not possible to have more than one
region of text selected at any time,
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Clearing a Selection

There are a number of ways to clear a selection:
» Click once anywhere in the document.
« Choose Edit=>Clear (fig. 3.7).

« Select something else.

Overtyping

Note that if you type anything while text is
selected, the selection will be deleted and replaced
with the text typed.

This facility may be disabled on Choices
(see 15.7).

AZ
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3.7 Cut, Copy, Paste & Delete
Menu=>Edite... v

The Cut, Copy and Paste options on the Edit
menu (fig. 3.7), are used to move or copy text
within the same document or to another document.

They do this via a clipboard, which may be viewed
using the Clipboard (2B) option on the icon bar
menu (fig. 2.2). Text or pictures are displayed on
the clipboard in exactly the same format as they
appear in the document.

Please note that if there is no selected text, the
following options are used to manipulate other
selected objects, such as frames, pictures or lines.
Cut text X
Cut deletes the selected text and places it on the
clipboard. The previous contents of the clipboard
are overwritten by this operation.

Copy text AC
Copy copies the selected text onto the clipboard.
The previous contents of the clipboard are
overwritten by this operation.

Paste text AV
Paste inserts the text that is on the clipboard into
the document at the caret. Text can be pasted into
any Ovation Pro document, not just the one from
which it was cut or copied. After pasting, the
clipboard contents remain unchanged so you can
paste more than once.

Use Cut followed by Paste to move text.
Use Copy followed by Paste to copy text.

Delete text K

Delete deletes the selected text. It does not place
the deleted text on the clipboard. This option is
only available if there is some text selected.

You may also delete selected text by pressing
Delete on the keyboard.

If Overtype has been set in Choices
IconbarMenur>Textr>Overtype

selected text will be deleted when entering new
text.
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Transferring Text Between Documents
Ovation Pro uses special rules to deal with
clashing style names when using cut, copy and
paste between documents.

The situation occurs when text containing a
defined style is transferred to another document
which contains a style of the same name, and that
style has a different definition. If this situation
occurs, by default Ovation Pro renames the style
in the transferred text. So if you edit Bodytext
in one document and then transfer it to another
document containing Bodytext, the transferred
style will be renamed Bodytext01.

Alternatively, you may use an option on Choices,
IconbarMenu=>Choices=Text

that causes the clashing style name to be discarded
(see 15.7). Then the transferred text will take over
the style attributes from the receiving document.

The above rules for clashing style names, also
apply to clashing colour names.
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3.8 Drag & Drop

Instead of using Cut, Copy and Paste to move or
copy text via the clipboard, you can use the drag
and drop facility to do this directly.

To use drag and drop, first select the text you wish
to move or copy. Click Select over the selection so
that the drag and drop tool is displayed (fig. 3.9).
Now drag until the pointer is over the required
insertion point and release Select to insert the text.

If you drag and drop within the same document,
the text is moved, if you drag and drop to another
document, the text is copied.

If you hold down Shift while dragging, the above
operations are transposed. So, if you drag and drop
within the same document, the text is copied,; if
you drag and drop to another document, the text is
moved.

If you drag and drop to something that isn’t an
Ovation Pro document, such as a directory display
or an Edit document, the text is exported as plain
ASCII text.

If you start a drag operation and wish to cancel it,
press Esc.

a

Fig. 3.9 - The drag and drop tool.
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Transferring Between Documents

The rules given earlier for dealing with clashing
style and colour names when using cut, copy and
paste, also apply to drag and drop (see 3.7).
Inserting Pathname

Holding down the Alt key and then dragging a file
or directory from a filer window into an

Ovation Pro document, will insert the full
pathname into the text.
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3.9 Find & Replace
Menu~>Edit<>Find F4

Edit=>Find opens a dialogue box which allows
you to search a story or document for a string, and
optionally replace the found string with another
string (fig. 3.10).

By default if there is no selected text, the search
starts at the caret and continues to the end of the
story. If there is a selection, only the selection is
searched.

The options in the Find dialogue box are described
below.

Find

Type in the string that you want to search for.
Pressing Return in this field will place the caret in
the Replace with field below.

Replace with

Type in the replacement string that will be
substituted for the search string when it is found.
Leave this field blank if you do not want to replace
the search string or if you want to delete the search
string. Pressing Return in this field will start the
search i.e. it is equivalent to clicking on Go.
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Case Sensitive

If Case sensitive is not selected, the search will

match all occurrences of the search string, making

no distinction between upper and lower case

characters. So searching for Abc will match with —
abc, Abc and ABC etc. The replace string will

match the upper-case/lower-case format of the

found string. So replacing with pgr in the

example above gives pqr, Pqr and PQR.

If Case sensitive is selected, the search will only
match occurrences of the search string with exactly
the same upper-case/lower-case format. So
searching for Abc will only match with Abc and
not abe or ABC. The replace string is substituted
unchanged.

Whole Word

If Whole word is not selected, the search will
match occurrences of the search string even if
bounded by other letters and numbers. So
searching for her would match with there and
other.

If Whole word is selected, the search will only
match occurrences of the search string that are not
bounded by other letters and numbers. So
searching for her would match with her and
(her), but not with there and other.

..m

Fig. 3.10 - The Find dialogue box.
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All Stories

If All stories is not selected, the search starts at the
caret and continues to the end of the story. If there
is a selection, only the selection is searched.

If All stories is selected, the search starts at the
caret and continues through each story until the
end of the document. But if Find from start is
selected as well the search starts at the beginning
of the first story.

Find From Start

If Find from start is not selected, the search starts
at the caret,

If Find from start is selected, the search starts
from the beginning of the current story rather than
the caret position or start of the marked area. It is
useful if you wish to search an entire story but
have forgotten to, or do not wish to move the caret
to the start of the story.

Find from start does not apply if you have a
selection or if All stories is selected. In the latter
case it starts at the beginning of the first story in
the document.

Count

Click on Count to count all the occurrences of the
search string. The number counted is displayed in
the icon to the left of the Cancel option.

Count acts in the same way as stated above under
the sections All Stories and Find From Start.
Previous

When you open the Find dialogue box, clicking on
Previous updates the search and replace strings
with those used in the last Find operation.

Text
Continue |  Replace |
Endoffilerepace |

| : Found

Fig. 3.1 - The Found dialogue box.
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Go

Click on Go to start the search. If the search string
cannot be found, the message Not found is
displayed in the Find dialogue box. Click on
Cancel to close the dialogue box.

‘When the first occurrence of the search string is
found, the Text found dialogue box is displayed
(fig. 3.11), indicating the operations available. The
found string is selected in the document.

Click on Continue to find the next occurrence of
the search string,.

Click on Replace, to replace the search string with
the replace string, and continue to the next
occurrence. If the replace string is blank, the found
string will be deleted.

Click on End of file replace to find and replace all
occurrences of the search string without stopping
for further instructions.

Click on Stop to abandon the search.

If the search string cannot be found, the message
Not found is displayed. Click on Stop to close
the dialogue box. Alternatively if Continue is
clicked on searching will recommence from the
start of the story or if All stories is selected, from
the start of the document.
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Wildcards

Click on Wildcards to display the extended Find
dialogue box (fig. 3.12). In this mode you can
introduce wildcards or special characters into the
search string (and in one case, into the replace
string).

To insert a wildcard, position the caret correctly in
the search string and then click on the required
wildcard icon. The escape sequence for that
wildcard is inserted into the string. If you wish you
may type the wildcard escape sequence directly
into the string.

In the following table, the escape sequence is
shown first, followed by the icon name, followed
by a description of the wildcard function.

\. Any char matches any single character.

\d  Any digit matches any single digit O to 9.

\a Any alpha matches any single alphanu-
meric character. Ato Z,atoz,0to 9and _.

\*  Any string matches any string of
characters.

\& Found refers to the string found and is used
in the replace string. For example, if you
search for ¢\ . t, putting \&s in the replace
string will replace cat, cot and cut
with cats, cots and cuts.

\\  “W=\matches the \ character.

\1  New line matches the new line character.

\p  New para matches the new paragraph
character i.e. Return character.

\t  Tab matches the tab character.
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Although not displayed in the extended Find
dialogue box the following wildcards can also be

used:

\¢
\e
\f
\g
\h
\m
\w

matches the chapter number
embedded frame

new frame

page number

active date

merge tag

one item of white space, i.e. space, non
breaking space or tab

Note \ e, \m and \w - cannot appear in the
replace string

Fig. 3.12 - The extended Find dialogue box with wildcards.
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3.10 Saving Documents
Menu=>Filec>Save F3

Before selecting the Save option, you must open a
directory display for the directory into which the
file is to be saved.

To save the document choose Filec>Save. A box
appears containing an icon, the document name,
and an OK box (fig. 3.13). If the document, hasn’t
been saved before, a default name will be supplied
e.g. Documentl, Document2, ete. If you want
to change the name, edit it in the usual way.

Ensure that the option Ovation Pro is selected, and
drag the icon to the required directory display to
save the file. An icon representing the file appears
in the directory display to confirm that the file has
been saved and the name of the file is updated in
the document window title bar.

You may also save documents in DDL (document
description language) format by choosing DDL
before saving (see Appendix I).

If a document has already been saved and has a
full pathname assigned to it, it can be resaved with
the same filename by clicking on OK or by
clicking on File=>Save.

Save as
[ Documentq_]
@ Ovation Pro '
) DDL
Fig. 3.13 - The Save dialogue box.
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Saving Text Stories

In addition to saving entire documents, you may
just save text stories.

To save a text story, position the caret in the story,
and choose Filec>Save story. Now use the
standard save box to save the story as a plain
ASCII file. You may also save the story in DDL
format by choosing DDL before saving

(see Appendix J).

To save selected text, select the text required then
choose Filec>Save selection. Now save the file in
the usual way.
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3.11 Basic Printing

Menur>File->Print... Print
Before you can print, you must load a printer
driver suitable for your printer. Ensure that the
printer driver has been configured correctly, for
such things as resolution and number of colours.

Choose File>Print or press Print to display the
Print dialogue box (fig. 3.14). The name of the
current printer driver is displayed in the title bar.
A brief description of the options on the Print
dialogue box is given below, but more detailed
information is given later in this user guide

(see 12.2).

Copies

Copies is the number of copies of each page that
you want to print.

Format

Format should be set to Normal the first time you
start a print job.

All Pages

All pages prints all pages in the document.
Range allows you to print the range of pages
specified in the writable field.

All Sides

All sides prints both left and right hand pages.

Left and Right allow you just to print one side of
the document. This is useful if you want to print a
double-sided document by printing one side then
turning the paper over and printing the other.
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Pause

If Pause is selected, Ovation Pro will pause
between each page printed until you click on
Continue on the Printing dialogue box (see
overleaf).

Reverse

If Reverse is selected, the order of printing 1s
reversed.

Collate

If Collate is not selected, Ovation Pro prints
multiple copies of each page, so pages are printed
in the order 1,1,1, 2,2,2, 3,3,3.

If Collate is selected when printing multiple
copies, Ovation Pro prints multiple copies of the
document, so pages are printed in the order 1,2,3,
1,2,3,1,2,3.

No Pictures

If No pictures is selected, Ovation Pro will ignore
pictures and just print text. Only the picture frame
guideline is printed. On some printers printing
pictures is very slow, so this option may be useful
for quickly printing draft copies.

Tumble

If Tumble is selected and All Sides is selected,
then printing on the even sides will be rotated by
180 degrees. If Left/Right or Front/Back are
selected all printing will be rotated by 180 degrees.

Print Setup

Print setup extends the Print dialogue box to
provide further advanced printing options

(see 12.3).

Chapter 12 gives information on many advanced
printing options available.

@ Alpages ) Range 159 t0 180
@ Alsides ) Right O Left

__|Pause _|Reverss _|Coliate
_|Nopicures _[Reflect _[Tumble

set | cancel |[—m—|

Fig. 3.14 - The Print dialogue box.
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Set

Click on Set to set the options in the Print
dialogue box, without actually printing the
document. These options will be saved with the
document when it is saved.

Print

Click on Print to print the document. The pointer

changes to an hourglass and the Printing dialogue
box is displayed (fig 3.15). It shows the Page and

Copy being printed.

The green slider gives a visual indication of how
much of the print job has been completed, but
please note that this is only accurate to the nearest
whole page.

Click on Cancel to terminate printing. Please note
that only a limited amount of multitasking is
possible when printing i.e. when the hourglass
occasionally turns back to the standard pointer. So
there may be a delay before Cancel takes effect.
Usually it is quicker to press Escape instead.

Click on Pause to pause printing. Again, there may
be a delay before Pause takes effect. When
paused, the Pause option changes to Continue
which you should click on to continue printing.

Ovation Pro can perform background printing if
required (see 12.4). If this mode is configured the
Cancel and Pause buttons will not work.

Fig. 3.15 - The Printing dialogue box.
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3.12 Closing Documents & Quitting
‘When you have finished working on a document,
close it by clicking on the close icon of the
document window. If the document has been
modified since it was last saved, a warning will be
displayed (fig. 3.16). Click on Save to save the
document before closing it; click on Discard to
close the document losing the latest changes; click
on Cancel to cancel the close operation and retain
the document in memory.

If you have finished using Ovation Pro, you can
remove the program from the computer’s memory
by choosing Quit on the icon bar menu (fig. 2.2).
Again, you will be wamned if your document has
been modified since it was last saved (fig. 3.17).
Click on Discard to quit Ovation Pro losing the
latest changes made to any modified documents, or
click on Cancel to cancel the quit operation.

Fig. 3.17 - Confirm box when quitting Ovation Pro.
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This chapter describes how to add a wide range of local style effects to
your text. These are applied directly to a selection or at the caret. They
provide the easiest and most direct way of adding style to a document.

Local format effects such as tab, indent and alignment which affect
whole paragraphs are described in Chapter 5.

Local effects are normally used when you wish to make a simple change
to a document, such as making a word bold. If you are producing a short
or simple document, then it is practical to use combinations of effects;
since if you want to change them, it is reasonably quick in a short
document.

In long or complex documents you should use defined styles
described as in Chapter 6. These allow style and format effects to be
combined together in a named style and applied in a single
operation. Defined styles can easily be modified at a later stage,
automatically updating all occurrences in the document.
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4.1 Applying Local Effects
Menu= Text.....

Local effects are used to change the appearance of
text in the document. Most effects may be
combined, so for example, you can have text in a
larger size that is bold and underlined.

The options Font, Size, Effect and Colour on the
Text menu (fig. 4.1) provide the basic effects that
may be applied. The Modify text dialogue box
provides all the basic effects plus a range of
advanced effects, all from a single dialogue box.

Changing Existing Text

You can apply an effect to any amount of text from
a single character to an entire story. To do this,
select the text required (see 3.6), and then choose
the required effect from the appropriate menu or
dialogue box.

Applying Style Effects as you Type

As you are typing, you can choose the required
effect from the appropriate menu or dialogue box,
and then continue typing. Any text subsequently
typed at the caret will use that effect. However, if
you move the caret before typing any text, the
effect will be removed.

e T i ]
Modify text...F6
Font b
Size P
Effect P
Colour...

Format.. *F
Alignment b
Leading b
Tabs... *Tab

Fig. 4.1 - The Text menu.
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Moving the Caret
If you move the caret into another part of the
document, any characters typed will be displayed
in the style that was current for the text
immediately before the new caret position.
Clearing Effects
You can clear all locals effects from the current
selection by choosing the option Local effects
(fig.4.2).

Menu=>StylecoRemovec>Local effects AL

Edit style.. *ME

Fig. 4.2 - Use Local effects to remove all effects.



SecTion 4.2 CHanaing Font 41

4.2 Changing Font
Menu=>Text= Font=

To change text to a new font, select the text or
position the caret as required, then choose the new
font from the Font menu (fig. 4.3). The font menu
is available from either the Text menu (fig. 4.1) or
the info palette (fig. 4.4). Applying a font in this
way, overwrites any other font already present.

Current Font

If there is no selection, the font that is current at
the caret is ticked on the Font menu and indicated
on the info palette.

If there is a selection, the font that is present
throughout the entire selection is ticked on the
Font menu and indicated on the info palette. If
there is no tick on the menu and no font name on
the info palette, it means that there is more than
one font present in the selection.

Goudy

Hamartan

Fig. 4.3 - Top of the Fig. 4.4 - The info palette displays the current font and provides a Font menu for choosing
Font menu. a new font.
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4.3 Changing Size

To change the size of text, select the text or
position the caret as required, then choose the size
required from the Size menu (fig. 4.5). The Size
menu is available from either the Text menu

(fig. 4.1) or the info palette (fig. 4.6).

Standard Sizes

The Size menu offers a range of standard sizes,
shown below at actual size.

8 point

10 point
12 point
14 point

18 point
24 point

36 point
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Units

The default units for type size are points (pt). In
computer terms, 1pt equals 1/72 of an inch. The
table below gives metric and imperial equivalents

for the standard type sizes.
pt mm in
8 2.82 0.11
10 3.53 0.14
12 4.23 0.17
14 4.94 0.19
18 6.35 0.25
24 8.47 0.33
36 12.70 0.50

Other units supported are the didot and the cicero
still used at times for book printing. The didot is
the equivalent of the point outside the UK and the
USA. There are 12 didots in 1 cicero. 1 point is
1/72th of an inch. A didot is 0.0148 inch or about
1/68th of an inch. Some examples of metric and

imperial equivalents for didots are:
didot mm inch
8 3.01 0.12
10 3.76 0.15
12 4.51 0.18
14 5.26 0.21
and for cicero's:
cicero mm inch
8 36.10 1.42
10 45.12 1.78
12 54.15 2.13
14 63.17 2.49

As fonts are nowadays generally computer
generated printers tend to use mm's or pt's for
sizes.

Within Ovation Pro units can be specified in
didots by using di, d or D the unit abbreviation
after the value and ciceros using ci or CI See
Appendix J for the complete set of supported units.

Current type size Size menu

|

a5y 1omm

| D] .

Fig. 4.5 - The

Size menu. changing to a new size.

Fig. 4.6 - The info palette displays the current type size and provides a Size menu for
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Other Sizes
Menu=>Text=>Sizew>

The last entry on the Size menu allows you to enter
any size between 1pt and 1000pt. The default unit
is points, but if you wish you may specify another
unit e.g. Smm or 0.25in. The value will be
converted to points next time the menu is
displayed.

Sizes may be specified to two decimal places.
However, the font manager has a maximum
resolution of 1/16pt (0.022 mm), so the type size
plotted may be rounded up slightly.

It is also possible to enter a calculation. If you
enter 12 + 50%, the result will be 18pt. You can
add or subtract by numbers or a percentage.

Similar comments about units and calculations
apply to all the writable icons in Ovation Pro, see
Appendix ] for more information.

Current Size

If there is no selection, the type size that is current
at the caret is ticked on the Size menu and
indicated on the info palette.

If there is a selection, the type size that is present
throughout the entire selection is ticked on the Size
menu and indicated on the info palette. If there is
no tick on the menu and no size given on the info
palette, it means that there is more than one size
present in the selection.

43
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4.4 Miscellaneous Effects
MenucText>Effecte>

The Text>Effect menu (fig. 4.7) provides the
effects that may be applied to selected text or at the
caret. Effects may also be chosen by clicking on
icons on the info palette (fig. 4.8).

Please note that applying effects toggles them on
and off. For example, if you apply Bold to some
normal text, the text will change to bold as
expected. However, if you apply Bold to some text
that is already bold, the bold effect will be
cancelled and the text changed to normal.

Normally the Effect menu closes after choosing an
effect, which is inconvenient if you wish to choose
a number of effects in one operation. If you choose
effects by clicking Adjust instead of Select, the
Effect menu will remain open. To close the menu,
click Select on the last effect you require.

CrarTeR 4

Normal
Normal deselects other effects such as Bold, Italic
etc.

This is normal text

Bold

Bold selects the bold variant of the current font. It
is useful for highlighting words. Bold can only be
used if there is a bold version of the current font
available.

Example of bold text

ltalic
Italic selects the italic variant of the current font. It
is useful for emphasizing words. Italic can only be
used if there is a italic version of the current font
available.

Example of italicised text

Underline

This effect underlines all characters including
spaces and punctuation characters.

Example of underlined text

Advanced underline effects may be specified on
the Modify text dialogue box. AF6

[r Textiame  X[10mm

| ) ~ ¥[10mm

Fig. 4.7 - The
Effect menu

the caret.

‘W(190mm |  Trinity
H[zzem | [N B 2] 0B 2] =
Normal / \\ssmsa:fpr
Bold uperscript

Italic Reverse

Underline

Fig. 4.8 - The info palette allows a range of effects to be applied to the selected text or to
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Reverse

Reverse swaps the text foreground and
background colours. By default this produces
white text on a black background.

Example of (S8 text
Superscript
This effect produces superscript text.
Example of superscript text

The size of the superscript may be specified in
Misc=>Preferences (see 15.14).

Subscript
This effect produces subscript text.

Example of subecrip text

The size of the subscript may be specified in
Misc=>Preferences (see 15.14).
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Current Effect

If there is no selection, any effects that are current
at the caret are ticked on the Effect menu and
indicated (in orange) on the info palette.

If there is a selection, any effects that are present
throughout the entire selection are ticked on the
Effect menu and indicated on the info palette. If an
effect is not ticked on the menu and not indicated
in orange on the info palette, it means that it is not
present throughout the selection.
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4.5 Text Colour
Menuc>Texte>Colour...

The Text=>Colour opens a dialogue box (fig. 4.9)
which allows you to change the colour of text.
Colour can be applied to a selection or at the caret
if there is no selection.

The scrollable window lists all the colours
available. A sample of each colour is given,
followed by its name. You can add your own
colours to the list using Miscr>Edit colours
(see 16.2).

Click Select on a colour to choose it. The two
coloured squares at the bottom of the dialogue box

show the chosen colour and the previous colour i.e.

the one that was current before the dialogue box
was opened.

Click on OK to apply the colour to the text.

Alternatively double-click on a colour to select it
and apply the colour in one operation.

Please note that the procedure described above for
selecting a text colour, is the standard system of
selecting colours throughout Ovation Pro.

Previous oolour\ =

Current colour—"] _|Bumﬂ"t

_- Tint [T % v A "Bk
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Tints

If you do not specify a tint, the chosen colour is
applied exactly as shown in the sample. This is
referred to as a solid colour and has 100% tint.
You can apply a tint of the solid colour by
choosing a percentage from the tint menu or by
entering an integer between 0 and 100 in the
writable field at the bottom of the menu.
Alternatively, use the up and down buttons to
change the tint value one percent at a time.

0
20
30
40
50
60
70
80
90
100

™

Tint menu

Fig. 4.9 - The standard Ovation Pro colour picker.
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4.6 Advanced Text Effects
Menu=>Text->Modify text F6

The Textc>Modify text dialogue box (fig. 4.10)
provides a wide range of advanced text effects that
may be applied to a selection or at the caret.

Current Text Effects

The Modify text dialogue box reflects all the
settings that are current at the caret or throughout a
selection.

If any effects are not present throughout a
selection, they are indicated on the Modify text
dialogue box as follows:

1. If the effect is set by a value in an icon, that
icon will be blanked out.

2. If the effect is set by a button, the button will
be indicated with a cross.

For example, the dialogue box shown in fig 4.10
shows the effects present in a selection. Since Size
and H scale are blank, it means that they are not
present throughout the selection.

The same is true for Bold which is indicated with a
‘crossed’ button. Blank buttons such as that for
Italic, indicate that the effect is switched off
throughout the selection. Ticked buttons such as
Underline, indicate that the effect is switched on
throughout the selection.
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Font
Changes the font of the text (see 4.2).
Size
Changes the size of the text (see 4.3).
Case
This provides a menu with three options for
specifying the case of the text:
Normal displays text in the case in which it was
typed or imported.
Title changes the first letter of each word to upper
case and the rest to lower case. Any individual
characters are changed to upper case.

This Text Is In Title Style.
All caps changes all letters to upper case.

THIS TEXT IS IN ALL CAPS.
Foreground
Changes the colour of the text using the colour
picker (see 4.5).
Background

Changes the background colour of the text using
the colour picker (see 4.5). The default background
colour is transparent.

Fig. 4.10 - The Modify text dialogue box.
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H scale

Horizontal scale allows you to compress or expand
text horizontally. You can scale text from 10% to
1000% of the normal unscaled width without
changing the text height.

759 horizontal scaling
100% horizontal scaling
125% horizontal scaling

The default horizontal scale is 100%.

Track

If there is no selection Tracking is equivalent to
Kerning.

Kerning moves the characters on either side of the
caret further apart or closer together. Characters
are moved apart using positive kemning values or
closer together using negative values. Kerning is
normally used to improve the appearance of
certain letter pairs such as AV and WA which look
better if they are moved closer together. In the
examples below the first pair of letters are spaced
normally (zero kerning), while the second pair
have a kerning value of -200.

AV
AV

Keming values are specified in units of .001 of an
em space and can be any integer value between
-1000 and 1000. In Ovation Pro, an em space is
defined as the current point size.

Please note that the latest outline fonts incorporate
auto-kerning which automatically improves the
appearance of some letter pairs (see 5.4). However,
you may wish to use the Track option for fine

tuning.

CHaPTER 4

Tracking 1s identical to kerning described above,
but is applied to selected text rather than letter
pairs. Negative tracking is useful for fitting text
onto lines, although if your text is justified you
may obtain better results using enhanced
justification (see 5.7). Positive tracking can give
attractive results for titles and headings.

Text tracked -100

Text tracked 0

Text tracked 250
V shift
This effect shifts text vertically above or below the
baseline. V shift is expressed as a percentage of
the type size. A positive value shifts the text up
and a negative value shifts the text down.

shift

Vertical

Vertical
Rotate
This effect rotates characters about their centres, to
the angle specified. A positive value rotates text
anti-clockwise, and a negative value rotates text
clockwise. The best results are obtained with upper
case text.

TEXT R0T ATED TO 20°

TEXT ROT4 TEDTO -20°

100%

shift -50%
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Skew

This effect skews text to the angle specified. A
positive value skews the text to the right and a
negative value, to the left. The angle is specified in
degrees and must be within the range -80° to 80°.

Text skewed 20°
Text skewed -20°

Bold

Bold selects the bold variant of the current font
(see 4.4).

Example of bold text

Italic

Italic selects the italic variant of the current font
(see 4.4).

Example of italicised text

Superscript

This effect produces superscript text (see 4.4).
Example of superscript text

Subscript
This effect produces subscript text (see 4.4).

Example of supseript text
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Underline

This effect underlines text. Click on the icon to the
right of the Underline option to display the
Underline specification dialogue box (fig. 4.11).
Word underline underlines all characters except
spaces.

Double underline underlines with a double line.

Example of underlined text

Text word underlined

Double underlining
Width opens a menu allowing you to specify the
width of the underlining (fig. 4.12). The width is
specified as a percentage of the type size of the
first character on the line. Thin is 2%, Medium is
4% and Thick is 8%. The last entry on the Width
menu allows you to specify a width in the range of
1% to 50%.

It is also possible to enter an absolute underline
width in size units, points etc. Values followed by
a % will be taken as a percentage anything else
will be taken as absolute with a default unit of
points.

Colour allows you to specify the underline colour
using the standard Ovation Pro colour picker. The
default colour is Transparent, which has a special
significance when used for underlining. It causes
the underline colour to be the same colour as the
text being underlined. This means that if the text
colour is changed, the underline colour will change
to match.

4.11 - The Underline specification dialogue box.
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Strikeout

This effect draws a line centrally through the text.
Click on the icon to the right of the Strikeout
option to display the Strikeout specification
dialogue box (fig. 4.13). Width and Colour
options are the same as for underline above.
Small caps

This effect changes all lower case letter to small
capitals. The default size is 65% of normal
capitals, but this can be changed in
Misc>Preferences (see 15.14). Aflp

ExampLE oF SMaLL Caps

Reverse
Reverse swaps the text foreground and
background colours (see 4.4).

Example of [{gia il text

4.13 - The Strikeout specification dialogue box.

4.12 - The Width menu

CHAPTER 4
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This chapter describes how to format paragraphs using local format
effects. These are applied directly to an individual paragraph or selection
of paragraphs and take effect immediately.

Local effects are normally used when you wish to make a simple change to a
document, such as justifying a paragraph. If you are producing a short or simple
document then it is practical to use combinations of local effects, since if you
want to change them, it is reasonably quick to do so in a short document.

In long or complex documents you should use defined styles described in
Chapter 6. These allow style and format effects to be combined together in a
named style and applied in a single operation. Defined styles may easily be
modified at a later stage, automatically updating all occurrences in the document.
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5.1 Applying Format Effects
Menu=Text>Format AF

Local format effects are used to change the format
of paragraphs of text. Alignment and Leading on
the Text menu (fig.5.1) provide the basic format
effects. The Format dialogue box provides the
complete range of text formatting effects.

Tabs opens the tab ruler and allows tab stops and
indents to be set.

Format effects can only be applied to whole
paragraphs. A paragraph is defined as being the
text between two Return characters, so it may be a
single line heading or a multiple line paragraph.
If you want to start a new line within the same
paragraph choose Misc=>Insert=>New Line or
press Shift Return.

Changing a Single Paragraph
To change the format of a single paragraph,
position the caret in the paragraph and choose the

required effect from the appropriate menu or
dialogue box.

Changing Multiple Paragraphs

If you select a number of paragraphs, formatting
will affect all paragraphs wholly or partially
selected.

@
VIV VS~V VL

Leading b

Tabs...
Fig. 5.1 - The Text menu.

*Tab

CHAPTER 5

Copying Format Effects

You can copy the format attributes from one
paragraph to another. To do this, place the caret in
the destination paragraph (or select a range of
paragraphs), then hold down Shift and click Adjust
in the source paragraph. This facility does not copy
text effects such as bold and italic.

Clearing Effects

You can clear all local format effects from the
caret or from a selected region by choosing
StylecoRemovervLocal effect (fig. 5.2).

Fig. 5.2 - Use Local effects to remove effects.
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5.2 Alignment
Menu=>Text>Alignement=>

To align selected paragraphs choose the alignment
you require from the Alignment menu (fig. 5.3) or
from the info palette (fig. 5.4).
Left
Left aligns paragraphs to the left margin, leaving
the right edge ragged. This is the default state. It is
also referred to as ‘flush left’, ‘ranged left’ or
‘ragged right’.
Left aligns paragraphs to the left margin, leaving the
right edge ragged. It is also referred to as ‘flush left’,
‘ranged left’ or ‘ragged right’.
Centre
Centre aligns paragraphs centrally between the
left and right indents, leaving both left and right
margins ragged.
Centre aligns paragraphs between the left and right
margins, leaving both margins ragged.
Right
Right aligns paragraphs to the right indent, leaving
the left edge ragged, It is also referred to as ‘flush
right’, ‘ranged right’ or ‘ragged left’.
Right aligns paragraphs to the right indent, leaving
the left edge ragged, It is also referred to as “flush
right’, ‘ranged right’ or ‘ragged left’.
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Justify

Justify aligns paragraphs so that both left and right
edges are aligned to the margins. It does this by
inserting extra space between the words on each
line.
Justify aligns paragraphs so that both left and right
edges are aligned to the margins. It does this by
inserting extra space between the words on each
line.

By default Ovation Pro uses the RISC OS font
manager to justify text by inserting extra space
between the words only. However it is possible to
achieve greater control over justification by
inserting extra space between letters. This feature
is called letter spacing (see 5.7).

Current Alignment

The alignment that is current at the caret or
throughout a selection is ticked on the Alignment
menu and indicated in orange on the info palette.
If there is more than one alignment setting in a

selection, there will be no tick on the menu and no
alignment indicated on the info palette.

| Textframe X 10mm
==Y "-_".1'5_‘?1011'|n1

Fig. 5.3- The
Alignment menu.

Left align /
Centre align
Right align
Fully Justify

Fig. 5.4 - The info palette allows you to align or justify paragraphs.
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5.3 Leading
Menu=>Text>Leading=

The Leading menu (fig. 5.5) allows you to set the
vertical spacing between lines of text.

Single space is the default leading and should be
suitable for most purposes. It is equivalent to 20%
relative leading (see overleaf).
Single space is the default leading and should be
suitable for most purposes. It is equivalent to 20%
relative leading (see overleaf).
Double space gives increased line spacing and is
equivalent to 120% relative leading.
Double space gives increased line spacing and is

equivalent to 120% relative leading.

The writable field at the bottom of the menu
allows you to specify other values, using one of the
three methods described below: absolute (value
entered as such), relative (value followed by a %)
or incremental leading (value preceded by a + or
by a-).

Please note that the default units for absolute and
incremental leading are points, but you may
specify another unit after the value e.g. Smm.

Single space I
Double space

[

Fig. 5.5 - The Leading menu.
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Absolute Leading
This is the distance between the base lines of each
line of type (fig. 5.6).
The example below uses 17pt absolute leading.
Notice that the line spacing is equal throughout the
paragraph, regardless of the type sizes present. It is
important that the value specified is large enough
to accommodate the biggest type size otherwise
lines will overlap.

This example uses 17pt absolute leading. Notice that

the line Spacmg is equal throughout the

paragraph, regardless of the type sizes present.
Absolute leading is useful if you wish to align text
with other objects, such as lines. In the example

below, the lines have been duplicated at 6mm
vertical offsets and the text is set to 6mm absolute

leading.
Absolute leading is useful if you wish to align text
with other objects, such as lines. In this example
the lines have been duplicated at 6mm vertical
offsets and the text is set to 6mm absolute leading.

You may see type described as ‘10 set on 17" or
10/17. This means 10pt text with 17pt absolute
leading.

T

qR

Fig. 5.6 - Absolute leading.
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Relative Leading

This is specified as a percentage of the current type
size. For example, if the type size is 45pt and the
leading is 20%, the line spacing is 45pt + 20% of
54pt (fig. 5.7).

To use relative leading you must add a % to the
value e.g. 15%.

Relative leading is the default type of leading

because it produces line spacing that is

proportional to the type size being used. In the

example below, the line spacing is increased to

accommodate the larger type on the third line.
This example paragraph uses 20% relative leading.
Relative leading is popular because it produces well
proportioned line spacing that is relative to the
type size being used.

54.09pt (45pt + 20% of 45pt)

-
|5

)
Fig. 5.7 - Relative leading.
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Incremental Leading
This is specified as a value to be added to, or
subtracted from, the current type size. For
example, if the type size is 45pt and the leading is
+5pt, the line spacing is 45pt + 5pt (fig. 5.8).
To use incremental leading you must prefix the
value witha +or-e.g. +5ptor -2pt.
The example below uses +5pt incremental leading.
Notice that the gap between the lines is equal
throughout the paragraph, irrespective of the type
size.
A positive value specifies the gap between the lines.
This example uses +5pt incremental leading. Notice
that the gap between the lines is equal throughout the
paragraph, regardless of the rype size.
Negative incremental leading closes the gap
between lines and can cause them to overlap. The
example below uses 12pt and 24pt text with -12pt
incremental leading.

Speétial

Current Leading

The leading that is current at the caret or
throughout a selection is ticked on the Leading
menu.

If there is more than one leading value in a
selection, there will be no tick on the menu.

Op -%pr (45pt + 5pt)
qR

Fig. 5.8 - Incremental leading.
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5.4 The Format Dialogue Box
Menu>Text>Format AF

The Format dialogue box (fig. 5.9) provides all

the formatting options that may be applied to the

current paragraph or a selection of paragraphs.

Please note that the indent options on this dialogue

box may also be specified on the tab ruler

(see 5.5).

Current Format Options

The Format dialogue box reflects all the settings

that are current at the caret or throughout a

selection.

If any effects are not present throughout a selection

of paragraphs, they are indicated on the Format

dialogue box as follows:

1. If the effect is set by a value in an icon, that
icon will be blanked out.

2. If the effect is set by a button, the button will
be indicated with a cross.

CHarer 5

For example, the Format dialogue box shown in
fig 5.9 shows the formatting effects present in a
selection. Since Space before and Alignment are
blank, it means that they are not consistent
throughout the selection.

The same is true for Auto hyphenation which is
indicated with a ‘crossed’ button. Blank buttons
such as that for Drop capital, indicate that the
effect is switched off throughout the selection.
Ticked buttons such as Auto kerning, indicate that
the effect is switched on throughout the selection.

Fig. 5.9 - The Format dialogue box.
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Left Indent

Left indent defines the left margin of the current
paragraph or selected paragraphs. It may be used
to distinguish paragraphs from surrounding text.

The left indent is measured from the left-hand
frame inset (fig. 5.10), or from the standoff of any
obstructing frames (fig. 5.11).

If the left indent value is preceded by the +
symbol, the indent is measured from the left edge
of the frame bounding box (fig. 5.12), ignoring any
obstructing frames (fig. 5.13).

Te Formar DiaLocue Box

Fig. 5.10 - The left indent is measured from the
left-hand frame inset.

Thefme‘aam ical
typewriter, which
originated in the

i USA about a
| century ago, @M
Ll 1 represented the

first major advance
over pen or pencil.
Its two principal a
4 = 4]
Fig. 5.11 - The left indent is measured from the
left-hand frame inset or from the standoff of any
obstructing frames.
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RN ediet i Frame inset N ovepe o &
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i CeE— 0, i e 1

Fig. 5.12 - If the left indent has a + prefix, the indent
is measured from the left edge of the frame
bounding box.

&

1 ago, represented the

The mechanical
typewriter, which
originated in the
USA about a century

=

first major advance
over pen or pencil.
Its two principal ad-
vantages were that a

=) £l

Fig. 5.13 - If the left indent has a + prefix, the indent
is measured from the left edge of the frame
bounding box ignoring obstructing frames.

57
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Right Indent

Right indent defines the right margin of the
current paragraph or selected paragraphs. It may be
used to distinguish paragraphs from surrounding
text.

The right indent is measured from the right-hand
frame inset (fig. 5.14), or from the standoff of any
obstructing frames (fig. 5.15).

If the right indent value is preceded by the +
symbol, the indent is measured from the right edge
of the frame bounding box (fig. 5.16), ignoring any
obstructing frames (fig. 5.17).

If the right indent value is preceded by the -
symbol, the indent is measured from the left-hand
inset or edge instead.

~ i g Frame bounding box
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Fig. 5.14 - The right indent is measured from the
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i

| Sl
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Fig. 5.16 - If the right indent has a + prefix, the

right-hand frame inset. indent is measured from the right edge of the frame
bounding box.

) =) & = r
The  mechanical Tine]  mechanical |
typewriter,  which typewriter,  which
originated in the originated in the
USA about a USA about a century =
grentury  ago, m aago, represented the| [
represented the first major advance | |
first major advance over pen or pencil. =
over pen or pencil, Iis two principal ad-
Its two principal ad- vantages were that a
5 = | i & #l

Fig. 5.15 - The right indent is measured from the
right-hand frame inset or from the standoff of any
obstructing frames.

Fig. 5.17 - If the right indent has a + prefix, the
indent is measured from the right edge of the frame
bounding box ignoring obstructing frames.
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1st Indent

This is the first line indent and defines the left
margin for the first line of the paragraph only. First
line indent is specified as an offset from the
normal left indent.

If the 1stindent is given a positive value, then the
first line of the paragraph will be indented from the
left indent by that amount (fig. 5.18). When used in
this way, the first line indent is often called the
paragraph indent,

Another use of the first line indent is to create a
hanging indent. This is where the first line indent
is positioned to the left of the left indent (fig. 5.19
and fig. 5.29). The example shown has a left indent
of 10mm and first line indent of -10mm. The
number on the first line of each paragraph starts at
the first line indent. A tab after the bullet forces
subsequent text on the first line to start at the left
indent. All subsequent lines start at the left indent.

‘When using hanging indents, if you want to start a
new line at the left indent, you should use

Menu>MisceoInsertc>New line TTReturn.

If you use Return, a new paragraph will be inserted
and typing will commence at the 1st indent.

F)

The|mechanical
typewriter, which
originated in the USA
about a century ago,
trepresented the first majorm
advance over pen or
pencil.

Its two principal
advantages were that a
L =) ’._Ll

Fig. 5.18 - The text in this frame has a Omm
leftindent, and a 10mm 1st indent.

Astindent [ tomm |

As seen in the Modify Format window; see Fig. 5.9
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Alignment

This option opens a menu allowing you to specify
paragraph alignment (see 5.2).

Space Before

This sets the amount of extra space inserted above
a paragraph.

Default units for Space before are points.

Space After

This sets the amount of extra space inserted below
a paragraph.

Instead of pressing Return to insert a blank line
between paragraphs, it is better to set Space after
to the same value as the type size. If at a later stage

you want smaller gaps between paragraphs, you
can reduce the Space after value.

Default units for Space after are points.

Leading

This sets the amount of space between lines. The
default value is 20%. See section 5.3 for more
information.

1. 1sfline indent is
useful for creating
numbered or
bulleted lists such as

m this. m

2. Each number or
bullet should be fol-
lowed by atab
character.

L, = £]

Fig. 5.19 - The text in this frame has a 10mm
left indent, and a -10mm 1st indent.

10mm|

g s

As seen in the Modify Format window; see Fig, 5.9
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Drop Cap
MenucoText<>Format....

Drop cap changes the first character in the
selected paragraphs to a drop cap (fig. 5.20). The
depth of the drop should be entered in the writable
icon provided.

The drop cap depth is specified in lines, based on
the depth of the first line.

Auto Kerning

Auto kerning uses the kerning data provided with
fonts to improve the appearance of certain
character pairs by adjusting the white space
between them.

Please note that this facility only works with newer

RISC OS 3 fonts such as those supplied with
Ovation Pro.

Ir:;

Lock to Grid

CHarTER 5

In a multi-column or multi-frame layout, text in
one column or frame may not align horizontally
with text in the others (fig. 5.21). Lock to grid
aligns text in the selected paragraphs to a baseline
grid. If Lock to grid is enabled, the baselines of
affected text are shifted to align to the grid

(fig. 5.22).

The baseline grid origin and grid spacing are set on
MisceoPreferences (see 15.14).

Auto Hyphenation

Auto hyphenation automatically hyphenates
words that run over the ends of lines (see 5.6).

Enhanced Justification

Enhanced justification allows you to control
word and letter spacing in justified text (see 5.7).

DTP ORIGINS
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Thbout a century ago,

represented the first
major advance over pen
or pencil. Its two

i

-1

=1
=
F=1
1=

incipal advantages
re that a competent
ist could write much
aster with a typewriter
han with pen or pencil [
d that the writing
uced was consistent
d clearly legible. It
s not surprising, then,

L

=

£

Fig. 5.21 - The baselines of text in columns do not align.

£l

fxentury ago, represented M
the first major advance
over pen or pencil. Its
two principal advantages

i =) g @
he|mechanical
originated in the The|mechanical
USA about a typewriter, which

dpriginated in the USA

about a century ago,
represented the first
major advance over pen

were that a competent

Fig. 5.20 - Drop cap, 4 lines deep.
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Fig. 5.22 - Use Lock to grid, to align the baselines of text.
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5.5 The Tab Ruler

Tab stops are inserted into the document by
pressing the Tab key.

The tab ruler allows you to specify the exact tab
and indent positions for the current paragraph or
selection of paragraphs.

Menu=>Text=>Tabs... ATab

After choosing Tabs, the tab ruler is placed over
the top of the current paragraph or selection of
paragraphs (fig. 5.23). The ruler is the width of the
frame less the insets. The markings on the ruler are
in the current units.

Setting Tabs

To set a tab, choose the type of tab you require
from the Tabs dialogue box, then click on the
white area of the tab ruler at the required position.
Further clicks on the tab ruler will set more tabs of
the chosen type.

If you want to set tabs at precise positions, select
the type of tab you require, then enter the exact
position in the icon labelled Position. Press Return
to set the tab.

When you have finished setting tabs, click on OK
to update the document.

Beyond the position of the last tab stop explicitly
set Ovation Pro will generate virtual stops every
10mm.

THe Tas RuLer 61

Moving Tabs

To move a tab, click over it and drag it to the
required position. Alternatively, click on it to
highlight it in red, then enter the required position
in the Position icon on Tabs dialogue box. Press
Return to set the tab to the new position.

You can select a number of tabs by clicking Select
over the first one, then clicking Adjust over any
other tabs you wish to add to the selection. A
selection of tabs can be moved in one operation by
dragging any of the tabs in the selection.

Click Select over the ruler markings to deselect all
tabs.

Deleting Tabs

To delete a tab or selection of tabs, drag them
down onto the tab ruler.

Clear

Alternatively all tabs can be removed by clicking
on the Clear button.
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The mechanical typewriter, which originated in the USA about a
century ago, represented the first major advance over pen or
pencil. Its two principal advantages were that a competent
typist could write much faster with a h,'pewnler than with pen or

Fig. 5.23 - The tab ruler is displayed above the current paragraph.
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Left Tab

The left tab causes text to be left aligned to the tab
stop (fig. 5.24).

Centre Tab

The centre tab causes text to be centred on the tab

stop (fig. 5.25).

Right Tab

The right tab causes text to be right aligned to the

tab stop (fig. 5.26).
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Fig. 5.25 - Centre tab.
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Decimal Tab

The decimal tab causes decimal points to be
aligned to the tab stop (fig. 5.27). The decimal
point character is usually a full stop, but may be
defined in Misc=>Preferences (see 15.14). In
addition the writable icon can be used to set an
individual decimal tab character for the currently
selected tab. If this is left blank the setting from
document Preferences will be used.

Text that doesn't contain a decimal point character
is right aligned to the tab stop.
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Fig. 5.26 - Right tab.
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Tab Leader

The Tab leader is a string of one to four
characters that are automatically printed in the tab
space.

Typically the Tab leader string is set to a full stop
(or a full stop and a space character), and is often
used in the contents pages of books and magazines
(fig. 5.28).

Different Tab leader strings can be set for each
tab. The string shown in the icon will be for the
currently selected tab.

T} =| |
CONTENTS

lintroduction] . ....... 1
Getting Started .. ... . 4
BasicDTP.......... 8

qAdvanced DTP .. ... 10m
Pictures. . ......... 12
Objects .. ......... 14
R o i 16
Glossary .......... 18

i} =) £

Fig. 5.28 - Page numbers tabbed
right with ‘dot-space’ tab leader.
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Setting Indents

The tab ruler may also be used to set the positions
of the indents. Indents may also be set on the
Format dialogue box, so please refer to that
section of this user guide for full details on the
operation of indents (see 5.4).

The Left indent and 1st indent are displayed
together at the left end of the tab ruler, and the
Right indent is displayed at the right end of the
tab ruler (fig. 5.29).

You may drag the indents to re-position them.
Alternatively, click on an indent to highlight it,
then enter the required position in the Position
field of the Tabs dialogue box.

You can move the Left indent and 1st indent
together by selecting them both and dragging in
one operation.

Unlike tabs, you cannot delete indents.

1st indent Right indent
/ Left indent
o
-
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The| mechanical typewriter, which
originated in the USA about a
century ago, represented the
first major advance over pen or

11} pencil. Its two principal 11}

advantages were that a

competent typist could write

much faster with a typewriter
than with pen or pencil and

i = 1

Fig. 5.29 - Indents may be set on the tab ruler.
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5.6 Automatic Hyphenation

Normally when a word runs over the end of a line,
the entire word is transferred to the start of the next
line. This process is called word wrap.
Alternatively, you may hyphenate words so that
they are split at the end of lines. This enables text
to be fitted better into frames; especially in narrow
columns. In justified text, it also reduces the size
of the gaps between words.

You may manually hyphenate a word by typing a
hyphen - at the required place. If that word runs
over the end of a line, it is split at the hyphen.

Soft Hyphen

Alternatively you may insert a soft hyphen by
typing Ctrl -. A soft hyphen does not appear until it
is needed i.e. if editing the text causes the word to
run over the end of a line. In this situation, the soft
hyphen becomes visible and the word is split at the
hyphen. If editing causes the word to move away
from the end of a line, the soft hyphen will
disappear.

You may delete a soft hyphen when it is visible
using Delete or Copy in the usual way. You may
also delete an invisible soft hyphen. To do this,
step through the word containing the soft hyphen
until the caret steps over the invisible hyphen, then
press Delete.

Hard Hyphen

If you want a hyphen in a word, but do not wish to
split the word at that hyphen, you may insert a
hard hyphen using Alt -.

CHaAPTER 5§

Auto Hyphenation

If Auto hyphenation is enabled, words that run
over the end of lines are automatically hyphenated.

Ovation Pro uses a hyphenation algorithm and an
exceptions dictionary to determine the best place
in a word for a hyphen. The exceptions dictionary
contains words that should not be hyphenated or
should only be hyphenated in a specific way. You
may edit or add words to the exceptions dictionary
if required (see 14.8).

Please note that hyphenation exceptions do not
take effect until the text is re-flowed.

The hyphenator ignores words that already contain
a normal, soft or hard hyphen, or words containing
non-alphabetic characters. In some cases it may
decide there is no suitable place for a hyphen, in
which case the word is not hyphenated and word
Wwrap occurs.

If the automatic hyphenator splits a word
incorrectly, you may do one of two things:

1. Add the word to the exceptions dictionary
specifying the correct hyphen position or
specifying that the word should not be
hyphenated at all.

2. Type a soft hyphen using Ctrl - at the start of
the word. This will stop the word from being
hyphenated.
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Auto Hyphenation Options
Menu=Text=>Format... AF

The Auto hyphenation dialogue box (fig. 5.30)
allows you to control certain aspects of the
automatic hyphenator. This box is displayed by
moving the pointer of the icon to the right of
Auto hyphenation.

It is not good practice to hyphenate very short
words, so Minimum characters in word specifies
the smallest size word that will be hyphenated.

Minimum before hyphen specifies the minimum
number of characters in the word that must precede
the hyphen. This prevents the hyphenator splitting
a word too close to its start.

Minimum after hyphen specifies the minimum
number of characters that must follow the hyphen.
This prevents the hyphenator splitting a word too
close to its end.

It is not good practice for too many consecutive
lines to end with a hyphen. Maximum
consecutive hyphens prevents this by specifying
the maximum number of consecutive lines that
may end with a hyphenated word. If this limit is
reached, the word at the end of the line will not be
hyphenated. A value of 0 means that there is no
maximum limit.

wmmmm E’
Minimum before hyphen [Z|
- Minimum after hyphen I: A
Maxmunmmwﬁvahymm E

Fig. 5.30 - The Auto hyphenation dialogue box.
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Hyphenation zone specifies a zone measured
from the right margin. The start of the last word in
the line must be outside this zone, for it to be
considered for auto hyphenation. The hyphenation
zone only has an effect on text that is left aligned.

If Break last word of paragraph is selected, the
hyphenator will attempt to break the last word in
the paragraph should it run over the end of the line.
Generally this is not regarded as good practice, so
this option is normally not selected.

The hyphenator does not normally split capitalised
words, but you may select Capitalised words if
you wish it to do so.
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5.7 Enhanced Justification
Menu=>Text-oFormat... AF

‘When a paragraph is justified, both left and right
edges are aligned to the margins. Normally this is
done by increasing the gaps between words until
the line fits; this is called word spacing. In some
circumstances, especially in narrow columns, this
can result in large gaps appearing in lines of text.
If these gaps join up over a number of consecutive
lines, an undesirable effect called ‘rivers of white’
may be produced.

Auto hyphenation can help reduce these
problems, but for best results you should use
Enhanced justification. This gives control over
word spacing, and allows you to introduce letter
spacing, should word spacing become excessive.

Enhanced justification is controlled from the
dialogue box which is displayed by moving the
pointer over the icon to right of Enhanced
justification (fig 5.31).

Enhanced justification
Letter spacing — ~ Word spacing
Minimum E % | | Minimum %
Maximum [ 25 | % | | Meximum [125] %

Fiusn zone [ omm |

Fig. 5.31 - The Enhanced justification dialogue box.
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Word Spacing

Minimum and Maximum are the expansion limits
for word spacing. The values are specified as
percentages, where 100% represents the width of a
standard space character. If text cannot be justified
within these limits, letter spacing is introduced (if
it is enabled).

Reducing the Minimum value should enable you

to fit more text into lines, although some clarity
will be lost as words get closer together.

Increasing the Maximum value allows word
spacing to become much greater before any
attempt is made to use letter spacing. This value
has no effect if letter spacing is not enabled.

Letter Spacing

Minimum and Maximum are the expansion limits
for letter spacing. The values are specified as
percentages, where 100% represents the width of a
standard space character. A normal letter space is
0%.

To disable letter spacing, set Minimum and
Maximum to 0%.

A negative Minimum value may cause letters to
overlap.

A large Maximum value will give excessive letter
spacing which is regarded as bad practice.
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Enhanced Justification Rules

Ovation Pro tries each of the following steps, until
the text becomes justified.

1. Increase word spacing from 100% up to
Maximum.

2. Decrease word spacing from 100% down to
Minimum.

3. Set word spacing to Maximum and increase
letter spacing from 0% to Maximum.

4. Set word spacing to Minimum and decrease
letter spacing from 0% to Minimum.

5. Increase word spacing from Maximum until
the line fits.

Notice that Ovation Pro attempts to justify the text
using word spacing before trying letter spacing,
and increases spacing before decreasing.

D'1'11«3* " mechanical |
typewriter, which
originated in the USA
about a century ago,
represented the first major
advance over pen or
geencil. Its two principal
advantages were that a
competent typist could
write much faster with a
typewriter than with pen
or pencil and that the
writing  produced was
L = £
Fig. 5.32 - Standard justification.
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Justification Examples

The examples below show how the same
paragraph may be justified in two different ways.
The first example (fig. 5.32), uses standard
justification. Word spacing is increased until text
fits on a line, and there is no letter spacing.

The second example (fig. 5.33), uses enhanced
word and letter spacing:

Word spacing Minimum 75%
Word spacing Maximum 125%
Letter spacing Minimum 0%
Word spacing Maximum +25%

Notice that there are fewer large gaps between
words and more text fits into the frame.

) & Bl
Themechanical typewriter,
which originated in the
USA about a century ago,
represented the first major
advance over pen or
pencil. Its two principal
gadvantages were that af
competent typist could
write much faster with a
typewriter than with pen or
pencil and that the writing
produced was consistent
and clearly legible. It was
G 1= £
Fig. 5.33 - Enhanced justification with

letter spacing.
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Other Justification Options

Normally when text is justified, if there is only a
single word on a line, it becomes left justified
(fig. 5.34). If Single words is selected, a single
word on a line is justified by adding sufficient
letter spacing (fig. 5.35).

Flush zone allows you to control justification of
the last line in a paragraph Normally the last line
of a justified paragraph is not justified. However, if
the end of the line is near to the right margin, it
may look better justified.

Flush zone defines a zone measured from the right
indent. If the end of the last line of the paragraph
falls within the flush zone, then that line is
Jjustified.

By default Flush zone is set to 0, which means
that the last line of a paragraph will never be
justified.

Iltwaslnotmtprising,
then, that  the

typewriter heralded
an ‘office revolution’
in which typewriter
manufacturers made
ontunes. Typingh
became part of the
school curriculum,
Despite its  many
advantages, the

mechanical
typewriter  suffered
|

Fig. 5.34 - The single word is
not justified.
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manufacturers made
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became part of the
school curriculum.
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& & £]

advantages, the
mechanical
typewriter suffered

Fig. 5.35 - The single word is
iustified,

CHaPTER 5
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5.8 Automatic Paragraph Numbering

It is possible to automatically insert bullet points
or number paragraphs. These facilities are
controlled from the Format dialogue box.

Menu=Text>Format...

Paragraph Level

This lets you set a level for each paragraph. Levels
can be in the range 0 to 7. In older versions of
Ovation Pro which do not support this feature, the
paragraph level defaults to 0,

AR

Uses of the paragraph level are structured
documents with automatic numbering of
paragraphs and automatic contents generation.

Auto Insert
Auto insertion controls the automatic insertion of
paragraph numbers or bullet points at the start of
each paragraph
Bullet points are symbols inserted before each
entry in a list for emphasis.

If you are going to climb Mount Everest ensure

you have;

OWarm pullover

OBoots and socks

OWoolly Hat

OMap and compass

OSandwiches

OMoney for bus fare home
Note that the bullet symbol is in a different font to
the text which follows it. In fact Ovation Pro
allows you to use a defined style (see Chapter 6)
for these, which means they can not only be in a
different font, but a different point size, colour etc.
You could of course produce the above list by
inserting each bullet by hand, the point of this
feature is that by merely applying an effect or style
the bullets can be generated.

In paragraph numbering, instead of the bullet
point, numbers are used for each member of the
list.

If you are going to climb Mount Everest six

essential items are

(1) Warm pullover

(2) Boots and socks

(3) Woolly Hat

(4) Map and compass

(5) Sandwiches

(6) Money for bus fare home
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Ovation Pro lets you automatically insert a
character before the bullet and a character after it -
in this example the brackets around the numbers.
In addition you can arrange for the bullet to be
followed by a tab character. Finally it is possible to
choose a different style for the numbering. For
example Roman numbers or a letter.

If you are going to climb Mount Everest you
need to take;

a)  Warm pullover

b)  Boots and socks

c) Woolly Hat

d)  Map and compass

e)  Sandwiches

f)  Money for bus fare home

Another aspect of paragraph numbering is in
structured documents, At the simplest level, each
paragraph in the document may be given a
number, allowing easy reference. More often the
document will be split into chapters, the chapters
into sections, and the sections into sub sections.
This process can continue through sub sub sections
and so on. Ovation Pro supports up to 8 levels of
paragraph numbering. This is an example.

Chapter 1 - Getting ready for the expedition
1.1 Raising funds

1.1.1 Visiting the bank manager

1.1.2 Arranging a jumble sale

1.2  Gathering supplies

1.2.1 Army and Navy stores

1.2.2 Knitwear world

1.2.3 The big butty sandwich bar

Only headings are shown. Normally the above sub
headings would be followed by the text of the
document. Notice that in this example Ovation Pro
has been told to include the chapter number as part
of the paragraph number (fig. 5.36).

Most people will have encountered documents like
this and used them successfully, yet the structure is
quite subtle. The numbering of sub sections is reset
when there is a new section at a higher level. So
section 1.2 is followed by 2.1 - as the first number
changes from 1 to 2, the second number is reset to
1, its starting value. The general rule is that when a
section number changes all more subordinate
section numbers are reset.
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This is made to work in Ovation Pro by allowing
paragraphs to be given a level value. Level one has
the highest priority, and level 7 the next to lowest.
So level 1 is what section headings are written in,
and level 7 would be used for sub-sub-sub-sub-
sub-sub-sub-sub sections. In the example above
‘1.1 Raising funds’ is a paragraph in level 1. 1.1.]
Visiting the bank manager’ is a paragraph in

level 2. You can confirm this by positioning the
caret in the text and pressing Control F to look at
the ‘Format’ window.

Level zero has the lowest priority, but it is special
because its number can always appear after the
lowest priority other level in use in a paragraph
number. So if your document only needs two
levels of sections (like the example above) you can
have the paragraph numbers shown in a sensible
way e.g. 2.2.1.1 rather than 2.2.1.1.1.1.1.1.1
(showing all 7 levels).

To repeat this, in a paragraph number like 1.2.3 the
number ‘1’ is the level 1 number, the ‘2’ is from
level 2 and the ‘3" from level 3. However it is
possible to arrange things so that the ‘1’ is the
chapter number and the ‘3" is the level 0 paragraph
number. Supposing though that 1.2.3 represents
the level 1, 2 and 3 numbers. Then 1.2.3 will only
appear at the start of a level 3 paragraph. The next
level 3 paragraph will display 1.2.4. If the
paragraph is in level 2 then the number would
appear as 1.2 and the next level 2 paragraph will
have number 1.3.

Its necessary to be clear that one style and either
another style or an effect are involved when
talking about bulleting. The first style is actually
used to render the bullet (red, 15pt, Dingbats). The
other style or effect is what tells Ovation Pro that
bullets should be inserted. The problem is that one
would like to call both these styles “the bullet
style”. The first instinct is to define a new style
called ‘BulletStyle’ and immediately the meaning
is lost. Which of the two styles is ‘BulletStyle’? So
in this document the style used for rendering the
bullet is called ‘BulletPoint’ and the one that is
used to insert bullets is called ‘BulletList’.

The icon to the right of Auto insert in the Format
window shows the bullet format, the option icon to
the right of that controls if bulleting is on or off.
Finally the menu icon on the far right opens the
bullet window.

CHaPTER 5

The bullet window (fig 5.36) allows the format of
the bullet to be set.

Bullet and Number select if bullet points or
paragraph numbers will be displayed. This choice
controls which of the following two sections in the
window is relevant.

For bullet points Bullet symbol shows the symbol
used and the menu icon to the right will open the
usual Ovation Pro chars window allowing you to
change the symbol.

For numbers Number format shows the number
format and the menu icon to the right opens a
menu to set the format. Start number lets you
enter the starting number.

The final group of icons is common to bullet
points and numbers. Style lets you optionally set a
style for rendering the bullet. Character before
and Character after allow you to enter characters
to be displayed before and after the bullet. Tab
after controls if a tab will be inserted after the
bullet point. This is often useful in combination
with hanging indents and so on.

Auto bullet and number

Fig. 5.36 - The Bullet dialogue box also showing that the
chapter number is included as part of the number format.
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The format menu (figure 5.37) sets the format used
for paragraph numbers.

The top part shows the way the numbers are
displayed.

123 normal Arabic numbers.
ili  lower case Roman.

III  upper case Roman.

abe lower case letters a to z
ABC upper case letters.

123a numbers for all levels except the last for
which a lower case letter is used.

123A the same but with an upper case letter.

The bottom part controls what numbers are
displayed.

n current level number.
n.n... all levels from level 1 to the lowest one.

c.n... the same but preceded by the chapter
number.

In the format windows the icon to the right of
Auto insert displays the text from the two parts of
the bullet format menu e.g. 123/n is Arabic style
numbering for the lowest level.

A subtle point is that a given point in the text can
only have one paragraph level value and it must
have such value. So wherever you position the
caret in a document, it is possible to ask what the
level is and get a unique answer.

Note that it is possible to assign a level to some
text without automatic paragraph numbering being
active. This is intended to support contents

Fig. 5.37 - The Bullet Format menu.
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generation. As far as bulleting is concerned such
text is ignored when it comes to calculating
paragraph numbers.

If a section contains some numbered paragraphs,
then some paragraphs of the same level with
bullets (as opposed to numbers), followed by more
numbered paragraphs, then the effect will be that
numbering is reset to the start value after the
bulleted area. This may be a useful trick to reset
numbering for special effects.

Level 0 has another special feature, this is that a
level O paragraph which does not have bulleting or
numbering active will reset the level 0 number.
This means that level 0 can be used for producing
a number of lists within a text story which does not
have any higher level text. For an example see the
first page of this section, where the after the list
numberered (1), (2)... the next list a,b,... follows
starting with the letter a, and with no intervening
higher level paragraphs to reset the level 0 number.
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Defined Styles
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Local text and format effects described in chapters 4 and 5 allow you to
instantly alter the style of text. However, if you need to apply

combinations of effects, it is much easier to define a style that combines

all the required effects, and then apply that style in a single operation.
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6.1 Overview

A defined style is a combination of effects with a
unique name that can be applied to text in a single
operation. It enables you to apply complex
combinations of effects quickly and consistently
throughout the document. So if you want headings
to be 18pt bold, you could define a style called
Heading to be 18pt bold, and apply it to the
appropriate headings.

A further advantage of a defined style is that if you
change its definition, all text in that style is
automatically updated throughout the document.
So if in the example above, you decide that
headings should be 24pt instead of 18pt, you need
only change style Heading to 24pt. Once this has
been done, all headings will automatically change
to 24pt.

Bodytext

Initially all text in Ovation Pro appears in a pre-
defined style called Bodytext. By default
Bodytext is 12pt Trinity, but you may edit the
definition as required. So if you run Ovation Pro
and type in a letter, the text of that letter will
appear in 12pt Trinity. If you then change
Bodytext to 13pt, all the text in the letter will be
automatically updated.

You may overlay Bodytext with other defined
styles or local effects. These may overwrite
various attributes of Bodytext. Local effects are
always applied on top of all other styles,
irrespective of the order in which they were
applied.

Overlayed styles and effects may be removed from
a selected region, but the base style, Bodytext,
must remain.

CHAPTER 6

Scope

Normally, a style is applied to a selected region,
but you may also define a scope which specifies
the amount of text that will be affected when the
style is applied. For example, a style with
paragraph scope is applied to entire paragraphs.
This can save a lot of time because it eliminates
the need to select paragraphs before applying
styles.

Keypresses

Another time saver is the ability to assign a
keypress to a defined style. The style can then be
applied at the press of a key.
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6.2 The Edit Style Dialogue Box
Menu<>Style<>Edit Style...

Choose Style=vEdit style (fig. 6.1) to open a
dialogue box which allows you to create, edit,
rename and delete styles (fig. 6.2).

The small window in the top left of the dialogue
box lists all the styles that have been defined. If
necessary, use the scroll bar to scroll through the
list. One style in this window will be pre-selected
ready for editing. The pre-selected style is the style
at the caret, or if there is more than one style at the
caret, the one that was applied last.

Initially there is only one style, Bodytext, so this is
pre-selected.

You may select another style for editing by
clicking on it.

The centre panel of the dialogue box shows a
preview of what the selected style looks like. The
preview shows text attributes such as font, size and
colour, but not format attributes such as alignment
and leading. If the previewed text is too big, it is

ATE

. cropped to fit the preview box.
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The bottom panel of the dialogue box shows a
summary of the attributes of the selected style. So
Bodytext sets the font to Trinity, the size to 12pt,
the text foreground colour to Black etc.

The buttons Text, Format and Tabs are used to
edit the selected style.

Any changes made in the Edit style dialogue box,
are not applied until you click on OK. If you click
on Cancel the dialogue box will be closed and all
the styles will remain unchanged.

Pressing Menu over the list of defined styles opens
a save box which can be used to save all the style
definitions as a text file.

Clicking and dragging a style in the list of defined
styles lets you reposition it. This is useful if you
find it convenient to have the styles on the style
menu in a particular order.

List of defined styles

Style preview

Style summary

ME
Remove >

Edit style. ..

v Bodytext AF1
Fig. 6.1 - The Style menu.

Fig. 6.2 - The Edit style dialogue box allows you to create, edit,
rename and delete styles.
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6.3 Creating Styles
Menu=>StylecoEdit styles...=>New

To create a new style click on New and type the
name of the style into the New style dialogue box
(fig. 6.3). The name must not be the same as an
existing style name.

By default Based on is not selected, so a
completely blank style is created i.e. all attributes
will have no effect.

If Based on is selected, the new style will be based
on the style that was selected when New was
chosen. However, you can base a new style on any
another style by choosing it from the menu.

Click on OK to create the new style and close the
dialogue box. The style you have created is added
to the list in the Edit style dialogue box, and is
automatically selected ready for editing.

Fig. 6.3 - The New style dialogue box.
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6.4 Editing Styles

Menur>StylecoEdit styles...>Text...
To edit a style, first ensure that the style you wish
to edit is selected in the Edit style dialogue box
(fig.6.2).
Text Attributes
To edit the text attributes of the selected style,
click on Text. This opens the Modify text
dialogue box (fig. 6.4) providing all the text effects
described earlier in this user guide (see 4.6).
Notice however that there is an additional icon to
the left of options such as Font and Size.
A ‘cross’ in this icon indicates that when the style
is applied to text, the attribute will have no effect.
When you create a new blank style, all attributes
are in this state.

If an attribute is ticked, it will have an effect when
the style is applied. Attributes automatically
become ticked if you alter them, or you can change
a cross to a tick by clicking on it.
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If you edit Bodytext you will notice that all
attributes are ticked and cannot be changed. This is
because Bodytext is the base style and must
define everything.

Attributes such as Bold and Italic may have three
states; a cross, a tick or blank. A cross in the icon
indicates that the attribute will have no effect. A
tick means that the attribute is set on, and a blank
means it is set off.

For example if you have some text that is Bold and
Underlined, and apply a style where Bold is
crossed, Italic is ticked and Underline is blank, the
resulting text will be Bold and Italic. This is
because Bold has no effect, Italic is applied and
Underline is removed.

‘crossed’ it will not be applied fo the fext.

Fig. 6.4 - The Modify text dialogue box is used for editing styles. If an attribute is
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Format Attributes Example

Menur>Stylec>Edit styles...>Format... Assume you want to create a style that will set text
To edit the format attributes of the selected style, tg ’:p‘tB"l:;l‘ Shth‘:;ld Chm.w;"mh;“g elee, # g’“
such as alignment and leading, click on Format. e 10 NemURE e y

This opens the Format dialogue box described Bigiytentud dny: other inidertying iylen.

earlier in this user guide (see 5.4). 1. First use New to create a blank style.

As in the Modify text option described above, 2. Click on Text to open the Modify text dialogue
format attributes have no effect if they are crossed, box. Since the style is completely blank, all the
applied if they are ticked or removed if they are attributes have a cross beside them.

blank (fig. 6.5). 3. Now choose 14pt from the Size menu. Notice
Tab Attributes that the Size option becomes ticked. Click on

Bold so that it is also ticked. (fig. 6.4).
4. Click on OK to apply the changes.

Menu=>Stylec>Edit styles...=>Tabs...
To edit the tab settings for the selected style, click

on Tabs. This opens the Tab dialogue box 5. The preview will now show 14pt Bold text and
(fig. 6.6) and tab ruler described earlier in this user the style summary will confirm that these two
guide (see 5.5). attributes have been assigned to the style.

An additional option on the Tab dialogue box,
Apply ruler, allows you to determine whether the
tab ruler will be applied or not. A cross indicates
that it will have no effect; a tick indicates it will be
applied.

In the writable icons next to Leader and to
Decimal tab you can set individual leader strings
and decimal tab characters for each tab. The
default decimal tab setting as set in Preferences

Menuc>MiscerPreferencescText AP
is used if the Decimal tab icon is left blank.

Apply effect

No effect

Fig. 6.5 - The Format dialogue box is used for editing styles. If an afiribute is
‘crossed' it will not be applied to the text.
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Scope

The Scope menu (fig. 6.7) allows you to specify

the amount of text affected when the style is
applied.

Selection causes the style to be applied to the text
selection. If there is no selected text, the style is

applied to the caret.

Paragraph causes the style to be applied to the
entire paragraph that contains the caret, or to all

paragraphs wholly or partially in the selection.

Paragraph is automatically selected if the Format
dialogue box has been used, since these attributes

normally only apply to whole paragraphs.

Word causes the style to be applied to the word at
the caret, or to all the words wholly or partially in

the selection.

Line causes the style to be applied to one whole

line of text.

Story applies the style to the whole of the current

story.
Key

You can assign a keypress to the selected style by

pressing the required key combination.

You can use almost any key in combination with

Ctrl, Shift or Ctrl Shift. However, to avoid

overriding existing key shorts cuts, we recommend

that you do not use any of the function keys
mentioned in the key short-cut overview
(see Appendix E).

In the Key icon, the Ctrl key is represented by the
symbol #, and the Shift key is represented by the

symbol TI.

You can remove the keypress from the selected

style by pressing Delete.

Tabs

Fig. 6.6 - The Tab dialogue box.
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6.5 Renaming & Deleting Styles
Rename

To rename the selected style, click on Rename to
open the Rename style dialogue box. Type in a
new name and click on OK.

Delete

Click on Delete to delete the selected style. All
occurrences of the style are deleted from the
document.

Fig. 6.7 - The Scope menu.
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6.6 Applying Styles
Menu=>Style=>

To apply a style, first select the text to be changed,
then choose the required style from the Style menu
(fig. 6.8).

Changing Selections

If the scope of the style you are applying is set to
Selection, the style is applied to the selection. If
there is no selection, the style is applied at the
caret, and any text subsequently typed will appear
in that style. Note however, that if you move the
caret before typing, the style will not be applied.
Changing Paragraphs

If the scope of the style you are selecting is set to
Paragraph, the style is applied to the paragraph
containing the caret; there is no need to select the
text in the paragraph.

If there is a selection, the style is applied to all
paragraphs that are wholly or partially selected.

In Ovation Pro, a paragraph is defined as the text
between two carriage returns, which may be a
single line or multiple lines of text.

SubHeading fIF2

FunctionName TF3
Function 1F4
Cardinn fice

Fig. 6.8 - The Style menu.
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Changing Words

If the scope of the style you are selecting is set to
Word, the style is applied to the word containing
the caret; there is no need to select the word.

If there is a selection, the style is applied to all
words that are wholly or partially selected.

Overlaying Styles

By default all text is displayed in the pre-defined
style called Bodytext. You may overlay any
number of additional styles on top of Bodytext.
For example, if you apply a style that sets Italic,
and overlay it with a style that sets Bold, the
resulting text will be Italic and Bold.

The attributes of the last style overlayed, overwrite
those conflicting attributes of the style beneath.
For example, if you apply one style that sets the
text size to be 14pt, and overlay it with another
style that sets text size to be 18pt, the resulting text
will be 18pt.

Styles and Effects

You can apply a combination of defined styles and
local effects to the same region of text. In this
situation, the defined styles are applied first and
the local effects are overlayed on top, irrespective
of the order in which they are applied.
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Current Style

If there is no selection, the styles that are current at
the caret are ticked on the Style menu.

If there is a selection, any styles that are present
throughout the selection, are ticked on the Style
menu. If a style is not ticked on the menu, it means
that it is not present throughout the selection.
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6.7 Removing Styles
Menu=>Stylec’Remove

The Remove menu (fig. 6.9) lists all the styles that
are present at the caret or somewhere within the
selection. The order of the styles on the menu
shows the order in which they were applied in the
document (the last style applied being at the top of
the menu).

Click on the style name to remove it from the caret
or selection.

Notice that Bodytext is not displayed on the
Remove menu. This is because Bodytext must
be present beneath all other styles, and cannot be
removed.

The Local effects options removes all local effects
at the caret or selection.

If you remove all styles and local effects from a
selection, the selection will be displayed in
Bodytext style.

Fig. 6.9 - The Remove menu.
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6.8 Merging Styles

You can merge the styles from another document
or stylesheet by dragging a document or stylesheet
onto the Edit style dialogue box (fig. 6.2).

If a style being merged has the same name as an
existing style, a warning box is displayed

(fig. 6.10). Since Bodytext exists in every
document, this warning box will always appear at
least once.

For each style name clash, the warning box
provides a number of options.

Skip causes the style to be ignored and not
merged.

Overwrite causes the style being merged to
overwrite the existing style.

Rename changes the name of the style being
merged so that it doesn't clash with any existing
style.

Cancel aborts the merge operation.

© Duplcate stle Bodytext found.

AN

CHAPTER 6

Another way in which styles may get merged is
when text is copied between documents.

A problem area is where a style in the text being
copied has the same name as a style in the
destination document but different values. What
happens depends on the settings in the Text
handling choices window

IconbarMenu=Choices—Text

If Rename styles is selected the styles of the
imported text will be used and if their names exist
they will be renamed (Style01, Style02, ...) .
Otherwise the imported styles with the same
names will take on the values of those in the
document into which the text is being imported.

The same point applies to the transfer of colours if
Rename colours is selected in Text choices.

Fig. 6.10 - This warmning box is displayed for each style name clash.
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7.4  Grid

7.5 Document Zoom

This chapter describes options that change the way the document looks
on the screen. They do not affect how the document is printed.

The Options menu lets you set the layout of the document on screen.
You can select which tools or facilities are available.

The Grid menu allows objects to be easily lined up, locked to certain
points and text lined up and locked to certain lines which can be
changed.

Zoom changes the magnification of what is seen on screen.
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7.1 The View Menu

Menu=>Vieweo.........
The View menu (fig. 7.1) provides a range of
options that control how the document is viewed

on-screen. View options are saved with documents
and can also be saved as default (see 15.2).

Fig. 7.1 - The View menu.

CHarTER 7

7.2 New View
MenucViewcoNew view

New view allows you to have any number of
windows open on the same document. Each
window can be scrolled to a different part of the
document and can have its own independent zoom
and view options. You can edit the document in
any of the windows; all the others will be updated
automatically. Typically this feature is used to
open a new view at a small scale, providing an
overview of the entire page.

The number of views that are currently open is
shown after the document name on the title bar.

Use the normal close icon to remove new views if
they are not needed.

Fig. 7.2 - The Options dialogue box.
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7.3 View Options
Menu=View=>Options©......
Options

Options opens a dialogue box allowing a number
of miscellaneous view options to be enabled and
disabled (fig. 7.2).

Toolbox
Toolbox opens and closes the toolbox.

Button Bar
Button bar opens and closes the button bar.

Info Palette
Info palette opens and closes the info palette.

Ao
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Rulers

Rulers shows or hides the page rulers (fig. 7.3).
Rulers are a visual aid for measuring, positioning
and resizing objects.

Ruler markings are in the current document units
and the origin is at the top left corner of the
document. Both units and origin may be changed
on Preferences (see 15.12 & 15.13).

If you click on a ruler, a ruler guideline is created.
Ruler guidelines are drawn across the page
vertically or horizontally and are a further aid for
positioning objects (see 8.4).

T Y .. PEYTH I IOTRR AT
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Fig. 7.3 - Document with Rulers shown.
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Pasteboard

Pasteboard shows or hides the document
pasteboard. The pasteboard is a grey margin
around the page that may be used like the normal
page, but is not printed (fig. 7.4). Typically it is
used to temporarily store objects. The contents of
the pasteboard are saved with the document.

If objects overlap from the page onto the
pasteboard, only the part of the object on the page
is printed. However, if Bleed is specified when
printing, a strip of the pasteboard around the
document is also printed (see 12.3).

The size of the pasteboard may be defined on
Preferences (see 15.13).

CHAPTER 7

Spelling Errors

Spelling Errors will make words which are not in
the spell check dictionaries for the current
document be displayed with a red underline (see
14.1).

Fig. 7.4 - Document at 30% zoom with an object on the Pasteboard (shown in grey).
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Pictures

Pictures shows or hides pictures in picture frames.
By default pictures are shown, but if your
document contains pictures that are slow to
redraw, you may wish to hide them. Frames
containing hidden pictures are indicated with a
cross through them (fig 7.5).

Guidelines

Guidelines shows or hides guidelines. By default
guidelines are shown, but you may wish to hide
them to see how your document will look when
printed.

There are three types of guidelines (fig 7.5):

» Frame guidelines

* Column guidelines

= Ruler guidelines

View Opmions 87

Print Margins

Most printers cannot print right up to the edge of
the page, so Print margins allows you to see the
margins around the paper that cannot be printed
(fig. 7.5). You should always ensure that
everything on the page to be printed is inside these
margins.

The print margins are obtained from the printer
drivers, so they will only be displayed if a printer
driver has been loaded.

£

guideline

\ Ruler guideline

&_]451mw

Fig. 7.5 - Document with print Margins shown. The frame contains a hidden picture.
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Facing Pages

When Facing pages is not selected, pages are
displayed vertically, one on top of another.

When Facing pages is selected, pages are
displayed in horizontal pairs (fig. 7.6). Non-
existent pages such as the page before page 1, are
shown in grey.

Page 1
Page 2 Page 3
Page 4 = R

Fig. 7.6 - The arrangement of a 4-page
document when Facing pages is enabled.

ChapTer 7

Invisibles

Invisibles shows or hides special symbols that
represent invisible characters in the document. It is
useful for finding where paragraph breaks have
been inserted or to check that double spaces have
not been inserted between words.

This feature is for information only and does not
affect the format or final printout of the document.

The invisible characters and the symbols used to
represent them are shown below.

New line -

New paragraph 1

New page §

Space .

Non-breaking space N

Tab
End of story €

¥
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7.4 Grid
There are two grids in Ovation Pro. The most
obvious one is the Object Grid, which is used for
drawing things. In addition to this, there is the Text
Baseline Grid. (Fig. 7.9).
The Object Grid

Menur>Viewe>Grid AG

This Grid option allows you to superimpose a
rectangular grid on the document. It is useful for
lining up objects or checking their relative size.
The grid is made up of ‘major points’, marked by a
cross, and ‘minor points’ marked by a dot
(fig.7.7).

The grid is controlled from the Grid dialogue box
(fig 7.8).

Show object displays the grid in the colour chosen
from the palette shown.

Grip 89

Lock grid switches grid lock on or off. Grid lock
causes new objects to align to the grid as they are
created and existing objects move in steps of the
grid spacing (see 8.4). Clicking on Grid on the
View menu also switches the grid lock on or off.
The grid does not have to be shown in order to use
the grid lock.

For fine movements, even with the grid lock set,
press and hold the mouse button on the object to be
moved and use the cursor keys.

Spacing allows you to set the distance between the
major points on the grid.

Sub divisions allows you to set the number of sub
divisions between each major point.

Fig. 7.7 - Document with the Object Grid shown.
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The Baseline Grid
Menu=View> Grid G

This is a grid which text baselines can be anchored
to, if the text style has the appropriate attribute set.

Menu=>Format...~>Lock to grid

The baseline grid configuration is set from
document preferences and is independent of the
object grid. Unlike the object grid which is an
attribute of the current document view the baseline
grid is part of the document structure. For example
whilst you can have 2 different object grids on
display in different views, clearly text has to be
anchored to just one grid at a time.

The grid window allows the display of the text
baseline grid (fig. 7.8).

There is also a button which allows objects to be
locked to the text baseline grid. If this is selected
locking to the baseline grid takes precedence over
locking to guidelines in the vertical direction. This
means that you can snap objects to the baseline
grid whilst simultaneously snapping to vertical
guidelines.

If both lock to the baseline and the object grid are
selected the object grid will take precedence.

CHapTER 7

7.5 Document Zoom

You can view and edit the document in a range of
preset zooms or any variable zoom you require.
The default zoom is 100% which shows your
document on screen at approximately 100% of the
true printed size.

One way to change the zoom is to use the Zoom
tool (see 2.9).

You may also set the zoom using the Zoom
dialogue box (fig. 7.10).

Menu= View=>Zoom
Choose 50%, 75%, 100%, 150%, 200% or

400% to set one of the standard preset zooms. See
Appendix E for keyboard short-cuts.

Az

Choose Variable to specify any zoom between
10% and 1000%. Enter the zoom value in the
writable icon, or use the up and down buttons to
alter the current value in 1% steps.

Fit window sets the document zoom so that an
entire page (or pair of pages) fits in the document
window.

Fit screen sets the document zoom so that an
entire page (or pair of pages) fits on the screen.

Fit width sets the document zoom so that an entire
page (not a pair of pages) fits on the screen.

Fit height sets the document zoom so that an
entire page (or pair of pages) fits on the screen.

Document zoom
@ variabie [ 100 J% A
Fitwindow | _Fitscreen |

Fig. 7.9: The Baseline Grid

Fig. 7.10 - The Zoom dialogue box.
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This chapter describes the tools for drawing and editing objects. You can
draw objects anywhere on the page, even overlapping other objects, but
not across page boundaries. There are three types of objects: frames,
lines and ruler guidelines.

Frames are the basic building blocks in Ovation Pro. They are used to
hold the text and pictures that appear on the page and are normally
rectangular (but may be any closed shape).

Lines are normally straight or curved open paths, but may be any shape
{open or closed). Even if line paths are closed, they cannot contain text
or graphics. Typically, Lines are used to add additional graphics to the
page and for this purpose are better than frames because they use less
memory.

Ruler guidelines are used to help align objects on the page.
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8.1 Drawing frames

Frames in Ovation Pro may be rectangular,
elliptical or irregular. In the latter case they may be
constructed from straight and curved line
segments, To draw a frame, click Select on the
Frame tool and on the required shape from the
toolbox (fig 8.1).

Normally after drawing a frame or line, the Select
tool is automatically re-selected ready for text
entry. If you wish to draw a number of frames in
succession, choose the Frame tool by clicking
Adjust, whereupon it will remain selected until
another tool is chosen.

An empty frame can contain either text or a
picture. If you wish to put a picture in a text frame,
you must delete all the text first. Similarly, if you
want to put text in picture frame, you must delete
the picture first. To delete a picture select it first by
double clicking on it and then delete it using the
menu

Menu<>Edit<>Delete picture AK

Frame tool

,— Rectangle
Ol eiise
| \)t—— Straight Line Segment
Curved Line Segment

Fig. 8.1 - The toolbox.
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Rectangular Frames

Move the crosshair to where you want one corner

of the rectangle to be, then click Select and drag to

the opposite corner. Finally release Select to

complete the operation (fig. 8.2).

To draw a perfect square, hold down Shift while

drawing the rectangle (or use grid lock):
Menu=View=>Grid

Elliptical or Circular Frames

Ellipses are arranged to fit within a rectangular

area. Move the crosshair pointer to the centre of

the area then click Select and drag to the required

size. Finally release Select to complete the

operation (fig. 8.3).

To draw a perfect circle, hold down Shift while

MG

drawing the ellipse (or use grid lock).
e, = £l I - £

il m [p o
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Fig. 8.2 - Arectangular Fig. 8.3 - An elliptical
frame. frame.
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Fig. 8.4 - A straight- sided Fig. 8.5 - A curved-sided
irreguiar frame. irregular frame.
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Irregular Frames

Choose Straight Line Segment or Curved Line
Segment from the toolbox. Click Select where you
want the line to start, then move to the endpoint
and click Select again. You can keep adding line
segments to the path by moving to the endpoint of
each new line and clicking Select. Alternatively
click and drag to each new endpoint, to allow auto-
scrolling at the edge of the window. You cannot go
beyond the page boundaries.

At any time you can change between straight and
curved lines by choosing the required type from
the toolbox. To draw perfectly horizontal or
vertical lines, hold down Shift to constrain pointer
movement to the horizontal or vertical.

Double-click Select or click Adjust to finish the
path. When drawing frames, the path is closed
automatically (figs. 84 & 8.5).

The shape of irregular frames can be edited in Path
Edit Mode (see 8.11).

Line tool

—— Reclangle
—— Ellipse
—— Sraight Line Segment
| —— Curved Line Segment

Fig. 8.6 - The toolbox.
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8.2 Drawing lines

The Line tool in allows you to draw rectangles,
ellipses, straight lines (fig. 8.7) and curved lines
(fig. 8.8). You can draw single lines or sequences
of connected lines. By default lines sequences are
open path, but can be closed (fig. 8.9 & 8.10) using
an option in Path Edit Mode (see 8.11).

To draw a line, choose both the Line tool and the
required shape from the toolbox (fig. 8.6). The
method of drawing lines is identical to that
described on the previous page for frames.

Remember that objects drawn with the line tool

cannot contain text or pictures.
[ = 1) & = £
] 1] m o
o = g L = £
Fig. 8.7 - A straight line. Fig. 8.9 - An open path
line.

3 = a B g
m L. W
¥ = g O 8 B
Fig. 8.8 - A curved line. Fig. 8.10 - A closed path

line.
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8.3 Text Overflow and Linking Frames

Once you have drawn a frame, you may type or
import text into it (see 3.1 & 3.3). If you type past
the bottom of the frame or import a story that is
too big, the overflow flag will be displayed in the
bottom right corner of the frame (fig. 8.12). In this
situation, the overflowed text will not be visible
and cannot be edited.

There are a number of things you can do to remove

the overflow flag:

1. Delete some of the text to make space for the
overflowed text.

2. Make the frame big enough to display all of the
text.

3. Link the overflowed frame to another empty
frame, so that the text will automatically flow
into the second frame.

CHaPTER 8

Linking Frames

To link two frames, select the Link tool from the
toolbox (fig. 8.11a). Now click in the first frame
and drag the pointer to the second frame. During
this operation, the pointer will change to a link
symbol. After linking, the overflow flag will
disappear from the first frame, but may be
displayed in the second frame if there is still not
enough space for the entire text story (fig. 8.13). If
you wish you can then link the second frame to a
third frame. You can link any number of frames
together in this way, even if they are on different
pages.

Editing Text in Linked Frames

Once frames are linked, text will flow automa-
tically between them, and may be edited as normal.
Caret movement will work correctly between the
frames, and you may select text across them by
clicking or dragging in the usual way.

T =,
The]mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first majorm

Link tool

20 o e

I

Fig. 8.11a - The toolbox.

[~}

advance over pen or
pencil. Its two principal
advantages were that a
competent typist could

m =1

L) 1=}

Fig. 8.12 - Frame with overflow flag.

1

advance over pen or
pencil. Its two principal

Fig. 8.11b - The info palette having selected
the Link Tool

advantages were that a
competent typist could

The mechanical write much faster with a
typewriter, which writer than with pen
originated in the USA pencil and that the
about a century ago, writing produced was
represented the first major consistent and clearly

|

legible. It was not
surprising, then, that the
typewriter heralded an
‘office revolution’ in

Fig. 8.13 - Two linked frames with link shown.
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Linking Frames on Master pages.

Frames on the Master pages can be linked. As well
as the usual type of linking there is another kind
called ‘auto-linking’. This means that when the
text in a master frame overflows in the document,
it will flow into the same frame on the next page
i.e. a page will be automatically created with new
frames linked to those on the preceding page.

Often this feature is used with a chain of linked
frames, where the last frame in the chain is auto-
linked to the first frame in the chain. When the last
frame overflows, a new page is inserted and the
text flows into the first frame on the new page.

To create an auto-link, use the Link tool in the
usual way, but drag back onto the first frame in the
linked chain (fig. 8.14). In the case of a single
frame, drag back onto that frame (fig. 8.15).

An 'auto-link' is shown in green when the Link tool
is selected.

It is possible to have more than one auto-link chain
in a chapter.

To delete an auto-link, choose the Link tool, click
over the link so that it is selected i.e. shown in red.
Now press Delete or click the 'Delete link' button
on the info palette.

A typical use of auto-linking is a template
document for labels. The idea is to draw the labels
on the master pages so that as each page is filled, a
new page of labels is inserted. Each label on the

Fig.8.14 - Autolink: text flows from frame 1 to 2, then to 3
and to 4 and finally to frame 1 on following page.

The auto-link of the
Main Master frame
is also shown
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master page is linked to the next label, and the last
label on the master page is linked to the first.

To create this type of document, open the master
pages and draw the labels as required. Now use the
Link tool to link all of the labels in the order that
you wish text to flow through them. Link the last
label back to the first label. This link will be
shown in green, indicating that it is an auto-link
and will generate a new page when it overflows.
Close the master pages, and save the document as
a template.

You can now type in the labels. Note that since we
are using linked frames, you can use Ctrl P or
Enter to start a new label.

If you wish to import data e.g. names and address
from a file, the data needs to be formatted correctly
first. Each field should be separated by a Line Feed
(0x0A) and each record by a Form Feed (0x0C). If
your data is in CSV format, then you will need to
convert your file before it is imported (using !Edit
for example).

Name<0A>

Address 1<0A>

Address 2<0A>

Postcode<0C>

Name<OQA>

Address 1<0A>

It is also possible to use mail merge to solve this
problem (see 12.5).

iolE  Master Document] ” gt

Fig.8.15 - Aufo—ﬂnidngco.tr..-mn 1 results in overflowing
text appearing on next page in column 1. Frame 1
overflows to frame 2, then to frame 1 on following page.
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Show Flow

‘When you choose the Link tool, arrows are drawn
in the document indicating where text flows

(fig. 8.13).

Changing a Link

If you link from a frame that already has an
outward link, the original link is removed and text
flows according to the new link.

Unlinking Frames

To unlink frames, choose the Link tool so that you
can see the arrows that show text flow. To remove
a link, click Select on the appropriate arrow, so
that it is highlighted i.e. shown in black (fig. 8.16).
Now press Delete to remove the link. Or click on
the Delete box on the info palette (fig. 8.11b).

An auto-link will be shown in red when selected.
In the case of a chain of linked frames with an

auto-link the auto-link must be removed before
you can remove or change the other links.

Removing a link has the effect of removing the
text from the linked frame (and any subsequently
linked frames) and joining it back to the end of the
previous frame. This will cause the previous frame
to overflow, but no text will be lost.

Frame Break

You can force the caret to the start of the next
linked frame by pressing Ctrl P or Enter, or by
choosing

Menu=>Misc>Insert<>New page.

The break character may also be deleted, causing
text that follows to flow back into the previous
frame.

CHarTER 8

Special Notes

The following points should be considered when
linking frames:

1. You cannot link to or from the Main frame,
since this is already linked.
2. You cannot link picture frames.

3. If a frame contains text, it can only be linked to
an empty frame that doesn’t already have an
inward link or to the first frame of a chain of
linked frames as long as these linked frames
are empty.

4. If a frame is empty, it can be linked to any text
frame that doesn’t already have an outward link
or to the first frame of the chain of linked
frames.

5. You cannot delete linked frames. But a page
with linked frames can be deleted if all linked
frames are within that page only.

6. You cannot cut or copy linked frames to the
clipboard, or copy linked frames using drag
and drop.

The mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first major
advance over pen or
pendcil. Its two pn'ncipay
advantages were that a
competent typist could

write much faster with a
writer than with pen
pencil and that the
writing produced was
consistent and clearly
legible. It was not
surprising, then, that the
typewriter heralded an
‘office revolution’ in

Fig. 8.16 - Two linked frames with highlighted arrow.
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8.4 Drawing Aids

There are a number of facilities available to help
you draw and manipulate objects.

Cancelling an Operation

Most operations concerned with manipulating
objects can be cancelled by pressing Esc at any
time. So if you are in the middle of drawing a
frame, pressing Esc will cancel the operation.
Auto Scrolling

The document window will automatically scroll if
you drag close to its edges. The speed of scrolling

is determined by how close the pointer is to the
window edge; the closer it is, the faster it scrolls.
Nudging the Pointer

When drawing, moving and resizing objects you
may position the pointer more accurately by
pressing the cursor keys to ‘nudge’ it one pixel in
the required direction. In this case Object snap (see
next paragraph) is overruled.
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Object Snap

When drawing, moving or resizing objects, the
edges of the objects snap into alignment with the
edges of other objects on the same page. Top edges
snap to top edges, bottom edges to bottom edges
etc (fig. 8.19).

Object snap may be disabled on Preferences
(see 15.13), and is automatically disabled if grid
lock is enabled.

Grid

If object grid lock is enabled (see 7.4), and an
object is drawn or resized, its edges will snap to
the grid. If an object is moved, it will jump in steps
of the grid spacing.

If grid lock is enabled, the Menu=>Object=>Snap
to grid option will snap the top left corner of the
selected object to the nearest grid point. The size
of the object is not altered.

£

i = 1
m m
i =) ]

Fig. 8.17 - The selected frame is dragged in the direction of the arrow so that the left and
bottom edges snap to the larger frame. The right edge of the selected frame is then
dragged to the right until it snaps to the right edge of the larger frame.
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Ruler Guidelines
Menu=View=>Options=>Rulers AR

‘When rulers are enabled (see 7.3), you can draw
your own vertical or horizontal guidelines across
the page. Edges of object will snap to these
guidelines when dragged close to them.

To draw a vertical guideline, click Select on the
horizontal ruler at the required position.
Alternatively, click Select then drag the guideline
to the required position. To draw a horizontal
guideline, do the same, but on the vertical ruler.

To move a guideline, move the pointer over the
guideline, so that the pointer changes to the
guideline tool (fig. 8.18). Now drag the guideline
to the required position. You can also drag a
number of selected guidelines in a single
operation.

To select guidelines, click Select over the first one,
then click Adjust over other guidelines to add them
to the selection. Selected guidelines are shown in
red.

CHAPTER 8

To move a selected guideline to an exact position,
choose Menu=>Object=>Modify and enter a value
in the dialogue box displayed (fig. 8.19).

To delete a guideline drag it to the extreme edge of
the page. Alternatively, to delete selected
guidelines choose Edit=>Delete.

To delete all vertical guidelines, click Ctrl Select
on the horizontal ruler. To delete all horizontal
guidelines click Ctrl Select on the vertical ruler.

Guidelines are normally drawn over the top of all
frames, but an option on

Menu=>Misce>Preferences ATP

allows them to be drawn behind instead

(see 15.13). Snap to ruler guidelines may be
disabled on Misce>Preferences (see 15.13), and is
automatically disabled if grid lock is enabled.

Fig. 8.18 - Document with vertical and horizontal ruler guidelines.

Fig. 8.19 - Modify guideline.
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8.5 Selecting objects

Before you can make changes to an object you
must select it. Ensure that the Select tool is active
(fig. 8.20) then click Select over the object. This
selects the object and deselects any other objects.

When an object is selected, it is enclosed in a red
‘bounding box’ with 8 blue *handles’ located
around its edges. The bounding box is a
rectangular guideline that completely encloses the
object (fig. 8.21 & 8.22). A handle is a small
square which can be dragged to resize the object.

In addition to frames and lines, you may also select
ruler guidelines. When selected they are shown in
red, but do not have handles.

You can select more than one object by clicking
Adjust on each additional object. Clicking Adjust
on an object that is already selected causes it to be
deselected.
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Another way of selecting all the objects in an area
is to construct a select box around the area by
holding down Ctrl Shift and pressing Select at one
corner of the area to be selected and dragging the
box to the opposite corner. Release Select when all
the objects to be selected are wholly within the
select box; the objects will then be selected.

If the object you want to select is obscured by
another object, hold down Ctrl Shift and double-
click over the top object to select the object
beneath. You may keep doing this to select
progressively deeper objects until you eventually
return to the top object.

If you want to permanently group a number of
objects, use Objectc>Group or ATK (see 9.11).

.— Select tool
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_Qd_ Fig. 8.21 - An active Fig. 8.22 - An active elliptical
rectangular frame with eight frame with eight handles for

Fig. 8.20 - The Select tool. handles for resizing. resizing.
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8.6 Moving Objects

To move an object, first ensure the Select tool is
selected. Then click Select over the object and
keep it pressed and completely still until the Move
pointer appears (fig. 8.23). Now drag the object to
its destination (which may be anywhere on the
same page) and release Select. If you hold down
Ctrl, you may drag the object immediately, without
holding the button down until the Move pointer
appears.

If you have a number of objects selected, moving
one of them will move the entire selection. You
can move a mixed selection of frames, lines and
ruler guidelines if you wish.

To constrain movement to the vertical or
horizontal, hold down Shift while dragging.

You can position objects precisely using the info
palette or the Modify dialogue box (see 9.1).

Using the Info Palette

X and Y on the info palette (fig 8.24) are the
coordinates of the top left corner of the selected
object or group. Coordinates are measured from
the top left comer of the page. X and Y may be
modified to change the position of the object. Press
Return after modifying the values to update the
document.

If there is a selection of objects, X and Y refer to
the first object selected. In this case if X and Y are
modified, the first object is moved to the position
specified and the rest are moved proportionally.

CHAPTER 8

Drag and Drop

You can move or copy objects using the drag and
drop facility. Unlike the normal move operation
described above, you can drag and drop objects to
any page in the same document or in a different
document.

To drag and drop selected objects, hold down Alt
then drag them to the required position.

If you drag and drop within the same document,
objects are moved, if you drag and drop to another
document, objects are copied.

If you hold down Shift Alt while dragging, the
above operations are transposed. So, if you drag
and drop within the same document, objects are
copied, if you drag and drop to another document,
objects are moved.

If you start a drag operation and wish to cancel it,
press Esc.

Please note that you cannot drag and drop master
objects or linked frames. But you can move linked
frames within a chapter.

For drag and drop of selected text see 3.8.

_ Tedrame  X[20mm

&) o ul 0 | f‘l’l 20mm
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Fig. 8.23 - The Move
tool moves objects.

Fig. 8.24 - The info palette gives the position of the selected object. You can reposition it
by changing the X and Y values.



SecTion 8.7

8.7 Resizing Objects

To change the shape or size of an object move the
pointer over one of the 8 handles so that the Resize
pointer appears (fig. 8.25). Now press Select and
drag the mouse until the object is the size and
shape that you want. There are two types of
handles:

» Corner handles will resize the object both
horizontally and vertically.

» Centre handles will make the object either
wider or longer.

If you hold down Ctrl while dragging, the original
shape (aspect ratio) of the object will be
maintained. If you hold down Shift, the object
bounding box shape will be constrained to a
square.

If you have a number of objects selected, resizing
one of them will resize the rest proportionally.
You can resize objects precisely using the info
palette or the Object=>Modify dialogue box or F7
(see 9.2). The sizes W and H mentioned on the
info palette refer to the first object selected.

a M

v

Fig. 8.25 - Move the pointer over a handle
and drag the resize tool to resize the object.
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Using the Info Palette

W and H on the info palette (fig. 8.26) are the
width and height of the selected object or group. W
and H can be modified to change the size of the

object. Press Return after modifying the values to
update the document.

If there is a selection of objects, W and H refer to
the first object selected. In this case if W and H are
modified, the first object is resized as specified and
the rest are resized proportionally.

X and Y on the info palette refer to the distance
from the top left corner of the page to the top left
corner of the object frame. By changing these
values you can reposition the object frame.

Resizing Picture Frames

If you resize a picture frame using Adjust, the

picture is resized too. This only functions in both

X and Y directions if Aspect lock has not been

selected. This can be set in
Menuc>Picture->Modify picture Fé

If aspect lock has been set the picture will be
resized according to the vertical size of the frame.

S

R{ﬂmm |IN B .

Fig. 8.26 - The info palette gives the size of the selected object. You can resize it by

changing the W and H values and move it by changing the X and Y values.



102 Drawine & Epiming OsuecTs

8.8 Rotating Objects

You can rotate text frames, picture frames and
lines. To rotate an object choose the Rotate tool on
the toolbox (fig. 8.27) then click Select and drag
on any part of the object until it is at the desired
angle (fig. 8.24). You may select a number of
objects either before or after choosing the Rotate
tool, and rotate them all by dragging on any object
in the selection.

The centre of rotation for the object or selection is
indicated by a small crosshair which is initially at
the centre of the object or selection, but may be
dragged to another position. Please note that if you
choose the rotate tool when there is no selected
object, the crosshair will not appear until you
select one or more objects.

Note that the Picture frame info palette does not

show the angle of rotation of the frame but the
angle of rotation of the picture within the frame

(fig. 10.9).

>l OlRC]e B

——— Rotate tool
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Using the Info Palette

When the Rotate tool is chosen, the info palette
provides a number of options concerned with
rotating objects (fig. 8.28).

A is the angle of rotation of the selected object or
group. The angle of rotation is in degrees and is
applied anti-clockwise. You may type in a new
value followed by Return to rotate the object to the
desired angle. Alternatively click on the up and
down icons to increase or decrease the angle.

If there is a selection of objects A refers to the first
object selected. In this case, if A is changed, the
first object is rotated as specified and the rest are
rotated incrementally.

Clicking on the 3 x 3 grid will position the
crosshair at the same relative position on the
selected object or selection. The 9 points relate to
the centre, the fours corners and the centres of the
four sides.

If Crosshair is selected, objects are rotated about
the crosshair, otherwise they are rotated about their
centres.

Crosshair —\—>e$- /_I

—e—8

Fig. 8.24 - Use the Rotate tool to rotate
the object around the crosshair.
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Fig. 8.27 - The toolbox.

Fig. 8.28 - When the Rotate tool is chosen, the info palette provides options to set the

angle of rotation and alter the position of the centre of rotation.
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8.9 Editing Objects using the Edit Menu
Menu=Edit=>.....oun

This section describes the options on the Edit
menu (fig. 8.29) concerned with objects. Some of
these options use the clipboard (fig. 8.30) which
can be viewed using the Clipboard option on the
icon bar menu or AB (see 2.2).

The options Clear, Cut, Copy and Delete apply to
selected objects provided that no text or picture is
selected, otherwise they will apply to the text or
picture.

Clear Az
Clear deselects all selected objects.
Select All ATTA

Select all selects all objects on the current page.
This is only possible if there is no active frame,
otherwise it selects all the text in the active frame.
Cut frame/line/selection Afx
Cut deletes selected objects, and places them on
the clipboard, overwriting the previous contents.
Copy frame/line/selection aflc
Copy copies the selected objects onto the
clipboard, overwriting the previous contents.

Cut Text frame X
Copy Textframe ~C

Paste Y
Delete Text frame K
Embed object
Select all A
Clear Az
Find... F4

Fig. 8.29 - The Edit menu.
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Paste frame/line/selection Afly

Paste inserts the object or objects that are on the
clipboard, into the document. After choosing
Paste, move the crosshair which then appears to
the top left comer of where the object is to be
pasted, and click Select.

An object can be pasted into any Ovation Pro
document, not just the one from which it was cut
or copied. After pasting, the clipboard contents
remain unchanged.

This option is only available if the clipboard
contains an object or selection of objects.

Delete frame/line/guideline/selection
This option deletes the selected object or objects.

Undo / Redo F8 /| F9

Undo cancels the last operation performed,
restoring your work fo its previous state. Redo
cancels the last undo operation performed.

The Undo and Redo options when applied to
objects are identical to those described previously
for text (see 3.4).

The mechanical I
typewriter, which ‘
originated in the USA
about a century ago,
represented the first major
advance over pen or
pencil. Its two principal |
advantages were that a
competent typist could

Fig. 8.30 - The clipboard containing a text frame.
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8.10 Embedding Objects
Menuc=vEdit<>Embed object

Normally in Ovation Pro objects are anchored to
the page, but Edit<"Embed object allows you to
embed an object or group into a text story such that
the object moves with its associated text when the
text reflows.

How to Embed an Object

First draw the object anywhere on the page and
Cut or Copy the object so that it is placed on the
Clipboard. Now position the caret at the required
insertion point in the text (fig. 8.31), and choose
Embed object.

The embedded object is aligned with the text’s
baseline and behaves just like a large character
which moves with its surrounding text when
editing causes text reflow. The text after the caret
is shifted to the right to make space for the object,
and the line of text is shifted down to
accommodate its height (fig. 8.32).

D,'['he mechanical utypewriter, \«.‘f'lid'ltj
originated in the USA about a century ago,
represented the first major advance over
pen or ncil.  Its two principal
advantages| were that a competent typist
could write much faster with a typewriter
than with pen or pencil and that the
gwriting produced was consistent andg
clearly legible. It was not surprising, then,
that the typewriter heralded an ‘office
revolution” in  which  typewriter
manufacturers made fortunes. Typing
became part of the school curriculum.
Despite its many advantages, the
mechanical typewriter suffered one major

O =3

Fig. 8.31 - A text frame with the caret positioned
ready for embedding an object.

CHaPTER B

Important Points

*  Embed object is only available if the clipboard
contains an object or group of objects. If the
clipboard contains a selection of objects that
are ungrouped, only the first object in the
selection will be embedded.

« You cannot ungroup an embedded group.

* You can resize an embedded object as you
would a normal object, but you cannot move it
except by moving the text in which it is
embedded.

« Atext overflow will occur if you try to embed
an object into a frame that is too small to
contain it.

«  After embedding, the clipboard contents
remain unchanged.

The mechanical typewriter, which
originated in the USA about a century ago,
represented the first major advance over
pen or ncil. principal

advantag ere that a
competent typist could write much faster
with a typewriter than with pen or pencil
and that the writing produced was
consistent and clearly legible. It was not
surprising, then, that the typewriter
Iheralded an ‘office revolution’ in which

Fig. 8.32 - An embedded frame is aligned to the
text baseline. The text is shifted to the right and the
line moved down to make space for the object.
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Modifying an Embedded Object

The mechanical typewriter,

Menu=>Object=......

If the embedded object is a frame, all the
normal operations can be applied to the text or
picture contents of the frame.

From the Object~>Modify dialogue box or F7
(see 9.2) you can apply all options except for
X, Y and Lock.

From the Object=>Text flow dialogue box you
can only apply Standoff.

Border and Shape can be applied, but all other
options on the Object menu are not applicable.

You can select an embedded object just like
normal text and Cut, Copy, Paste and Delete it
using options on the Edit menu.

An embedded object can be placed in a
paragraph on its own by ensuring there is a
Return character directly before and after it
(fig. 8.33).

Options on the Format dialogue box such as
Indent, Alignment, Space before and

Space after can be applied to a paragraph that
contains an embedded object. Tabs can also be
applied.

which.
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+ The bottom of an embedded object is aligned
with the text’s baseline, but you can shift it up
and down vertically using V.Shift on the
Modify text dialogue box. All other options on
this dialogue box are not applicable.

= Relative leading (i.e. that specified as a
percentage) is calculated from the size of the
text in the line and not from the size of the
embedded object.

Embedding Pictures Directly

You can drag a picture directly from disc into a

text story. A picture frame is then automatically

embedded at the pointer position, and the picture
placed in it.

|originated in the USA about a century ago,
|represented the first major advance over
jpen or pencil. Its two principal

advantages o o

i @

o = &
|were that a competent typist could write
much faster with a typewriter than with
pen or pencil and that the writing
|produced was consistent and clearly
|legible. It was not surprising, then, that the

Fig. 8.33 - Embedded frame in a separate
paragraph with Centre alignment.
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8.11 Path Edit Mode
Menu=>Object->Shape ATH

The shape of objects drawn using straight and
curved line segments, can be edited in Path Edit
Mode.
You cannot edit the shape of rectangles or
ellipses without changing them to polygons
first using Object=>Shape (see 9.9).

To edit a path, choose the Path Edit Mode tool on
the toolbox (fig. 8.34) and click Select on the path
to be edited. This is not necessary if an object is
selected before entering this mode.

The end points of each segment are shown in blue
and may be dragged to reposition them (they will
snap to the grid if grid lock is enabled). You can
constrain movement to horizontal or vertical by
holding down Shift while dragging. When moving
a point you may use the cursor keys to nudge the
pointer in any direction.

Click Select over an end point to select the line
segment. Click Adjust on a point to add or remove
a line segment to or from the selection. Selected
end points and line segments are displayed in red.
If you have a number of end points selected,

moving one of them will move the entire selection.

Path Edit Mode tool

.34 - The toolbox.

S
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If you select the end point of a curved segment, the
control point for the Bezier curve is shown in
orange and may be dragged to reposition it

(fig. 8.35). If you hold down Shift while you drag a
control point, the corresponding control point in
the next curve is also moved to keep the angle of
join constant.

To edit another path, click Select over it. If the
object you want to edit is obscured by another
object, holding down Alt and double-clicking over
the top object will select the one underneath. You
can keep doing this to select progressively deeper
objects.

If you find that editing paths is too slow because
surrounding text is continually being redrawn, you
can disable the redraws using an option on

Iconbar=>Menu=>Choices=>Viewr....
Deselect 'Instant updates on path edit' (see 15.6).

‘When you have finished editing your object, leave
Path edit mode by choosing the Select tool on the
toolbox.

Please note that in Path Edit Mode most of the
usual Ovation Pro operations are not available.

Control points

] i Selected
N, end point
s g

Fig. 8.35 - An irregular object in path edit mode with
an endpoint selected. The two control points may be
dragged to change the angle of join.



SecTion 8.11

Path Edit Options

In Path Edit Mode, the info palette provides a
number of options concerned with editing the
selected path (fig. 8.36). All of the options may be
applied to a single selected segment or to a
selection of segments.

The writable icons X and Y are the coordinates of
the selected end point. Coordinates are measured
from the ruler origin (normally the top left corner
of the page). These values may be modified to
change the position of the point. If there is a
selection of points, X and Y refer to first end point
selected. In this case, if X and Y are modified, the
first end point is moved to the position specified
and the rest are moved incrementally.

Change to straight line changes the selected
curved line segment or move segment into a
straight line.

Change to curve changes the selected straight line
segment or move segment to a curved line.

Change to move changes the selected straight line
segment or curved line segment to a move segment
i.e. an invisible line.
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Make horizontal moves the selected end point
either up or down to make the line segment
horizontal (relative to the object rotation).

Make vertical moves the selected end point either
left or right to make the line segment vertical
(relative to the object rotation).

Add point adds a new segment into the selected
segment, of the same type as the selected segment.

Delete segment deletes the selected segment.

Flatten path straightens the join between two
curved lines or a straight line and a curved line, so
that the tangent is continuous at that point.

Open/close path turns a closed path into an open
one, or an open path into a closed one.

Snap to grid aligns the selected end point to the
grid. The grid or grid lock must be enabled for this
option to work.

Change to move Make horizontal
Change fo curve Make vertical
Change to straight .f."ne / Choose curve

FE=r 1|

Addpoim/

Delete segment

Flatten path
Fig. 8.36 - The info palette in Path Edit Mode
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Editing the Inset and Standoff Curves

The description above explains how to edit the
shape of objects constructed using straight and
curved line segments. However, you may also edit
the ‘curves’ which repel text inside and outside a
frame. This facility only applies to frames, and not
lines which are always transparent and do not repel
text. You cannot edit the Inset or Standoff curves
for rectangles or ellipses without changing them to
polygons first using the Object=>Shape option
(see 9.9). AfTH
Clicking on Choose curve on the info palette

(fig. 8.36) allows you to toggle through the
following three modes:

Default mode: this allows you to edit
the shape of the object.

Inset mode: this allows you to edit the
Inset curve.

Standoff mode: this allows you to edit
the Standoff curve.

%:T“"“IE

Both Inset and Standoff curves are attached to the
frame shape and are moved and resized when the
frame is moved and resized.

Mhe mechanical typewriter, which|
originated in the USA about a century ago,
represented the first major advance over
pen or pencil. Its two principal advantages
were that a competent typist could write
much faster with a typewriter than with pen
or pencil and that the writing produced was|
consistent and clearly legible. It was not
surprising, then, that the typewriter
heralded an ‘office revolution’ in which
typewriter manufacturers made fortunes.
Typing became part of the school
curriculum. Despite its many advantages,
the mechanical typewriter suffered one
major drawback. As soon as the typist hit
| u
Fig. 8.37 - The outer line is the frame guideline
and the inner line is the default Inset curve.
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Editing the Inset Curve

To edit the Inset curve, click on the object you
wish to edit and then toggle the Choose curve
button on the info palette until you are in the Inset
mode.

The Inset curve is positioned around the inside of
the frame and repels the text flowing in the frame.
By default it is the same shape as the frame, but
positioned 1mm in from the edge of the frame
{fig. 8.37). The default inset distance is specified
on the Modify dialogue box (see 9.1). F7

The frame outline is drawn in grey with the Inset
curve drawn in grey with the end points in blue.
You can now edit the Inset curve using the same
operations described on the previous pages

(fig. 8.38).

If you wish to reset the Inset curve to its original
shape and position, reset the Inset value on the
Modify dialogue box to 1mm.

‘;'he L
mechanical typewriter, which
originated in the USA about a century,
ago, represented the first major
advance over pen or pencil. Its two
principal advantages were that a
competent typist could write much
faster with a typewriter than with pen
or pencil and that the writing
produced was consistent and clearly
legible. It was not surprising, then,
that the typewriter heralded an “office
revolution’ in  which typewriter
manufacturers made ]
fortun

L

Fig. 8.38 - The Inset curve has been edited
causing the text to flow inside the new shape.
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Editing the Standoff Curve
Menu=>Object>Text flow AT

To edit the Standoff curve, click on the object you
wish to edit and then toggle the Choose curve
button on the info palette until you are in the
Standoff mode.

The Standoff curve is the positioned around the
outside of the frame and repels text flowing around
the outside of the frame. By default it is the same
shape as the frame, but positioned 1mm out from
the edge of the frame (fig. 8.39). The default
standoff distance is specified on the

Object>Text flow dialogue box (see 9.7).

The frame outline is drawn in grey with the
Standoff curve drawn in grey with the end points
in blue. You can now edit the Standoff curve using
the same operations described on the previous
pages (fig. 8.40).

If you wish to reset the Standoff curve to its
original shape and position, reset the Standoff
value on the Text flow dialogue box to 1mm.

The mechanical typewriter, which
originatgd in the USA about a ceqlury ago,
\represe nted the
first major
|advance over pen
|o r pencil.
[ts two principal
|advanta ges were
|that a compete
Int typist could
write much
[faster with a
typewrity gr than
with pen or penml and that the writing
!produced was consistent and clearly

Fig. 8.39 - The inner line is the frame guideline
and the outer line is the default Standoff curve.
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Editing Picture Runaround

The Picture option on the Object=>Text flow
dialogue box automatically modifies the default
Standoff curve so that it follows the shape of the
picture instead of the frame. Using the facilities
described in this chapter you may edit the Standoff
curve to fine-tune the runaround shape to your
exact requirements.

The mechanical typewriter, which
originated in the U _‘rnbout a century
ago, represented g the first major

advance over _ L. pen or
pencil. lts t w o
principal/ advantag
es were/ that a
compete’ nt typist
could, /write
mu c h faster
with anN “typewriter
than with _ —_pen or pencil
and tha® =—®he writing

\produced was consistent and clearly
Ieglbie It was not surprising, then, that the

Fig. 8.40 - The Standoff curve has been edited
causing the text to flow around the new shape.
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Notes:



Working with Objects

9.1 VORI s oo s i oo B o TR T AR
9.2 MOy TOXEFIAINIO. o waiarsnmane e vm w5, s s iy
9.3 Modify Picture Frame . ..........coiiiiiiiiiniinnnnnns
9.4 Modify Line: o snamisvinrmini s sieesn s i wran e ss s
9.5 Modify Objact ..« iiiipidnas s ivinayades
9.6 BOTTOE 5 i i e R A o i i
9.7 Text Flow around a FrameorPicture . ...........covivnuenn
9.8 Duplicate Object .. . ..o i
9.9 Shape of Object ;. .ii v vsivimmesiisiian s isvnrreaves
910 Front/Baek: ..:coviaisainaieiaiiissiyenySding s
QAT CTOURUINGIOUI o a7 i 0 A B
912 Make Local/Make Master...........ccoviiiiiiinnnnnnnn.
813 S0 GN ovv v s s s ey s

This chapter describes all the options on the Object menu concerned
with manipulating objects.
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9.1 Modify

Menu=>Object=>Modify nnnn F7
The Object=>Modify option (fig. 9.1) allows you
to alter the properties of selected objects.
The properties that can be altered depend upon the
type of objects selected, so 4 different dialogue
boxes may appear:

Modify text frame,

Modify picture frame,

Modify line,

Modify object.
The latter is displayed if the selection or group
contains mixed types of objects.
In a selection, the settings shown in the dialogue
box refer to the first object selected. If you alter X,
Y, Width, Height, Angle or Skew the first object
is altered as specified, and all other objects are
altered proportionally.
Only those properties that you change are updated
in the document when you click on OK.

The Modify option can also be used to set the
exact position of ruler guidelines (see 8.4).

OriginX [1637mm | Radus
e — = KECE
Border.. AMF Origin ¥ | 16.09mm Inset | 1mm |

Text flow... AT ‘Width [ 3358mm | Filcolour [ |
| Sheve.. "W Height [ 21.73mm aign [ Top |

Duglont.. 4D angle [ 0 = /. Cotumns [ 1] /5 B

veto locai Stew [ 0 |* 7\ Fistine [Hon
----------------- _[Lock _

Front — =

Arrange... Fig. 9.2 - The Modify text frame dialogue box allows you to
Fig. 9.1 - The Object menu, alter the properties of text frames.
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9.2 Modify Text Frame

Menu=>Object=>Modify... F7
The Modify text frame dialogue box is displayed
if a text frame is selected or if the selection
contains only text frames (fig. 9.2).

Origin X/Origin Y

These values are the coordinates of the top left
comer of the selected frame. They may be
modified to change the position of the object.
Coordinates are measured from the top left corner
of the page.

Width/Height

These values are the width and height of the
selected frame. They may be modified to change
the size of the frame.

Angle

This is the angle of rotation of the selected frame.
The angle is in degrees, and is applied clockwise
(figs. 9.3 & 9.4). You may type in a new value
followed by Return or use the up and down icons
to increase or decrease the angle by one degree.
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Skew

This is the angle of skew for the selected frame.
You can enter a new value or click on the up and
down icons to change the skew angle one degree at
a time. A positive value skews the frame to the
right (fig. 9.5) and a negative value, to the left

(fig. 9.6). The angle is specified in degrees and
must be within the range -80° to 80°.

If a multi-column frame is skewed, the columns
are also skewed.

Radius

This value is the corner radius of rectangular
frames (fig. 9.7). The radius must be a positive
value smaller than half the length of the shortest
side. This value is ignored if the frame is not
rectangular in shape.

Fig. 9.3 - Frame rotated 60°.,

o

Fig. 9.4 - Frame rotated -45°.

The] mechanical

typewriter, which typewriter,

represented the
first major advance

=) = =&l
Thé mechanical Pd The] mech-
which

originated in the originated in the which originated in
USA  about a USA  about a ythe USA  about ag
century ago, century ago, century ago, rep-

represented the
Erst major advance
£ i, = £1

&

anical  typewriter,

resented the  first
\ major advance /

Fig. 9.5 - Frame skewed 25°,

Fig. 9.6 - Frame skewed -25°,

Fig. 8.7 - Frame with round corners.
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Inset

Inset is the gap between the edge of the frame and
the text flowing inside the frame. It prevents the
text from touching the sides and improves the
appearance of frames that have a frame border (fig.
9.8 & 9.9). The default inset is Imm and is set in

IconbarMenu=>Choices=> Textc>

The inset normally follows the shape of the frame,
but it can be made any shape by editing the Inset
curve as described in the previous chapter. This is
useful if you want to have a different inset on
different sides of the frame. If the inset curve is
edited, the value for Inset is blanked out. Resetting
this value will reset the inset so that it follows the
shape of the frame.

Fill colour

This is the current background colour of the
selected frame. To change the background colour
click on the icon to the right of the colour to
display the standard Ovation Pro colour picker.
Frames can be made transparent by choosing
Transparent from the scrolling window.
Transparent frames are ideal for overlaying text
onto graphics e.g. adding a caption to a picture.

More advanced possibilities are available using the
Fill applet.
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Align
This option specifies how text is aligned vertically
in the frame. The submenu provides four options:

Top is the default setting and causes text to be
aligned with the top of the frame (fig. 9.10).

Bottom causes text to be aligned with the bottom
of the frame (fig. 9.11).

Centre causes text to be vertically centred in the
frame (fig. 9.12).

Justify inserts additional white space between the
lines of text so that it fills the frame vertically (fig.
9.13).

Please note that Bottom, Centre and Justify do
not work if the frame is overlapped by another
object that causes the text to reflow or if the frame
is not rectangular. In this case the text reverts to
Top alignment.

r"fhei Dfma'f:l*a»anica«]"_J n‘rhe{
kypewriter, which typewriter,

= 1) s = ]
mechanical ]

which mechanical

priginated in the USA
pbout a century ago,
Qepresented  the  firs{l
major advance over pen

pr pencil. Its two)
principal  advantages
L =) £

Fig. 9.8 - Frame with Omm Inset.

g =) 1
The mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first
major advance over
pen or pencil. Its two
principal  advantages
=) 2|

£

-
L=

L
k=

Fig. 9.9 - Frame with 2mm Inset.

originated in the USA
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Fig. 9.10 - Text aligned Top.
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Thei mechanical
typewriter, which

geriginated in the USAg
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Fig. 9.11 - Text aligned Bottom.

typewriter, which
originated in the USA
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Fig. 9.12 - Text aligned Centre.
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Fig. 9.13 - Text fully justified.
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Columns

This option specifies the number of columns in the
text frame. The default gutter (the space between
the columns) is 5Smm, but this and other advanced
settings can be modified from the Column
specification dialogue box (fig. 9.14) which is
opened by clicking on the icon to the right of the
Columns option.

Gutter width allows you to specify the gap
between the columns.

Column width allows you to specify the width of
the columns,

If Display column guides is selected, a vertical
line is drawn centrally in each gutter (fig. 9.15).

Guide width allows you to specify the thickness
of the column guides (fig. 9.16). You may choose a
standard width from the menu or enter your own
value at the bottom of the menu. The default width
is Thin which is the thinnest line possible on the
output device.

Guide colour allows you to specify the colour for
the column guide using the standard Ovation Pro
colour picker.
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First Line

When text is flowed into a frame, a decision is
taken how far down the first line of text is placed.

The sub menu provides four options:

Accent - the maximum size of the fonts in the line
using all the available characters is calculated. This
includes high bit or accented characters.

Ascender - this is similar but only the characters
with codes less than 127 are used. This includes all
the ‘normal’ ASCII characters used in English.

Fit - the exact height of the line is calculated and
used.

Grid - the baseline is snapped to the text baseline
grid (see 5.4).

Older versions of Ovation Pro used the Accent
setting by default.

Notice that the first two (and last) options give a
distance which is independent of the precise
characters used in the line - the base line of a row
of mmmmm'’s is positioned in the same place as a
row of MMMMMM s, For the fit option the
mmmm’s would be placed higher.

Lock

This option locks the frame so that it cannot be
accidentally moved or resized by dragging. If a
frame is locked it has no handles, and the pointer
changes to the lock symbol if you try to move the
frame.

D‘The[ mechanical J}:dvance over pen
typewriter, which| | br pencil. Its two 0.25mm
originated in t incipal ad- 0.5mm
fJSA  about a vantages were thatth Y 1mm
century ago,| | p competent typist 2mm
represented  the| | could write much
first ~ajor| | faster with  a -
: : : i - £
Fig. 9.14 - Dialogue box for setting Fig. 9.15 - Frame with two columns and a Fig. 9.16 - Column
column specification. green coloured column guide. Guide Width menu.
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9.3 Modify Picture Frame
Menu=>Object=>Modify...

The Modify picture frame dialogue box is
displayed if a picture frame is selected or if the
selection or group contains only picture frames
(fig. 9.17).

Operation is identical to that described for text
frames above except that the options Align and
Columns are not applicable to picture frames and
do not appear in the dialogue box and Inset
operates slightly differently for picture frames than
for text frames.

Inset

In a picture frame the inset is a border inside the
frame, of the width specified and the colour of the
frame fill colour. If a picture is made to fit a frame
(see 10.4), it will be scaled to fit inside the inset
(fig. 9.18 & 9.19). The default picture frame inset
is Omm, but this may be changed on the Picture
Choices dialogue box (see 15.7).

IconbarMenur>Choices=>Picture=>

F7
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The inset normally follows the shape of the frame,
but it can be made any shape by editing the Inset
curve as described in the previous section. This is
useful if you want to have a different inset on
different sides of the frame. If the inset curve is
edited, the value for Inset is blanked out. Resetting
this value will reset the inset so that it follows the
shape of the frame.

Additional information

The Arrange applet provides a number of ways of
aligning and spacing out frames. See the Help file
of the applet.

Origin X 17.120n]
iy
Width | 86.52mm
Height [ 64.35mm |
Angie [ 0 |*wA
Skew [ 0 |°wA
_|Lock

Facus o |
oot o

Modify picture frame

Filcolour [ °H]

_cancel [[_ox_|

Fig. 9.17 - The Modify picture frame dialogue box provides
options for altering the properties of picture frames.

e = t
Fig. .19 - Picture frame with Tmm Inset.
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9.4 Modify line

Menu>Object=>Modify. .. F7
The Modify line dialogue box is displayed if a line
is selected or if the selection or group contains
only lines.
Operation is similar to that described for text
frames above except that the options Radius,
Inset, Align and Columns are not applicable and
Width and Height have a different interpretation
for lines. There are also a number of new options
concemned with line style (fig. 9.20).
Width/Height

These values refer to the width and height of the
bounding box that contains the line.
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Line width

This option allows you to set the line width to any
of the predefined values from the menu or enter
your own value at the bottom of the menu

(fig. 9.21). The default width Thin is the thinnest
line possible on the output device. You can change
the default line width on the Choices dialogue box
(see 15.9).

The width of a single selected line can be
increased or decreased in steps of 0.5mm using
Ctrl > or Ctl <.

Line colour

Allows you to set the line colour using the
standard Ovation Pro colour picker.

Pattern

This option displays a menu of dashed and dotted
line patterns that can be applied to lines (fig. 9.22).

Modi

e
st

Fig. 9.20 - The Modify line dialogue box.

Fig. 9.22 - The Pattern menu.
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Join

Join specifies how lines are joined together and is
only significant on thick lines. There are three
types of joins (figs. 9.23 & 9.24):

Mitred brings the outer edges of lines together to a
point.

Round rounds off the point where the lines join.
The default option Bevelled, cuts off the corner
where the lines join.

Start cap/End cap

These options specify what the end of lines look
like. Caps only apply to open paths and are only
significant on thick lines. The menu provides four
options (figs. 9.25 & 9.26):

Butt, squares off the line at the end point. This is
the default option.

Round adds a solid semicircular to the end of the
line.

Square adds a square to the end of the line. The
square has half the width of the line.

Fig. 9.25 - Start caps menu.

Fig. 9.26 - Butt, Round,
Square & Triangle caps.

CHAPTER 9

Triangle adds a triangle to the end of the line,
allowing you to create lines with arrowheads. This
option has its own submenu (fig. 9.27) allowing
you to set the width and height of the triangle.
Choose one of the predefined values or enter your
own value at the bottom of the menu. The Width
and Height values should be specified as multiples
of the width of the main line.

You can change the default Width and Height
values on the Choices dialogue box (see 15.9).
Please note that you cannot generate arrowheads of
a reasonable size on a line of width Thin; you
must have a line width of at least 0.25mm.

777

Fig. 9.24 - Mitred, Round and Bevelled joins.

Fig. 9.27 - The Caps menu.
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9.5 Modify Object
Menu=>Object>oModify... F7
This dialogue box is displayed if there is a group
selected or if the selection contains mixed types of
objects i.e. text frames, picture frames and lines
(fig. 9.28).
The options provided are those that are common to
all types of objects in the selection or group.
Operation of these options is identical to that
described for text frames earlier.

Fig. 9.28 - The Modify object dialogue box.

119
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9.6 Border
Menu<>Object<>Border... ATF

Normally the edges of frames are just guidelines,
and are not printed, but you can add a border
around the outside of a frame using the Border
dialogue box (fig. 9.29).

The scrolling window in the top left corner of the
border dialogue box, shows all the border styles
that are available. Use the vertical scroll bar to
scroll through the complete list, and click on the
border you wish to use. The chosen border is then
highlighted. It is possible to add additional simple
border styles (see Appendix F).

Draw file borders can be used as well as line
borders. One example is supplied which allows
crop marks to be easily added to any frame. In
Ovation Pro the border width is used to scale the
designs, so you may find some only look correct at
a certain border width.

Note that borders are not stored in Ovation Pro

documents, so if you use a new border you must
provide it to anyone who you want to be able to
use the document.

Draw file borders can only be applied to
rectangular frames. If the border colour is
transparent, then the colours in the original Draw
file will be used (nb these are RGB colours),
otherwise the brightness of the colour in the Draw
file will be used as a tint of the border colour. So

CHapTER 9

for example black in the Draw file border will
produce 100% of the current border colour
(including the tint set for it). White in the Draw
file will produce white in the border.

The option Border determines whether the border
is applied to the frame. The action of choosing a
border style, automatically selects this option. If
you want to remove a border from a frame,
deselect this option.

The Colour option allows you to choose a colour
for the border using the standard Ovation Pro
colour picker.

Width allows you to set the border width to any of
the predefined values from the menu or enter your
own value at the bottom of the menu. The default
width Thin is the thinnest line possible on the
output device.

Click on OK to apply the border to the selected
frame or selection of frames. You can add borders
to rectangular, elliptical or even irregular frames
(figs. 9.30 & 9.31).

Design size is only available for Draw borders and
when selected sets the frame width to that of the
original border in the Draw file.

The mechanical
typewriter, which
originated in the USA
about a century ago,

I—Bondar ‘Colour -_j Width l—__]
__|smum coiour [N 5 m[—_]

| Use design size for border

represented the first major
advance over pen or
pencil. Its two principal
advantages were that a
competent typist could

Fig. 9.30 - Border around rectangular frame.

The
mechanical
typewriter, which
originated in the USA
about a century ago,
represented  the  first
major advance over

pen or pencil.

Fig. 9.29 - The Border dialogue box.

Fig. 9.31 - Border around circular frame.
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Adding Borders to Specified Sides

You may use the four options in the top right
corner of the dialogue box to determine which
sides of the frame the border is to be applied

(fig. 9.32). By default all four options are selected,
causing the border to be applied to all four sides.
Please note that these options only have an effect
on rectangular frames. Borders on elliptical and

irregular frames are always applied to the entire
frame outline.
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Drop Shadow

You can add a drop shadow to rectangular frames
by choosing the Shadow option (fig. 9.33). The
best drop shadow effect is obtained by applying a
border and a shadow (fig. 9.34). In this case the
border is always applied to all four sides of the
frame.

You may choose the shadow colour and width
using the options provided.

When Shadow is selected, the four options in the
top right corner of the dialogue box allow you to
choose the comer of the frame to which the
shadow is applied.

You cannot apply a drop shadow to an elliptical or
irregular frame.

e,
| The mechanical
|typewriter, which
|originated in the USA
about a century ago,
represented the first major

advance over pen or
pencil. Its two principal
advantages were that a
competent lypist could

Fig. 9.32 - Border on top and bottom only.

The mechanical
typewriter, which
originated in the USA
about a century ago,
represented the first major
advance over pen or
pencil. Its two principal

advantages were that a
competent typist could

Fig. 9.33 - The Border dialogue box with Shadow selected.

Fig. 9.34 - Border and drop shadow.
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9.7 Text Flow
Menu=>Object=>Text flow. .. AT

If a frame is positioned over another frame
containing text, the text may be repelled and flow
around the frame. Text flow controls how the text
flows around the frame (fig. 9.35).

It only applies to frames, and not lines which are
always transparent and do not repel text.
Runaround

These options control whether text flows around
the obstructing frame or behind it.

None causes the text to flow behind the frame
completely ignoring it (fig. 9.36).

Frame causes the text to flow around the frame
shape leaving a gap around the frame of whose
size is specified by Standoff (fig. 9.37).

Picture causes the text to flow around the shape of
the picture in the frame leaving a gap around the
frame specified by Standoff (fig. 9.38). It is only
available if the frame contains a picture.

Fig. 9.35 - Text flow controls how text is repelled.
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The mechanical typewriter, which
originated in the USA about a century ago,
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Fig. 9.36 - Runaround set to None.

The mechanical typewriter, which
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with a typewriter than with pen or pencil

and that the writing produced wasl

Fig. 9.37 - Runaround set to Frame.
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Picture Runaround

Choosing Picture runaround causes Ovation Pro
to trace the edge of the picture in the frame and
then generate a Standoff curve of the same shape.
The Standoff curve follows the shape of the picture
but stands off by the distance specified by the
value of Standoff (1mm by default).

You can set picture runaround for Draw files or
bit-image files such as sprites which may have a
mask or a solid background. In the latter case,
Ovation Pro detects the background colour and
ignores it when tracing the sprite outline.
Furthermore, it sets the Inset curve to the exact
shape of the picture thus masking out the
background colour.

Setting Picture runaround automatically sets the
frame to a transparent background so that it does
not obscure the text that flows behind it.

Please note that there is a delay when setting
picture runaround while the picture is traced. The
length of the delay depends upon the size and
complexity of the picture. You can press Esc at
any time to cancel picture runaround.

You can control how accurately Ovation Pro
traces the picture using the Runaround error on
the Choices dialogue box (see 15.8).

IconbarMenu=>Choices=>Picture>

The mechanical typewriter, which

|originated in the USA about a century
ago, represented _f the firsf major
advance over or
|pencil. {ts w o
|principdl dvantag
|es wer hat a
icotnpet typist
icoul rite
fm u c r with
a typewt with
pen or f the
writin uced

was consistent and clearly legible. It was
not surprising, then, that the typewriter

Fig. 9.38 - Runaround set to Picture.
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Editing the Standoff Curve

The standoff normally follows the shape of the
frame or picture, but it can be made any shape by
editing the Standoff curve in path edit mode

(fig. 9.39). This is useful if you want to have a
different standoff on different sides of the frame or
if the text doesn’t flow around the picture exactly
as you require.

If the standoff curve is edited, the value for
Standoff is blanked out. Resetting this value will
reset the text flow so that it follows the shape of
the frame or picture again.

The mechanical typewriter, which
originated in the US oul a century
ago, represente the first major
advance over N pen or
pencil. Its 4 Lt w o
principal advantag

es were chat a
compete; nt typist
could MWrite
much "/ faster with
a typewritef®’ ¥~ “than  with
pen or pencil and that the|
writin roduced|

was consistent and clearly legible. It was |
not surprising, then, that the typewriter |

Fig. 9.39 - Editing picture runaround.
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Text flow

These options control how text flows around
frames and pictures. The text can flow around the

Wider, Left, Right, Both or Neither sides.

[The mechanical typewriter, which
|originated in the USA about a century ago,
[represe? g &

nted
the first
imajor
advanc
le over(]
pen or
|pencil.
|Its two

advantages were that a competent typist
could write much faster with a typewriter

Fig. 9.40 - Text flow to Left side.
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Fig. 9.41 - Text flow to Right side.
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Fig. 9.42 - Text flow to Both sides.
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Fig. 9.43 - Text flow to Neither side.
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9.8 Duplicate
Menu=>Object=>Duplicate...

Duplicate allows an object or selection to be
copied a number of times at specified horizontal
and vertical offsets (fig. 9.44). It is particularly
useful for creating tables and grids from lines or
frames.

Number of times specifies the number of
duplications to be made.

Vertical offset is the vertical shift made before
each duplication (fig. 9.45). This value should be
positive for a downward shift, negative for an
upward shift or zero for no vertical shift.

Horizontal offset is the horizontal shift made
before each duplication (fig. 9.46). This value
should be positive for a rightwards shift, negative
for an leftwards shift or zero for no horizontal
shift.,

Fig. 9.44 - The Duplicate dialogue box.
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Making One Duplication D
You can make one duplication of an object or
selection by pressing Ctrl Shift D. The offsets used
are the same as those set on the Duplicate
dialogue box.

Fig. 9.45 - The single line has been duplicated
to form a series of 10 lines, 4mm apart using:
No of times = 3, Vertical offset = 3mm,
Horizontal offset = Omm.

L

Fig. 9.46 - The single 10mm x 10mm frame has been duplicated to form a

series of 8 frames, 5mm apart using:

No of times = 7, Vertical offset = 0mm, Horizontal offset = 15mm.
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9.9 Shape
Menu=>Object->Shape... ATH

Shape opens a dialogue box which indicates the
shape of the selected object, and allows you to
change it (fig. 9.47).

Rectangle changes an ellipse or polygon into a
rectangle. The rectangle will be the same size and
shape as the bounding box of the original object.

Ellipse changes a rectangle or polygon into a
ellipse. The ellipse will have the same size
bounding box as the bounding box of the original
object.

Polygon changes a rectangle or ellipse into a
polygon. The polygon will have the same size
bounding box and shape as the original shape, but
will be constructed from straight and curved line
segments thus allowing a rectangular or elliptical
shape to be edited in path edit mode.

(!
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Regular polygon changes any object into a regular
polygon with the number of sides specified

(fig. 9.48). The polygon will have the same size
bounding box and shape as the bounding box of
the original object. If you wish to draw perfect
regular shapes such as triangles, hexagons,
octagons etc., your original object must be

perfectly square.

Star changes any object into a star with the
number of points specified.

=

F=

']\

The
\lypewriter, which /
\ ongmated in the /
» USA about a /

& £
mechanical /

=)

IJ'IT ?; e I'ﬂ_
mechanicaf\\
/ typewriter, which
/ originated in the USA

F;g 947 - ﬂwShapedfan'oguebox

originated in the USA
gpbout a century ago,g
represented the first major
advance over pen or

~_pencil. Its two

1

. principal ,

Fe=t o

£
a

m centu ry};" m about a century ago,fj
Nago,/ \ represented the first
\ repre / '\ major advance over /
\se/ \pen or pencil. Its /
\ / \two pnnc:pal
i £ £l 3 =
———8—— —
AT h e AT h e
“mechanical ~“mechanical -,
" typewriter, which /typewriter, which

orlgmated in the USA \
[;about a century ago,

| major advance over |
'_pen or pencil. Its |
~t w o
., g

yrepresented the first |

f_r L=
Fig. 9.48 - Regular polygons.




Secrion 9.10 anp 9.11

9.10 Front/Back

Menu=>Object=>Front AU
Menu=Object<>Back AH

There are two ways to send objects to the back or
bring them to the front.

Using menu options

If a number of objects occupy the same area of the
page, the object created last is said to be at the top
of the stack and obscures other objects lower down
the stack. The Front option brings the selected
object to the top of the stack. It is only available
when there is a single object selected which is not
already at the front.

The Back option pushes the selected object to the
bottom of the stack, hiding it behind any other
objects that occupy the same area of the page. It is
only available when there is a single object
selected which is not already at the back.

Using keyboard short-cuts.

When using the keyboard short-cuts the object is
moved one layer at a time. In this way you can
change the following order of a stack of frames.

Beware that you can send an object behind the
main text frame, making it invisible. To retrieve
such an object either put the main frame at the
back or drag an area holding down the shift and
control keys. The object outline will be visible if it
has been totally enclosed within the dragged area,
and the selection can then be moved forward.
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9.11 Group/Ungroup
Menu=>Object=>Group ATK

Group tums a number of selected objects into a
single group. A group has a single bounding box
enclosing all the objects in the group, and can be
moved, rotated, duplicated, grouped etc. just as
though it were a single object (fig. 9.49). If the
group is resized by dragging, all the objects in the
group are resized by the same relative amount. If
the group contains frames, you may click in a
frame to edit its contents. Group is only available
when there is more than one object selected.

Ungroup breaks down a group into the objects that
make it up. It is only available when there is a
single group selected. It has the same key short-cut
as Group.

I =) 5
The mechanical !write much faster with a
typewriter, which | |typewriter than with pen

about a century ago,
represented the first major
advance over pen or

ncil. Its two principal
advantages were that a

originated in the USA| lor pencil and that the

competent typist could

|writing produced was
|consistent and clearly
legible. It was not
surprising, then, that theY
typewriter heralded an
‘office revolution’ in

| Three frames in a group.

=

£1

Fig. 9.49 - The Group option allows a number of objects to be
grouped together and manipulated as a single object.
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9.12 Make Local/Make Master
Menu=>Object<>Make Local

Make local converts a Master object generated by
the Master Pages, into a normal object that can be
edited in the usual way. Make local is only
available when the selected object or objects are
Master objects.

Make master converts a Master object that has
been made local, back into a Master object.

Make master is only available when the selected
object or objects are Master objects that have been
made local.

Any changes that were made to a local object
are lost when it is made back into a Master
object.
Refer to Chapter 11 for more details about Master
objects.

CHaPTER 9

9.13 Snap to Grid
Menu=>Object=>Snap to Grid

This option causes the top left corner of the
selected objects to snap to the nearest grid point. It
only applies if either the grid or grid lock is
enabled (see 7.4).
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Working with Pictures

A General Picture Handling

100  Importing PIotUres . o i s i s sl sisimai s wish e i
10:2  Solactng PICUNS .o v ames s awis ei e i e s
103 MovIng PICHINGS v avvv v swmm v misna m s s o0 wis s sraisis

104 ResizingPictures . .......coiirinuinrai i eniinennannn
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108 Optionson‘the Edit Menu: «.vasasmavmme s omessmes
10.9 Object Linkingand Embedding. ............coivviinnvnnn.

B Large Picture Support
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10.11 Sefting Picturechoices.........coviiiaiiiiiiiiiiiinnans
10.12 Referenced PicturesandMailMerge . ... ..................
1013 Snags, HiMs and TIPS« v vcmvamin woimvism v s swesmieas

This chapter describes how to import pictures into frames, and then
manipulate them in various ways.

The handling of large and/or high resolution pictures or complicated
vector files is mentioned separately in the second part of this chapter
starting with an introduction to this aspect of picture handling.
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10.1 Importing Pictures The imported picture is centred and scaled to fit
inside the frame but keeping its original aspect
ratio i.e. its original shape. If the frame is
rectangular, the entire picture will be visible

To import a picture, drag the picture file into a
frame. You may import standard Acorn Sprite and

Draw files, plus other popular formats detailed in 5
the Ovation Pro release notes. If you try and load (figs. 10.1 and 10.2), otherwise the edges of the

an unrecognised picture format, the file will be picture are cropped to suit the shape of the frame
interpreted as a text file and you will be asked to (figs.10.3 and 104).

confirm whether you wish to proceed loading it

(see 3.3).

A warning is given if there is insufficient memory

to load the picture.

The frame may be any shape, but must be
completely empty or already contain a picture (in
which case the old picture is overwritten). You
cannot import a picture into a frame that already
contains text unless all the text is deleted first,
otherwise the picture is embedded in the text (see
later).

= ——— g 2|
Fig. 10.1 - Fit to frame with aspect lock. Fig. 10.3 - Fit picture in elliptical frame.

Fig. 10.2 - Fit to frame with aspect lock. Fig. 10.4 - Fit picture in irregular frame.
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Importing at a Specified Scale

If you hold down Ctrl when importing a picture,
the picture is imported at the scale specified in
Choices (see 14.7). By default this is 100% i.e. the
original picture size.

Embedding a Picture

If you drag a picture into a text frame which is not
empty, the picture is imported into an
automatically generated picture frame which is
embedded into the text at the pointer position.

The picture is imported at its original scale, but
scaled down to fit if necessary.

Saving Pictures

If there is an active picture frame, the Save picture
option becomes available on the File menu. This
allows you to save the picture in the frame to disc,
or to another application. The picture is saved in
the same format that it was loaded in.

Fig. 10.5 - A selected picture.
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10.2 Selecting Pictures

If a picture hasn't been selected, operations such as
move, rotate, cut, copy etc. apply to the selected
frame and its contents. If the picture has been
selected, these operations apply to the picture only;
the frame remains unchanged.

Choose the Select tool on the toolbox and double-
click on a picture to select it. A three-pronged
resize tool is displayed over the centre of the
picture confirming that it is selected (fig. 10.5).

Click Adjust over a selected picture to deselect it.
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10.3 Moving Pictures

To move a picture within a frame, ensure that the
Select tool is active then double-click over the
picture to select it. Now click and hold Select over
the picture (not over a handle) and when the Hand
tool appears (fig. 10.6) you can move the picture.

You can constrain movement to the vertical or
horizontal direction by holding down Shift before
dragging and keeping it held down while moving
the picture.

You can position the picture within the frame
precisely using the info palette or the Modify

picture dialogue box (see 10.7). Fé

Fig. 10.6 - Use the hand tool to drag
the picture to a new position.

CHapTER 10

Using the Info Palette

You may use the info palette (fig. 10.7) to position
the picture in the selected frame (in this case the
picture does not need to be selected). X and Y are
the offsets from the top left corner of the frame to
the top left corner of the picture, and can be
modified to change the position of the picture.
Press Return afterwards to update the document.

Alternatively, click on the up and down buttons to
move the picture in the appropriate direction.

Note that the X and Y fields towards the left side
of the info palette refer to the picture frame,
whereas X and Y towards the right edge refer to
the picture itself.

& [Xlomm | W|4.95mm| Scale] %

£ ComET

¥ % " v[187.57md H[.670m Aspect| 100

= v[omm

= _Fit | or |

Fig. 10.7 - The info palette gives the position of the current picture. You can reposition it by
changing the X and Y values. The info seen here reflects details of Fig. 10.6
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10.4 Resizing Pictures
Menu=>Picture=>Modify picture... Fé6

To resize a picture, ensure that the Select tool is
active then double-click over the picture to select it
(fig. 10.8). To resize the picture, drag the handle at
the end of the diagonal line on the resize gadget. If
Aspect lock is selected on the Modify picture
dialogue box, the picture shape will be retained.

To resize the picture in the horizontal direction
only, drag the handle at the end of the horizontal
line. To resize the picture in the vertical direction
only, drag the handle at the end of the vertical line.
You can resize the picture precisely by using the
info palette or the Modify picture dialogue box
(see 10.7).

Using the Info Palette

You may use the info palette (fig. 10.9) to resize
the picture in the selected frame (in this case the
picture does not need to be selected).

Scale is the scale of the current picture as a
percentage of its original size. You can enter a new
value or click on the up and down icons to change
the scale one percent at a time. Changing this value
affects scaling in both X and Y direction, so the
picture shape is not changed.

Fig. 10.8 - Double click on the picture to select it
instead of the frame.
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Aspect is the ratio of the horizontal scale of the
picture to the vertical. You can enter a new value
or click on the up and down icons to change the
aspect one percent at a time. A value of 100%
means that the picture is displayed in its original
shape. To stretch a picture sideways increase this
value, and to squash a picture sideways decrease
this value. For example, to make a picture twice as
wide as its original, set Aspect to 200%.

Resizing Frame & Picture

If you resize a picture frame by dragging its handle
using Adjust, the picture is resized too. With
Aspect lock set the picture will be resized to fit the
height of the frame. Otherwise the picture will
follow the size of the frame.

Fit

This option scales the picture so that it fits the
frame. If the Aspect lock option on the
Modify picture dialogue box is selected, the
picture shape will remain unchanged. If
Aspect lock is not selected, the picture may be
stretched to fit the frame exactly.

Ctr

This option will centre the picture without
changing its scale. It is especially useful if due to
rescaling the picture has moved out of sight.

Drag the handles to scale the picture.
~ Pctreiame | X|20mm | W[49.30mm| Scalel ® [= xonm |54l o |3
127 ¥|188.01md H|48.82mm| Aspect| 100 | ¥[owm | [hit | i

Fig. 10.9 - The info palette allows the scale and aspect ratio of the picture in the sel

frame to be altered. The Fit option, fits the picture to the frame..
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10.5 Rotating Pictures

‘Whenever a picture frame is active, A on the info
palette (fig. 10.9) shows the angle of rotation for
the picture. The angle is in degrees and is
measured anti-clockwise. You may enter a new
value and press Return or click on the up and down
icons to increase or decrease the angle by one
degree or by ten degrees while holding down Shift.
The picture is rotated about the centre of the frame.

To set an exact angle use the Angle dialogue box
on the Modify picture menu

Menu=>Picturec>Modify picture...

Using the Rotate Tool

Ensure that the Select tool is active then double-
click over the picture to select it. Now choose the
Rotate tool (fig. 10.10) then click Select and drag
on any part of the picture until it is at the required
angle (fig. 10.11).

The centre of rotation for the picture is indicated
by a small crosshair, which can be dragged to a
new position if required.

F6
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Using the Info Palette

‘When a picture is selected and the Rotate tool
chosen, the options on the info palette (fig. 10.12)
apply to the rotation of the picture instead of the
object.

A is the angle of rotation of the picture. The angle
of rotation is in degrees and is measured anti-
clockwise. You may type in a new value followed
by Return to rotate the picture to the desired angle.
Alternatively click on the up and down icons to
increase or decrease the angle by one degree.
Clicking on the 3 x 3 grid will position the
crosshair at the same relative position on the frame
containing the picture. The 9 points relate to the
centre, the fours corners and the centres of the four
sides.

If Crosshair is selected, the picture is rotated
about the crosshair, otherwise it is rotated about its
centre.

Rotating is not possible when a picture has
been locked.

—— Rotate tool it

1]

S The crosshair

=4}

Fig. 10.11 - When a picture is selected you may use the rotate tool to rotate the picture
about the centre of rotation indicated by the crosshair.
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ig. 10.10 - The Rotate tool.

Fig. 10.12 - When a picture is selected and the Rotate tool chosen, the info palette
provides options concerned with rotating the picture.
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10.6 Cropping Pictures

The Crop tool (fig. 10.13) allows you to crop or cut
off unwanted edges of a picture leaving the part
you do want filling the frame.

Position the pointer at the top left corner of the
rectangle you want to retain and drag to the bottom
right corner (fig. 10.14). When you release Select
the part of the picture you have chosen is ‘fitted’
into the frame (fig. 10.15) as follows:

= If Aspect lock on the Modify picture dialogue
box is selected (see 10.7), the picture is scaled
to fit the frame without changing shape.

» If Aspect lock is not selected, the picture is
scaled to fit the frame precisely, changing its
shape is necessary.

You can’t crop a picture if it has been locked.

Cropping can actually be done by dragging from
any corner to the opposite diagonal corner. When
using the Crop tool, you must start within the
picture frame. You can eventually drag beyond the
picture frame, resulting in a scaling down of the

cropped picture.

il
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+—— Crop tool
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Fig. 10.13 - The Crop tool.
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It is important to remember that the Crop tool only
results in a changed view within the picture frame.
But the original picture is not changed in any way,
as can be seen by resizing the picture frame.

This also means that by selecting the picture (by
double clicking on it) one can move the picture to
reposition it within the frame,

The Crop Info palette gives information while
cropping a picture frame. It does not allow you to
set dimensions.

To reset, select the picture using the Select tool
and then click Fit on the Picture Info palette.

Fig. 10.15 - The cropped picture.
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10.7 Modify Picture
Menu=> Picturec>Modify picture... Fé6

The Modify picture dialogue box (fig. 10.16 &
fig. 10.17) is available from the main menu when a
picture frame is active.

It can also be displayed by triple-clicking over a
picture.

Scale

This is the scale of the current picture as a
percentage of its original size. You can enter a new
value or click on the up and down icons to change
the scale one percent at a time. Changing this value
affects scaling in both X and Y direction, so the
picture shape is not changed.

Aspect

This is the horizontal scaling of the picture. You
can enter a new value or click on the up and down
icons to change the aspect one percent at a time. A
value of 100% means that the picture is displayed
at its original shape. To stretch a picture sideways
increase this value, and to squash a picture
sideways decrease this value. For example, to
make a picture twice as wide as its original, set
Aspect to 200%.

Angle

This is the angle of rotation of the picture in the
frame. You can enter a new value or click on the
up and down icons to change the angle one degree
at a time. The angle is specified in degrees, and a
positive angle is applied anti-clockwise.

Charter 10

Tile

This allows the picture in a frame to be repeated on
a rectangular grid. The X and Y distance icons are
the separation between copies in the frame of
reference of the original picture. So for example if
the distance is 10mm and the scale the picture is
rendered at is 50% the distance you see will be
Smm (fig.10.18).

Perfect joins between copies of pictures may not
be possible. If you get slivers of frame background
showing through, try a small negative value for the
distances.

Tile X

oy A A2 AR08
= S S S S
dAdAAA8288

Fig, 10.18 - A tiled mode 12 sprite, size 34x17 pixels with
settings: Scale 50%, Aspect 100%, Tile X=5mm Y=7mm

sten [0 |

@ No lock ) Centre lock ) Lock

_Ixa Y from bottom left
Process... Fit_ | Cancel IJ oK |
Screen..

Fig. 10.16 - The Picture menu.

Fig. 10.17 - The Modify picture box provides options for altering the
properties of pictures.. Values as used for fig. 10.18.
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XY

These show the offsets from the top left corner of
the frame to the top left corner of the picture. You
can enter a new value or click on the up and down
icons.

X and Y from bottom left

When this is selected the X and Y coordinates will
show the offset of the origin of the pictures
internal space from the bottom left corner of the
picture frame.

Skew

This is the angle of skew for the picture. You can
enter a new value or click on the up and down
icons to change the angle of skew one degree at a
time. A positive value skews the picture to the
right (fig. 10.19) and a negative value, to the left
(fig. 10.19). The angle is specified in degrees and
must be within the range -80° to 80°.

No Lock

No lock is the default setting and allows the
picture to be moved, resized or rotated from the
dialogue box, info palette or by dragging.
Centre Lock

If Centre lock is selected, the picture is locked to

the centre of the frame. The X and Y values cannot
be changed, nor can the picture be moved from the

info palette or by dragging.
Lock

This option locks the picture so that it cannot be
moved, resized or rotated from the info palette or
by dragging.

Fig. 10.19 - Picture skewed 25°
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Aspect Lock

If Aspect lock is selected, the Auto scale, Fit and
crop options will scale the picture to fit the frame
retaining its original shape. If Aspect lock is not

selected, the Auto scale, Fit and crop options will
stretch the picture to fit the frame precisely.

The diagonal scale gadget is also affected by this

option.

Auto scale

If Auto scale is selected, then re-sizing a picture
frame with Select causes the picture to be re-sized
too. This normally only happens if you re-size a
picture frame with Adjust.

Hide picture

If Hide picture is selected, the picture in the frame
is hidden and replaced by a cross. this may be
useful if the picture is slow to redraw.

Fig. 10.20 - Picture skewed -25°
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10.8 Options on the Edit Menu
Menu=>Edit<>

The Edit menu (fig. 10.21) contains a number of
operations that you can apply to a selected picture.
If you do not have a selected picture, the
operations on this menu will apply to the frame.

To select a picture double-click on it so that the
resize gadget is displayed (fig. 10.22). Click Adjust
to deselect a picture,

Cut picture X
Cut deletes the selected picture and places it on
the clipboard. The previous contents of the
clipboard are overwritten by this operation.

Copy picture

Copy copies the selected picture onto the
clipboard. The previous contents of the clipboard
are overwritten by this operation.

Paste picture AV
Paste inserts the picture that is on the clipboard,
into the active picture frame. A picture can be
pasted into any Ovation Pro document, not just the
one from which it was cut or copied. After pasting,
the clipboard contents remain unchanged. This
option is only available if the clipboard contains a
picture and there is a picture frame or empty frame
active.

Wonrking witH PicTuRes

AC

Copy Picture frame ~C

Paste Text v
Delete Picture frame*K
Embed object

Select all A
Clear L 4
Find F4

Fig. 10.21 - The Edit menu.

CHapter 10

Delete picture K

This option deletes the selected picture.

Select all AA

When one object has been selected Select all
results in all frames on the present page being
selected.

Clear r
Clear deselects the selected picture(s).

L
Fig. 10.22 - A selected picture.
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Drag & Drop

Instead of using Cut, Copy and Paste to move or
copy a picture via the clipboard, you can use the
drag and drop facility to do this directly.

To use drag and drop, first select the picture you
wish to move or copy. Now press Alt and click
Select over the picture so that the drag and drop
tool is displayed. Then drag until the pointer is
over the required frame and release Select to insert
the picture. The destination frame must be empty
or contain a picture (in which case the original
picture is overwritten).

If you drag and drop within the same document,
the picture is moved; if you drag and drop to
another document, the picture is copied.

If you hold down Shift Alt while dragging, the
above operations are transposed. So, if you drag
and drop within the same document, the picture is
copied, if you drag and drop to another document,
the picture is moved.

If you drag and drop to something that isn’t an
Ovation Pro document, such as a directory display
or another application such as Draw, the picture is
exported to it.

If you start a drag operation and wish to cancel it,
press Esc.
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Pictures and memory use

If you copy a picture or picture frame within the
same document using ‘drag and drop’, the
resulting copy is simply a pointer (or reference) to
the original and uses no extra memory. However,
if you ‘drag and drop’ to another document, an
entirely separate copy is made in the destination
document.

The same is true when pictures or picture frames
are copied using Copy and Paste via the clipboard.
However, since the clipboard is treated as a
separate document, a separate copy is kept on the
clipboard until it is overwritten by another object.
For example, if you import a 100K sprite, copy it
to the clipboard and then paste it back 6 times,
only 200K or RAM will be used (100K in the
document and 100K on the clipboard). When
another object is copied to the clipboard, causing
the picture to be overwritten, the resulting RAM
used will be only 100K.
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10.9 Object, Linking & Embedding (OLE)
The OLE facility allows you to transfer a picture
directly to another application for editing. Once the
editing is complete, the picture is automatically
transferred back to Ovation Pro.

To use OLE, press Ctrl and double-click with
Select on the picture. Typically the picture might
be a sprite or Draw file, but can be any type of
picture provided a suitable editor is available. A
suitable editor is an application that can load and
edit that type of picture format. If an editor is
available, it is loaded and the picture transferred
into it ready for editing.

If no suitable editor for that type of picture is
available, the message No run action
specified for this filetypeis
displayed.

Once you have finished editing the picture, use the
standard save option in the editing package to
automatically transfer the picture back into
Ovation Pro.
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Large Picture Support

Ovation Pro provides some facilities for handling large pictures. These are
referenced pictures and proxy pictures.

Normally pictures are embedded in Ovation Pro documents. So for example a
document containing five 20Mb pictures will be at least 100Mb in size. A
referenced picture on the other hand is not embedded in a document. Instead the
document contains the filename/path of the picture (the reference) and the
picture is stored on disc separate from the document.

Typically referenced pictures will be used by those producing documents
including high resolution pictures for professional printing. By keeping the
pictures separate from the document it becomes easier to modify because it uses
less memory. In addition referenced pictures are only loaded when needed, this
is a simple form of virtual memory. So in the above example it might be possible
to edit the document using only 25Mb of memory.

There are a couple of other situations in which referenced pictures are useful.
Firstly if you have a large number of documents which contain the same picture.
The classic example is a logo used on a letterhead. By making this a referenced
picture there can be a substantial overall saving in disc space.

The other possibility opened by referenced pictures is mail merging where the
pictures in the merged documents change depending on the data used.
Traditional mail merge allows you to personalise documents by inserting
someone's name and address, now you can also include their picture.

A proxy picture is a small fast to render picture which is used in place of a large
or slow to render picture whilst the document is edited. The standard use of proxy
pictures is in conjunction with large referenced pictures. The referenced picture is
only ever loaded into memory when the document is printed, the rest of the time
the proxy is used. Another less common use is for pictures that are slow to render
e.g. complex vector pictures.

On the following pages you can find information on:

Importing PICMIres . vcoviminirsvi iz invainrs vns sa by as 142
Setting Pichirg choltes oo cic v svvunami s e s s inaaies 145
Referenced Picturesand MailMerge .............ccooviiiiiinnans 146

Shags, HIMS 8Nt TIPS .« .o masaie .5 0w s win s e e o s @me as 147

141
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10.10 Importing Pictures

If Shift is held down when a picture is drag and
dropped into a frame, a new dialogue box will
appear (fig.10.23).

Proxy

The two buttons Proxy and Reference control if
the imported picture will have a proxy generated
for it and if it will be referenced. A referenced
picture must exist on disc, you can’t drag the
picture from another application. The menu icon to
the far right of the Proxy button allows you to
open another window to set the parameters for the
proxy image (fig.10.24).

Crarter 10

Proxy image, size

The buttons on the left control the size of the
proxy. If for example the source picture is 2 inches
square, then selecting base/2 will generate a proxy
picture 1 inch square. Assuming the same
resolution the proxy picture would have (1/2) *
(1/2) i.e. (1/4) the number of pixels.

Proxy image, colour depth

The group of buttons on the right set the colour
depth for the proxy. Normally you will use scaling
and colour depth so that the proxy picture is
smaller than the original picture, i.e. it is scaled
down and has a lower colour depth.

Dithering

The Dithering button controls if dithering will be
used when making the proxy picture in low colour
depths.

Once a picture is imported it is still possible to
control the Proxy and Reference aspects from two
new entries which appear on the Picture menu,
accessible from the main menu when a picture
frame is selected (fig. 22.25).

Menu<Picturec........

into a frame if the Shift key is held down.

Fig, 10.23 - This window appears when a picture is dragged and dropped

Prory image =
y— “Coowdeph -
OBase DBase || J2bpp ) 16bp Moty pickure..F6
@ouu Dowwz | Dewn Do o
JBase2 ) Base's | @ 8bpp Reference...
me Proxy...
: Process...

Fig, 10.24 - The window to set the Proxy parameters.

Fig, 10.25 - The Picture menu
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Reference...
Menu=Picture=>Reference...

Selecting Reference... will open the dialogue box
showing the location of the referenced picture (fig.
10.26)

The top icon shows the Path to the referenced
picture and can be edited to change the location of
the picture pointed to. You can drop a file into this
icon to set up a path.

The Embed picture in document and Embed all
pictures in document options load the current
referenced picture or all referenced pictures in the
document - effectively these buttons scrap the
reference. You might use these buttons if you
wanted to prepare the document for passing on to
someone else and the pictures are not too large.

The path is subject to the usual Ovation Pro macro
expansion. So text in { braces } will be expanded.
A common example is

{filepath}.”.picture

This expands to a file called ‘picture’ in the
directory containing the document . The point is
that as long as the picture is in the same directory
as the document this reference will work, so you
can move the document and picture without having
to change the references.
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Collect referenced pictures opens a save box
with a directory icon. This allows you to create a
directory, into which all the referenced pictures in
the document will be copied from their current
locations. This a way of gathering all the pictures
for a document in one place before sending the
document and pictures for printing. When the save
box is first opened the path shown is that of the
current document in position independent form -
which means the path makes use of the {filepath}
macro as just described. If you simply press return,
this sort of path will be used for the collected
pictures. So you can subsequently move the
document and its pictures around - e.g. from disc
to disc. Alternatively if you drag and drop the icon
in the save box, the absolute path of the destination
directory will be used. So you might drag it to the
removable disc you are using to send your
document to the printer on. In general the
collection option allows you to change all the
reference paths in a document, providing they are
good to start off with. For example you might
change all the references from absolute to position
independent.

Fig, 10.26 - Picture reference window



144  Working witH PicTures

Proxy...

Menu=Picture=>Proxy...
Selecting Proxy... will open a dialogue box
allowing the proxy picture to be controlled
(fig. 10.27).
The top section is the usual way of selecting the
size of a proxy picture. The two icons underneath
this display the size of the picture and the current
proxy picture (if there is one). Make proxy
picture will create a new proxy picture using the
chosen settings. Remove proxy picture removes
the proxy, and finally Remove all proxy pictures
removes all proxy pictures from the current
document.

Crarter 10

There is a new button on the main menu
View=>Options window (fig. 10.28).

Menu=View=>Qptions...... AQ
‘When Use proxies is ticked proxy pictures will be
used for on screen display in the current window.
You'd probably untick this if you wanted to check
if the document displayed correctly with the real
pictures, prior to printing it.

Fig, 10.27 - The Proxy window

Fig, 10.28 - The View Options window
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10.11 Setting Picture Choices
IconbarMenu<>Choices=>Picture=>

Some large picture handling options can be set in
the Picture Choices window (fig. 10.29).

The Picture cache is an area of memory which is
used for holding referenced pictures whilst they
are needed e.g. when printing, This memory is
shared between all documents.

You can use Picture choices to set the maximum
size for the cache. Note that an attempt will be
made to load any picture, no matter how big.
Typically the picture cache maximum size controls
how many pictures will be held in memory at any
one time. As the picture cache becomes full,
pictures will be removed from it to make space for
new pictures.

Below this choice, there are two features which
work in a similar way. Reference if over allows
you to tell Ovation Pro to automatically reference
a picture on loading if it is over a given size.
Proxy if over automatically creates a proxy
picture if the original is over a given size. Note
that this assumes the raw file size is a reliable
indication of the size of the picture. Usually it will
be, but for example you might want to create
proxies for vector files of quite modest size. You
can also set the default parameters for creating
proxy picture by clicking on the menu icon to the
far right of Proxy if over.

Fig. 10.29 - The Picture Choices window

Picture CHoices
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10.12 Referenced Pictures and

Mail Merge

Normally mail merge is a way of customising
documents with text. Typically you may have a
comma separated value (CSV) file from a database
with the names and addresses of the people you
want to send a standard letter to (see 12.5).
Referenced pictures allow the possibility of adding
pictures to documents under the control of a CSV
file. So not only can you address your letter to
Mr. Jones, you can also include his picture in it.
Some possible applications;
(1) Producing identity cards. Given a standard card

layout and a database of names and pictures.

(2) Producing catalogue sheets of clip art. A simple
program will produce a list of all the picture
files in a given directory as a CSV file. You can
then have a document which displays a number
of these pictures on each page.

To set up for mail merge, load a referenced
picture. Typically you're going to need a picture to
display as a default when not mail merging. Select
the picture box and open the Reference...
window.

Menu=>Picturec>Reference...
The correct sort of text to enter is as follows;

{macv=field(l); if(macv=="")
macv="ADFS::HardDisc4.$.Q.5pritel";}

Roughly translated the path for the picture is taken
from the first field in the current CSV file record
(i.e. field(1)), if that is the null string (which is the
value when there is no mail merging going on)
then the path is the given string (ADFS etc.), a
good choice for this latter is the path to the original
referenced picture.

All the tricks you can use with mail merge fields
are also possible with the contents of the reference
path. For example you could add code to scan the
contents of a directory for pictures. Or supply a
picture depending on the contents of other fields
e.g. a smiley picture for those with more than £0 in
their account and a frown for those with less

than £0.

Charter 10

To create a document for displaying sheets of clip
art.

(a) Create a page design with a number of frames.

(b) Hold down shift and load a picture from disc
into each frame, selecting the reference button.
The picture should be some sort of ‘default’. Also
notice that you have to do this once for each frame,
you can’t just copy the picture and you can’t copy
the frame with the picture in it. This is so that you
get a separate picture within Ovation Pro in each
frame.

(c) Now for each picture on the page except the
last one, open the Reference... window

Menu=>Picture->Reference...
and change the path to something like:

{macv=field(l); if(macv=="")
macv="ADFS: :HardDisc4.$.Q.DrawFile";
else nextrecord()}

This says see what the first field in the mail merge
CSV file is, if it is null then use the default name,
otherwise use the field as the reference for the
picture and then move to the next record in the
CSV file.

The last picture on the page should have a
reference path like;

{macv=field(l); if(macv==""
macv="ADFS: :HardDisc4.$.Q.DrawFile";}
(d) Create a CSV file of your pictures. One easy
way to do this is using the !EnumDir application.
This can be found in the Extras.EnumDir
directory.

(e) Mail merge in the normal way.

For general information on mailmerging see 12.5.
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10.13 Snags, Hints and Tips

1. Proxies are only generated correctly for
ArtWorks files if the screen mode matches the bpp
value for the proxy.

2. If you use large picture features the resulting
Ovation Pro document may not work with older
versions of Ovation Pro.

3. There is considerable scope for ending up with a
referenced picture where the reference points at a
non-existent file. Typically this will generate an
error when redrawing the page. The problem then
is how to get at the window that will let you
change the reference path for the picture. What
you need to do is pop up the main menu and open
the View options window and deselect ‘Pictures’.
You can then safely expand the window and
change the reference.

4. If you save a document as DDL or a Stylesheet
then when reloaded the file name is lost. This
precludes the use of relative paths.

5. If a referenced picture has a document relative
path and you copy it to another document it need
no longer be the case that the path is correct.
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6. Often you may have a document where many
picture frames contain the same picture. Obviously
it is wasteful if the document contains one copy of
the picture for each frame, Ovation Pro makes
every effort to only have one copy of the picture in
the document. If you edit the picture say by using
OLE on it, only the copy in the frame where the
editing takes place changes. This behaviour is now
retained for embedded pictures. However the large
picture features described here do not work in this
way - if you change the proxy picture setting it will
change in all picture frames that use that picture.
OLE on referenced pictures takes place on the
actual referenced file. Again that implies that a
change to the picture will be reflected in all frames
that use it. It also means your original data is at
risk from any rogue OLE editor. Finally if you
want the behaviour that OLE on a picture changes
it in all frames that use it, you can get this by using
referenced pictures.

7. Pictures loaded via the Transloader system can’t
be referenced. So for example whilst TIFF files
may normally load transparently, they can’t be
referenced, and you must convert them into Sprite
files and reference those. Alternatively a
transparent conversion system like ImageFS may
be used.
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Notes:
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This chapter describes how to create new documents, how fo insert,
delete, copy and paste chapters, how to insert and delete pages, and
how to edit master pages.
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11.1 Overview

Ovation Pro documents consist of one or more
chapters, each containing one or more pages.
Initially a new document consists of one chapter
containing one page, but new chapters and pages
may be inserted as required.

Pages are normally displayed one on top o the
other, with page and chapter breaks indicated by
broad grey lines.

Master Pages

Each chapter has a master page (2 master pages in
double-sided documents) which controls the
format of all the pages in the chapter such as the
paper size, margins, headers and footers. Master
pages enable you to create a template for the pages
in your document, ensuring a consistent
appearance is obtained throughout.

CHapTER 11

Each page added to the chapter is based on the
master page for that chapter.

Master pages in Qvation Pro are dynamic. This
means that if the master page is changed, all the
pages in the chapter are instantly updated from the
master pages.

Master pages can be displayed and edited just like
other pages.

Master Objects

Frames or lines drawn on the master pages are
called master frames or master lines, and are
automatically inserted on all the pages in the
chapter. Normally, master objects can only be
modified on the master pages. If you want to
modify a master object on the document page, you
must make it local first (see 11.3).

Fig. 11.1 - The active document window.

Default master frame
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Default Master Frame

Each master page normally has a default master
frame (fig. 11.1). This frame is used for the body
of the text in a document. It is automatically linked
to the master frame on the following page.

If you type or import text so that it flows over the
end of the default master frame, a new page is
inserted at the end of the chapter and the text flows
onto it. This process is called automatic page
insertion.

If you delete all the text from the default master
frame on the last page of a chapter, that page is
deleted. This process is called automatic page
deletion. The page is not deleted if there are any
additional objects on it i.e. if the page doesn’t
match its master page.

Current Page & Chapter

The current chapter and page number is shown in
the icon in the bottom left corner of the info
palette. The number is in the form c.p, where c is
the chapter number and p is the page number.

If there is more than one page visible in the
document window, the current chapter/page is the
one in the centre of the window.

Fig 11.2 - The Goto page dialogue box.
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Goto Page

You can go directly to any page in the document
by choosing Goto page on the Page menu.

Menu=>Page=>Goto page... F5

Enter the required page number then press Return
or click OK (fig. 11.2).

Ovation Pro finds the page by searching from the
beginning of the document until the page number
is found. If you have a multi-chapter document
with duplicate page numbers, you should enter the
full chapter and page number in the form c.p.

It is also possible to use more complex formats e.g.
S.* takes you to the first page in chapter S. (See
12.2, Range.)
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11.2 Creating New Documents
IconbarMenu=>New...

If you click on the Ovation Pro icon on the icon
bar, a new document is opened based on the
default master page. The default master page
defines an A4 page containing a default master
frame with 10mm margins all round.

If you wish to create a document with a different
layout, choose New on the icon bar menu

(fig. 11.3). This opens a dialogue box which
allows you to specify the format of the default
master pages for a new document (fig. 11.4). All
the settings for the default master page can easily
be changed at a later stage.

Page

Page is the page size, which is set to A4 by
default. You may choose another standard size
from the menu, or choose Other to specify a non-
standard size using the H and W options.

Please note that this option just sets the page size
in Ovation Pro, and does not set the paper size for
printing (which is done using the printer drivers).

CHaPTER 11

Sideways

If Sideways is selected, the paper will be turned on
its side. So if you want to use A5 paper with
landscape orientation, choose A5 from the Page
menu and choose Sideways.

Sideways swaps the paper width and height
dimensions, so it affects both standard and non-
standard paper sizes.

Sideways automatically enables sideways printing,
but this may be disabled if required on the Print
dialogue box (see 12.3).

Colour

Colour allows the paper background colour to be
specified using the standard Ovation Pro colour
picker.

If Bleed is enabled on the Print dialogue box
(see 12.3), the paper background colour will
extend the bleed distance over the paper edges.
The amount of Bleed can be changed in Choices:

IconbarMenu=>Choices=>Print...

Nawdmtmar_n
Page [ A4 __| i 297
Colour | _[ w 210mm :_ISidemaya
-V Default master frame
Cotumns [ 1 A 5
Top| tomm | et 1omm | Header| omm |
, Bottom [ tomm | Right [ tomm | Footer [ omm |
_Jmmmuau JLeft | Right (& Mimor

Fig 11.3 - The icon bar menu.

Fig 11.4 - The New dialogue box defines the default master pages.
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Default Master Frame

If Default master frame is selected, the master
pages will be created with a default master frame
which has the margins specified.

If Default master frame is not selected, the
master pages will be created without a default
master frame i.e. completely blank. In this case
you will have to draw all your own frames either
on the master pages or directly on the document
pages.

This can be useful when creating a document
which does not have a natural one frame per page
text flow e.g. a template for printing labels.
Another situation in which it is useful is where
there is a set of frames completely covering the
Default master frame. Normally a new page will
be added because of the automatic page insertion

produced by the text overflow in the default master

frame, and this extra page may be undesirable.

Top margin

Left Main Righ
nargin frame margin

Footer
Bottom margin

Fig 11.5 - The page margins.
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Columns is the number of columns in the default
master frame. Advanced options may be specified
on the dialogue box that is obtained by clicking on
the icon to the right of the Columns option

(see 9.2 and fig 9.14, copied on this page).

Top, Bottom, Left and Right specify the margins
around the default master frame i.e. they determine
the size and position of the frame (fig 11.5).

Header and Footer specify the space reserved at
the top and bottom of the default frame into which
header and footer information may placed. The
header space is measured from the top of the
frame; the footer space is measured from the
bottom (fig 11.5).

ol il S " N

Copy of Fig. 9.14 - Dialogue box for
sefting column specification.
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Double sided

If Double sided is selected, two master pages are
created; one for left-hand pages and one for right-
hand pages.

Typically this enables you to have a bigger inside
margin for binding, or to alternate the position of
page numbering so that it is always on the outer
edge (like the page numbering for this user guide).
If Left is selected, the settings for Colour,
Columns and all the margins refer to the left-hand
master page only.

If Right is selected, the settings for Colour,
Columns and all the margins refer to the right-
hand master page only.

If Mirror is selected, the left and right master
pages use the same settings, except that Left and
Right margins change to Outer and Inner
margins (fig. 11.6).

Please note that Page, H, W and Sideways must
be the same for both left and right master pages.

=

Quter Left Inner | Inner Right
margin page margin | margin page marg

Fig 11.6 - The page margins for a double-sided document.
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11.3 Editing the Master Pages
Menur>Page-vEdit master pages AE

Choose Edit master page (fig. 11.7) to edit the
master pages. A new document window is opened
showing the master page or pages for the current
chapter. The title bar of the new window confirms
that you are viewing the master pages. You may
use the vertical scroll bar to look at the master
pages for any other chapters that exist. The chapter
number for the currently displayed master page is
shown in the icon in the bottom left corner of the
info palette. If the document is double-sided, there
will be two master pages for each chapter
identified by and L or R after the chapter number
in the info palette.

The master pages may be edited just like normal
pages. You can type directly into the header or
footer spaces or draw other objects anywhere on
the page. When the master pages are closed, this
information will be automatically updated
throughout the chapter.

You can alter the size, shape and attributes of the
default master frame, but you cannot type or
import any text into it - the contents of the default
master frame can only be edited in the document.
You can create objects with text or pictures in the
default master frame. See Master Objects on the
following page.

T o 1171
Edit master pages*E
Page guidelines...

Goto page... F5
Fig 11.7 - The Page menu.
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Frame Handling

If you draw a frame on the master pages and leave
it empty, the frame contents can be edited in the
document. Do this if you wish to put empty guide
frames on each page of the chapter.

If you draw a frame on the master pages and put
some text or a picture in it, the contents of that
frame cannot be edited in the document i.e. the
contents are determined by the frame on the master
page. This is useful if you want the same text or
picture to appear on each page of the chapter.

Headers and Footers
The same rules given above for frames also apply
to the headers and footers.

= If they are blank in the master pages, they may
be edited in the document.

= If you enter text into them in the master pages,
they cannot be edited in the document.

Please note that you cannot import pictures
directly into the header or footer space, but you
can draw additional frames for pictures if required.
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Page Guidelines

When you are viewing the master pages, the
Guidelines option on the Page menu becomes
available.

MasterpageMenu~>Page~>Page guidelines
This option opens a dialogue box allowing you to
change the paper size, colour and margins for the
current chapter (fig. 11.8).

The options available are identical to those on the
New dialogue box (fig. 11.2).
Closing the Master Pages

Click on the close icon to close the master pages.
The document will be updated with the changes
you have made.
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Master Objects
Any objects drawn on the master pages will appear
on each page in the document. If the double-sided
option has been selected objects drawn on the left-
hand master pages will only appear on left-hand
document pages and likewise for right-hand pages.
These objects are referred to as master objects.
Master objects can be selected, but do not have
handles and cannot be modified in any way unless
they are made local. To make a selected object
local, choose Make local from the Object menu
(fig. 11.9).

Menu=>Object>Make local
Once an object has been made local, it can be
modified in any way and is not updated by the
master pages.
A master object that has been made local can be
changed back to a master object by choosing
Make master from the Object menu. All changes
applied since it was made local will be lost.

Fig 11.8 - The Guidelines box allows you to alter the master pages.

Snap to grid
Fig 11.9 - The Object menu.
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11.4 Adding a New Chapter
Menus>PagecoNew chaptert.......

To insert a chapter, choose Before current
chapter or After current chapter from the
Pagec>New chapter menu (fig. 11.10).

The new chapter inherits the master pages from the
current chapter, but of course these may be edited
as described carlicr.

‘When you insert a chapter, the Modify chapter
dialogue box is displayed (fig. 11.11).

Start on left and Start on right determine
whether the first page of the chapter starts on a
left-hand or right-hand page.

Start number is the page number for the first page
in the chapter.

Numeric, Roman upper and Roman lower are
the three page number styles available. They are

used whenever you insert a page number using
Page number on the Insert menu.

Omit header on first page and Omit footer on
first page allow you to omit the header or footer
on the first page of the chapter.

Click on OK to insert the chapter.

Fig 11.10 - The Insert Chapter menu.
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11.5 Modifying Chapters
Menu=>Page=>Modify chapter...

You can use the Modify chapter option at any
time to change various aspects of the current
chapter (see 11.4).

The same options are available as when adding a
new chapter (see 11.4).
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11.6 Importing a Chapter
Menu=>Page=>Copy chapter

It is possible to copy chapters to the clipboard and
paste chapters from it.

This provides a way of moving chapters from one
document to another, changing the order of
chapters in a document, or duplicating a chapter.

The Page menu has entries for Copy chapter and
Paste chapter. The Paste chapter entry has an
associated sub menu which allows a choice of
pasting the new chapter before or after the current
one (fig. 11.12).

Edit master pages"E
Page guidelines...

New chapter I
Modify chapter...
Copy chapter

After current chapter...

Crapter 11

11.7 Deleting a Chapter
Menuc>PagecoDelete chapter

Choose Delete chapter to delete the current
chapter.

Of course it is not possible to delete a chapter if it
is the only chapter in the document.

Insert page...
Delete page...
Goto page... F5

Fig. 11.12 - Copy and Paste for chapters
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11.8 Page Insertion & Deletion

When editing text in the default master frame,
pages are automatically added when text overflows
at the end of the chapter. If text is deleted leaving
pages at the end of the chapter empty, these pages
are automatically deleted.

However, it is possible to manually insert or delete
pages. Before explaining how this is done a good
understanding of what happens when inserting or
deleting pages is necessary.

When you have only text in your document and no
local objects, you can insert or delete any amount
of pages. The end result remains the same as text is
automatically reflowed as has been explained
above.

But if your document has local objects you will
lose these if you delete pages on which they are
present. On the other hand if you insert a page
before a page having an object, that object will
now be on the page after the one you just inserted.
And most probably the newly inserted page will
now been reflowed with the text that initially was

—. alongside the object which has moved up a page.

Put in a simple way: inserting or deleting pages
has no effect on text present in the default
master frame but moves objects when inserting
and moves and possibly deletes objects when
deleting pages.

This means that after deleting or inserting
pages in a document with local objects you
must check the text and object layout.
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Inserting Pages
Menu=>Pagec>Insert page...

To insert a page based on the master pages, choose
Insert page. This opens a dialogue box allowing
you to specify the number of pages to insert and
where they should be inserted (fig. 11.13).

Click on OK to insert the pages.

For example, import 10 pages of text into the
default master frame of a new document. Now if
you insert 5 pages before page 1, you will create a
15 page document. However, the last 5 pages will
be blank and therefore automatically deleted. So
the final document will be the same as the original!

If the last 5 pages had contained any additional
objects, they would not be deleted. The pages
11 to 15 would then only have those objects
and no text on those pages in the master frame.

Fig 11.13 - The Insert page dialogue box.
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Deleting Pages
Menur>Pager>Delete page...

To delete a page, choose Delete page. This opens
a dialogue box allowing you to specify the range
of pages to delete (fig. 11.14).

Click on OK to delete the pages.

This option deletes pages and any objects on those
pages, but it does not delete any text in the default
master frame. This text will flow onto the next
page and new pages will be automatically added at
the end of the chapter to accommodate the
overflow.

This means that in some cases your document will
be unchanged after deleting pages. For example,
import 10 pages of text into the default master
frame of a new document. Now if you delete all 10
pages, 10 new pages will be automatically re-
inserted to accommodate the text.

But if you have a 10-page document with local
objects as well as text on all pages, deleting 10
pages will result in the loss of all objects. Only the
text in the master frame will remain.

‘When inserting or deleting pages it is possible to
use more complex formats to select page numbers
e.g. S.* for the first page in chapter S. (See 12.2,
Range.)

Fig 11.14 - The Delete page dialogue box.

CHAPTER 11

Double sided documents

With double sided documents it is better to insert
or delete an even number of pages. This is
especially important if the left and right hand
pages have a different layout.
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11.9 Examples

Examples of how to set up two typical types of
documents are given below.

Example 1

This is a single-sided document with just one
chapter. It has a header containing the document
name and a footer containing the page number.
Both name and number are centred (fig. 11.15).

1. Choose New from the icon bar menu and set
Header and Footer to 10mm.

2. Click on OK to close the dialogue box and
create the document.
3. Choose Menu~>Page~>Edit master pages.

4. Type the document name in the header, and
align it to the centre using the appropriate icon
on the info palette.

Document Name

Fig 11.15 - Example 1.
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5. Put the caret in the footer and insert the page
number using Insert->Page number.

Menu~>Misce>Insert~>Page number AN

The page number is indicated by a # on master
pages. Align the page number to the centre.

6. Close the master pages using the normal close
icon on the title bar.

Now type or import the text for the document. As
each page is filled, a new page is inserted with the
name in the header and the correct page number in
the footer.
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Example 2

This is a double-sided document with multiple

chapters, and a wider inside margin to

accommodate the binding. It has a header

containing the chapter number and a footer

containing the page number. Both name and

number are positioned on the outside edges of the

pages (fig. 11.16).

1. Choose New from the icon bar menu and set
Header and Footer to 10mm.

2. Choose Double-sided and Mirror, then set the
Inside margin to 15mm

3. Click on OK to close the dialogue box and
create the document.

4. Choose Page=>Edit master pages. Ensure that
you are viewing the left-hand master page,

which is indicated by 1L in the bottom left
corner of the info palette.

5. Type Chapter 1 in the header of the left-hand
master page, and insert the page number in the
footer (as described in Example 1).
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6. Use the vertical scroll bar to scroll down to the
right-hand master page. The icon in the bottom
left corner of the info palette will show 1R.

7. Type Chapter 1 inthe header of the right-
hand master page, and align it to the right edge
using the appropriate icon on the info palette.
Insert the page number in the footer and align it
to the right edge.

8. Close the master pages using the normal close
icon on the title bar.

Now type or import the text for the document. As
each page is filled, a new left or right hand page is
correctly inserted.

To add another chapter, use the New chapter
option on the Page menu (see. /1.4). Ensure that
you set the correct starting side for the new
chapter, so that it follows on from the previous
chapter.

Chapter 1

Left page

#

Right page

Chapter 1

#

Fig 11.16 - Example 2. View - facing pages set on in the Options menu N0
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Ovation Pro uses RISC OS printer drivers to print documents exactly as
they appear on the screen, at any resolution that your printer can deliver.
To print a document, you must have a printer driver installed that is
suitable for your printer. A wide range of printer drivers are supplied with
. your computer, and others are available separately from other suppliers.

The Mail Merge facility allows a document to be printed a number of
times merging different data into each printout. Typically this feature
could be used to print a standard letter to a number of different names
and addresses.

The following Mail Merge examples show how fields can be used to
generate special results.

. Generating address labels: multiple addresses on one page
. Adding sequential numbers to documents: raffle tickets

. Adding random number to documents: bingo tickets

. Creating new Mail Merge data from other fields

. Generating Mail Merge data from other sources

. Manipulating Mail Merge data (e.g. removing blank fields)

. The Impulse Protocol: external control of mailmerging

b = 4 I N T S
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12.1 Printers & Printer Drivers

Ovation Pro can print on any printer, provided a
suitable printer driver has been installed in the
printer manager, !Printers. It is essential that
you choose the correct driver for your printer,
otherwise it will at best produce a poor quality
printout, or at worst deliver pure rubbish! Each
printer driver has a default configuration, such as
resolution and quality, and you may need to
change this to produce the results you require.

Connection

You should configure the printer driver to use the
correct interface for your printer. Normally this
will be the parallel interface, but you may also
print to the serial port, to the network or to file.

Resolution

Most printer drivers support a range of print
resolutions, so you must make a trade-off between
print quality and speed. Higher resolutions give
better print quality, but take longer to print.

Quality

You can configure most drivers to print in mono
(black and white), grey scales or colour (if it is a
colour printer). The quickest results will generally
be obtained by printing in mono.

Please refer to your RISC OS 3 user guide for
details of how to install and configure printer
definition files.
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Page Size and Paper Size

The page size is the size of the page set in Ovation
Pro. The paper size is the size of the paper that is
fed into the printer.

It is very important that printer driver is set up to
have the same paper size as the paper being fed
into the printer.

Usually the paper size should be set to the same
page size used in Ovation Pro, but in some cases
they may be different. For example, you may wish
to print an A5 page on A4 paper, or printing two
A5 pages side-by-side on A4 paper.

Printing on Fan-fold Paper

A problem that often occurs on dot-matrix printers
is unexpected blank pages that appear when
printing on fan-fold or continuous paper. This
happens because the default page size in Ovation
Pro is A4, and this is larger than the standard fan-
fold paper length of 11 inches. So the very bottom
of the A4 page has to be printed on an additional
sheet of fan-fold paper.

(In Continental European countries the general
default size for fanfold paper is 12 inches.)

The solution is to set the Ovation Pro page size
and the printer driver paper size to 11 inches long.
Also ensure that the printer dip-switch is set to 11
inch paper and no perforation-skip.

Landscape Pages

Normally, Ovation Pro prints each page of the
document upright on the paper. However, if the
page was set to be Sideways, it is printed sideways
on the paper i.e. the print option Sideways is
automatically selected (see 12.3).

Portrait
o Sideways

also called
Landscape
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Print Margins
Menu=>Viewe>Options=>Print margins ATO

Most printers cannot print right up to the edges of
the paper i.e. there is a margin around the paper on
which the printer cannot print. You can view this
margin by selecting the Print margin option on
the Options dialogue box. The print margin is
shown as a grey margin around the page (fig. 7.5).
The area inside the print margins is the printable
area, If the page size is bigger than the paper size,
the print margin will show the area that cannot be
printed.

If any objects on the page extend into the print
margin, they will not be printed. There are a
number of solutions to this problem:

+ Redesign the page so that all objects fit wholly
within the printable area.

« If there is space at the opposite edge of the
paper, shift the page across when printing.
Options X and Y on the Print dialogue box
allow you to do this (see 12.3, Advanced Print
setup options).

= Scale the page down when printing so that all
objects fit in the printable area. Any easy way
to do this is using the Fit option on the Print
dialogue box (see 12.3).

Print=~>Print setup

Note that the print margin is read from the printer
driver, so a printer driver must be loaded for it to
be displayed.
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PostScript Printing

‘When printing on PostScript printers, it is
important to be aware of how fonts are mapped
and downloaded.

« The !FontPrint application allows Acorn
font names to be mapped to equivalent
PostScript font names. So if you print a font for
which there is a PostScript equivalent, the in-
built PostScript font will be used. This often
results in quicker and higher quality printing.

« If you print a font for which there is no
mapping to a PostScript equivalent, the Acomn
font is downloaded to the printer and retained
for the duration of that print job.

* Youmay use ! FontPrint to indicate that
certain fonts are to be downloaded to the
printer whenever ! Printers is started. The
downloaded font is retained until the printer is
reset. Use this option with care because
downloaded fonts take up large amounts of
memory in the printer.

Please refer to your computer user guide for more

details about font mapping and downloading to

PostScript printers.
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Print Speed & Memory Requirements

The time taken to print a page depends upon the
type of printer you are using and the complexity of
the page. PostScript and other laser printers are
usually the quickest printers. Inkjet and in
particular dot-matrix printers tend to be the
slowest.

You can normally speed up printing in a number of
ways:

+ Reduce the print resolution. You could use a
lower resolution for draft printouts, then switch
to the highest resolution for the final copy.

= Reduce the print quality. If you are only
printing in black and white, ensure that your
printer driver is configured to mono (dot-
matrix and inkjet printers only).

+ Free more memory before printing.

Most printer drivers print pages by ‘redrawing’

them at the printer resolution into a sprite area in

RAM. That area is then dumped to the printer. If

there is insufficient memory to hold the entire page

in the sprite area, the page is printed in strips.

Clearly the greater free memory available, the

fewer strips will be needed and the faster the page

will be printed.

The above description is not true for PostScript

printers, which generally need less free memory.
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If required, you can make extra memory available
in the following ways:

* Quit any other unneeded applications before
printing.

= Having configured !Printers, quit it from
the icon bar to free memory used by the
application. The actual printing is done by a
meodule that remains active even after
!Printers has been removed.

» Change to a lower screen mode before printing.
Although the screen display may look poor, the
print quality will be unaffected.

Other ways of saving memory are described in
Appendix A.
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12.2 Basic Printing
Menu=>File=>Print... Print

To print a document, first ensure that the correct
printer driver has been loaded and configured.

Now choose File=>Print to open the Print
dialogue box (fig. 12.1) which provides all the
basic print options.

The name of the current printer driver is displayed
in the title bar.

Print Setup

If you click on Print setup, the dialogue box
expands to display the advanced print setup
options (see 12.3, fig 12.8).

Copies

Copies is the number of copies of each page that
you want to print, For a multi-page document, each
page in tumn is printed the specified number of
times i.e. in the order 1,1,1,2,2,2, 3,3,3 etc.

You may use the Collate option if you want pages

to be sorted into order automatically i.e. in the
order 1,2,3,1,2,3, 1,2,3 etc.

Some printers, such as PostScript and other laser
printers, retain a copy of the printed image in their
memory, so printing multiple copies of the same
page takes only slightly longer than printing one
copy.
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Format

Choose the format of the printed pages from the
Print format menu (fig. 12.2).

Normal

Normal is the default format, and prints pages in
the order they appear in the document. Each page
is printed upright at 100% scale, and centred on the
paper. However, you may change the scaling,
orientation etc. using the advanced print options
(see 12.3).

Because printer drivers or printer hardware will
occasionally crash your computer it is good
Ppractice to save your document before trying to
print it.

Pamphlet
Galley
Printers pairs
Booklet b

Thumbnails P
Tile(2x2)

Fig. 12.1 - Basic options on the Print dialogue box

Fig. 12.2 - The Print format menu.
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Pamphiet

Pamphlet prints 2 pages side-by-side on each
sheet of paper (fig. 12.3). The pages are printed in
such an order that when folded they create a
pamphlet with correctly ordered pages (fig. 12.4).
Typically this option is used to produce small A5
booklets printed sideways on A4 paper, although
other sizes may be used too.

By default each page is printed sideways at 71%
scale, and the pair of pages are centred on the
paper. These settings are suitable for printing an
A4 document on A4 paper, producing an A5
pamphlet. However, you may change the scaling,
orientation etc. using advanced print options

(see 12.3). For example if your document is A5,
the scaling should be set to 100%.

Your document may have any number of pages,
but the number of pages in the booklet will be
rounded up to a multiple of 4 pages. So if you print
7 pages, you will get an 8-page booklet with the
last page blank. To obtain sensible results,
pamphlets should always start on a right-hand

page.

4 1 2 3

Fig. 12.3 - A 4-page document Pamphlet printed.

Fig. 12.4 - A folded 4-page pamphiet.
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To print the pamphlet, choose Front to print the
front side of the paper only, then turn the paper
over and choose Back to print the back side. So if
you have an 8-page document, choose Front to
print pages 8/1 on the first sheet and 6/3 on the
second. Turn the paper over and select Back and
Reverse to print pages 2/7 on the back of 8/1, and
pages 4/5 on the back of 6/3. You should now be
able to fold the sheets in half for a correctly
ordered booklet.

You may need to experiment to find the correct
way to turn the paper over, so that the back side is
printed correctly.

If you print the pamphlet with All sides selected, it
will all be printed on one side of the paper only.
This may be useful if you wish to print multiple
copies of the pamphlet on a photocopier.

Please note that when pamphlet printing you may
find that the edges of the document are not printed
because they fall in the print margin. In this case
you should select the Fit option, or reduce the
scale manually (see 12.3).
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Galley

Galley prints 2 pages side-by-side on each sheet of
paper (fig. 12.5). Galley printing is useful for
producing draft copies of documents at a smaller
scale and thus using less paper.

Pages are printed in the order they appear in the
document. By default each page is printed
sideways at 71% scale, and the pair of pages are
centred on the paper. These settings are suitable
for printing an A4 document on A4 paper,
producing an A5 pamphlet. However, you may
change the scaling, orientation etc. using advanced
print options (see 12.3). For example if your
document is AS, the scaling should be set to 100%.

Notice that pages are printed on the same sides as
they appear in the document. So if a document
starts on a right-hand page, the first page printed
will be a blank left-hand page. If you want to avoid
this blank page (fig. 12.6), you should set the
document to start on a left hand page using

Start on left on the Pagec>Modify chapter
dialogue box.
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If All sides on the Print dialogue box is selected,
each sheet is printed in turn on one side of the
paper.

You may print on both sides of the paper by using
the Front and Back options on the Print dialogue
box. Choose Front to print the front side of the
paper only, then turn the paper over and select
Back and Reverse to print the back side. So if you
have an 8-page document that starts on a left-hand
page, choose Front to print pages 1/2 on the first
sheet, and 5/6 on the second. Turn the paper over
and choose Back to print pages 3/4 on the back of
1/2, and pages 7/8 on the back of 5/6.

You may need to experiment to find the correct
way to turn the paper over, so that the back side is
printed correctly. You may need to use the
Reverse option to reverse the order of printing the
back side.

Please note that when galley printing you may find
that the edges of the document are not printed
because they fall in the print margin. In this case
you should select the Fit option, or reduce the
scale manually (see 12.3).

4

1 2 3
Fig. 12.5 - A 4-page document Galley printed. Document starts
on right-hand page
j 1 2 3 4

Fig. 12.6 - A 4-page document Galley printed.
Document starts on left-hand page
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Printers pairs

This is the same as Pamphlet but used for A4 size
printouts without scaling or sideways printing.
Booklet, Thumbnails & Tile

The following printing formats are also available if
the Imposit applet has been installed:

* Booklet

* Thumbnails

= Tile

Booklet

Booklet is equivalent to ‘Four-up’ printing found
on other systems. It prints 4 pages on each sheet of
paper. The pages are printed in such an order that
after printing the front and back of the sheet, it can
be folded twice and trimmed to form an eight-page
booklet.

If 'Use half-sections’ is ticked, and the booklet has
4 pages, then those four pages will be printed on
one side of the sheet. Remember to print just the
Front side, otherwise 2 sheets will be printed.

If 'Use half-sections' is ticked, and the booklet has
12-pages, 20 pages etc. (a multiple of 8 plus 4 or
less) the outer four pages will be printed separately
as a 4-page section. The remainder of the pages
will be printed as standard 8-page sections.

Thumbnails

Normally Ovation Pro prints one page onto each
sheet of paper, but with Thumbnails it prints as
many as it can. In order to print more than one
page per sheet, the page size has to be smaller than
the paper size or Scale must be set to less than
100%. The number of pages that will fit is also
affected by the Sideways option.

The Thumbnails menu will let you choose as many
pages as will fit in the paper area or the printable
area, or you can specify how many thumbnails are
required. Finally you can have the contents of all
the thumbnails the same. This may be useful for
tasks like printing business cards, where you only
have to design one card, but can have a matrix of 4
by 8 printed out.

Tile

By using the Tile print format you print one large
Ppage across a number of smaller sheets of paper.
You might use this facility to print a large poster
onto a number of A4 sheets of paper.
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All pages

Select All pages to print all pages in the document.
The page numbers are shown in the icon to the
right of Range.

Range

Select Range to print the range of pages specified
in the writable icon. Page numbers specified
should be the same as those shown in the
document. So if you have a document whose start
page is 8, you may print the first 4 pages by
specifying the range 8 to 11.

The page number of the current page (the one in
the centre of the document window) is shown on
the info palette and the Filec>Info dialogue box.

If your document has more than one chapter and
the page numbering is not continuous, the page
number format must be specified in the form c.n
where c is the chapter number and n is the page
number. So for example, if you have a document
with 2 chapters each starting at page 1, and you
wish to print the first 4 pages from chapter 2, you
should use the range 2.1 to 2.4.

The following forms can be used for page
numbers:

N the first page in the document with page
number N e.g. typed as 6
page number P in chapter S e.g. 2.6
-- ditto -- e.g. 2/6
absolute page number N e.g. A6
aN  --ditto -- e.g.ab
.* first page in chapter S e.g. 2.*
-- ditto -- e.g. 2.
f --ditto--e.g. 2.f
.F --ditto--e.g. 2.F
1 last pageinchapter S (letter L)e.g. 2.1
-- ditto -- e.g. 2.

A page range can be written as:

Pn  start and end with page Pn
Pn-Qn Start with page Pn and end with page Qn

Page ranges can be concatenated with a comma.
The following examples are valid:

1.1-6.5

1,2,3,9,18,20

1,6,88-99

1 to 15

Al to A6, AlO to 15.6,36,45

w
c
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All sides

All sides causes both left-hand and right-hand
pages to be printed.

Left and Right allow you to print either the left-
hand or right-hand pages. This enables you to print
double-sided documents by printing one side, then
turning the paper over and printing the other.

If you are pamphlet or galley printing, All sides
causes both sides of each sheet to be printed. The
Left and Right options change to Front and Back,
and allow you to print either the front or back of
the sheets. This enables you to print double-sided
pamphlets or gallies (see the earlier description of
Pamphlet and Galley).

Pause

If Pause is selected, printing will pause between
each page printed until you click on Continue on
the Printing dialogue box.

Reverse

If Reverse is selected, printing starts with the last
page instead of the first.

If your printer stacks pages face-up they will be
incorrectly ordered after printing. In this case you
can use Reverse to correct the page ordering. You
may also need to use this option when printing the
back side of double-sided documents.
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Collate

If Collate is not selected, Ovation Pro prints
multiple copies of each page, so pages are printed
in the order 1,1,1, 2,2,2, 3,3,3.

If Collate is selected when printing multiple
copies, Ovation Pro prints multiple copies of the
document, so pages are printed in the order 1,2,3,
1,23, 1,23,

Some printers such as dot-matrix, take the same
amount of time to print each copy of a page. In this
case Collate may be used to stack the pages in the
correct order.

However, other printers such as PostScript, can
keep an image of the last page, and print multiple
copies of it very quickly without any further
reprocessing. In this case it is faster to leave
Collate not selected, so that multiple copies of
each page are printed consecutively.

No pictures

If No pictures is selected, Ovation Pro will ignore
pictures and just print text. Only the picture frame
guideline is printed. On some printers such as
PostScript, printing pictures is very slow, so this
option may be useful for quickly printing draft
copies.

Reflect

Reflect prints a mirrored image of the document.
Tumble

If Tumble is selected and All Sides is selected,
then printing on the even sides will be rotated by
180 degrees. If Left/Right or Front/Back are
selected all printing will be rotated by 180 degrees.

This is useful for using a printer with a duplex unit
(which allows printing on both sides of the paper
in one pass).

It is also useful when preparing printout to be sent
to a commercial printer where it is necessary to
arrange the pages as required for the printing
machine.
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Set

All the options on the Print dialogue box are
stored in the document when it is saved. Click on
Set to set the values without actually printing
anything.

Print

Click on Print to print the document. The pointer
changes to an hourglass and the Printing dialogue
box is displayed (fig 12.7). It shows the Page and
Copy being printed, and if you are mail merging,
the current Record.

The green slider gives a visual indication of how
much of the print job has been completed, but
please note that this is only accurate to the nearest
whole page.

Separation indicates the colour of the plate being
printed when printing separations.

Click on Cancel to terminate printing. There is
only a limited amount of multitasking possible
when printing i.e. when the hourglass occasionally
turns back to the standard pointer, so there may be
a delay before Cancel takes effect. Usually it is
quicker to press Esc instead.

Click on Pause to pause printing. Again, there may
be a delay before Pause takes effect. When
paused, the Pause option changes to Continue
which you should click on to continue printing.

Fig. 12.7 - The Printing dialogue box.
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Printing Multiple Documents

You can print multiple documents by dragging a
selection directly from disc to the printer driver
icon on the icon bar.
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12.3 Advanced Print Setup Options
Select Print setup to expand the Print dialogue
box to display the advanced setup options

(fig. 12.8).

Fit

If Fit is selected, Scale is automatically set so that
the entire page fits inside the printable area. The
consequence of this is that your printed output may
become smaller, but all of it will be printed.

X and Y are automatically set so that the page is
centred within the printable area. However, if
Centre is also selected, the page will be centred on
the paper. This may result in the scale being
reduced further.

‘When Fit is selected, Scale, X and Y are shaded
and cannot be manually altered.

When calculating the scale, Fit takes Bleed and
Printers marks into account i.e. it ensures they
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Scale

Scale allows you to set how big the page is printed
on the paper. At 100%, the page is printed at
exactly the size specified in the document. So a
frame that is 100mm square in the document is
printed exactly 100mm square on the paper. To
print the page at half size, set the scale to 50%. If
you want to print an A4 page at AS size, set the
scale to 71%.

Aspect

Aspect allows you to set the horizontal scale of the
printed page. A value of 100% means that the page
is printed the same shape that it appears in the
document. To stretch the printed page sideways,
increase this value, or to squash it sideways,
decrease this value. So to print the page 10%
wider, set Aspect to 110%.

are within the printable area.

Print (Lasrjet 4M)
copes 1] /A Format[ Nomal  g|
@ Alpages  ORange | 15910180 |
@ Alsides ) Right Dbt
__|Pause _|Reverse _|Coliate
_|Nopictures _[Reflect _[Tumble
V@m

set | careal [

Fig. 12.8 - The extended Print dialogue box.
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Centre

If Centre is selected, X and Y are automatically
set so that pages are printed in the centre of the
paper.

‘When Centre is selected, X and Y are shaded and
cannot be manually altered.

XY

X and Y are the offsets from the bottom left corner
of the paper to the bottom left comer of the page
(fig. 12.9). They allow you to accurately position
printed pages on the paper.

Bleed and Printers marks are taken into account
if they are selected.

Sideways

If Sideways is not selected, pages are printed
upright on the paper. This is often called portrait
printing.

If Sideways is selected, pages are rotated through
90° and printed sideways. This is often called
landscape printing. Sideways is automatically
selected if the page format in the document is
defined to be Sideways in the New or

Page guidelines dialogue boxes.

Paper

Page

X

Fig. 12.9 - X and Y specify the position of the
printed page on the paper.

CHapTER 12

Bleed

If Bleed is not selected, the exact page area is
printed on the paper.

If Bleed is selected, the page area plus an extra
3mm margin all around the page, is printed.

If you want an object to go to the edge of the
paper, you must print the page on a bigger piece of
paper and trim it afterwards. Unfortunately
inaccuracies in trimming may result in a gap along
the edge of the paper. The solution is to bleed the
object off the page, then use the Bleed option to
print a slightly larger page. Trimming the paper to
the page size should then give perfect results

(fig. 12.10).

The amount of bleed may be changed, and saved,
in the Choices dialogue box (see 15.4)

IconbarMenu=>Choices=>Print=>Bleed
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Printers marks

Printers marks are positioned outside the page
area of your document (fig 12.10). If Crop
check has been set in Choices (see 15.4) you
will be alerted if the printable area is bigger
than the paper size. If you decide to proceed
the printout will be cropped.

If Printers marks is selected, crop marks are
printed around the edges of the page (fig. 12.10).
These are used to trim a page to size when it has
been printed on a larger piece of paper. In addition,
registration marks are printed at the centres of
each side of the page. These are used to help align
separated film.

The window which opens when you click on the
icon to the right of Printers marks lets you
choose which crop and/or registration marks are to
be printed.

The thickness and size of the printers marks may
be changed in Choices (see 15.4).

Fd n
Crop
marks
& ;3
Registration marks
I -lﬂ'.‘ |

Fig. 12.10 - Page showing Printers marks
and object bleeding off the edge of the page.
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Print Sheet

When the print format is set to Pamphlet or
Galley, the Print sheet option becomes available
and allows you to easily print individual sheets.
The Print sheet dialogue box shows the pages that
will be printed on the front and back of each sheet
of paper (fig. 12.11).

Sheet shows the sheet number that is currently
being displayed followed by the total number of
sheets required for the document. Click on the up
and down icons to step to other sheets.

Print sheet prints the current sheet. The options
Front and Back allow you to choose whether to
print the front or back of the current sheet.

The number of copies, scaling etc. are all set on
the normal Print dialogue box (fig. 12.8).

Fig. 12.11 represents what you see when you open the
print sheet window for this chapter and select the sheet
which contains this page (the Pamphlet print format
must be chosen first).

Front will print pages 176 and 173 sideways on an A4
sized page. Turn the page around. put back into the
printer, then select Back to have pages 174 and 175
printed on the reverse side.

Fig. 12.11 - The Print sheet dialogue box
allows you to print individual sheets.
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12.4 Background Printing

In general printing consists of rendering when the
document is converted into a form the printer can
understand and then spooling that data into the
printer via the parallel port etc.

There are two ways this process can be
accomplished;

Multitasking

This was the only way allowed under older
versions of RISC OS, rendering and spooling take
place at the same time, the printing application can
allow the desktop to run whilst printing is taking
place (hence multitasking), but only to a small
extent, so effectively the application takes over the
desktop for the whole time it takes to both render
and spool.

Background

This is the approach used in later versions of
RISC OS. There is no multitasking possible whilst
rendering is taking place, so nothing on the
desktop will respond to mouse clicks including the
Cancel button on the Ovation Pro Printing window
(fig. 12.7) and the Pause between pages option.
However the spooling phase can multitask well
and cause little interruption to using other
programs.

Another advantage of Background mode is that
!Printers will support queuing of both documents
to be printed and spooled data being fed to the
printer.

The choice between Background and Multitasking
mode depends on your needs. For many printers
(parallel port ink jet or laser) spooling takes longer
than rendering, so Background mode is the best.
For other printers perhaps those with a fast
interface or controlled by PostScript the spooling
phase may take little time, and the advantage of
having some control whilst rendering makes
Multitasking mode optimal.

Ovation Pro lets you use which mode is best for
you. This is done by the Background option on
the Print choices dialogue box.

IconbarMenu<>Choices<>Print choices

Background mode is not available on RISC OS 2
and it is possible that future versions of RISC OS
will not allow Multitasking mode.
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To gain the full benefit of Background mode,
‘Print in Background' must be selected on the
printer driver ‘Connections’ window in !Printers.
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12.5 Mail Merge

The mail merge facility allows you to print a
document a number of times, merging different
data into each printout. You insert merge tags into
the text at the required places, and specify a
comma separated value (CSV) file which contains
suitable data. When you print, the merge tags are
replaced by the data. This process continues until
all the data has been exhausted.

Typically mail merge could be used to print a
standard letter a number of times, merging
different names and address into each copy.

CSV File Format

The data used for mail merge must be in CSV
format. Many applications output data in this
format, or if you wish you can create your own
CSV file.

A CSV file comprises a number of records
separated by a carriage return or line feed. Each
record comprises a number of fields each separated
by a comma.

field 1,field 2,field 3<CR>

field 1,field 2,field 3<CR>

field 1,field 2,field 3<CR>

field 1,field 2,field 3

The example above has four records each
containing three fields. Notice that a carriage
return is not needed after the last record.

If data in a field contains a comma, the entire field
must be enclosed in double quotes:

"field 1,2",field 3,field 4<CR>

The filetype of the CSV file may be set to Text or
CSV.
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A simple CSV file containing people’s names,
might look like this:

Smith,John,Mr, 3456 7<CR>

Jones, Sue,Miss,34985<CR>
Clarke,Ian,Mr,33450<CR>
Simpson,Linda,Mrs, 33986

Creating CSV Files

You may create your own CSV file by typing the
data in the format described above, in a text editor
such as Edit. Press Return at the end of each
record, and only insert spaces where they are
needed as part of the text in each field. Once the
data has been prepared it should be saved to disc.

Creating CSV Files in Ovation Pro

You may create CSV files using Ovation Pro in a
similar manner. However, when you save the file,
you must use File=>Save story to save the file as
plain ASCII text.

If you later reload the CSV file into Ovation
Pro for editing, you must ensure that any
quotation marks in the file are not converted to
smart quotes using the Smart quotes facility.
If the CSV file contains quotations marks, you
should disable Smart quotes on Choices

(see 15.7).

Other CSV files

In general one can export a CSV file directly from
a Database to disc.
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Inserting Merge Tags
Menu>Misc>Insert->Merge tag... ATM

Once you have prepared the CSV file, you should
create the Ovation Pro document inserting merge
tags where you want to insert data (fig. 12.12).

To insert a merge tag, position the caret at the
required position and press Ctrl Shift M to display
the Mail merge tag dialogue box (fig. 12.13).
Now enter the number of the field to be inserted
and click on OK. Fields are numbered from 1
upwards. A tag of the form [Merge n]is
inserted in the text, where n is the field number.
when the mail merge is started, the merge tag will
be replaced by the field whose number is specified.
This will happen for each record in the CSV file.

The merge tag [Merge n], can be edited just
like normal text, but it behaves just like a single
character. You may apply effects and styles to the
merge tag, and these will be applied to the data
when it is merged.
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Example CSV File & Document
A simple CSV file might look like this:

Smith,John,Mr, 34567<CR>
Jones,Sue,Miss, 34985<CR>
Clarke,Ian,Mr,33450<CR>
Simpson,Linda,Mrs, 33986

The Ovation Pro document might look like this:
To: [Merge 3]
Dear [Merge 2]

Thanks you for your wvaluable
order, ref. [Merge 4].

[Merge 1]

‘When you use mail merge, the first record printed
will look like this:

To: Mr Smith

Dear John

Thanks you for your valuable
order, ref. 34567.

The second record will be:

To: Miss Jones

Dear Sue

Thanks you for your valuable
order, ref. 34985.

Notice the use of spaces between the merge tags,
and the last tag which is highlighted in bold.

Ovation Pro Mail Merge Example

Memo
To: [Merge 3] [Merge 1]
Dear [Merge 2]

Thanks for your valuable order, ref. [Merge 4].

Fig. 12.12 - An example Mail merge document, partly shown

ﬁudwmm

Fig. 12.13 - The Mail merge
tag dialogue box.
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Starting the Mail Merge
Menu>File->Print... Print

To start the mail merge, first open the File<>Print
dialogue box and set the number of copies and the
print format that you require. Once this has been
done, click on Set to set the options without
printing the document.

Now choose Mail merge to open the Mail merge
dialogue box (fig. 12.14).

Menu=>Filec>Mail merge...

The name of the CSV file to be merged should be
entered into the icon labelled CSV file. The easiest
way to do this is to just drag the CSV file into this
icon.

To perform the mail merge click on Print.
Ovation Pro will now print the document once for
each record in the CSV file. The current record
being printed is indicated in the Printing dialogue
box.

Before printing each page, the merge tags are
replaced by the data from the CSV file and the text
reflowed. If the fields in the data file are longer
than the merge tags, the text may overflow its
frame. To reduce the possibility of this happening
always ensure there is some blank space at the
bottom of text frames containing merge
commands.

The example CSV file, named CSVfile, and the
document shown on the previous page, named
MailMerge, are supplied with Ovation Pro in the
directory 12_Examples.
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Ignore headings record
The Ignore headings record button allows you to
make Ovation Pro ignore the first record in the

CSV file. Some CSYV files use this record for the
names of the fields.

First

The First button will mail merge in the first record
of the CSV file. Once this has been clicked on the
other buttons will become available,

Next

Next merges in the next record, after having
selected First.

Clear

Clear terminates the merge process, and the merge
tags in the document revert to their usual
appearance e.g, [Merge 1].

First, Next and Clear let the merge takes place
without any printing, so you can preview the mail
merge without using paper. At any time the Print
record button will print the document in it’s
current state i.e. with merge tags replaced by a
record from the CSV file.

Fix

The Fix button permanently replaces the mail
merge tags with their current values. Use this with
care! Effectively it creates a new document and
you lose the old one.

Fig. 12.14 - The Mail merge dialogue box.
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12.6 Mail Merge, advanced features
Fields

Mail merge fields are conventionally referred to by
anumber 1. . n corresponding to the field in the
CSYV file being merged. So field 1 is replaced by
the first field in the CSV file and so on.

It is possible to associate with each field, two
strings, firstly a name which is not currently used.
Secondly a command. This is a macro which is
evaluated each time the merge field occurs in the
document.

A button on the mail merge window, called

Fields... allows access to a window which can be
used to manipulate these field strings.

Menu=>Filec>Mail merge...~>Fields...

Various tricks can be played using field
commands:

1. Adding sequential numbers to documents whilst
printing;

2. Adding random numbers to documents whilst
printing;

3. Generating new mail merge data on the basis of
other fields e.g.

(if (field(1l)=="Mr.") macv="his"
else macv="her"}

4. Merging more than one CSV file record into one
print of one document. This provides a solution to

the old problem of how to do a mailmerge on a
sheet of address labels;

5. Generating mail merge data from other sources,
e.g. the Impulse protocol;

6. Manipulating mail merge data, e.g. removing
blank lines from addresses.

Some examples follow for using Fields. For these
examples a CSV file called UK is included in the
directory 12_Examples.

A description of all the script functions can be
found in the separate Script document.

Mail Merge can also be done with pictures (see
10.12).

It is possible to control the way merged printing is
formed into print jobs (see 15.4).

It is not possible to have more than one merged
print of a document on one sheet of paper.

CHaAPTER 12

12.7 Mail Merge, some examples

1. Generating Address Labels

The problem: you have a CSV file of names and
addresses, one name and address per record. You
have sheets of A4 sticky labels, perhaps 20 to a
page, and you want to print the names and address
20 to a sheet on the labels.

And the solution;

a. Design a label. Insert into it mail merge tags for
each field in the CSV file. e.g. 1,2,3. After all the
usual tags, add one more, e.g. tag number 99

(fig. 12.15)

b. Open the Fields window. Click on New, enter a
number of 99, and a name of next. For the body of
the field enter { nextrecord ()} (fig. 12.16).

c. Duplicate as many labels across and down the
page as you require.

d. Remove from the last label on the page mail
merge tag 99.

e. You can now do a standard mail merge
operation on the page, for each label on the page,
one record from your CSV file will be merged.

The document Examplel in 12_Examples
demonstrates the above.

A questionable area with this technique is what is
meant by the ‘last label’, this is the last piece of
text that the mail merge data will be merged into,
usually it will be the frame which is at the front,
i.e. on top of all the other frames.

( Merge 1]
[Merge 2]
[Merge 3]
[Merge 4]
[Merge 5]
[Merge 6]
[Merge 99]

\ J
Fig. 12.15 - The merge tags in a label. See Example1

Fig. 12.16 - Entering the command in the Fields window
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2. Adding sequential numbers to
documents.
Or how to print your own raffle tickets.

The situation here is that we want each document
to have its own unique number.

The solution;

a, Install the Unique number applet.
b. Create a field, say number 99.

c. For the body of the field enter:

{macv=(unique_getprefix() +
unique_getnumber());unique_putnumber (
itos(stoi(unique_getnumber()) + 1));}
The unique number generated will follow the same
rules as explained for the unique number applet.

d. Use tag number 99 in your document when
inserting the merge tag. AfM.
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3. Adding Random numbers to documents
Or how to print your own bingo tickets.

Here we want to have random numbers appearing
in documents. The solution is similar to that in the
previous section. The only problem is obtaining
random numbers. To do this it is necessary to add
a random number generator to the Ovation Pro
script library. This is provided in the !MergeLib
script in !OvnPro.Library.
Now follow the steps in the previous section, but
this time step c is;
c. {macv=itos(merge_random(49))}
It is supposed that 49 is the highest possible
number. Otherwise change this number.
If you really were printing bingo tickets you’d
have to add some checks to prevent the same

numbers being printed more than once on
individual tickets.
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4. Creating new mail merge data from
other fields.

The first example of this is using the POBar applet
(which creates UK Post Office bar codes) to
automatically insert bar codes into the mail merge.

This is done as follows;

a. Create a new field, e.g. tag number 99. Now
assuming that the CSV file you are merging
contains the post code in field 6, enter this for the
field body.

{macv=bar_code("",field(6),"1A")}

b. Insert mail merge tag 99 in your document to be
printed, e.g. usually a label. This tag should be
surrounded by white space, be in the POBar font at
14pt, and be horizontal or vertical.

The document Example4 demonstrates the above.
Note that you must have the POBar applet and font
installed for any of the above to work.

Another example is customising printed
documents on the basis of some mail merge field.
For example setting up the following for the body
of a field.

{if (field(1l)=="Mr".) macv="his" else
macv="her"}

With this field created, you can use the
corresponding tag in place of the words “his” and
(ihar!!.

Yet another idea is to create some data if a field in
the CSV file is blank. This field definition might
be used;

{if(field(5)=="") macv="No fax
number" else macv="Fax: "+field(5)}
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5. Generating Mail Merge Data From Other
Sources

Usually mail merge data comes from the ‘CSV
file’ a file implicitly associated with the mail
merge operation. With the new features this need
no longer be the case. It is for example quite
possible to use the First and Next buttons with no
CSV file at all. Even if the CSV file is being used
some data can come from other sources. You could
read a name from the CSV file, and then find data
associated with that name in another file, and
merge it into the document.

A ‘mail merge’ with no CSV file gets into the
realms of macro text. One idea is to set up a tag
which allows you to write “Continued on page
[X]". When the fields are replaced X would be
filled in with the page reference - this would
probably make use of the book mark manager.

Another idea would be to support text of the form
“page 1 of [X]".
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6. Manipulating Mail Merge Data

The first example of this is how to remove blank
fields from records. Typically some addresses will
have 4 lines, others 5, but the post code will
always be in the 6th field. You want to avoid
unsightly blank lines.

A horrible solution is followed by a simpler one.
For each of the fields in the CSV file, set up a field
with this body. Note that one number changes for
each field. The line below is for field 5.

{int i=1,j=1;while(j<=5 &&
i<=maxfield()) {if(field(i)!="")j++;
i++;} macv=field(i-1);} (fig.12.18)

The document Example 6 demonstrates this.

Notice that the above code uses maxfield () to
set the limit on the number of fields that will be
searched for blanks. However the example CSV
file UK in 12_Examples only uses fields 2 to 6 for
the address, later fields are used for other
information which we don’t want to appear on the
label. To get around that, replace maxfield()
with the number 6. It is also necessary to replace
eachmacv=field(i-1) with
macv=(j<=5)?"":field(i-1);

replacing 5 with the appropriate number.

Fig. 12.17 - The merge tags in a label

i .:lialdm. ﬁﬂﬁeﬁi]r-"ﬁu; ieei} mmwﬁn‘dti—?):]
cfield() (iffield(i)t=")++; ++:} macvefiekd(i-1};}
pfield(}} fittfeld(i}l="Y++; i++ ) fiakd(i-1):}
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The above field definitions are tedious to type. The
!MergeLib file mentioned in section 3, provides a
function which does all the hard work. You can
now use for the field bodies;

{macv=merge_strip(5,maxfield())} (fig. 12.19)

Here the first number is the intended field number
(1 to 6 in the example), the second argument of the
function can as before be replaced with the last
field of data to be entered, as in the last but two
paragraph this could be;

{macv=merge_strip(5,6) }

In both of these cases you would of course define
six fields, and enter these macros with the first
number stepping between 1 and 6. The document
Example6a demonstrates this.

{macv=merge_strip(2.6)}
|macvemerge_strip(3.6)}

 pubeld) (IHfeld(i) b4+ i++:) macv=fieid(i-1):}
> Pliiee) fieid (1)}

(macv=merge_strip(4,6)}
{macv=merge_strip(5.6)}

{int I« 1 = 1;while(j<=6 &8 i<=maxfisla()) {if(fie

{macv=merge_strip(6.6))

fresaes L o il £

Fig. 12.18 - The general commands for the merge tags to
avoid blank lines. Field 6 shows the start of the command

Fig. 12.19 - Using the script command "merge_strip".
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7. The Impulse Protocol

This is a protocol invented by Computer Concepts
to allow programs to exchange data and control
one another. Typically Ovation Pro acts as the
server (or slave) program, and another application
controls a mail merge process. So you may be
using the Impact database program and ask it to
produce a standard letter with someone's details
merged in. Impact will load an Ovation Pro
document into Ovafion Pro, and then tell

Ovation Pro to merge data into the document
(using the Impulse protocol). Ovation Pre then
asks Impact to supply the data for various merge
tags (again using the Impulse protocol). Impact
may then instruct Ovation Pro to print the
document and finally remove the merged data
from it.

To use the Impulse protocol the |Impulse applet
must be installed in Ovation Pro.

From the user’s point of view, the problem is how
to set up the bodies of the mail merge fields so that
they use the Impulse protocol to get data.

If you have Impact there is a simple way of doing
this. Impact allows you to drag text files of
Impression DDF commands into documents at the
point where you want the mail merge data to
appear. You can use exactly this technique with
Ovation Pro. You must have the ! TransDDF
loader visible and it has to have been modified so
that it will inspect text files as well as DDF files
with the correct file type.

To do this, you must modify the !Boot and !Run
files inside !TransDDF. In each of these files there
is a line;

| Set FFGServer$TransDDFa -T &FFF &B25
-R TransDDF$Dir

Remove the | from the start of the line and then
resave the file.

When you drag the DDF files into the Ovation
document the necessary fields will be created
automatically.

The other option is to set up the fields yourself. As
usual you use the fields window and create fields
for the mail merge tags you want to use. The key
to using Impulse, is that there is in Ovation Pro a
new function impulse () which takes as its
argument an impulse command and returns a
string.
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This is a typical body for an impulse field;

{macv=impulse(":Impact.Addresses
Fetchaddress")}

As usual with Impulse the name after the colon
(Impact) is that of the program the command is
aimed at, and the second string Addresses is
that of the document the command applies to, there
then follows the command (Fetchaddress).
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The first part of this chapter describes how to prepare Ovation Pro
documents for lithographic (litho) printing. Litho printing is the most
widely used printing process today, and is suitable for most applications
(except for very short runs of less than, say, 500 copies).

If your document only needs to use two or three basic colours, you can
print it very economically using spot-colour printing. If you want to print
using the full range of colours, then you should use full-colour printing.
When printing it is often necessary to modify the appearance of pictures
and graphics. Information on this is given in the second part of this
chapter.

B. Image Processing
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13.1 Installation

This chapter describes the facilities provided

by the Ovation Pro Colour Supplement. This
supplement to the main program is provided in the
form of an extension applet, which must be
installed before it can be used.

The applet is called !ColSupp. It must be copied
into the directory !OvnPro.Applets, and then
Ovation Pro must be re-run.

By default the Colour Supplement applet is
installed, so unless you have removed it, you
probably need to do nothing.

CHapTER 13



Secmion 13.2

13.2 Litho Printing

After completing and checking your document, the
first job is to have it typeset. This involves printing
the document to a PostScript file and sending it to
a typesetting bureau (see /3.8). Occasionally, a
bureau will accept Ovation Pro files directly.

The bureau will print a very high quality original
of your document using an imagesetter.

For high quality or full-colour work, they will
usually produce film. This can be used directly to
make the printing plates.

A cheaper alternative is a bromide (photographic
paper), which needs to be photographed to produce
the printing plate. This is often called camera-
ready copy.

Your printer will be able to tell you which is the
best material for a particular job.

Proofs

For full-colour work, it is essential to proof your
work before it is printed. A proof is a high quality
colour print produced directly from the set of four
film separations. The two dry-proofing processes
that are often available are called Chromalin and
Matchprint proofs. They are quite expensive, but
allow you to check that everything is correct
before the more-expensive print job commences.

Ask your bureau which proofing process is
available, and how much it will cost.
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Printing

A litho press uses a printing plate wrapped around
arevolving cylinder. The printing plate, which is
presensitized with a light-sensitive coating, is
placed in contact with the film and exposed to
high-intensity light. After exposure the plate is
treated with an emulsion developer leaving a hard
image on the plate, which is then treated with a
greasy medium.

After being mounted in the press, the plate is first
dampened and then coated with ink. The areas
coated with grease attract ink, while water on the
areas not to be printed, repels ink. The ink is then
transferred to a rubber blanket cylinder, before
being transferred to the paper.

The process is often called offiset litho printing
because the printing plate does not come into
contact with the paper.

Colour Printing

The process described above prints one ink onto
the paper. To print another ink, the operator has to
change the plate, change the ink and then print
onto the paper for a second time. This explains
why two-colour spot printing is cheaper than full-
colour printing using four inks.

Some printing presses can print more than one ink
at a time, but due to the more complex setting up
required, they are normally only economical for
long print jobs.
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13.3 Spot-Colour Printing

If your document only needs to use two or three
basic colours, you can print it very economically
using spot-colour printing. If you want to print
using the full range of colours, then you should use
Sfull-colour printing.

Spot colour work is simpler to achieve than full-
colour work, and two or three spot-colour work is
always cheaper than full-colour work.

First you need to decide whether you want to print
with two or three colours. Using three colours will
be more expensive, but will give a greater scope
for designing the document.

Note that in addition to the basic colours you can
use any number of tints of those colours. For
example, if you are doing a two-colour job using
black and red, you can use greys and pinks.

Menu=>Misc=>Edit colours...
Use the Misc=>Edit colour dialogue box to
create named colours for each of the spots (in the
example above, both black and red already exist),

and for each colour choose the Spot colour option
at the bottom of the dialogue box (fig. 13.1).

__| Non-printing

Fig. 13.1 - The Edit colour dialogue box.
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Specifying Colour

‘When you print spot-colour separations, each basic
colour and any tints are placed on a separate plate.
It is essential for you to tell the printer the precise
colour to be used for each plate. You can do this
by choosing colours from a standard swatch.

Spot colours defined in Ovation Pro are used for
the screen display only, so it doesn’t matter if they
don’t match the eventual printed colour. However,
in order to help you visualise what the printed
document will look like, it is useful to define the
screen colours to match the printed colours. You
can do this by defining colours using CMYK
values obtained from the colour swatch you are
using.

In order for the printer to know the colour of each
plate, Ovation Pro prints the colour name at the
top of each separation. Therefore, it is useful to set
the Ovation Pro colour name to the name given on
the swatch.
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13.4 Full-Colour Printing

In printing, most colours can be reproduced by
mixing the correct proportions of the three process
colours - cyan, magenta and yellow. Black and
greys can be reproduced by combining equal
amounts of cyan, magenta and yellow, but in
practice this gives poor results, so a black ink is
also used to add finer detail and greater density.

‘When you print separations, any colours that have
not been designated as spot colours will be
separated into CMYK components. When the
CMYK separations are printed, they will combine
to reproduce the colour of the original.

Tint Charts

‘When full-colour printing, your document can use
any colours defined using the Edit colour dialogue
box. However, the eventual printed colours may
differ from those viewed on the screen (see 13.5).
It is therefore essential to select colours from tint
charts.

A tint chart usually shows samples of over a
thousand tints made up from cyan, magenta and
yellow. Once you have found the colour required,
you should read the cyan, magenta and yellow
values from the chart and use them to define a
colour in Ovation Pro. The chosen colour may not
look correct on-screen, but provided it has been
defined using the CMYK model, the printed colour
should match the colour in the tint chart.
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13.5 Colour Correction
RGB to CMYK Correction

In order to print RGB (and HSV) colours used in
Ovation Pro documents in a full-colour process,
these colours must be converted to CMYK. A
simple translation that assumes process inks used
in printing are the inverse of RGB light, gives
inaccurate colour reproduction. Ovation Pro
provides a correction system that improves this.

Before printing full-colour separations you should
select the Use correction table option on the
Colour Choices dialogue box (fig. 13.2).

IconbarMenu=>Choices—>Colours

When this is selected, Ovation Pro uses a special
algorithm and separation tables to apply correction
when converting RGB colours to CMYK colours.

Note that this does not affect colours defined using
the CMYK colour model. Nor does it affect spot-
colour printing.

The Use correction table submenu allows
different separation tables to be chosen for
different typesetters. The default table, TypeSet,
should be suitable for most situations.

Alternative compatible tables can be added by
copying them into the directory:
!OovnPro.Applets. !ColSupp.Resources
.cmyk
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CMYK to RGB Correction

Ovation Pro provides a system to improve the
display of CMYK colours (intended for output to a
four-colour press) on an RGB colour monitor.

To enable this feature, choose Use inks to display
CMYK colours from the Colour Choices dialogue
box (fig. 13.2).

Note that even though this does improve the
accuracy of CMYK colours on-screen, you should
not entirely rely on the colour you see on the
display. For precise colour reproduction always
specify colours using CMYK values chosen from
tint charts (see 13.4).

The sub-menu provided above this option allows
you to choose different ink mapping files that
control how RGB is mapped to CMYK for
different printing processes. Currently two ink
mapping files are provided. Both are for SWOP
printing (Standard Web Offset Printing) colours.

Note that currently the ink mapping file is only
used for converting CMYK to RGB, not for
separating RGB into CMYK.

@ Use correction table

Table | Typeset

) No correction

| Use inks to display CMYK colours

Mep |

SWOP on coated stock “H|

goas) el o]

Fig. 13.2 - The Colour Choices dialogue box.
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13.6 Preparing Your Document
Overprinting
Menu=>MiscevEdit colours...

Overprinting is used to compensate for
misalignment of printing plates during printing.
Suppose your document contains some black text
printed on a cyan background. The black plate will
contain the black text (fig. 13.3). The cyan plate
will contain the cyan background with a ‘knock-
out’ for the black text (fig. 13.4).

If the document is printed with the plates exactly
in register, the black text will be printed exactly
over the white ‘knock-out’ (fig. 13.5). However, if
there is misregistration, thin white gaps can be
seen around the text (fig. 13.6). This problem
doesn’t just happen with text, but applies to all
overlapping objects.

Overprinting helps solve this problem by
preventing the background from being knocked-
out. So in the example above, the background is
printed solid cyan without the knock-out, and the
black text is printed on top of the cyan.

This generally only gives acceptable results when
printing relatively opaque inks, such as black.
Overprinting less opaque colours, such as yellow,
may show a colour shift when overprinted.

Overprint

Overprint

Fig. 13.3 - The black plate
containing the black text.

knock-out for black text.

OVErprint:

Fig. 13.5 - Correctly printed
with no misregistration.

Fig. 13.6 - Printed with
misregistration.
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Colour Level Overprint

You can specify that a particular colour will
overprint by choosing the colour on the Edit
colour dialogue box and then choosing Overprint
this colour from the Overprint dialogue box

(fig. 13.7).

Overprint limit specifies the tint above which an
object colour will overprint its background. So the
default value of 90% means that overprint will
only occur with tints of 90% and above. This
option prevents lighter tints, which are less
opaque, from overprinting.

Object Level Overprint

You can specify that a particular object will
overprint by choosing Overprint on the colour
picker when applying colour to an object.

Fig. 13.4 - The cyan plate with

Fig. 13.7 - The Separations dialogue box.



192 CommerciaL CoLour PrRINTING

Font Mapping

If your document uses RISC OS fonts for which
there are PostScript equivalents, use

!FontPrint to map the RISC OS fonts to the
PostScript fonts. This is the recommended
procedure, but only if your bureau has the font you
require, Note that the PostScript printer driver
contains default mappings for many standard fonts,
s0 it is unnecessary to map Acorn fonts such as
Corpus, Homerton and Trinity.

!FontPrint is an Acorn application supplied
with RISC O8S, and can usually be found in the
Printing directory of your hard disc.

Any unmapped fonts are written into the
PostScript file and temporarily downloaded to the
typesetter for the duration of the print job. This
will increase the size of the PostScript file, but it
allows any Acorn font to be printed even if there
isn't a PostScript equivalent.

Note that you should not use the Download option
provided in ! FontPrint. This downloads RISC
OS fonts to the typesetter whenever !Printers
is started. These take up large amounts of memory,
which is not released even after the file has
printed.
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Ovation Pro Page Size

Set the required page size in Ovation Pro using the
New (see 11.2) or Page guidelines (see /1.3 -
Page guidelines) dialogue boxes.

The maximum page size that you can typeset
depends upon the typesetting bureau you are using.
You should have no problem up to A3, but above
that you should check the maximum width with
your bureau. Remember that printers marks
increase the overall dimensions by 14mm. That is
if you use the default values for the crop marks
(see 12.3 - Printers marks).
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Printing Pictures

You can set half-tone screen information for the
selected picture on the Halftone screen dialogue
box (fig.13.8).

Menu<>Picture=>Screen...

The options in this dialogue box are intended for
experienced users, and should not normally be
altered.

Note that you can also change the half-tone screen
information for all pictures in a document (see
13.7, step 6).

Frequency is the density of the half-tone screen,
measured in lines per inch. Usually a frequency of
100 is suitable for monochrome work and 150 for
process colour work.

Check with the bureau/printer if you are in doubt.

Spot specifies the shape of the half-tone dot. Use
the default, unless you are experienced in creating
PostScript separations.

Angle specifies the half-tone screen angle for the
ink highlighted in the panel above. Unless you are
experienced in creating PostScript separations, you
should use the default angles as supplied. If the
wrong halftone screen angles are set, an
undesirable screen clash, called moiré, may occur.

Black: 150 Ipi, 45

Cyan: 150 Ipi, 105°
Magenta: 150 Ipi, 75°
Yellow: 150 Ipi, 90°

Fig. 13.8 - The Screen dialogue box.
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Checking the Separations

At any time you can use the Separations menu to
view any of the individual separations on-screen.

Menu=> Viewr>Separations

This menu will help you check that correct number
of separations are being printed i.e. there are no
additional spot colour plates. Experienced users
will be able to use this option to check that the
overprint settings are correct.
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13.7 Creating a PostScript File

© If you are producing full-colour separations,
ensure that colour correction is enabled and
the correct table is selected.

The standard colour correction table called
TypeSet should normally be used. This is
confirmed in the title bar of the Separations
dialogue box.

Print=>Print setup->Separations

You can change the colour correction table using
the Colour Choices dialogue box (see 13.5).

IconbarMenu=>Choices=>Colour

@ Load a suitable PostScript printer driver
and configure it to print to file.

In most situations you should use the PostScript
Level 1 driver. Please refer to your computer user
guide for details of how to print to a file.
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® Choose a suitable PostScript paper size.

The PostScript printer driver provides a wide range
of standard paper sizes e.g. A2, A3 and A4.
However, printers marks increase the dimensions
of the page, so using these standard sizes may
result in your page being cropped.

You should create and use your own paper
definition when producing PostScript output for
typesetting. Set the paper size to the Ovation Pro
page size, plus 14mm for the printers marks. The
graphics margins should be set to 0. So the paper
size for an A4 page should be 224 x 311.

Note that if you do not set a big enough paper size,
Ovation Pro will warn you when printing.
However, to avoid this warning every time you
print, you should set up a suitable paper size before
printing as described above.
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© Set the options on the Print dialogue box.
Menu=>File~Print Print

Reflect causes pages to be mirror printed, and
should usually be selected if you are printing to
film. However, please check with your bureau
first. If they require emulsion side down, Reflect
should be selected; if they require emulsion side
up, Reflect should not be selected.

Choose Print setup to expand the Print dialogue
box to display the advanced setup options.

Centre should be selected.

Bleed causes Ovation Pro to print an extra 3mm
margin around the edge of the page. If your
document contains objects that bleed off the edge
of the page, choose the Bleed option.

W S T ey G B |

Separation names & /

other info Crop
marks

\ Registration marks /

Colour bar

Fig. 13.9 - Printers marks.
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Printers marks should be selected. This causes
Ovation Pro to print the following special marks
around the edge of the page (fig. 13.9).

Crop marks show the edges of the page and are
used to trim the page to size.

Registration marks are used to help align the
separated film when preparing the printing plates.

Separation names causes the name of the ink to be
printed on each separation. The document name,
page number, date and time are printed after the
ink name. You can edit this information or add
your own text using the Text option on the
Separations dialogue box (see overleaf).

The Colour bar is used to check the quality of the
colours on the proofs. Note that the colour bar is
not printed on spot separations.
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© Set options on the Separations dialogue box.
Print=>Print setupr>Separations

Colour separations should be selected when you
are printing full colour or spot colour separations
(fig. 13.10).

The Plates menu allows you to choose which
separations to print.

All process prints separations for the four process
colours. This is the default setting.

All spots prints separations for all spot colours.
The Plates menu also list the four process colours
followed by any spot colours that have been
defined. You can choose to print individual plates
by ticking and unticking them directly on the
menu.

= Separations (Typesel) |
_|Colourseparations '
Plates [ Allplates =

Téic"t-[{rﬂename; P{pagenumber} {Cﬂteﬁma]{lr\?:

Fig. 13.10 - The Separations dialogue box.
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The Text icon allows you to specify any additional
text that is to be printed after the separation name
in the top left corner of the page (see fig. 13.9). In
addition to ASCII text you can insert macros
which will be expanded during printing. The
following macros are particularly useful:
{filename}

{filepath}

{chapternumber}

{pagenumber}

{date}

{time}

{datetime}

The default string is set to:

{filename} P{pagenumber}{datetime}
which typically expands to:

Documentl P1 11:4lam 27 February 1997
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@ Set options on the Screen dialogue box.
Print<>Print setup=>Separations=>Screen

PostScript screen causes half-tone screen
information to be written into the PostScript file,
and should usually be selected (fig. 13.11).

Note that the options in this dialogue box are
intended for experienced users, and should not
normally be altered.

Frequency is the density of the half-tone screen,
measured in lines per inch. Usually a frequency of
100 is suitable for monochrome work and 150 for
process colour work.

Check with the bureau/printer if you are in doubt.

Spot specifies the shape of the half-tone dot. Use
the default, unless you are experienced in creating
PostScript separations.

Angle specifies the half-tone screen angle for the
ink highlighted in the panel above. Unless you are
experienced in creating PostScript separations, you
should use the default angles as supplied. If the
wrong halftone screen angles are set, an
undesirable screen clash, called moiré, may occur.

Halftorie screen
P

I Cyan: 150 Ipi, 105° E |
] Magenta: 150 Ipi, 75° A

] ¥
|

Yellow: 150 Ipi, 90°

Fig. 13.11 - The Screen dialogue box.
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@ Print to the PostScript file.

Once all the above options are set correctly, click
on OK in the Print dialogue box to create the
PostScript file.

When printing the usual Printing dialogue box is
displayed showing the progress that has been
made. the icon in the bottom left-hand comner of
this dialogue box shows the colour of the
separation currently being sent to the printer.



198 CommerciaL CoLour PRINTING

13.8 Submitting the File to a Bureau
Most bureaux cannot read Acorn format discs, so
your files must be submitted in PC or Apple
format. Please check with the bureau which format
they prefer.

PC format discs can be formatted and written to
directly from your Acorn system, but make sure
that any PostScript files are given a ps file
extension.

To format and write to Apple format discs, you
need to purchase a separate utility to do this.

For small jobs you will be able to send the

PostScript files using floppy discs. For bigger jobs

you will have to use one of the following

alternatives:

= Split the job into separate parts so that each
part will fit on a floppy disc

= Use a file archiver such as !SparkFS to
compress the files in Zip format. However, you
must ensure that the bureau has suitable
software to decompress the files.

» Transfer files using removable drives such as
CDR or Zip drives.

» Transfer the files electronically using direct
modem connection or perhaps via email.

CHarTeR 13
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B. Image Processing
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Ovation Pro enables you to modify the appearance of imported bitmap
and vector graphics using simple brightness, contrast and gamma
sliders. You can also define custom settings by editing points on the
colour map. Any of the three standard colour models may be used to
make adjustments.

Ovation Pro also allows you to change colour pictures into monochrome
pictures, and to change the foreground and background colours of
. monochrome pictures.

Image processing can be applied to Sprites, JPEG's, Draw files and
ArtWorks files.
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13.9 The Process Dialogue Box
Menur>Picture~>Process...

The Process dialogue box (fig. 13.1) is available
from the main menu when a picture frame is
active. Image processing can only be applied to
one picture at a time.

Model

This is the colour model that will be used when
you are modifying the picture. For CMYK
pictures, CMYK is the default model. For other
pictures, RGB is the default model. You can
choose any colour model for any picture,
irrespective of the picture type. However note that
processing a CMYK picture using the RGB setting
will often mix colours between the CMYK plates.
This may be highly undesirable.

Colour

This is the colour component that will be modified.

The colour map displays a coloured curve for each
of the components.

If you choose All, all colour components for that
model will be modified in one operation, and the
curve of the map is shown in black.
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Update

By default the Update option is selected, meaning
that the picture is updated instantly as changes are
made in the Process box.

If Update is not selected, the picture is not updated
until you click on OK. This prevents the picture
from being updated after each change you make,
which might be quite slow for very large pictures.
Defauit

Click on Default to cancel any processing that has
been applied to the picture.

If you have closed the Process dialogue box, you
can always return to the previous picture settings
using the Undo option.

(@ RGB ) CMYK ) HSV
@An OR D6 U8B

‘Brightness | ]

[ d |«>

Contrast | 1

Lo |«

' Gamma | 1

__|Usespots [V Update

[ >

_|ouowone  Lower I Bl Voo [ E

 Defautt | Cancel || oK |

Fig. 13.1 - The Process dialogue box.
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Use spots
If this is selected any spot colours in ArtWorks
files will act as spot colours.

In order to get a spot colour in an ArtWorks file to
appear on a spot plate the following conditions
must be true.

1. The ArtWorks file must have a spot colour
defined in it.

2. The image processing window must have the
Use spots button selected.

3. The Ovation document must have a spot colour
with the same name as the ArtWorks spot colour.

I (white)

Output

0 (black)
0 Input 1
(black) (white)

Fig. 13.2 Colour map.
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Colour Map

The colour map illustrates the changes made by
the brightness, contrast and gamma sliders. Later
on in this chapter you'll see how it can be used to
define a custom colour map.

The map shows a picture’s input values on the
horizontal axis, plotted against output values on
the vertical axis (fig. 13.2).

When the map is a 45° line from 0,0 to 1, 1,
output values equal input values i.e. normal
brightness and contrast (fig. 13.3).

Fig. 13.3 Output values equal input values.
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13.10 Brightness, Contrast & Gamma
Menu<>Picture=>Process...

You can change the brightness, contrast and
gamma values of a picture using the sliders located
in the centre of the Process dialogue box.

Brightness

Drag the Brightness slider to the right to increase
brightness, or to the left to decrease brightness.
‘When the slider is in the middle, there is no
modification.

Brightness may also be specified by setting a value
in the writable icon to the right of the slider. A
value of 0 means no modifications, -100 means
minimum brightness and 100 means maximum
brightness.

The colour map illustrates the changes made to the
brightness slider. If you increase the brightness,
the line on the map moves up and the output values
become higher than the input values (fig. 13.4). If
you decrease the brightness, the line moves down
and the output values become lower than the input
values (fig. 13.5).

Note that the brightness slider adjusts the levels of
colour according to the current colour model, so
the description given above is only true for the
RGB colour model.
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CMYK and HSV Models

With the CMYK model, the brightness slider
increases or decreases the levels of Cyan,
Magenta, Yellow and Black. So, an increase in
levels of CMYK, results in a decrease in
brightness. A decrease in levels of CMYK, results
in an increase in brightness.

With HSV, the brightness slider increases or
decreases the levels of Hue, Saturation and Value.
It is not very useful to increase or decrease all
three HSV levels simultaneously, but it can be
useful adjusting them individually.

Fig. 13.4 Increased brightness.

Fig. 13.5 Decreased brightness.
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Contrast

Drag the Contrast slider to the right to increase
contrast, or to the left to decrease contrast. When
the slider is in the middle, there is no modification,

Contrast may also be specified by setting a value in
the writable icon to the right of the slider. A value
of 0 means no modifications, -100 means
minimum contrast and 100 means maximum
contrast.

The colour map illustrates the changes made to the
contrast slider. If you increase the contrast, the line
on the map is rotated anti-clockwise, reducing the
range of input values (fig. 13.6). If you decrease
the contrast, the line is rotated clockwise, reducing
the range of output values (fig. 13.7).

Note that the contrast slider adjusts the levels of
colour according to the current colour model, so
the description given above is only true for the
RGB colour model.

0 |

Fig. 13.6 Increased contrast.
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CMYK and HSV Models

With the CMYK model, the contrast slider
increases or decreases the levels of Cyan,
Magenta, Yellow and Black. So, an increase in
levels of CMYK, results in a decrease in contrast.
A decrease in levels of CMYK, results in an
increase in contrast.

With HSV, the contrast slider increases or
decreases the levels of Hue, Saturation and Value.
It is not very useful to increase or decrease all
three HSV levels simultaneously, but it can be
useful adjusting them individually.

Fig. 13.7 Decreased conlrast.
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Gamma

Drag the Gamma slider to the right to increase the
gamma value, or to the left to decrease the gamma
value. When the slider is in the middle, there is no
modification i.e gamma value is 1.

Gamma may also be specified by setting a value in
the range is 0.05 to 5.75, in the writable icon to the
right of the slider. The up/down icons can be used
to step through this range in 0.01 increments for
values below 1, and 0.05 for values above 1.

The colour map illustrates the changes made to the
gamma slider (figs. 13.8 & 13.9).

Note that the gamma slider adjusts the levels of
colour according to the current colour model.

Fig. 13.8 Gamma value of 1.8,

0

Fig. 13.9 Gamma value of 0.75.
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13.11 Custom Colour Map
Menu=>Picture=>Process...

You can create custom colour maps using the 4

tools provided (fig. 13.10).

Linear

Choose this tool to reset the colour map to a 45°
line from 0, O to 1, 1. This sets output values equal
to input values i.e. normal brightness and contrast.

Note that the brightness, contrast and gamma

sliders are only available when this tool is selected.

Straight Segment

Choose this tool to convert the current map into a
series of straight line segments. You can edit the
map by dragging the control points. Click Select to
add new points, or click Adjust over points to
delete them.

Linear

Straight segment

Curved segment

Invert —— D ;

Fig. 13.10 - The custom colour map.
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Curved Segment

Choose this tool to convert the current map into a
series of curved line segments. You can edit the
map by dragging the control points. Click Select to
add new points, or click Adjust over points to
delete them.

Invert

Choose this tool to flip the colour map upside
down. This produces a negative of the curve
currently shown on the graph.

Note that you can use the Invert tool to invert the
adjustments made by the brightness, contrast and

gamma sliders.
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13.12 Duotones
Menur>Picturec>Process...

The Duotone option allows you to specify the two
colours used in a monochrome picture. If the
current picture is multi-coloured, it is converted to
monochrome first.

Lower allows you to specify the new colour for
the black component of the monochrome image
using the standard colour picker. Upper allows
you to specify the new colour for the white
component of the monochrome image.

Duotone is particularly useful when commercially
printing documents using spot colours. It allows a
colour or monochrome picture to be printed using
white and any individual spot colour, or even using
two spot colours.

Deselect Duotone to revert back to the original
image.

! vs
Fig. 13.11 - The original Fig. 13.12 - In black and
picture white

CHarTER 13
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The Spelling Checker
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Ovation Pro will allow you to check text visually by marking up words or
interactively. The spell checker can also find repeated words.

The Ovation Pro spelling checker checks the spelling of words in the
document and identifies those that have been misspelt or mistyped. To
help you make corrections, it can suggest the correct spelling or allow
you to browse through a dictionary for the correct word.

The spelling checker cannot identify correctly spelt words that are used
in the wrong context, so you should always read your documents
carefully after spellchecking.

This section also describes how to create and maintain user dictionaries
and how to add words to the hyphenation exceptions dictionary.

By moving the spelicheck dictionaries to a common area on disc it is
possible to install new versions of Ovation Pro without having to copy
the dictionaries. It is also explained how to organise dictionaries when
using Ovation Pro on a network.
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14.1 Spellchecking

Experience shows that checking text, especially
when reading a document from the screen is prone
to missing mistakes. Ovation Pro has two facilities
to help check your text:

= interactive spell check.

= marking wrongly spelt words.

Before either of these can function properly, a
dictionary must be available. Normally
Ovation Pro uses the dictionary named
!MainDict by default.

Interactive approach

The text of the document is checked and if a
potential error is found a window opens giving
you several options.

To activate this procedure Spellcheck is used.

Menu=>Misc=>Spellcheck=.......

The visual way

Ovation Pro can also mark all words it believes
are wrongly spelt. This can be selected by setting
Spelling errors in the View Options menu

Menuc> View=>Options....... Afo

Words not in the dictionary are underlined in red,

e.g. wrognlyy.

Repeated words

A special facility is the indication of repeated
words when using the interactive spell check. A
‘repeated word’ is the common typographical error
of typing the same word twice e.g. “the the”. The
Spellcheck error window has an icon at the
bottom which displays "Repeated word" if this is
the source of the error (fig. 14.2).
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14.2 Dictionaries

The spelling checker works by checking the words
in a document against the words in the currently
loaded dictionaries. If a word can be found in a
dictionary, it is assumed that it is spelt correctly.
Main Dictionary

The main dictionary !MainDict, contains over
67,000 UK English words covering basic
vocabulary. Each word ending is treated as a
separate word, so there are entries for walk,
walks,walker,walking, walked etc. It also
contains many real names such as country and city
names. These names are capitalised in the
dictionary, so the spelling checker will insist that
they are correctly capitalised in the document.

You may add any words to the main dictionary,
but it is recommended that any personal words
such as names of people, towns and roads, or any
specialist terms are put into user dictionaries.

User Dictionaries

You may supplement the main dictionary with any
number of user dictionaries. These may contain
personal names, foreign words or technical terms
for use with specific documents.

For your convenience an empty user dictionary
called ! UserDict is supplied by default.

A special user dictionary called ! HyphDict is
also supplied. This contains hyphenation
exceptions and is used by the hyphenator, not the
spelling checker. However, it is maintained in the
same way as other user dictionaries (see 14.8).
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Rules for Capitalisation

When the spelling checker compares words in the
document against those in the dictionaries, it takes
the capitalisation of the words into account
i.e.whether the letters are in lower-case, upper-case
or a mixture of both.

The rules for capitalisation are as follows:

« A word in the document in all upper-case will
match with the same word in the dictionary,
regardless of the upper-case/lower-case format
of the word in the dictionary.

So the word introduction in the dictionary
will match with INTRODUCTION in the
document.

* A word in the dictionary in all lower-case will
match with the same word in all lower-case or
in lower-case with an initial capital.

So the word march in the dictionary will
match with march or March in the document.

+ A word in the dictionary in mixed lower-case
and upper-case will only match with the same
word in exactly the same format (or in all
upper-case as permitted by the first rule above).

So the word PostScript in the dictionary
will only match with PostScript or
POSTSCRIPT in the document.

The general rule is that words that are valid in all
lower-case, must appear thus in the dictionary.

Check from caret...
Check as you type

Fig. 14.1 - The Spelicheck menu.
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Please note that dictionaries can contain more than
one copy of the same word, if each copy has a
different lower-case/upper-case format.

Loading & Attaching Dictionaries

If you spellcheck a document without loading any
dictionaries first, the ! MainDict and
!UserDict dictionaries are automatically
loaded. This arrangement should be suitable for
most applications.

Alternatively you may explicitly load the

dictionaries required using the option

Spellcheck=>Dictionary (fig 14.1).
Menuc>Misce>Spellcheck=>Dictionary...

The process of loading a dictionary involves two

stages:

= The dictionary is physically loaded into
memory if it is not already in memory.

+ The dictionary is attached to the current
document. This means that it will be used when
the document is spellchecked.

The names of the dictionaries attached to a
document are saved with the document. So when
the document is reloaded and spelichecked, the
appropriate dictionaries are automatically loaded
from disc.

Fig. 14.2 - A Repeated Word found.
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14.3 Check Story/From Caret
Menu>MisceoSpellchecke......

Choose Spellcheck=>Check story to check all the
words in the current story against the words in the
currently loaded dictionaries. The check starts at
the beginning of the story and continues to the end
of it, irrespective of the position of the caret or of
selected text.

Alternatively, Spellcheck=>Check from caret will
check the spelling of all the words from the word
containing the caret to the end of the story or from
the start of a selection.

Remember that if you have not explicitly loaded
any dictionaries, the !MainDict and
{UserDict dictionaries will be automatically
loaded for you.

If there are no spelling errors, the message

No spelling errors is displayed. Otherwise
the word is highlighted and the Spellcheck
dialogue box is displayed with the queried word in
the writable icon (fig. 14.3).

ommission ]

Fig. 14.3 - The Spelicheck dialogue box.
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Ignore

If you consider that the queried word, despite its
omission from the loaded dictionaries, is correct as
it stands, you may click on the Ignore option. The
spell check will then resume at the following word.

Words that are ignored are placed in a special
dictionary embedded in the document called

! Ignore. If you spellcheck a document more
than once in the same session, words ignored in the
first spell check will not be queried again in
subsequent spell checks. This feature can save
considerable time.

Each loaded document that has been spell checked
may have its own ignore dictionary.

An ignore dictionary remains resident until the
document is closed or until the dictionary is
deleted using the Spellcheck=>Dictionary
dialogue box. Alternatively you may use an option
on the Choices dialogue box (see 15.7), which
causes the ignore dictionary to be saved with the
document. This means that ignored words will not
be queried next time the document is loaded and
spell checked (fig. 14.4).

Edit lignore
| 5 words

e

hyphenator

spelicheck

spelichecked

spelichecks
|

Addword_| Delete word |

Fig. 14.4 - An example lignore dictionary
created while spelichecking this chapter.
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Guess

If Guess is selected, the window above the queried
word shows the words that the spelling checker
suggests may be the correct spelling. The guesses
are made on the assumption that one of the
following simple typing errors has been made:

» There is a single typing error.

= A pair of letters have been transposed.
+ There is one missing letter.

+ There is one extra letter

In the example dialogue box shown, the queried
word is ommission, and one of the guesses is
correctly shown as omission.

If the queried word is incorrect and the intended
word is listed in the guess window, you can
replace the misspelt word in the document by
double-clicking over the intended word in the
guess window. The new word will replace the
misspelt word, taking the same upper-case and
lower-case format. The spell check will then
resume at the following word.

Browse

If Browse is selected, the window above the
queried word lists the words in !MainDict that
are adjacent to the queried word in the dictionary.
The default dictionary being browsed is
!MainDict, but this may be changed by
choosing any loaded dictionary from the Browse
menu.

Use the vertical scroll bar to browse through the
list of words. If the queried word is incorrect and
the intended word is listed in the browse window,
you can replace the misspelt word in the document
by double-clicking over the intended word in the
browse window. The new word will replace the
misspelt word, taking the same upper-case and
lower-case format. The spell check will then
resume at the following word.
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Replace

If the queried word is incorrect and the intended
word is not listed in the guess or browse window,
you may correct the misspelt word directly in the
writable icon. Alternatively click select over the
closest word in the guess or browse window to
transfer that word to the writable icon, where it
may be edited.

Notice that if Browse is selected, the browse
window is continually updated to show the words
adjacent to the queried word as it is edited.

When you have corrected the queried word, click
on Replace to replace it in the document and
continue the spellcheck.

Add

If you consider that the queried word is not only
correct but also sufficiently important to merit a
place in a dictionary, click on Add. The spell
check will then resume at the following word.

The dictionary to which the word is added is
shown in the icon to the right of the words Add to.
If you have not explicitly loaded any dictionaries,
the default dictionary to which words are added is
! UserDict. This may be changed by choosing
another dictionary from the menu. Please note that
words are not physically inserted into dictionaries
until the spell check has completed.

The Cursor upand Cursor down keys
in the spell check window allow stepping
through words. This allows error correction
without taking your hands off the keyboard.
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Cancel

You may cancel the spell check at any time by
clicking on Cancel. If any words have been added
to any dictionaries (except the ignore dictionary)
during the spellcheck, you will be asked if you
wish to retain the changes (fig. 14.5).

The End of the Spell Check

‘When the spell check has finished, you will be
asked if you wish to retain the changes made to the
dictionaries (fig. 14.5).

@ Dictionaries changed. Refain changes?

Fig. 14.5 - Click on Yes to retain the changes made to
any dictionaries during the spelicheck.
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14.4 Check Word
Menuc>Misc<>Spellcheck=>Check word... AW

Choose Check word to check the spelling of just
the word at the caret. If the word is present in one
of the loaded dictionaries you will hear a beep, and
no further action is taken.

If the word is not present in any of the loaded
dictionaries, the Spellcheck dialogue box is
displayed with the queried word in the writable
icon. The procedure for correcting the queried
word is the same as for Check story described

earlier.

‘When the queried word has been corrected or
ignored, the dialogue box is closed and the spell
check stops.
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14.5 Check Document

Menuc>Misce>Spellcheck=> Check document. ..
Choose Check document to check the spelling of
all the word in all stories in the document. The

procedure for correcting queried words is the same
as for Check story described earlier.
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14.6 Check as You Type
Menu=>Misc=>Spellcheck=>Check as you type

This checks the spelling of each word after you

have typed it. The word ends when you type a

space, tab, carriage return or punctuation mark.

If the typed word is absent from the dictionaries

currently loaded, a beep will be heard. At this

point you can:

= Ignore the warning if you consider the word to
be correct.

= Correct the spelling in the document.

« Choose Check word to use the facilities on the
Spelicheck dialogue box to correct the word.

Words are not checked if you move the caret off

the word before you have finished typing it, nor

are words created as a result of the insertion or

deletion of characters.

Another way of checking while you type is by

setting Spelling errors in
View=>Options=>Spelling errors

If this is done then wrongly typed words are
marked.

Afo
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14.7 Creating & Editing Dictionaries
Menu=>Misc>Spellcheck= Dictionary...

The Spellcheck=>Dictionary option opens the
Dictionary dialogue box (fig. 14.6). This allows
you to load, remove, create, delete and edit
dictionaries.

The small window lists all the dictionaries that
currently exist. Those that are loaded and attached
to the current document are ticked. Apart from
!MainDict, !UserDict and any other user
dictionaries you have created, this window will
often list two further dictionaries, ! HyphDict
and ! Ignore.

! HyphDict contains a list of words that are
hyphenated in a special way by the automatic
hyphenator (see 14.8). | HyphDict is
automatically loaded and attached to the current
document, but may be edited, deleted and re-
created just like any other dictionary.

The embedded dictionary ! Ignore contains a list

of words that were ignored during previous
spellcheck operations on the current document.

! Ignore may be edited and deleted just like
other dictionaries. Unlike other dictionaries,

! Ignore is normally deleted when the document
is closed, unless you choose to save it with the
document (see 14.2).

14.6 - The Dictionary dialogue box allows you to
load, remove, create, delete and edit dictionaries.
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Selecting a Dictionary

Most of the operations described below apply to a
selected dictionary. To select a dictionary, click
Select over its name so that it becomes
highlighted. You may only select one dictionary at
a time.
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Load

The Load option loads the selected dictionary (if it
is not already loaded), and attaches it to the current
document. A tick next to the dictionary name
indicates that it is attached, and will be checked
against next time the document is spellchecked.
Remove

Remove, detaches the selected dictionary from the
current document, and if it is not attached to any
other loaded documents, removes it from memory.
This means that the selected dictionary will not be
checked against next time the document is spell
checked.

Please note that Remove does not actually delete
the dictionary.

14.7 - The Create dictionary dialogue box.
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Create

The Create option opens the Create dictionary
box (fig. 14.7), which allows you to create a
dictionary with the name specified.

A warning is given if you attempt to create a
dictionary with the same name as an existing
dictionary.

You can create and save any number of
dictionaries with your document. However the
total number of dictionaries that can be created
may be restricted by the 77 files in a directory limit
of some versions of RISC OS.

Delete
The Delete option deletes the selected dictionary.

Since this action is irreversible, you will be asked
for confirmation before the deletion takes place.
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Edit

Dictionary files cannot be edited directly in a text
editor since they are in a special compressed
format. Compression is essential to allow a
dictionary such as !MainDict to hold over

67,000 words in a file that is of manageable length.

The Edit option allows you to examine and edit
the contents of a dictionary.

Remember that most words in the dictionaries
should be in lower-case letters so that they will
match with all lower-case words or words with
initial capitals. If words in the dictionary have
capitals, the spelling checker will insist that
queried words are capitalised.

Click on Edit to open the Edit dialogue box for
the selected dictionary (fig. 14.8). Alternatively,
double-click on the dictionary name in the
scrolling window. The name of the dictionary
being edited is confirmed in the title bar.

The window in the dialogue box lists the words in
the dictionary in alphabetical order. You may use
the scroll bar to scroll through the list of words.
The number of words in the dictionary is shown in
an icon to the right of the window.

_' ] oK |
14.8 - The Edit dialogue box allows you to
edit dictionaries.
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Add

To add a new word to the dictionary, simple type it
into the icon below the word list, and press Return
or click on Add. Your new word is inserted into
the dictionary in the correct place, and highlighted
in the word list. If you are adding a number of
words to the dictionary, remember to clear the
writable icon using Ctrl U, before typing each new
word.

Notice that as you type into the writable icon, the
word list continually updates, showing you the
words adjacent to it in the dictionary. This feature
may be used at any time to locate words in the
dictionary.

To add a word based on a word in the word list,
click Select over the word in the word list to
transfer it to the writable icon. Now edit the word
as required, then press Return or click on Add to
add it to the dictionary.

Delete

To delete a word, click Select on it so that it is
highlighted, then click on Delete.

Saving the Dictionary

Click on OK to save the dictionary with all the
changes you have made. Click on Cancel to close
the dialogue box without updating the dictionary.
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Import & Export

In addition to adding words individually into a
dictionary, you may import words in bulk from
file. To do this, prepare an ASCII text file of
words, with each word separated by a carriage
return or line feed character. Now drag the file of
words to the Edit dialogue box, where it will be
merged into the existing dictionary. Please note
that with large dictionaries, this process may take
some lime to complete.

To export all words from the current dictionary,
click Menu over the Edit dialogue box to open the
standard save box. Now drag the icon to disc or to
a suitable editor. The file will contain each word
separated by a line feed character.
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14.8 Hyphenation Exceptions

The special dictionary called ! HyphDict is used

by the automatic hyphenator to deal with words

that do not hyphenate correctly using the standard
algorithm. So if you find that a word is regularly
hyphenated incorrectly, you may add it to

!HyphDict. This may be done in one of two

ways:

« If the word is added to ! HyphDict without
any hyphens, then it will be ignored by the
automatic hyphenation algorithm i.e. it will not
be hyphenated

« If the word added ! HyphDict contains one or
more hyphens, it will only be hyphenated at
one of the hyphens. So if you add the word
auto-matic, it will only be hyphenated
between auto and matic.

Please note that ! HyphDict is only used when

automatic hyphenation has been enabled (see 5.6).
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14.9 Relocating Spelicheck Dictionaries

Dictionaries are stored in the sub-directory called
Dictionary of the directory !Words. The
location of !Words depends upon how you have
installed Ovation Pro:

« If you have installed Ovation Pro to hard disc,
!Words is hidden away inside ! OvnPro.

Relocating |Words

You can store ! Words in any location by moving
it from inside ! OvnPro and dragging it to the
required place. You must double-click on !Words
after moving it, to reset the path to the new
location.

By placing ! Words in the Resources directory of
your ! Boot directory, you can ensure

Ovation Pro will always know where to find its
dictionaries. This will also allow other programs
which understand the same dictionary format to
use them.

CHAPTER 14

Spell Checking on a Network

A common requirement when running

Ovation Pro on a network is to allow users to
share !MainDict, but have their own user
dictionaries.

To do this, copy ! UserWords from the

Ovation Pro CD directory
DavidPilling.Extras.UserWords, into
the root directory of each user, and double-click on
each copy to make them active. Whereas ! Words
contains dictionaries that are shared by all users,
!UserWords contains user dictionaries that are
local to individual users.

‘When Ovation Pro is re-run, each user can browse
the same shared version of !MainDict, and add
words to their own local copy of ! UserDict.
Any new dictionaries created, are saved locally in
!UserWords, and override any other dictionaries
in ! Words with the same name.

If !MainDict is edited, it is automatically saved
locally in ! UserWords and overrides the original
shared version.
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Customisation
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This chapter describes the ways in which you can customise
Ovation Pro for general use or for specific applications.

Stylesheets fully describe the format and style of documents. You can
save the stylesheet from a document and use it as a template for
creating other similar documents. You may also save a stylesheet so
that it is used as default for each new document opened.

Application Choices allow you to configure the application in various
ways. There is just one set of Choices that affects all documents.

Document Preferences allow you to configure individual documents.

In addition to the above options, you may also customise the button bar
(see Chapter 16) and the menus (see Chapter 17).
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15.1 Stylesheets
Menu=>Filer>Save stylesheet

The Save stylesheet option opens a dialogue box
(fig 15.1), which allows you to save a stylesheet
for the current document. The procedure for saving
a stylesheet is identical to that described
previously for saving documents (see 3.9).

The stylesheet describes the format and style of the
document from which it is saved, but it doesn't
have any actual contents. Whenever you save a
document, its stylesheet is automatically saved
with it. However, if you want to use the same
layout for other documents, you can save the
stylesheet separately.

A stylesheet may be re-loaded just like any other
document i.e. by double-clicking on it, or dragging
it to the Ovation Pro icon on the icon bar.

So if you want to create a new document based on
the style of an existing document, save the
stylesheet from the document, then double-click on
the stylesheet to create a new document. Every
time you need to create a new document having
the same layout, just load the stylesheet from disc.

Fig. 15.1 - The Save stylesheet box.
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The following information is saved in stylesheets:
+ Defined styles
= Defined colours
Master pages
= Objects on the master pages.
« View options, Grid and Zoom
« Toolbox and info palette position
« Preferences

Please note that objects, text and pictures in the
document pages are NOT saved in stylesheets.
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15.2 Changing the Default Document
Menu=>File=>Save as default

The Save as default option allows you to
overwrite the default document with a stylesheet
based on the current document. The default
document is the blank document that appears when
you click on the Ovation Pro icon on the icon bar.

To change the default document:

1. Click on the Ovation Pro icon on the icon bar
to open a blank document (or load any other
document whose layout you want to use).

Modify the document as required. Ovation Pro
uses a stylesheet to define the default
document, so you may change any of the
attributes that are saved in stylesheets

(see 15.1). Typically you might want to change
the page margins, document zoom, defined
styles or colours.

Note that the default document cannot contain
objects, text or pictures, except those on the
master pages.

Click on Save as default to save the current
document as the default document. You will be
prompted for confirmation before the old
default document is overwritten (fig. 15.2).

Click on the Ovation Pro icon on the icon bar
to open a new default document.

g

About to update default document. Are
~ you sure you want to proceed?

i =

Fig. 15.2 - Confirmation box when using Save as

i T

default,

e

i =

Cranaing THE Derault Document. 221
A feature for advanced users, is that it is possible
to save a document (i.e. as opposed to a stylesheet)
as the default document. This has to be done
manually by opening !OvnPro and finding the
location of the file Default.

If you do this, the first object of each type in the
document which is not a master object is used as a
prototype.

By this mechanism it is possible to make new text
frames default to transparent fill or have no text
runaround etc.

Sometimes this approach will overlap with options
in the choices window being provided to control
the defaults for objects (see below). Settings in the
choices windows take precedence.
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15.3 Application Choices
IconbarMenu=>Choices...=.........

Choose Choices from the icon bar menu to open a
dialogue box that allows the Ovation Pro
application to be configured (fig. 15.3).

Note that choices are attached to the application,
and affect all the documents that you create or load
i.e there is one set of choices for all documents.

There are seven groups of choices: Print,
General, View, Text, Picture, Line and Colour.
Click on the appropriate icon in the scrolling pane
at the left of the dialogue box to display all the
associated choices. The choices are described on
the following pages of this user guide.

Once you are happy with the choices, click on OK
to apply them for the current session only.

Alternatively, click on Save to apply the choices
and save them so that they will be used by default
next time Ovation Pro is run. You will be
prompted for confirmation before the old choices
are overwritten.

In addition to the settings in the choices dialogue
box, clicking on Save also saves the order of the
tools in the toolbox (see 2.6).

Application choices

[V Background | Merge

[V Cropcheck [ Preprintpass
Reg. width | 0.09mm |

CropHlength [ 7mm | Gap[ amm | [

GropViength [ 7mm | Gap[ anm |

Fig. 15.3 - The Choices dialogue box
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15.4 Print Choices
IconbarMenu=>Choices<>Print
For all available choices see fig. 15.4. You will
need to use the scrollbar to see them all.
Print Memory
Whilst printing Ovation Pro can require some
extra memory to handle complex objects like
irregular picture frames, however on systems with
little memory, the printer drivers may claim all the
memory in the machine as soon as printing starts.
The Print Memory value is an amount of memory
which will be claimed by Ovation Pro before
printing starts, so that if extra memory is needed it
will be available. The larger Print Memory is, the
faster printing is likely to be. However because the
memory is always claimed large values are
wasteful.
Background

If Background printing is selected then there is no
multitasking whilst rendering takes place.
However you can use the computer whilst the data
is spooled to the printer. (see 12.4 for a full
discussion).

Merge

If off a mail merge will produce one print file
containing all the merged versions. If set then a
file will be produced for each merged version;
Background printing should be off in this case.
This option will be of interest to those attempting
to mail merge to ArcFax.

Print choices
Print memory [ 195K '/ A
VBWDW __J Mama :

. Em
CropHlength | 7mm | Gap
CropVlength | 7mm |
Reg. Hlength | 6mm |
Reg. Viength [ 4mm | @Gap

pog s o |

Fig. 15.4 - The Choices=Print menu, showing all options
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Crop check

If Crop check has been selected you will be
alerted if the area being printed is bigger than the
available area on the printer.

Preprint pass

This enables the RISC OS preprint scan pass. This
is a feature of later versions of RISC OS that
allows more efficient use of memory when
printing. Preprint pass must be enabled to print
JPEG's using Computer Concept's printer drivers.
Bleed and the following icons

If Bleed is selected an additional margin all around
the page is printed. Useful if you want an object to
go to the edge of the paper (see 12.3 and fig.
12.10).

The other icons let you set the sizes of the crop and
registration marks (see 12.3 Printers marks).
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15.5 General Choices

IconbarMenuc> Choices<>General
General choices are associated with the general
operation of Ovation Pro (fig. 15.5).

Date Format

Date format sets the format of the date string
inserted by the Menu=~>Misc->Insert>Date
option (see 3.2). A full explanation of this format
is given in Appendix D.

Time Format

Time format sets the format of the time string
inserted by the Menu=>Miscr>Insert=>Time
option (see 3.2). A full explanation of this format
is given in Appendix D.

Save Buffer

If Save buffer is not selected, the undo buffer is
flushed whenever documents are saved.

If Save buffer is selected, the undo buffer is saved
with documents (see 3.4). This means that when
you reload the document, you can undo operations
that were performed in a previous session. Another
advantage 1s that when you reload a document, the
caret will be at the position it was when the
document was saved.

The drawback with this facility, is that documents
become longer in size than necessary.

General choices

ZDﬁk—ﬁ?Um_t-;[ %ZDY%ST %m"%cs%vn] '[

Time format | %2Z12:%MI%AM |
__| save buffer Buflersize | 8 | K
[V Load interactive help
[V Give warnings
| Global clipboard Giipboards [ 1 |

Fig. 15.5 - General choices.

CHarTER 15

Buffer Size

Buffer size is the size of the undo buffer. The
larger the buffer size, the more operations can be
undone. Note that different types of operations use
different amounts of memory in the buffer, so the
buffer size cannot be directly related to the actual
number of steps.

Load Interactive Help

If Load interactive help is selected, interactive
help data is loaded when Ovation Pro is run. Since
the interactive help data is very large, by default
this option is not selected.

This option only takes effect when Ovation Pro is
run, so for it to take effect you must remember to
save the choices and re-run Ovation Pro.

Give Warnings

Give warnings allows you to enable or disable
various warning prompts that are displayed in
certain circumstances.

Global clipboard

If selected Ovation Pro will use the global
clipboard, allowing data exchange with other
programs that use it, as well as normal clipboard
operation within Ovation Pro.

Clipboards

Ovation Pro supports multiple clipboards. This
icon lets you set the number of clipboards.

To use the multiple clipboards more easily, install
the Clipboards applet.
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15.6 View Choices

IconbarMenu=>Choices<>View
View choices are associated with the way Ovation
Pro documents look on the screen (fig. 15.6).
Flashing Caret
Flashing caret allows you to have a flashing caret,
making it easier to locate in the document.
Period
Period in the time in centi-seconds that the
flashing caret is switched on/switched off.
Attach Toolbox

If Attach toolbox is selected, the toolbox is
attached to the document window (see 2.6). If the
document window is moved, the toolbox moves
with it.

If Attach toolbox is not selected, the toolbox
becomes attached to the screen and doesn't move
with the document window. If the choices are
saved, the position of the detached toolbox is also
saved.

Fig. 15.6 - View choices.

View CHoices 225
Attach Info Palette

If Attach info palette is selected, the info palette
is attached to the document window (see 2.7). If
the document window is moved, the info palette
moves with it.

If Attach info palette is not selected, the info
palette becomes attached to the screen and doesn't
move with the document window. If the choices
are saved, the position of the detached info palette
is also saved.

Instant Updates on Path Edit

If Instant updates on path edit is selected,
surrounding text is continually updated as paths
are edited in Path Edit Mode (see 8.11).

If Instant updates on path edit is not selected,
surrounding text is not updated until Path Edit
Mode is exited. This may be useful if path editing
becomes very slow due to the text reflows.
Crosshairs when moving selection

If this option is selected large crosshairs will be
displayed whilst objects are being moved.
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15.7 Text Choices
IconbarMenu=> Choices=>Text

Text choices are associated with text editing, text
styles and text frames (fig. 15.7).

Single Shift Font

Single Shift Font specifies the font used by the
single shift font facility (see 3.2).

Text Frame Inset

Text frame inset is the default inset used by text
frames (see 9.2). If you don't want text frames to
have an inset by default, set this value to 0.
Rename Styles

Rename styles controls what happens when text
containing defined styles is transferred to another
document containing the same style names, but
with different attributes,

If Rename styles is selected, a clashing style name
in the transferred text is renamed by adding a
number to the end of the name.

If Rename styles is not selected, a clashing style
name in the transferred text is discarded, and the
style in the destination document is used.

Rename Colours

Rename colours controls what happens when text
containing defined colours is transferred to another
document containing the same colour names, but
with different colours.

If Rename colours is selected, colours names are
renamed, otherwise they are discarded (operation
is the same as Rename styles above).

~ Texthandling choices |
Stgestiftont [ Sewyn  t]
Textframeinset [ 1mm |
[ Rename styles [ Rename colours
[V Smart quotes __|PC-style delete
[ overtype
_|saveignoredwords [ 1 A Minlength
[V Check repeated words

Fig. 15.7 - Text choices.
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Smart Quotes

If Smart quotes is selected, plain quotation marks
in imported text are converted to fancy quotes
(see 3.3), otherwise they remain unchanged.
PC-style Delete

If PC-style delete is selected, the Delete key
behaves as the Copy key i.e. it deletes the
character to the right of the caret.

The Copy key then behaves as THome i.e. it
moves you to the start of the last page in the
document.

The Backspace key can be used as Delete.

Overtype

Overtype controls what happens when you type
while there is some text selected (see 3.6).

If Overtype is selected, the selected text is deleted
and replaced by the typed text.

If Overtype is not selected, the selected text is
deselected and the typed text is inserted before it.

Save Ignored Words

If Save ignored words is selected, the dictionary
of ignored words generated by the spelling checker
! Ignore, is saved with the document whenever it
is saved. This means that when the document is re-
loaded, previously ignored words are ignored
when the document is spellchecked. The drawback
with this facility is that documents become bigger
in size.

If Save ignored words is not selected, the
dictionary of ignored words is not saved with the
document.

Min length

Min length sets the minimum length of words
which will be spell checked.

Check repeated word

If Check repeated words is selected the spelling
checker will report repeated words, e.g. the the.
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15.8 Picture Choices

IconbarMenu=>Choices=>Picture

Picture choices are associated with picture
handling (fig. 15.8).

Picture Frame Inset

Picture frame inset is the default inset used by
picture frames (see 9.3).

Runaround Error

Runaround error controls how accurately
Ovation Pro traces the picture when using Picture
runaround (see 9.7). The value entered is the
average error for each pixel traced. Smaller values
will give more accurately traced pictures, although
the trace will then take longer to complete.
Picture Import with Ctrl

If you import a picture into a picture frame while
pressing Ctrl, the picture is imported at a pre-
defined scale (see 10).1). Picture import with Ctrl
specifies that scale. So, for example, if you want to
ensure that imported pictures are always scaled to
75% of their original size, set Picture import with

T Ctrlto 75%.

_jcem lock IFMpaotm

Fig. 15.8 - Picture choices.
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Centre Lock

If Centre lock is selected, the Centre lock option
in the Modify picture dialogue box will be
selected by default (see 10.7).

Aspect Lock

If Aspect lock is selected, the Aspect lock option
in the Modify picture dialogue box will be
selected by default (see 10.7).

Auto Scale

If Auto scale is selected, the Auto scale option in
the Modify picture dialogue box will be selected
by default (see 10.7).

Picture Cache Max size

Reference if over

Proxy if over

These choices are explained in 10.11.
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15.9 Line Choices
IconbarMenu=>Choicese>Line

Line choices are associated with line drawing

(fig. 15.9).

Default Line Width

Default line width sets the default width for all

lines drawn in Ovation Pro. Choose a predefined

width from the menu, or enter your own value in

the field at the bottom of the menu (see 9.4).

Default Triangle Width

Default triangle width is the default width of the

triangle for lines with arrowheads. Choose a

predefined width from the menu, or enter your

own value in the field at the bottom of the menu.

The width is specified as a multiple of the line

width (see 9.4).

Default Triangle Height

Default triangle height is the default height of the
triangle for lines with arrowheads. Choose a
predefined height from the menu, or enter your
own value in the field at the bottom of the menu.
The height is specified as a multiple of the line
width (see 9.4).
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15.10 Colour Correction Choices
IconbarMenu=>Choicesc>Colour

In general the colours one sees on screen are not

the same as the colours output by a printer. When

printing RGB (and equivalent HSV) colours must

be converted to CMYK colours. For use on screen

CMYK colours must be converted to RGB.

The conversion from RGB to CMYK is done using
colour correction tables.

Colour correction choices lets you select whether
this colour correction should take place or not and
which table will be used.

Use inks to display CMYK colours is used to
give a more realistic display of CMYK colours on
screen.

See 13.5 for a full discussion.

Fig. 15.10 - Colour correction choices.
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15.11 Document Preferences
Menuc>Misc>Preferences... Atp

Choose Misc>Preferences to open a dialogue box
that allows Ovation Pro document preferences to
be configured (fig. 15.11).

Preferences are attached to documents, so you may
have different settings for different documents.
‘When a document is saved, its preferences are
saved with it.

There are three categories of preferences: General,
View and Text. Click on the appropriate icon in
the scrolling pane at the left of the dialogue box, to
display all the associated Preferences. The
Preferences are described on the following pages
of this user guide.

Once you are happy with the preferences, click on
OK to apply them to the current document.

Alternatively, click on Save to apply the
preferences and save them so that they will be used
by default each time a new document is opened.
You will be prompted for confirmation before the
old preferences are overwritten.

Fig. 15.11 - The Preferences dialogue box.

DocumeNT PREFERENCES
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15.12 General Preferences
Menu=>Misc=>Preferences...”>General AP

General preferences are associated with the general
setup of the document (fig. 15.12).

Document Units

Document units specifies the default units for the
document. You may choose millimetres (mm),
inches (in) or points (pt) from the menu

(fig. 15.13). The chosen units are used whenever a
measurement is entered into a dialogue box or
menu. They are also used for the page rulers and
tab ruler.

Start Chapter Number

Start chapter number is the chapter number for
the first chapter in the document. If you split a
document into a number of separate files, you may
need to use this option to ensure that each section
starts with the correct chapter number.

Chapter/Page Separator

Chapter/page separator is the character used to
separate the chapter number and page number.
This option is for future expansion only, and has
no effect in this release.

Document units | mm g}'
Start chapter number | 1 |
Chapter/page separator | . |

| Prompt for auto save
[V Auto pageinsert [/ Auto page delete

Fig. 15.12 - General preferences.
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Auto Save

If Auto save is selected, the document will be
automatically saved at the interval specified.

If Prompt for auto saved is not selected, the
document will be saved without any user
intervention required, except the first time that the
document is saved after loading. You must then
confirm that you want to save the document under
the same name or you can save it under a new
name.

If Prompt for auto save is selected, the normal
Save box will be displayed before the document is
saved. Click on OK to save the document, or click
outside the Save box to cancel.

Auto save does not operate if the document has
never been saved, or if it has not been modified
since it was last saved.

Autosave also only takes place if at least 10
seconds have elapsed since the last keystroke,
otherwise it is postponed by 10 seconds. This
prevents a burst of typing ending up in the Save
box.

Auto Page Insert/Delete

These control the automatic insertion of pages
when the text in an auto linked text frame chain
overflows the last frame and deletion when there
isn’t enough text to fill it.

This feature will be useful if you want a document
which is a fixed number of pages long and don’t
want it to keep changing in size as you work on it.

Another consequence is that with auto page
insertion and deletion turned off, the insert and
delete page entries on the page menu will do
exactly what you tell them (see /1.8). So if you
insert a page the document is guaranteed to end up
one page longer - because there will be no auto
page deletion of any excess page after the
insertion.

Fig. 15.13 - The Units menu.
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15.13 View Preferences
Menu>MisceoPreferences...>View ATP

View preferences are associated with the way the
document looks on the screen (fig. 15.14).

Pasteboard Width

This is the width of pasteboard added to each side
of each page. The width of the pasteboard above
and below each page is fixed at 10mm.

This option does not enable the pasteboard, which
is done using an option on the View=>Options
dialogue box (see 7.3).

Menu>View=>Options=>

Ruler Origin X/Y

The ruler origin is normally at X =0, Y =0 i.e. in
the top left corner of the page. You may change
the ruler origin by modifying these values. All
object coordinates in Ovation Pro are measured
from the ruler origin.

Snap to Ruler Guidelines

If this option is selected, the edges of objects that
are moved or resized will snap to ruler guidelines
(see 8.4).

This option is automatically disabled if grid lock is
selected.

Ao

Pasteboard width | 100mm] |
Ruler origin X | omm |
Pulroign¥ “omn |

I—Smhmhrgﬁm‘(m

[V snaptoobjects

@mmmmm Qmm

Fig. 15.14 - View preferences.
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Snap to Objects

If this option is selected, the edges of objects that
are moved or resized will snap to the edges of
other objects (see 8.4).

This option is automatically disabled if grid lock is
selected.

Guidelines to Front/Back

This option determines whether ruler guidelines
are drawn in front of all objects or behind all
objects (see 8.4).
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15.14 Text Preferences
Menuc>MiscoPreferences...>Text AP

Text preferences are associated with text styles and

formatting (fig. 15.15).

Baseline Grid Spacing

This specifies the spacing of the baseline grid

(see 54).

Baseline Grid Origin

This specifies the origin of the baseline grid,

measured from the top of the page (see 5.4).

Superscript Size

This specifies the superscript size, as a percentage

of the normal character size (see 4.4).

Subscript Size

This specifies the subscript size, as a percentage of

the normal character size (see 4.4).

Small Caps Size

This specifies the size of small caps, as a

percentage of the normal character size (see 4.6).

Decimal Tab Character

This option specifies up to three characters that are
aligned to decimal tabs (see 5.5).

Hyphenation Character

This allows you to enter up to three characters that
will be used for hyphenation. If the icon is left
blank the default ‘-’ character will be used. Words

are broken at this character if they won’t fit on a
line.

Text handling preferences

Baseline grid spacing

Baseline  grid origin

Superscript size [ 65 | %

Subscriptsize [ 65 ] %

Small caps size [66]%
an 15.15 - Text preferences.
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Defined Colours
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This chapter describes how to define your own colours, and add them to
the standard Ovation Pro colour picker.
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16.1 Overview

Whenever a colour is chosen in Ovation Pro, it is
chosen from the standard colour picker (fig. 16.1).

Menu=>Text<>Colour...

The colour picker allows a colour to be chosen
from the default set of colours, and an optional tint
applied (see 4.5).

There are two main advantages of using named
colours:

= They can be applied quickly and consistently
throughout the document by choosing their
names. Without a name, a colour would have to
be applied by setting its RGB value, which is
slow and prone to error.

» If you're not happy with a colour used
throughout the document, you can just edit the
definition in one place and all occurrences of
the colour are updated throughout the
document.

This chapter describes how to add, remove or edit
colours on the colour picker.

10

20

30

40

50

60

70

Currantco.'our\ 80

o 90

e O v 100

Tint [100 % -uﬂ\
Previous colour—"| = . '

_|Cmm-tnt Tint menu

Fig. 16.1 - The standard Ovation Pro colour picker.
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16.2 Editing Colours
Menu=>Misc=oEdit colours...
Choose Misc=>Edit colour to display the
— Edit colour dialogue box (fig. 16.2). This box

displays the colours available in the scrollable
window.

Editing operations apply to the selected colour,
which is highlighted in the window. To select a
colour, click Select over it.

Fig. 16.2 - The Edit colour dialogue box.

oy New colour _
Colour name | I |
Back g

Basedon [

Fig. 16.3 - The New colour dialogue box.
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To create a new colour, choose New and type the

name of the colour into the New colour dialogue

box (fig. 16.3). The name must not be the same as
any existing colour name.

If there is a colour selected when you choose New,
the new colour will be based on the selected
colour. However, you may base the new colour on
any existing colour, by choosing the colour name
from the menu (fig. 16.4).

Click on OK to create the new colour and close the
dialogue box. The colour you have created is
added to the list of colours in the window, and
automatically selected ready for editing.

Cyan
Magenta
Yellow

Reistrati

Fig. 16.4 - Base new colour
on a colour from the menu.
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Rename

To rename the selected colour, click on Rename to
open the Rename colour dialogue box (fig. 16.5).
Type in a new name and click on OK.

Please note that you cannot rename the colours
Black, White, Transparent or Registration or those
that were created from a colour chart.

Delete
Click on Delete to delete the selected colour.

Please note that you cannot delete the colours
Black, White, Transparent or Registration.

Spot
When selected this indicates that the selected

colour should be printed on a separate plate (see
13.3).

Non-printing

When selected this flags the selected colour as
‘non-printing’. And, as you might expect, anything
in this colour will appear on screen, but not on
printed material.

ArcFax embedded commands will work in a non-
printing colour - since as long as there is a text or
frame background colour, non-printing text is
rendered as e.g. white on white.

L Renamecolour |
Oldname Green
‘New name [ |

Fig. 16.5 - The Rename colour dialogue box.
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Chart

To create a new colour based on a colour from one
of the standard Ovation Pro colour charts, click on
Chart (see 16 4).

Edit

To edit the selected colour, click on Edit.

If the colour was created using New, the colour
model dialogue box will be displayed (see 16.3).
If the colour was created using Chart, the colour
chart dialogue box will be displayed (see 16.4).
Overprint

Used to control how colours will be printed on
colour plates they do not appear on (see 13.6).
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16.3 Colour Models

When you click on Edit, the Colour choice

dialogue box is displayed (fig. 16.6). This allows

you to specify a colour from one of three colour
models: RGB, CMYK or HSV.

Please note that if the selected colour was

originally chosen from the colour chart, the

Colour chart dialogue box is displayed instead

(see 16.4).

RGB Colour Model

This colour model specifies colours by mixing

Red, Green and Blue light (fig. 16.6). This is the

default model used for new colours.

There are 6 ways of choosing a colour in the RGB

model.

+ Drag the Red, Green or Blue sliders. As you
move a slider the resulting colour is shown in
the box at the bottom left of the window. At the
same time, the numeric values change to show
you the percentages of the colours chosen.

+ Click anywhere in the colour slice, or drag
continuously around it.

Click here to

choose RGB "“‘----@ RGB ch.m{ i) ielsv

Colour slice —— |

Drag on sliders to_—1"

change values "‘\“‘ :

Result of colour mix—__|
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= Type in the Red, Green and Blue values
directly. After typing a value you must enter it
by press Return, Tab or the up/down cursor
keys. Pressing Return in the Blue field, is the
same as clicking on OK.

* Click on the up/down arrows. This allows fine
tuning of a colour, changing the values by 1%.
Clicking with the Shift key held down, changes
the values by 0.1%.

» Click on a standard desktop colour directly.
» Click on None to create a transparent colour.

In the RGB model, the Colour slice is a plane
through the RGB colour cube. The slice is taken
with a single constant colour. In the example
shown, the constant colour is Blue at 100%.

The colour slice shows all the colours available by
varying the Red and Green components, but
keeping the Blue component constant.

Click on OK to apply the colour and close the
dialogue box.

Click to change

standard colour

Fig. 16.6 - The RGB colour model.
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CMYK Colour Model

This colour model is often used when you want to
create colour separations for four-colour process
printing. Click on CMYK to choose this model
(fig. 16.7).

There are 5 ways of choosing a colour in the
CMYK model.

* Drag the Cyan, Magenta, Yellow and Black
sliders. As you move a slider the resulting
colour is shown in the box at the bottom left of
the window. At the same time, the numeric

values change to show you the percentages of
the colours chosen.

» Type in the Cyan, Magenta, Yellow and Black
values directly. After typing a value you must
enter it by pressing Return, Tab or the up/down
cursor keys. Pressing Return in the Blue field,
is the same as clicking on OK.

« Click on the up/down arrows. This allows fine
tuning of a colour, changing the values by 1%.
Clicking with the Shift key held down, changes
the values by 0.1%.

+ Click on a standard desktop colour directly.

« Click on None to create a transparent colour.

Click on OK to apply the colour and close the
dialogue box.
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HSV Colour Model = Click on the up/down arrows. This allows fine
This colour model is often used by artists tuning of a colour, changing the values by 1%.
(fig. 16.8). You start with the basic colour, and Clicking with the Shift key held down, changes
then add elements of white and black to get the the values by 0.1%.

exact colour. Hue is the basic colour. Saturationis < Click on a standard desktop colour directly.

the amount of white added to the colour. Value is ¢ Click oo Nobe o sicste s oclions
the amount of black added to the colour i.e. the I 2
brightness. In the HSV model, the Colour slice is a surface
through a colour cone. The slice is taken with one
of the components constant. In the example shown,
the constant component is Value at 100%.

There are 6 ways of choosing a colour in the HSV
model.

» Drag the Hue, Saturation or Value sliders. As

you move & slider the resulting colour is shown The colour slice shows all the colours available by

: ; arying the Saturation and Hue components, but
in the box at the bottom left of the window. At v] Pt POUETIR
the same time, the numeric values change to e

show you the percentages of the colours Click on OK to apply the colour and close the
chosen. dialogue box.

» Click anywhere in the colour slice, or drag
continuously around it.

« Type in the Hue, Saturation or Value values
directly. After typing a value you must enter it
by pressing Return, Tab or the up/down cursor
keys. Pressing Return in the Value field, is the
same as clicking on OK.

Click here to
choose HSV

Drag on sliders to — |

change values \ }

f‘zxsuﬂofmfour\_-; - Y s g == Click to choose a
~ e i el standard colour

[T Type values in
directly

Fig. 16.8 - The HSV colour model.
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16.4 Colour Charts

The Ovation Pro Colour chart dialogue box
(fig. 16.9) is displayed by clicking on Chart or if
you select an existing chart colour by clicking on
Edit.

This facility allows you to choose colours from
pre-defined colour charts, a number of which are
supplied by default. The icon labelled Chart
shows the current chart name, but you may choose
another chart from the menu (fig. 16.10). The
colours in the chart are displayed in the main
window. Use the horizontal scroll bar to view all
the colours in the chart.

There are three ways of choosing a colour from the
chart.

» Click on the colour or its name, then click on
OK to close the dialogue box and add the
colour to the list of available colours.

« If you want to choose a number of colours,
double-click on each name then finally click on
OK. This closes the dialogue box and adds the
selected colours to the list of available colours.

CHaPTER 16

» Type in the name of the colour in the writable
icon provided. As you type each character,
Ovation Pro will attempt to find and highlight
a matching colour name in the chart. Now
double-click on the colour to choose it, or click —
on OK to choose the colour and close the
dialogue box.

After choosing a colour and closing the

Colour chart dialogue box, the chosen colour is
added to the list of available colours. The chart
name and colour name are combined to create a
full name. For example, if you choose Mustard
from the Rainbow chart, the full colour name is
Rainbow Mustard.

You can easily create your own colour charts
(see Appendix G).

The various charts are used in different printing
processes. When creating a Web page layout you
are advised to use the colours in the NetSafe chart.

Colour chart

Pale Pink Pale Orange Pale Yellow Pale Green

Pink Peach Yellow Green
e gy | _ Lo R

Red Mustard Grass Green

[ — — e
| Burgundy | Forest Green
icEsadatmis]

Fig. 16.10 - The Colour

Fig. 16.9 - The Colour chart dafague box, with 'swgunay selected.

charts menu.
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This chapter describes the macros facility which allows three types of
macros to be defined:

Button macros represent buttons that appear on the button bar. You can
add buttons to the button bar that type in strings, execute keypresses for
common options or call functions directly in Ovation Pro.

Key macros represent keys on the keyboard allowing them to be
redefined. Virtually all the keys may be redefined including special key
combinations using Ctrl, Shift etc.

User macros allow common constants to be given simple textual names.
They are useful for defining constants that you may wish to use several
times in other macro definitions.
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17.1The Macros Dialogue Box
Menu=>Misce>Macros...

Choose Misce>Macros to display the Macros

dialogue box (fig. 17.1). Each row in the table

represents a single macro, and comprises:

* The macro name.

+  An optional sprite used to represent the macro
on the button bar (button macros only).

+ The actual macro definition.

+ An option which determines whether the button
will appear on the button bar (button macros
only).

The options Button, Key and User control the
type of macros being displayed. By default Button
is selected, causing the dialogue box to display all
the button macros.

{picktool(1,0)}
{picktool(3,0)}
{picktool(4,0))
{picktool(11,0)}
{picktool(2,0)}
{picktool(10.0)}

Fig. 17.1 - The Macros dialogue box showing the buttons that have been defined.
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17.2 Creating Button Macros

Choose Button on the Macros dialogue box to
display the button macros, then click on New to
display the New button dialogue box (fig. 17.2).

Type in a name for the button you require
(maximum 12 characters). The button name must
not be the same as any other macro already defined
or the name of any keyboard character. So you
cannot define buttons called A, h, F3, Print etc.

The width of the button displayed on the button
bar is determined by the width of the text you type,
so choose short names if you want to fit lots of
buttons on the button bar. The button name doesn’t
have any significance if you choose to use a sprite
to represent the button.

If you wish to assign a sprite to your button, click
on the icon to the right of the Sprite option to
display the button box (fig. 17.3).

The button box is a palette of sprites that may be
used for button legends. Use the vertical scroll bar
to scroll through the entire list, and choose the
sprite you require by clicking on it. The button box
will then be closed and the sprite name displayed
in the New dialogue box. If you should then decide
not to use the sprite, you can deselect the Sprite
option.
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When you have completed the dialogue box, click
on OK to create the button.

The new button name will appear in the first
column at the bottom of the macro list, but at this
stage doesn’t yet appear on the button bar. If you
have assigned a sprite to the button, this will be
displayed in the second column.

The icon in the third column contains the actual
definition, which at this stage is blank. If you type
some text into this icon, choosing the button on the
button bar will type the text into the document.
Full details of how to define macro bodies are
given later in this chapter.

The final column is an option which determines if
the button appears on the button bar. Ovation Pro
is supplied with a wide range of predefined
buttons, but only a small selection are actually
enabled (see 17.7).
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17.3 Creating Key Macros

Choose Key on the Macros dialogue box to
display the key macros, then click on New to
display the New key dialogue box (fig. 17.4).
Now press the key or key combination that you
wish to define. You may define any key on the
main keyboard or keypad except for Escape, Break
and Return. In addition you may also define key
combinations using Ctrl, Shift or Ctrl Shift. You
cannot define key combinations using the Alt key
since this is reserved for accessing international
characters.

The key name you have chosen is displayed in the
New key dialogue box.

When you have correctly chosen the key you wish
to define, click on OK to close the dialogue box.
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The new key macro name is displayed in the first
column at the bottom of the key macro list

(fig. 17.5). The icon in the second column is for
the actual definition, which at this stage is blank. If
you type some text into this icon, it will be typed
into the document when the keypress is invoked.
Full details of how to define the macro bodies are
given later in this chapter.

{objectforward(1)}

{objectbackward(1)}

[S_CRighty") setzonetobm (b); bmdelete(by}} |

feintabox(): else open_menufeinfo_box(1))}]

{ferarme)

Fig. 17.5 - The Macros dialogue box showing the keys that have been defined.
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17.4 Creating User Macros The new user macro name will be displayed in the
Choose User on the Macros dialogue box to first column at the bottom of the macro list
disphymcmm'mcnckﬁmm (fig. 17.7). The icon in the second column is for

et e N dialo 17.6). the actual definition, which at this stage is blank.
display the New macro dialogus box (1176} it letnil o w1 defiio iaio bodion 50

Type in a name for the macro you require given overleaf.

(maximum 12 characters). The name must not be
the same as any other macro already defined or the
name of any keyboard character. So you cannot
define buttons called A, h, F3, Print etc,

If you intend to use this macro in other definitions,
it will be an advantage to keep the name as short as
possible.

‘When you have correctly typed the user macro
name, click on OK to close the New macro

dialogue box.

David Piling
FY51LR Clevelys|

XS

Fig. 17.7 - The Macros dialogue box showing the user macros that have been defined.
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17.5 Defining Macros

To define a macro, click Select in the definition
icon to the right of the macro name, and type in a
string. The string may contain all the usual ASCII
characters, but must not begin with { or <.

In addition to the normal printable characters, you
can introduce any ASCII characters in the range 0

to 31 or 127 to 255 using special escape sequences.

If you wish to start the string with { or <, you
must use the alternative sequences | { or | <.

John types John

RegardsiM types Regards followed by CR
|t]o types * (ASCII code 143)
|<6> types the string <6>

Key expansions

If the definition string corresponds to the name of
a key enclosed in braces { }, that key will be
invoked. All the keys on the keyboard may be used
except Return, Escape and Break. Keys may also
be prefixed by the following sequences:

S_ Shift plus key
c_ Ctrl plus key
Cs_ Ctrl Shift plus key

If a key in a definition has already been redefined
using a key macro, the new definition will be used
unless the key name is preceded by a single quote
character. In that case, the original operation of the
key is invoked i.e. the one predefined in Ovation
Pro.

{F1} invoke the keypress F1

{Cc_V} invoke keypress Ctrl V

{s_F3} invoke the keypress Shift F3
{CRight} invoke the keypress Cursor Right
{F3} invoke the keypress F3

{ "F3} invoke the original keypress F3
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Macro expansions

If the definition string is a macro name enclosed in
braces { } it will be evaluated.

{dtp} expands the user macro dtp
{mcl}{mc2} expands mcl and mc2
Function expansions

If the definition string enclosed in braces { }
doesn’t match a macro name or keypress, it is

passed to the script language and executed as a
function.

{setalign(1l)} calls setalign()

System expansions

If the definition string is enclosed in angle brackets
<> then it is evaluated as a system variable (using
0S_ReadVarVal or OS_ReadUnsigned).
<Sys$Time> expands variable Sys$Time
<&FF> expands hex number &FF
<2_10111010> expands binary 10111010
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17.6 Other Macro Operations
Recording Macro Definitions

The previous pages describe how to type in macro
definitions, but it is possible to record definitions
directly from the document. It is useful if you wish
to program a button, key or macro with a
complicated key sequence.

First, choose the macro you wish to define by
clicking Select in its definition icon. Select the
Record option, and click in the document window
without closing the Macros window. Now
anything typed into the document will be recorded
in the macro definition, including any special
keypresses. Switch off recording when you have
finished by deselecting the Record option.

Expanding Macros

Double-click on the macro name to expand it.
Editing a Button Macro

Click on Edit to display the Edit button dialogue

box (fig. 17.8). You may use this dialogue box to
change the sprite assigned to the button.

Please note that the Edit option is only available
for button macros.

Fig. 17.8 - The Edit button dialogue box.
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Copying a Macro

This option copies the macro definition that
contains the caret. The Copy dialogue box allows
you to type in a different name for the new copy.
Operation of this dialogue box is identical to that
for the New option described previously.
Deleting a Macro

This option deletes the macro definition that
contains the caret. The macro is not completely
deleted until OK is clicked, so if you wish to
restore the deleted macro, click on Cancel and
then reopen the Macros dialogue box.

Saving the Macros

Click on Save to save all the macro definitions so
that they will be loaded automatically each time
Ovation Pro is run.

Click Menu to display a standard save box,
allowing you to save macros in a named file. To
reload the macros, double-click on the file or drag
it to the Ovation Pro icon on the icon bar. Loading
a macros file in this way overwrites any macros
currently loaded.
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17.7 Summary of Pre-defined buttons
The following pages list all the predefined buttons
available in Ovation Pro. By default only a
selection of these are enabled (see 2.8), but you
may enable the buttons that you require or add
your own buttons. Many of the buttons may be
used as templates for your own buttons. So for
example, the button Corpus sets the font to
Corpus but you may copy the button and edit its
definition to set another font. To do this you will
need some knowledge of the Ovation Pro script
language and functions, which are described in
detail in the separate Script manual.

Almost all button sprites can be found in the files
Buttons and Buttons22 within the Ovation
Pro application. (Some buttons present on the
Button bar may originate from an applet and these
have their own Buttons files.)

Remember to click on Save to save any changes
you make.

Tools

X select tool.
E_.gﬂ Frame tool.
Q] Rotate tool
Qj Magnify tool.

lcon Bar menu

EA| Ovation Pro Info dialogue box (see 2.2).
g] New document (see 11.2).

ll Choices dialogue box (see 14.3).
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File Menu

File info dialogue box (see 3.1).
Save (see 3.9).

gj Save (without prompt).

@ Save story/picture (see 3.9 & 10.2).
ﬂ Save stylesheet (see 15.1).

@] Revert to saved (see 3.4).

| Print dialogue box (see 3.10).

@ Mail merge dialogue box (see 12.5).

Edit Menu

Select all (see 3.5).

i Clear selection (see 3.5).

E_l Cut selection (see 3.6).

ﬁ Copy selection (see 3.6).

_@ Paste selection (see 3.6).

ﬁ Delete selection (see 3.6).

[ Show/hide Clipboard (see 3.6).
ﬂ Embed object from clipboard (see 8.10).
El Undo (see 3.4).

il Redo (see 3.4).

Find dialogue box (see 3.8).
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New view (see 7.2).

Options dialogue box (see 7.3).
Show/hide Toolbox (see 7.3).
Show/hide Info palette (see 7.3).
Show/hide Rulers (see 7.3).
Show/hide Pasteboard (see 7.3).
Show/hide Pictures (see 7.3).
Show/hide Guidelines (see 7.3).
Show/hide Print margins (see 7.3).

Enable/disable Facing pages (see 7.3).

Show/hide Invisibles (see 7.3).
Grid dialogue box (see 7.4).
Enable/disable grid (see 7.4).
Zoom dialogue box (see 7.5).
75% zoom (see 7.5).

125%| 125% zoom (see 7.5).

2]
=2

Zoom to Fit window (see 7.5).

Zoom to Fit screen (see 7.5).
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Text/Picture Menu
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Modify text dialogue box (see 4.6).

Font menu (see 4.2).

| Set font to Corpus.

Size menu (see 4.3).

Set type size to 13pt

Effect menu (see 4.4).

Set text to Normal (see 4.4).

Set text to Bold (see 4.4).

Set text to Italic (see 4.4).
Underline text (see 4.4).

Reverse out text (see 4.4).

Set text to Superscript (see 4.4).
Set text to Subscript (see 4.4).
Text Colour dialogue box (see 4.5).
Text Format dialogue box (see 5.4).
Alignment menu (see 5.2).

Left align text (see 5.2).

Centre align text (see 5.2).

Right align text (see 5.2).

Fully Justify text (see 5.2).

Single space line spacing (see 5.3).
Double space line spacing (see 5.3).
Set 14pt absolute leading (see 5.3).
Display Tabs ruler (see 5.5).
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Style Menu

EI Style menu (see 6.6).

§f|  Edit style dialogue box (see 6.2).
Style#1 | Apply Style#1l to text (see 6.6).
gl Remove Local effects (see 4.1).

Object Menu

Border dialogue box (see 9.6).
Text flow dialogue box (see 9.7).

g

% Duplicate dialogue box (see 9.8).
@ Shape dialogue box (see 9.9).

.@] Bring to Front (see 9.10).

F|  PuttoBack (see9.10).

H Group/Ungroup objects (see 9.11).
@ Make local/master (see 9.12).

_ﬁl Snap to grid (see 9.13).

Page Menu

Edit master pages (see 11.3).
Insert New chapter (see 11.4).
Edit Page guidelines (see 11.3).
Modify chapter (see 11.6).
Delete chapter (see 11.5).
Insert page (see 11.7).

Delete page (see 11.7).

EEEERRDCEE

Goto page (see 11.1).

Modify object dialogue box (see 9.1).

CHaprTER 17

Misc Menu

ﬂ Check word (see 14.4).

ZI Check story (see 14.3).

Ed Check document (see 14.5).

| Check from caret (see 14.3).
_@‘_/_I Check as you type (see 14.6).
E Dictionary dialogue box (see 14.7).
i] Characters box (see 3.2).

_mJ Insert menu (see 3.2).

E_ﬁlj Insert Chapter number (see 3.2).
EI Insert Page number (see 3.2).
@] Insert Date (see 3.2).

Insert Active date (see 3.2).

Insert Time (see 3.2).

Start New page (see 3.2).

(3| start New line (see 3.2).

,@;J Insert Hard space (see 3.2).

@I Insert Hard hyphen (see 3.2).

@ Insert Soft hyphen (see 3.2).

Insert Merge tag (see 3.2).

(7] Preferences dialogue box (see 15.11).
= Edit colour dialogue box (see 16.2).
m Macros dialogue box (see 17.1).
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Applets
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Many new features can be added to Ovation Pro by installing Applets.
Applets may allow new graphics filetypes to be used, provide new print
formats, and extend text handling capabilities.
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18.1 Adding Features with Applets
Applets are software extensions that can be used to
add new features to Ovation Pro. An example
applet is !ColSupp, which provides the
professional colour printing features described in
Chapter 13.

This is the only applet to be installed by default in
Ovation Pro, but many more applets are supplied
with the program and can be installed if required.
Each applet comes with its own documentation
this may be in the form of a Text file or

Ovation Pro document, or as a !Help file inside the
applet. Applet !Help files can be displayed in the
same was as the !Help files with any RISC OS
application - select the applet in a filer window,
press Menu, display the sub menu from the
App"XXX" entry, and click on Help.

In addition to the applets supplied, new applets are
being developed by David Pilling and third parties
and can be found on the web.

Some of the features provided by applets are;

= Rendering ArtWorks and EPS files

+ Automatic entry of smart quotes and ligatures

« Graduated, patterned and hatched fills

= Page and Style palettes

« Simple pocket calculator

* Mines game

« New Print imposition formats
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18.2 Installing Applets

To install Applets they should be copied into the
10vnPro.Applets directory before running
Ovation Pro.

Most of the Applets supplied with Ovation Pro are
accessed through a new menu called Applets
which is added to the bottom of the main menu.
However, they may also add options to other
menus, define new keypresses, provide new tools
on the toolbox or add buttons to the button bar.
Note the Applets menu will not appear unless an
applet which requires it is loaded.

Applets increase the amount of memory used by
Ovation Pro and slow down the loading time, so it
is recommended that you only install the Applets
that you need.

You can disable Applets in the !|OvnPro.Applets
directory by double-clicking on them so that their
names are suffixed with a *-’. When you re-run
Ovation Pro, disabled Applets are not loaded. To
re-enable an Applet double-click over it again.

Auto-running Applications

If you copy applications inside the —
!OvnPro.Applets directory, they will be
automatically executed when Ovation Pro is run.

In fact any file in that directory will be run. A

common mistake is to leave a text file in this

directory, the result of which will be that it is

loaded into an editor each time Ovation Pro is run.
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18.3 Inside Applets

An applet is akin to a RISC OS application. Itis a
directory whose name begins with an ! mark.
Inside this there can be ! Boot and ! Run files just
like an application. However if the applet has a
tARun file this will be executed when the applet
is loaded, rather than the ! Run file.

Most applets have a dummy zero length ! ARun
file and a simple utility ! Run file, whose job is to
toggle the - sign at the end of the applet name. So
when you double click on the applet it is enabled
or disabled (i.e. ! Run is executed), and when
Ovation Pro loads the applet the ! Run file is not
executed, because of the presence of a ! ARun file
which is executed instead.

Again as with application, the applet can have
!Sprites and !Help files which will be used
by RISC OS.

A Text file called ! Info provides information on
the version number of the applet. This is a typical
example:

majorversion:1
minorversion:2
info:Pop-up calculator
author:David Pilling
majorcompatible:2
minorcompatible: 46

This tells you that the applet version is 1.02 and
that it is compatible with versions of Ovation Pro
greater than or equal to 2.46.

Directories Library and AutoRun can contain
script files just like the directories of the same
names inside the main ! OvnPro directory.

An AResources directory can hold resource
files which will be automatically merged in with
the main programs resources. These include, Help,
Messages, Templates, Sprites and Buttons files.
Finally some applets have an absolute Image file.
Any given applet can have one or all of the above
files.

Some simple applets will just supply resources and
so have no code files, Most applets are based on
the script language and have the Library and/or
AutoRun directories. The ARM code in an Applet
Image file is linked to the main program at run
time.

253
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Notes:
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Ovation Pro Script Language
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Ovation Pro contains an integrated script language that may be used to
control many aspects of its operation, such as the menu organisation,
macros and configuration. The script language is an advanced feature of
Ovation Pro, and you do not need to understand it to make full use of
the software.

Since the initial release of Ovation Pro the documentation of the script
language has almost doubled in size. It has therefore been decided to
not include all this material in the main manual anymore. Only a short
introduction is given on the following page.

For full documentation on the script language see the separate manual.
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19.1 Overview

The integrated script language in Ovation Pro is
based on a simple subset of the C programming
language.

If you are familiar with C programming, then
using the script language should pose few
problems. If you are not familiar with C, then it is
recommended that you obtain one of the many
beginners books on the C that are available.

The important point to note about the script
language, is that you do not need to use it or
understand it to make full use of Ovation Pro.
However, you may wish to use the script language
for the following reasons:

= The entire Ovation Pro menu structure is
controlled by the script language. By editing
the menu scripts you may re-organise the
menus, add menu entries or change the
function of menu options. You may also add
menus to the button bar.

« The macros system which allows you to define
button bar buttons and re-define keys, is based
around the script language. An understanding
of the script language will allow you to
generate your own advanced button and key
macros.

* Ovation Pro choices and preferences are saved
in script files. Creating script files of this type
allow you to configure the software for
different applications.

«  Script programs can write text to the caret or
read text from the caret, so it is possible to
write scripts that generate or modify
documents.
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The Script manual describes the following resident
functions that may be accessed from the script
language.

System Functions

These functions are mainly concerned with
accessing RISC OS.

« RISC OS functions
« String functions
= File input/output functions

Ovation Pro Functions

These functions carry out operations in
Ovation Pro.

*  Macro functions

* Menu control functions
« Icon bar menu functions
* File menu functions

« Edit menu functions

= View menu functions

= Text/Picture menu functions
» Style menu functions

= Object menu functions

» Page menu functions

« Misc menu functions

= Miscellaneous functions
= Macros

Examples of the use of the script language can be
found in !OvnPro.AutoRun.!Macros. Or open the
Macros... window

Menur>Misc>Macros...



Memory Problems

Ovation Pro is a large complex piece of software and requires over 1Mb
of free memory in which to run. Whilst it will run on a 2Mb computer,
virtually all of the remaining memory is used for screen memory, font
cache and module space. Additional memory is also required when
printing and spell checking, so a minimum of 4Mb is recommended.

In addition to the memory required by Ovation Pro itself, the documents
you produce need to fit in memory. If your documents consists mainly of
text, then you will be able to produce large multi-page documents in
single files on a 4Mb system. However, once you start introducing
pictures you will find the memory is used up very quickly, and you may
need to split your documents into smaller files. Alternatively consider
using referenced pictures (see 10.10).

This section describes a number of ways in which you can save memory
on your system.

Today there are many different types of RISC OS computers in use, this
section is only relevant to users of older machines with little memory. If
you have more than 8Mb it is not relevant to you.
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Quitting Other Applications

You can save memory by quitting other
applications:

Quit applications such as ! Edit and !Draw
which are loaded onto the icon bar.

Remove applications such as ! NewLook
(only present on older machines) which use a
considerable amount of memory, but do not
appear on the icon bar. Often applications of
this type are loaded automatically when they
are ‘seen’ in the desktop, or by the boot
sequence.

Quit !Printers after configuring it. After
quitting, the module that does the actual
printing remains active.

Some applications load parts of their programs
into module area. The only way to recover this
memory is to reset the computer before starting
Ovation Pro.

Configuring Ovation Pro

There are number of ways of configuring
Ovation Pro to save memory.

Use Menuc>Misc=>Min memory to flush the
undo buffer and recover memory used by
deleted objects.

Reduce the size of the undo buffer (see 15.5).
This will also reduce the size of saved
documents if Ovation Pro is configured to save
the undo buffer with documents.

If you load a document which has a dictionary
attached, that dictionary will be automatically
loaded into memory. You can save memory by
removing the dictionary from the document.
Provided the dictionary is not being used by
another loaded document, it will be removed
from memory (see 14.7).

Deselect the option Load interactive help on
Choices to prevent the help data from being
loaded when Ovation Pro is run (see 115.5).

AppeNDIX A

Configuring your System

There are a number of ways of configuring your
system to save memory:

Change to a screen mode which has a lower
resolution and fewer colours. A very low
resolution monochrome screen mode can save
a lot of memory, but is not really suitable for
DTP work. However it may be useful if you
need to free a lot of memory for printing.

A font cache of 256K is generally the minimum
required for DTP work, but if necessary this
could be reduced to 128K or even 64K.
Reducing this value will almost certainly slow
down the redrawing of documents, particularly
those containing text in many fonts, sizes and
styles. The size of the font cache may be
temporarily altered using the task manager, or
permanently using !Configure.

Other memory areas such as the module area,
system sprite area and RAM disc should all
normally be set to zero. Use ! Configure to
set these values. Please refer to your computer
user guide for details of their use.



Character Sets & Escape
Sequences

The tables overleatf list the full Latin1 character set. They give the ASCII
code followed by the character in Homerton, Selwyn and Sidney fonts.
Characters not available directly from the keyboard may be obtained by
holding down Alt and typing the ASCII code on the numeric keypad.
When Alt is released, the character is inserted at the caret position.
Alternatively you may use the Characters facility on the Misc menu or
the single shift font change facility to insert non-standard characters.

The final column gives the escape sequence that may be used to
represent special characters in macro definitions (see 16.5).
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Key Macro Names

When defining macros, the key names listed overleaf may be used in
macro definitions to represent keys on the keyboard (see 17.5).
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Acorn keyboard

Esc Fl1 F2 F3 F4 F5 F6 F7 F8 F9 Fl0

Fll Fl2

L% 3k 5
Tab g wer
asdfgh

zxcvbn

Print Slock

Insert Home
Delete Copy

Cup
CLeft CDown

NLock K/ K*
K7 K8 K9 K-
K4 K5 K6 K+
Kl K2 K3

KO0 K. Enter

6 7890 - =¢£ BS
tyuiop [ ]\
3 k1 ; ' Return

m , . / Space

PageUp
PageDown

Cright

K#

PC-style keyboard

Esc Fl1 F2 F3 F4 F5
Fll Fl2

1234567829
Tabgwerty
asdfghijk

\2xcvbnm,

= g
-~

Print Slock

Insert Home PageUp
Delete End PageDown

Cup
CLeft CDown Cright

NLock K/ K* K-
E7 EB K9 K+

K4 K5 K6

Kl K2 K3 Enter
KO0 K.
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Fé F7 F8 F9 Fl0

0 - = BS
op [ ]

' # Return
/ Space



Date & Time Format

Options on the Misc<=vInsert menu (Section 3.2) allow the current date
and time to be inserted into documents. This chapter describes how to
define the format of the date and time strings that are inserted.



266 Dare & Time Formar

Date and Time Format
Iconbar Menu=>Choices=>General

The date and time is controlled by the strings Date
format and Time format in the General section
of the Choices dialogue box (fig. D.1). Each
format string is made up of a number of
components that begin with the character . The %
character is followed by a two-character code from
the table below, which may be preceded by a z if
you want leading zeros to be suppressed.

Appenoix D

Any other characters separating the components
are inserted in the string unchanged.

So, for example, in Date format the components
are $ZDY, %ST, ¥MO, %CE and $YR, with two
spaces separating them. In Time format the
components are $212, $MI and $AM, with a colon
separating them.

The default date and time strings produce the
following results when inserted into a document.

3rd February 1995

Code Meaning Example
CS  centiseconds 99 %:07pm
SE  seconds 59 Examples
MI  minutes 45 Format string Output string
12 hours in 12-hour format 07 $ZDY%ST %M3 3¥YR 3rd Feb 95
24 hours in 24-hour format 19 $ZDY/%ZMN/$YR 3/2/95
aM ‘am’ or ‘pm’ am $ZMN-%ZDY-%YR 2-3-95
PM  ‘am’ or ‘pm’ pm $WE the %ZIDY%ST Friday the 13th
WE weekday, in full Friday Week $%ZWK %CE%YR Week 5 1995
W3  weekday, first 3 letters only Thu %12:%MI:%SE 02:35:09
WN  weekday, as a number 5 $224:3%ZMI%AM 14:35pm
DY  day of month 12
ST  suffix ‘st’, ‘nd’, ‘rd’ or ‘th’ st
MO month, in full March
M3 month, first 3 letters only Jan
MN month, as a number 12
CE  century 20
YR  year within century 95
WK  week of the year 52

Application choices

i

‘General choices

Date format | %ZDY%ST %MO %CE%YR |

| Time format | %Z12:%MI%AM |
[V Loadinteractive help i
[V Give warnings
__| Global clipboard Clipboards |I|

save | Cancel [[_oK |

Fig. D.1 - Choices dialogue box.



Keyboard and Mouse Short-cuts

This appendix lists all the default keyboard and mouse short-cuts. They
may be redefined if required using the Macros facility (17.3). In the short-
cut definitions that follow, the symbol * is used to represent the Ctrl key
and T is used to represent Shift.
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Caret Movement

— - Caret left/right one character

T 1 Caret up/down one line

e 1> Caret left/right one word

T Caret up/down one
paragraph

Y Caret to start/end of line

ol Caret to start/end of text
story

AT AL Scroll up/down through story

Page Movement

Page Up Scroll up one screen

Page Down Scroll down one screen

TPage Up Move to start of previous
page

'Page Down Move to start of next page

APage Up Move to start of first page in
chapter

APage Down Move to start of last page in
chapter

Home Move to start of first page in
document

THome Move to start of last page in
document

Deleting Text

Delete Delete character to left of
caret

Copy Delete character to right of
caret

TDelete Delete word at caret

ficopy Delete next word

ADelete Delete from caret to start of
line

ACopy Delete from caret to end of
line

MDelete Delete line of text

AfiCopy Delete line of text

Backspace Operates as Delete key

PC-style Delete

If PC-style delete is selected in the General
section of the Choices dialogue box, the Delete
key operates as the Copy key above. The Copy key
then behaves as End i.e. THome.

Arpenoix E
Selecting Text
Click and drag Select text region
1 click Select Clear selection
2 clicks Select Select word + following
spaces
12 clicks Select Select word only
3 clicks Select Select line
4 clicks Select Select paragraph
5 clicks Select Select story
1 click Adjust Extend/reduce selection
Drag & Drop

To drag and drop text, first select the text then
press Select and drag it to the required insertion
point.

To drag and drop a picture, first double-click to
select the picture then press Alt and drag the
picture to a suitable frame.

To drag and drop (move) an object within a page,
press and hold Select then drag to the required
position. Alternatively press Control and drag with
Select. For drag and drop between pages or
documents see the next paragraph.

The following operations apply when dragging to
within the same document:

Select and drag Move text
Alt Select and drag  Move object or picture
T Select and drag ~ Copy text

AltT Select and drag Copy text, object or picture

The following operations apply when dragging to
another document:

Select and drag Copy text

T Select and drag ~ Move text

Alt Select and drag  Copy object or picture

AltT Select and drag Move text, object or picture

Text Size, Kerning & Scale

~fe N> Decrease/increase font size by 1pt

~M< A Decrease/increase font size
through range

LT Decrease/increase kemning or
tracking by 1/1000 em

| P Decrease/increase kerning or
tracking by 1/100 em

Ll Decrease/increase horizontal
scale by 1%

At ~mM Decrease/increase horizontal

scale by 5%
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Key Presses in Dialogue Boxes
T Move caret to previous writable icon

d Move caret to next writable
icon

Return Move caret to next writable
icon

AC Copy contents of writable
icon to clipboard

~U Delete contents of writable
icon

Y Paste clipboard contents into
writable icon

X Cut contents of writable icon
to clipboard

Escape Same as clicking Cancel

When using ‘bump’ arrows for increasing and
decreasing values, Shift can be used to increase the
step size by a factor of 10.

Selecting Objects

Click Select on an object to select it, deselecting
any other objects.

Click Adjust on an object to add or remove it from
the selection.

Press Ctrl Shift and drag a rectangle around a
number of objects to be selected.

Press Ctrl Shift and double-click to select objects

hidden beneath other objects.

Working with Objects

When drawing, moving or resizing objects:

- -3 Nudge pointer left or right

Tl Nudge pointer up or down

Escape Cancel the operation

‘When drawing objects:

Press T To constrain rectangle or
ellipse to a perfect square or
circle

When moving objects:

Press * To move object without a
pause

Press T To constrain movement to
horizontal or vertical

‘When resizing objects:

Press To maintain original aspect
ratio of object

Press T To constrain shape to a

perfect square
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Working with Pictures
Double-click on a picture to select it.

A selected picture may be moved by dragging.
Press Shift to constrain movement to horizontal or
vertical.

A selected picture may be resized by dragging the
handles on the Resize gadget.

A selected picture may be rotated using the Rotate
tool.

Click Adjust on a picture to deselect it.
Ctrl double-click Select for O.L.E.

Triple-click on picture to open Modify picture
dialogue box.

Function keys
Key Key with Ctrl
File info Body text

F1
F2 .. Close document
F3 Save

F4 Find

F5 Goto page

F6  Modify text/picture

F7  Modify object

F8 Undo

F9 Redo

F10 Single shift font change

F11 Characters (see Misc menu)

F12 * commands
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Keys with Ctrl and Ctrl Shift

Ctrl

Remove All styles/effects
ClipBoard

Copy

Insert Date

Edit master page

Format

Show/Hide Guidelines
Object to back
Show/Hide Invisibles

Delete object

Remove Local effects
Show/Hide Print Margin
Page Number

New Page/Column

Show/Hide Rulers
Spellcheck Story
Open Thesaurus
Move object forward
Paste selection
Spellcheck Word

Cut selection

Set Marker/Select area
Clear selection

Discretionary hyphen
100% zoom

200% zoom

150% zoom

400% zoom

50% zoom

Variable zoom

shift baseline down 1%
shift baseline up 1%
decrease font size by 1pt
increase font size by 1pt
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When a line has been selected:
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Miscellaneous Key Presses

Return
Ctrl Shift TReturn
Select All Enter
Bold Tab
Centre Ctrl Tab
Duplicate Print
Edit style Insert
Frame border Mnsert
Grid lock Mnsert
Object sHape Alt Space
Italic Alt -
Justify Curl -
Group/Ungroup
Left align
Merge command
Normal
View Options
Preferences
Swap char pair
Right align
Swap case
Text flow
Underline
ReVerse
Select Word

Return to caret

Zoom options
Superscript
Subscript

down by 5%
up by 5%

36pt ---> 8pt
8pt ---> 36pt

> increase line width with Smm
< decrease line width with Smm

New paragraph

New line

New page, frame or column
Insert tab character
Display Tab/Indent ruler
Display Print dialogue box
Paste contents of clipboard
Insert filename

Insert file path
Non-breaking space
Non-breaking hyphen

Soft hyphen



Defining Borders

This section describes how to edit the borders styles supplied with
Ovation Pro, or add your own styles.
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Border Definition File
Menu=>Object=>Border... AF
Ovation Pro supports two types of borders. First
simple lines suitable for use on all types of frames,
including irregular ones. These are defined in Text
files, using the format described below. Second
graphical borders. These use the same format as
‘Impression’ and are defined in Draw files which
can be edited and created using the Draw program.
All the borders that appear in the Object=>Border
dialogue box are defined in files in the directory
10vnPro. !OvnResDir. ! Borders
The format of the Text files defining simple
borders is explained below.
Line Styles
Lines which begin with the command Line, define
the line styles that may be used in border
definitions. The syntax of the Line command is:

Line <n> <pattern> <size> <join>
Where:
n is the number of the line style.

patternis a word whose bit pattern defines the
line pattern.
size is the size in 1/1000 pt, at which the pattern
is plotted.
join is the line join style, as follows:

0 mitre

1 round
2 bevelled

These line style definitions are exclusively for the
borders and have nothing in common with lines
drawn using the Line tool.

Appenoix F

Border Styles

Lines which begin with the command Border,
define the actual borders. The syntax of the
Border command is:

Border <name> <definition>
Where:
name is the name of the border.

definition is a string that defines the lines and
gaps in the border. A number in the string refers to
a line style number and an underline represents a
gap. For example:

Border Example 11_3

In this example, the border named Example
consists of two lines of style 1 and one line of style
3, with a gap between them. These are plotted
from the outside, inwards to the frame edge.

The total thickness of the border is determined by
the value specified on the Border dialogue box.



Defining Colour Charts

This section describes how to define the colour charts that may be used
when defining colour using the Misc<>Edit colours option.
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Defining Colour Charts

Charts are defined in ASCII files and saved in
directory !OvnPro. !OvnResDir.Colours.
The chart is given the same name as the name of
the file that defines it.

The format of the file that defines a colour chart is
shown in the extract below:

// 56 Named Colours
// 23/10/95

HSV

Pale Pink,0,20,100
Pink,0,30,100

Red, 0,100,100
Burgundy, 0,100,770
Vermilion, 15,100,100
Terracotta, 15,100, 80
/#

Lines like the first two which start with // are
comments, and have no effect.

The next line contains a word which defines the
colour model for the data. The word may be HSV,
RGB or CMYK, and should be terminated with a
carriage return or line feed character.

The following lines define the colours which
appear in the chart. Each definition should have
either four or five fields separated by a comma,
and should be terminated by a carriage return or
line feed character.

The first field is the name of the colour. The length
of this name added to the chart name should not
exceed 22 characters.

The values after the colour name, define the
colour.
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HSV

If the colour model is HSV, there should be three
values after the colour name, relating to the Hue,
Saturation and Value for the colour. Hue should be
specified in the range 0 to 360°, and the other
values in the range 0 to 100%. All values are
accurate to 1 decimal place.

RGB

If the colour model is RGB, there should be three
values after the colour name, relating to the Red,
Green and Blue values for the colour. All values
should be specified in the range 0 to 100% and to
an accuracy of 1 decimal place.

CMYK

If the colour model is CMYK, there should be four
values after the colour name, relating to the Cyan,
Magenta, Yellow and Black values for the colour.
All values should be specified in the range 0 to
100% and to an accuracy of 1 decimal place.

Formatting the Chart

The colours you define are displayed in a series of
columns, with 7 colours per column. You can
introduce a blank space into the chart at any time
by defining a colour as /# (see earlier example).

Loading the Chart

Once you have created the colour chart, you must
save it and re-run Ovation Pro in order for it to
appear on the Chart menu of the Chart dialogue
box. Once it has registered on the menu, you can
freely edit the colours in the chart without having
to re-run Ovation Pro. Charts are only loaded from
disc when they are needed, so there is no memory
overhead in creating lots of charts (other then
using disc space).



Adding Sprites to the Button Box

Chapter 16 describes how to add buttons to the button bar using sprites
stored in the button box (see 16.2). A wide range of sprites relating to
many Ovation Pro functions are provided by default, but this section
describes how to add your own sprites for use on the button bar.
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Adding Sprites to the Button Box

The button box sprites are stored in two files in the
directory !OvnPro. !0vnResDir.

Buttons are the sprites used in low resolution
‘non-square pixel’ screen modes, such as 12, 15
and 39. In this file, sprites should be designed as
mode 12 sprites (or equivalent) and should be 10
pixels high by 20 pixels wide.

Buttons22 are the sprites used for high
resolution ‘square pixel’ screen modes such as 20,
27, and 31. In this file, sprites should be designed
as mode 20 sprites (or equivalent) and should be
20 pixels high by 20 pixels wide.

Use the Paint application to add new sprites to
either or both of the above files, depending on the
screen mode you normally use. The maximum
number of sprites that can be in a file is 256.

Sprites do not need a mask, and the background
should be colour 1 (light grey). The easiest way to
add a new sprite is to copy an existing sprite, then
edit the copy as required.

Appenpix_H



Document Description Language

The Document Description Language (DDL) is a file format that
describes Ovation Pro documents in textual form. This short appendix
describes why the DDL may be useful and when it should be used.
However, it does not give full DDL syntax which is beyond the scope of
this user guide.



278  Document DescrIPTION LANGUAGE

Purpose of the DDL

A document saved in DDL format may be read or
altered by loading it into a text editor such as Edit.
One purpose of the DDL format is to allow foreign
file format converters to be easily written. So, a
foreign file could be converted to DDL format and
then loaded into Ovation Pro. Likewise, an
Ovation Pro document could be saved as a DDL
file, which could then be converted to another
format. Conversion via the DDL is much easier
than using the native Ovation Pro file format
(which is compacted and not easily deciphered).

Most of the existing loaders for alien files (e.g.
RTF and Impression) work by transparently
converting the file to DDL format and getting
Ovation Pro to load it.

Saving in DDL Format

When you save a document or text story, you may
choose to save it in DDL format. Once saved, the
resulting text file could then be interpreted by a
separate program for processing or conversion.

Loading DDL Files

If you double-click on a DDL format document, it
will be loaded into Ovation Pro in the usual way.
If a DDL file just describes a text story, then it
may be dragged into an Ovation Pro text frame or
to the icon bar icon.

Native Format Versus DDL Format

In normal circumstances you should save
documents in Ovation Pro format, rather than
DDL format. There are three reasons for this:

* Ovation Pro files are usually more compact.

= Ovation Pro files contain flow information,
which specifies exactly where each line of text
appears on the page. This means that they load
more quickly than DDL files, which must
calculate the flow information during loading.

» QOvation Pro files contain document view
information such as zoom. DDL files do not
contain this information, and will use the
defaults on loading.
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Using DDL on Problem Documents

One side effect of saving a document as DDL and
loading a DDL document is that Ovation Pro is
forced to analyse and tidy the structure of the
whole document. This means that if you get a
document which behaves badly, a possible fix is to
save it as DDL and then reload the DDL version.



Expression Evaluation and Units

Within Ovation Pro there are many writable icons into which values can
be entered. It is possible to enter expressions and use various units
using the same format in all of them.
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Units

The following units and abbreviations are
supported.

Millimetre mm, m, M
Inch in, 1,",1
Point pt,p, P
Pica pi, PI
Centimetre cm, ¢, C
Didot di,d,D
Cicero ci, CI
Foot ft, '

Yard yd

The didot is the equivalent of the point outside the
UK and USA. There are 12 didot’s in 1 cicero. A
point is 1/72nd of an inch. A didot is 0.0148 inch
or about 1/68th of an inch

A pica is equal to 1/6 of an inch, or 12pt.
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Expression Evaluation

In any icon where you type a value, you can type
in an expression.

For example;

10+20

6%2.123

The operator precedence is

unary +/-  (e.g. using - for a negative value)
(and ) (brackets)

/and * (division and multiplication)
units and % (e.g. mm)

+and - (addition and subtraction)
More advanced examples;

100mm+10%

5/6"

here " is short for inch, but note that the value of
this is (5/6) inches and not 5/(6 inches).
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A

Accent

A mark on a character denoting pronunciation in a
given language e.g. the acute on é.

Additive colours

Red, Green and Blue. The primary colours of light
that may be mixed to generate all colours in
photographic reproduction.

Alignment

The arrangement of the surplus space in a line of
type. Type may be aligned left, centred, aligned
right or fully justified, (i.e. space divided equally
throughout the line). Vertical alignment is the
arrangement of surplus space vertically in a frame.
Alphanumeric set

A set of characters containing letter and figures,
but possibly containing punctuation marks and
other symbols.

Ampersand

The symbol & used in place of the word ‘and’.

Antialiasing

A technique which reduces the jagged edges of
fonts or bit-mapped images by displaying pixels at
the edges in intermediate shades of the image
colour. This has the effect of softening the edges of
the image.

Ascender

The part of a lower-case letter which extends
above the x-height e.g. the upper part of b.

ASCII

An abbreviation for American Standard Code for
Information Interchange. This defines how
numeric codes are assigned to the alphanumeric
characters used by most computers.

Aspect ratio

The ratio of an object’s width to its height.

Autoflow

The facility to flow type automatically from one
frame or page to another.

B
Back to back
Printing on both sides of a sheet.

Banner
A main heading across the full width of a page.

Base alignment
See Base line grid lock.

Base line

The imaginary line upon which the bases of
capitals sit.

Base line grid lock

The alignment of base lines to a common grid.

Bézier curve

A mathematically defined curve between two
points. The curve is edited my dragging control
points.

Binding margin

An inside margin that is wider than the standard
margin to allow for punching or binding.
Bit-depth

The number of bits used to define the number of
grey levels or colours available e.g. 24-bit colour.
Bitmapped font

A font with jagged edges made up of pixels as
opposed to a smooth-edged outline font.
Bitmapped graphic

An image such as a Sprite made up of pixels as
opposed to an object-oriented graphic such as a
Draw file.

Bleed

The part of a page that extends beyond the trim
marks of the page.

Body

The main part of a story not including headings
etc.

Bold

A type style in which characters are emphasised
with thicker-than-standard black lines.
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Border

A decorative outline drawn around a frame, used
to highlight the contents of the frame or to
distinguish it from its surroundings.

Box rule

A paragraph or graphic, ruled off on all four sides.

Bromide

A high quality print on paper coated with silver
bromide emulsion.

Bullet

A large dot or symbol normally preceding listed
items which require emphasis.

Cc

©

The mark used to identify the copyright owners
name and to signify that an item is protected by
international copyright laws.

Cap line

An imaginary line running across the top of
capitals.

Caps

An abbreviation for capitals i.e. upper-case letters.

Caps and smalls

Type consisting of capitals for initial letters and
small caps for lower-case letters.

Caption

Descriptive text normally attached to an
illustration.

Caret

The I-shaped cursor in DTP software which
indicates where text will appear when typed.
Case

Alphabetic characters may be either lower-case
(small letters) or upper-case (capitals).

Centred

Alignment of type so that it is centrally placed on
each line, with any remaining space divided
equally between the left and right margins. Type
may also be centred vertically in a frame.
Character

Any printable letter, number or symbol.

GLOSSARY

Chromalin

A proofing system.

Cicero

A European unit equal to 4.511mm or 12 Didot
points.

Clipart

A set of pictures and symbols for importing into
documents.

Clipboard

In DTP software, a temporary store for text,
pictures or objects which have been cut or copied
from the document. The contents of the clipboard
may be pasted back into any document.

CMYK

The four process colours of Cyan, Yellow,
Magenta and Key (Black) used in four-colour
printing.

Codet

See Colour bar.

Collate

A printing option that puts pages in the correct
order when printing multiple copies.

Colour bar

A standard set of colour bars, printed outside the
page area, used in four-colour printing to show the
strength and registration of the colours.

Colour correction

The adjustment of colour values to improve colour
reproduction of the printed image.

Colour model

The system in which colours are defined and
edited. The most common models used in DTP are
RGB (Red, Green,Blue), HSV (Hue, Saturation
and Value) and CMYK (Cyan, Magenta, Yellow
and Key).

Colour separations

The division of colours into separate plates for
printing using the spot-colour or four-colour
process.

Column
A section of a frame or page divided vertically
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Column rule

The vertical line drawn between columns.
Condensed type

A typeface with a narrow appearance or a normal
typeface that has been squashed horizontally.
Contrast

The degree of separation of tones in an image.

Copy
The text from which the printed page is to be

prepared.

cpi

Abbreviation for Characters Per Inch.

cpl

Abbreviation for Characters Per Line.

Crop

The process of discarding the unwanted edges of a
graphic.

Crop marks

Marks which act as a guide for cropping the
printed material.

Cut and paste

The process of deleting an item from a document,
placing then placing it elsewhere. In DTP
software, this is done via the clipboard.

Cyan

One of the four process colours, often called
process blue.

D

Dash

Either an em-dash — (ASCII 152) or an en-dash —
(ASCII 151), as opposed to a hyphen - .
Decimal tab

A tab stop which aligns the decimal point in
decimal numbers on the tab stop.

Descender

The part of a lower-case letter which extends

. below the baseline e.g. the tail of y.
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Desktop publishing

The activity of document creation or graphic
design using a desktop computer. The final result
is usually camera-ready artwork or data files in a
form suitable for high-end printing.

Didot point

The European unit for type equal to 0.0148in.

Dingbat
A font of decorative symbols such as Selwyn font.

Discretionary hyphen

See Soft hyphen.

Dithering

A technique used to simulate extra colours by
mixing colours in different patterns.

Document description language (DDL)

A type of language used to describe an entire
document.

Dot gain

The process during reproduction where halftone
dots grow in size.

Dot matrix printer

A low-cost printer that creates printed characters
by hitting the correct combination of pins through
an inked ribbon.

Double page spread

Two facing pages of a document.

Draw files

Object-oriented graphics that are compatible with
the Acorn Draw module and the Draw application.
Drop cap

A large initial character at the beginning of a
paragraph that drops into the lines beneath.

Drop shadow

A shadow behind an image or frame, designed to
bring the object forward.
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Duotone

Normally refers to the process of printing a
halftone in two colours using two halftones
generated from the same original. This is also
called duplex halftone. Strictly speaking, a duotone
is a monochrome image printed in two shades of
the same colour.

Duplex halftone

See Duotone.

E

Ellipsis

The symbol ... indicating that the end of the text
has been omitted.

Em

A linear measurement equal to the point size of the
type, but traditionally the area of the capital letter
M.

Em dash

A dash that is an em wide — (ASCII 152).

Emuilsion side

The side of photographic film which hold the
emulsion. The emulsion on positive film is on the
back of the film (emulsion side down) while on
negative film it is on the front (emulsion side up).
En

Half the width of an em.

En dash
A dash that is an en wide — (ASCII 151).

EPS

Abbreviation for encapsulated PostScript which is
a standard graphics file format.

Exception dictionary

A user-defined list of words that should not be
hyphenated using the standard hyphenation
algorithm.

Expanded type

A typeface with a wider appearance or a normal
typeface that has been stretched horizontally.
Export

The facility to save all or parts of a document in an

appropriate format for use in another application
e.g. text may be saved as an ASCII file.
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F

Facing pages

Pages that face each other in a double-sided
document.

Family

A set of typefaces in all sizes and styles.

Feint ruling

Lines horizontal lines drawn on a page as a guide
for placing text.

First line indent

The indent applied to the first line of a paragraph.
A zero first line indent combined with a positive
left indent is used to produce a hanging indent.
Fixed word spacing

The standard spacing between words for
unjustified text.

Fixed hyphen

See Hard hyphen.

Fixed space

See Hard space.

Flat plan

A diagrammatic plan used to organise the layout of
a document.

Flush left/right

See Left align/Right align.

Flush paragraph

Paragraph where the first word is not indented, but
set flush against the left margin.

Font

A complete set of alphabetic and numeric
characters, punctuation marks or other symbols of
matching style and size. Also called a Typeface.
Foolscap

In Europe a paper size of 13%4" x 17".

Footer

Text or graphics repeated at the bottom of every
page (above the bottom margin). Typically, the
footer contains the page number.

Footnotes

Short, explanatory notes printed at the bottom of a
page or at the end of a chapter and referenced to
the appropriate passages in the main text.
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Format

Collective term for paragraph attributes such as
justification, indentation, tabs etc.

Fount

See Font.

Four-colour process

The colour printing process using the colours
Cyan, Magenta, Yellow and Key (Black).

Frame

Boxes in which text and graphics are placed when
creating documents using DTP software. normally
frames may only be rectangular, but in Ovation
Pro they may be any regular or irregular shape.
Frontispiece

An illustration facing the title page of a book.

G

GIF

Abbreviation for Graphic Image Format. A
standard bitmapped graphic format.

Greeking

A process in some DTP systems which substitutes
text or pictures with a grey tint to speed up screen
redraw.

Grid

A matrix of equally spaced lines or points drawn in
the background, allowing objects such as frames
and lines to be positioned with greater accuracy
and consistency.

Guideline

A line which appears on the screen as an aid in
laying out the document, but which is not printed.
Gutter

The common term for the margin between
columns in multi-column documents. A standard
gutter width is 1 pica (12pt).

H

Halftone

An image reproduced by the halftone process. The
halftone process is where an image is simulated by
a pattern of dots of varying sizes.

Handles

In DTP software, small squares attached to the
active object, and used to re-size or re-shape the
object.
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Hanging indent

The effect where the first line of a paragraph is
flush with the left margin and subsequent lines are
indented, so that the body of the paragraph appears
to ‘hang’ from the first line.

Hanging punctuation

Punctuation marks allowed to fall outside the right
margin.

Hard hyphen

A non-breaking hyphen. Words separated by a
hard hyphen are never split between lines.

Hard space

A non-breaking space. Words separated by a hard
space are never split between lines.

Header

Text or graphics repeated at the top of every page
(below the top margin). Typically, the header
contains the chapter name.

Heavy

See Bold.

Hinting

A technique used by the font manager to improve
the rendering of outline fonts, especially at lower
resolutions.

Horizontal Scale

A style effect which allows type to be condensed
or expanded horizontally.

Hue

The pure pigment of a colour, not including any
black or white.

Hyphenation

The process of introducing hyphens in words at the
end of lines so that they are split across two lines.
The position of the hyphen in the word is
determined by a hyphenation algorithm

and exceptions dictionary.

|

Image file

See Bitmapped graphic.

Imagesetter

A high-resolution output device used to produce
film or camera-ready artwork on bromide paper.
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Import

The introduction of text or graphics from another
application into a document either directly or from
a file on disc.

Indent

The left indent is the distance between the left
margin and the start of the line of text. The right
indent is the distance between the end of the line of
text, and the right margin.

Inferior character

See Subscript.

Inset

The margin around the inside of a text or picture
frame, which prevents the contents of the frame
running into the frame edge.

ltalics

A specially designed sloping version of a typeface.

J

Jaggie

The term used to described the stepped appearance
of bit-mapped fonts and images.

JPEG

A popular compressed bitmapped graphic format.

Justification

The arrangement of the surplus space in a line of
type where extra white space is inserted between
the words and letters in a line so that both left and
right edges are aligned to the margins.

K

Kerning

Fine adjustment of white space between letter pairs
to enhance their appearance. It is mostly used to
reduce the white space between characters in
larger font sizes.

Key

The black plate in CMYK printing.

Keyline

A line indicating the size and position of an
illustration.
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L

Laminate

A transparent plastic coating applied to paper or
cardboard giving it a protective finish.
Landscape

The orientation of a page such that its longest edge
is horizontal.

Leader

A line of characters (usually dots) that lead the eye
across the page between tabbed text.

Leadering

See Leader

Leading

The vertical spacing between lines of text.
Pronounced ‘ledding’, it takes its name from the
strips of lead that were used to space out lines of
type in mechanical printing. In Ovation Pro,
leading may be specified as an distance between
the baselines of type (as a percentage or an
absolute value) or as a gap between the bounding
boxes of type.

Left aligned

A paragraph format option where text is aligned to
the left margin, leaving the right edge ragged. Left
aligned is also referred to as ‘flush left’, ‘ranged
left’ or ‘ragged right’.

Legal

A standard paper size 8.5 inches wide by 14 inches
long.

Letter

A standard paper size 8.5 inches wide by 11 inches
long.

Letterspacing

The spacing between letters. Letterspacing may be
adjusted using kerning, tracking or by fully
Jjustifying the paragraph.

Linking

The process of connecting a number of text frames
together so that text of one story flows
automatically from frame to frame.
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M

Macro

A single label that identifies a larger unit of text.
The text is often a sequence of commands that may
be executed by ‘expanding’ the macro.

Magenta

One of the four process colours, sometimes called
process red.

Margins

The blanks areas around the edges of a page.

Master Frames

Frames which appear on the Master Pages and as a
result appear on each page in the document.
Master Pages

Special pages in DTP software that act as a
template for all the pages that are inserted into the
document. Master pages define the format of the
page and may contain text, pictures and lines that
are to be inserted on every page. Usually there are
separate master pages for every chapter of the
document.

Mono spaced

The situation where all characters in a font have
even spacing regardless of their actual widths. So a
mono spaced letter ‘I’ uses the same horizontal
space as an ‘M’. A typical mono spaced font is
Courier. The opposite of Mono spaced is
Proportionally spaced.

N

Negative leading

The situation where the absolute leading is smaller
than the size of the type e.g. 12pt text on 10pt
leading.

(@)

Outset

See Standoff.

P

Page

One side of a leaf.

Page description language (PDL)

A type of programming language, such as
PostScript, used to describe a document to a
printer.
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Pamphlet

A short, unbound booklet.

Paragraph

In Ovation Pro a paragraph is defined as the text
between two carriage returns.

PCD

See Photo CD.

Photo CD

A CD containing high resolution bitmapped
graphic images.

Pica

A unit used in typesetting. A pica is equal to 1/6 of
an inch, or 12pt.

Point

The standard unit of measuring type size. In DTP
work, a point is equal to 1/72 of an inch. Strictly
speaking a point is 0.013837in or 72.27 to the inch.
Portrait

The orientation of a page such that the longest
edge is vertical.

Posterize

To divide a continuous tone image into a number
of flat tones.

Process colours

See CMYK.

Proportionally spaced

The situation where characters in a font have been
designed with varying widths. So a proportionally
spaced letter ‘I" uses less horizontal space then the
letter *‘M’. The opposite of proportionally spaced is
Mono spaced.

R

Ragged left/right

See Right aligned/Left aligned.

Ranged left/right

See Left aligned/Right aligned.

Register marks

Marks positioned outside the page area used to
ensure that the separations are accurately
superimposed.
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Right aligned

A paragraph format option where type is aligned to
the right margin, leaving the left edge ragged.
Right aligned is also referred to as ‘flush right’,
‘ranged right’ or ‘ragged left’.

Rivers (of white)

A problem that occurs in badly justified type
where spaces between words form streams of
continuous white areas down the page.

Rule

A straight horizontal or vertical line used to
separate or emphasise areas of type.
Runaround

The way in which type fits around frames and
irregular graphics.

Running head

See Header.

S
Sans serif

A typeface which lacks ‘serifs’, the minute cross-
lines finishing off the main strokes of the
characters. Helvetica is an example of a sans serif

typeface.

Screen angle

The angle at which halftone screens are rotated to
minimise undesirable dot patterns.

Script

A typeface designed in the style of handwriting.
Separations

See Colour separations.

Serif

A small cross-line finishing off the main strokes of
the characters in some fonts. Times is an example
of a serif typeface.

Set solid

Type which has been set without any leading.
Skew

An effect which allows you to slant text, graphics
or frames.
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Small caps

Capitals that are smaller in size than standard
capitals. Normally they are generated by scaling
full size capitals, but strictly speaking they should
be a specially designed font.

Soft hyphen

A hyphen inserted into a word by the user which is
only displayed if that word appears at the end of a
line and needs to be split. Also called a
Discretionary hyphen.

Story

In DTP software, an independent block of text
contained within a text frame, or in a series of
linked text frames.

Strikeout/strike through

The term describing type with a horizontal line
drawn through its centre.

Stylesheet

In Ovation Pro, a file which describes the exact
format and style of a document and which may be
used as a template for other documents, A
stylesheet contains master page definitions,
defined styles, view options etc.

Subscript

Smaller sized characters set below the baseline, as
in H;O. Also called Inferior.

Superscript

Smaller sized characters set above the baseline, as
in n2. Also called Superior.

Swatch

A sample of material, paper or colour.

T

Tab leadering

See Leader

Tabloid

A standard paper size 11 inches wide by 17 inches
long.

Tab stop

A horizontal position to which type is aligned
when the Tab key is pressed.
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Text chain

A text story that flows through a series of linked
frames.

TIFF

An abbreviation for Tagged Image File Format. A
standard bitmapped graphic format.

Tiling

The process of printing a sheet over a series of
smaller sheets which must be joined to create the
complete image.

Tint

The effect of adding white or allowing the
background to show through a solid colour. Tints
are specified as percentages of the solid colour.
Tracking

Fine adjustment of the space between characters.
Tracking is similar to kerning, but applies to
selected text instead of letter pairs.

Trapping

The deliberate overlapping of colours to eliminate
gaps that may be caused by registration problems
when printing

Trim marks

See Crop marks.

Typeface

See Font.

Type family

See Family.

Typesetting
The process of setting text in a typeface in
preparation for printing.
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u

UCR

See Under colour removal.

Under colour removal

The process of removing equal (usually) amounts
of Cyan, Magenta and Yellow and replacing them
with Black. This process reduces the amount of ink
used and gives better reproduction of certain
colours.

Unjustified

Type that is left aligned or, strictly speaking, not
fully justified.

\"

Vignette

An image with no discernible border or an image
which gradually fades into the background. Also
used to describe a graduated fill.

w

Word underline

A text style that underlines all characters except
spaces.

Word wrap

The forcing of words that are not hyphenated and
which will not fit on the end of the line to be
carried over to the next line.

X

x-height

The height of the main body of lower-case
characters excluding their ascenders e.g. the height
of a, ¢, e, i, m, etc.

Y

Yellow

One of the four process colours.
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Index

To ease finding certain topics in the Index, several styles have been
used depending on the subject.

General index information is in the general Bodytext style of the manual,
but in the Index named "MainBody".

References to files, applications or functions are in Corpus style.
References to menu topics are in Bold style.

References to menu selections in windows or options available on

the Info palette are in Homerton style.

This system is not always followed, especially in the case of sub-entries
falling under a common main entry.

At times certain topics appear often in the manual. The main page
reference giving specific information on the subject is then printed in
Bold style.

The page numbering continues throughout all Chapters, Appendices and
this Index, starting with page 1 in Chapter 1.

Including the Appendices this is the 30th chapter of the manual.
This manual contains 306 pages with a total of ~81100 words.

The separate Script manual presently contains ~20650 words and 126
pages.
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